Managing AIX V4 on PCI-Based
RISC System/6000 Workstations (40P/43P)

September 1995
Abstract

The RISC System/6000 family of products, typically based on the Microchannel bus architecture, has been expanded to include a new line of products based on the PowerPC microprocessor, the Peripheral Component Interconnect (PCI) bus architecture and the PowerPC Reference Platform Specification (PReP). The AIX Version 4.1 operating system had to be enhanced to support these new systems, and a new software layer had to be incorporated between AIX and the hardware to allow for a transparent implementation of the PowerPC Reference Platform Specification.

Support for the Industry Standard Architecture (ISA) bus architecture has been added to allow for the use of the large number of ISA adapters available for personal computers.

All these enhancements present new environments and new configuration tasks to system engineers, system administrators and customer engineers. This book is intended to describe this new environment and to assist the support personnel in accomplishing these new tasks.

(272 pages)
Abstract ........................................................................................................ iii

Special Notices ................................................................................................ xvii

Preface ........................................................................................................... xix
How This Document is Organized ................................................................... xix
Related Publications ....................................................................................... xx
International Technical Support Organization Publications .................... xx
ITSO Redbooks on the World Wide Web (WWW) ........................................... xxi
Acknowledgments .......................................................................................... xxi

Chapter 1. PowerPC Reference Platform Specification ................................. 1
1.1 Why Have a PowerPC Reference Platform Specification? .................... 1
1.2 The PowerPC Reference Platform (PReP) Specification ......................... 3
1.3 Hardware Configuration ........................................................................... 4
1.4 Architecture ............................................................................................. 7
1.4.1 System Topology .................................................................................. 7
1.5 Machine Abstraction ................................................................................ 8
1.5.1 Machine Abstraction Achievements ..................................................... 8
1.5.2 Machine Abstraction Requirements .................................................... 9
1.5.3 Abstraction Example .......................................................................... 9
1.5.4 Abstraction Software Components ..................................................... 10
1.6 Firmware .................................................................................................. 12
1.6.1 firmware Problems ........................................................................... 13
1.6.2 The Solution: Open Firmware ............................................................. 13
1.6.3 RSPC Firmware (System ROS) .......................................................... 15
1.6.4 Bi-Endian Support ............................................................................ 16
1.7 PReP Reference Implementation ............................................................. 18
1.7.1 Portable System ................................................................................ 18
1.7.2 Energy-Managed Workstation ........................................................... 18
1.7.3 Medialess Workstation ..................................................................... 18
1.7.4 Technical Workstation ..................................................................... 19
1.7.5 Server System .................................................................................. 20
1.7.6 Multiprocessor System ..................................................................... 20
1.8 Power Management .................................................................................. 20
1.8.1 Macro Power Management Model ..................................................... 20
1.8.2 Implementation for Energy-Managed Systems ................................... 22
1.9 The PowerPC Hardware Reference Platform (HRP) Architecture .......... 24
1.9.1 HRP Architecture - Introduction and History ................................... 24
1.9.2 The HRP Architecture Document .................................................... 25
1.9.3 Purpose of The HRP Architecture Document ................................... 25
1.9.4 HRP Architecture Goals .................................................................. 25
1.9.5 HRP Brand and Certification .............................................................. 26

Chapter 2. Introducing the Hardware ............................................................ 27
2.1 Introducing the PCI Bus Architecture ..................................................... 27
2.1.1 PCI Local Bus Overview ................................................................ 27
2.1.2 PCI Features and Benefits ................................................................. 28
2.2 Introducing the ISA Bus Architecture .................................................... 32
2.2.1 Why ISA Support? .......................................................................... 32
2.2.2 How to Connect to the PowerPC ....................................................... 32
2.3 Introducing the PCMCIA Bus Architecture ........................................ 33
   2.3.1 PCMCIA Cards ........................................................................... 35
   2.3.2 PCMCIA Socket ........................................................................ 35
   2.3.3 Software Services ....................................................................... 36
2.4 Plug and Play .................................................................................... 36
   2.4.1 What is Plug and Play? ................................................................. 37
   2.4.2 Plug and Play Benefits .................................................................. 37
   2.4.3 Plug and Play Hardware and Software Requirements .................. 37
2.5 RISC System/6000 Model 40P .............................................................. 38
   2.5.1 RISC System/6000 Model 40P Features and Benefits .................. 39
   2.5.2 RISC System/6000 Model 40P Hardware Characteristics ............. 41
   2.5.3 RISC System/6000 Model 40P System Performance .................... 43
   2.5.4 RISC System/6000 Model 40P Limitations .................................... 45
2.6 RISC System/6000 Model 43P .............................................................. 45
   2.6.1 RISC System/6000 Model 43P Series Features and Benefits .......... 47
   2.6.2 RISC System/6000 Model 43P Series Hardware Characteristics .... 49
   2.6.3 RISC System/6000 Model 43P System Performance .................... 52
   2.6.4 RISC System/6000 Model 43P Limitations .................................... 54

Chapter 3. Boot Support ........................................................................ 55
3.1 Multiple-Platform Boot .................................................................... 55
   3.1.1 Platform-Specific Components .................................................... 56
   3.1.2 Impact on Boot Utilities, Commands and Scripts ......................... 58
3.2 Boot Components Specifically for AIX on RSPC Systems .................. 59
   3.2.1 RSPC firmware .......................................................................... 60
   3.2.2 Software ROS for AIX ................................................................. 60
   3.2.3 Non-Volatile RAM (NVRAM) ...................................................... 62
   3.2.4 Hardfile Layout for RSPC Systems .............................................. 64
3.3 RSPC Systems Boot Image ................................................................. 67
   3.3.1 Structure of the RSPC Boot Image ................................................. 68
   3.3.2 RSPC Boot Image Creation .......................................................... 69
   3.3.3 Modifications to the Boot Commands .......................................... 70
3.4 Supported Boot Devices on RSPC Systems ....................................... 72
   3.4.1 Supported External Boot Devices ............................................... 73
   3.4.2 Selecting Boot Devices ................................................................. 73

Chapter 4. AIX Version 4 Network Installation ....................................... 77
4.1 Preparing the Network Environment .................................................. 77
4.2 NIM Master Configuration ................................................................. 78
   4.2.1 Installing the NIM Master Filesets .............................................. 78
   4.2.2 Filesystems Creation ................................................................. 79
   4.2.3 NIM Master Activation ............................................................... 79
   4.2.4 NIM Network Objects Definition .............................................. 82
   4.2.5 NIM Client Machines Definition .............................................. 84
   4.2.6 Resource Objects Definition ..................................................... 86
   4.2.7 Allocating Resources for the Stand-Alone Installation ................ 90
   4.2.8 Initiating the BOS Installation .................................................. 91
   4.2.9 Client RSPC Configuration ....................................................... 92
   4.2.10 Post Installation Operations ..................................................... 96
   4.2.11 RSPC Systems Network Installation Limitations ....................... 97

Chapter 5. Device Configuration on RSPC Systems .............................. 99
5.1 Device Configuration ......................................................................... 99
5.2 Device Configuration Database ......................................................... 100
   5.2.1 Database Object Classes ............................................................ 101
| 5.2.2 | Enhancements to the Configuration Database | 105 |
| 5.3  | Preparing ISA Adapter Configuration | 106 |
| 5.3.1 | Recording Settings of ISA Adapters Already Configured | 106 |
| 5.3.2 | Selecting Parameter Values for ISA Adapters | 109 |
| 5.4  | Configuring ISA Adapters | 112 |
| 5.4.1 | Using SMIT or Command Line | 112 |
| 5.4.2 | Configuring ISA Ethernet Adapters | 113 |
| 5.4.3 | Configuring ISA Token-Ring Adapters | 115 |
| 5.4.4 | Testing ISA Adapter Configuration | 119 |
| 5.5  | Setting Up and Configuring an X.25 Network | 120 |
| 5.5.1 | X.25 Introduction | 120 |
| 5.5.2 | X.25 Terminology | 121 |
| 5.5.3 | Planning Your X.25 Configuration | 122 |
| 5.5.4 | Installing the X.25 Support Software (AIXLink/X.25) | 122 |
| 5.5.5 | Configuring ISA X.25 Adapters | 124 |
| 5.5.6 | Basic X.25 Communication Tests | 129 |
| 5.6  | Configuring PCI Adapters | 129 |
| 5.6.1 | Configuring Non-Graphic PCI Adapters | 130 |
| 5.6.2 | Configuring PCI Graphic Adapters | 130 |
| 5.6.3 | Accessing the Second Display | 133 |
| 5.6.4 | Adapter Combinations for Multihead Support | 133 |
| 5.7  | Configuring SCSI Devices | 134 |

**Chapter 6. AIX Version 4.1.3 Power Management**

| 6.1  | AIX Version 4.1.3 Power Management Components | 135 |
| 6.2  | Power Management States | 136 |
| 6.3  | Power Management Software Installation and Configuration | 139 |
| 6.3.1 | PM Installation | 140 |
| 6.3.2 | PM Configuration | 141 |
| 6.4  | Possible Power Management Problems and Warnings | 143 |

**Chapter 7. Troubleshooting and Miscellaneous**

| 7.1  | Problem-Solving and Reference Guide | 147 |
| 7.1.1 | Problem-Solving Overview | 147 |
| 7.1.2 | Problem-Solving Tools | 148 |
| 7.2  | Handling Power-Up Problems | 149 |
| 7.2.1 | Power-Up Initialization | 149 |
| 7.2.2 | Handling Power-Up Failures | 152 |
| 7.3  | Software ROS Initialization | 153 |
| 7.3.1 | Handling Software ROS Problems | 154 |
| 7.4  | Handling AIX Boot Problems | 155 |
| 7.5  | Hardware Diagnostics | 156 |
| 7.5.1 | Displaying the Error Log | 156 |
| 7.5.2 | Running Diagnostics Tests | 158 |
| 7.5.3 | Hardware Test Limitations | 159 |
| 7.6  | Miscellaneous Hints and Tips | 159 |
| 7.6.1 | Starting System Management Services | 159 |
| 7.6.2 | Handling Network Installation Problems | 161 |
| 7.6.3 | Updating the Firmware | 161 |
| 7.6.4 | Setting the System Passwords | 162 |
| 7.6.5 | Setting the Machine Serial Number | 164 |
| 7.6.6 | Entering the Kernel Debug Program | 164 |
| 7.6.7 | Using the Error Logging Facility | 165 |
| 7.6.8 | Using the System Dump Facility | 165 |
| 7.6.9 | Information Sources | 166 |
10.3.7 WABI Tools .................................................. 242
10.3.8 Installing and Using the DOS Shell .................. 244
10.3.9 The Font Cache ............................................. 245
10.3.10 Remote Execution of WABI ............................ 246
10.3.11 Running DOS and Windows Applications on WABI ... 246
10.3.12 Networking Support for WABI for AIX ............... 249
10.4 Comparison of SoftWindows and WABI ................. 250
10.5 Some Windows and DOS Software We Tested .......... 253
  10.5.1 Games, Demos and Miscellaneous Software ........... 253
  10.5.2 FrameMaker 4.0 ........................................... 254
  10.5.3 Lotus Freelance Graphics 2.01 ......................... 254

Appendix A. Devices Supported on the RISC System/6000 Model 40P ... 257

Appendix B. IBM GXT150P Configuration Tables .................. 259
  B.1 IBM Monitors ................................................ 259
  B.2 Non-IBM Monitors .......................................... 261
  B.3 Monitor Cables .............................................. 262

Appendix C. Windows Applications Supported Under WABI ......... 263

List of Abbreviations ............................................... 265

Index .............................................................. 267
## Figures

1. Old Compatibility Model ........................................... 1  
2. Innovation Within The Old Compatibility Model .................. 2  
3. PReP Specification Compatibility Model .......................... 2  
4. PReP Specification Design Environment .......................... 3  
5. System Topology for PReP-Compliant System ...................... 7  
6. Architecture-Machine Abstractions ............................... 9  
7. Boot-Time Abstraction Software .................................. 10  
8. Run-Time Abstraction Software ................................... 12  
9. Typical Open Firmware System Diagram ......................... 15  
10. RSPC firmware Block Diagram .................................. 16  
11. 32-bit Big/Little-Endian Values ................................. 17  
13. Macro Power-Management Model ................................. 21  
15. Power Status ..................................................... 23  
16. PCI System Block Diagram ....................................... 28  
17. PCI to Another Bus Bridges ....................................... 30  
18. Multiple PCI Buses ................................................ 31  
19. ISA-PowerPC Direct Connection .................................. 33  
20. PCMCIA Reference Implementation ............................... 34  
21. PCMCIA System Layout ........................................... 35  
22. RISC System/6000 Model 40P .................................... 38  
23. RISC System/6000 Model 40P System Diagram .................. 39  
24. RISC System/6000 Model 43P .................................... 46  
25. RISC System/6000 Model 43P System Diagram .................. 47  
26. Relation Map of Base Proto File and Proto Extension Files .. 56  
27. AIX Boot Sequence on RSPC Systems ............................ 59  
28. NVRAM Layout ................................................... 62  
29. Hardfile Layout on a "Classical" RISC System/6000 ............... 64  
30. Hardfile Layout on RSPC Systems ............................... 65  
31. AIX Hardfile Layout on RSPC Systems .......................... 65  
32. Boot Record Structure on RSPC Systems ......................... 66  
33. Boot Record on RSPC Systems ................................... 67  
34. RSPC Boot Image Layout ......................................... 68  
35. Structure of the RSPC Boot Image ............................... 69  
36. AIX Version 4 Boot Image Creation .............................. 70  
37. IBM 7210 Model 001 CD-ROM Drive Types ....................... 73  
38. System Management Services Menu .............................. 74  
39. Boot Sequence Selection Submenu ............................... 75  
40. Boot Device Selection Submenu .................................. 76  
41. Network Topology Example Used in Chapter 4 .................. 77  
42. NIM Master Configure Menu ..................................... 81  
43. NIM Master Successful Activation ............................... 81  
44. Network Topology. Not All Network Objects Need to be Defined. 82  
45. Defining the Second Network .................................... 83  
46. Defining the Route Between First and Second Networks ....... 84  
47. Machine Object Definition Menu ................................. 86  
48. Resource Object Definition Menu (SPOT Resource) .......... 89  
49. Initial Boot Screen .............................................. 92  
50. System Management Service Menu ................................ 93  
51. System Management Utilities Menu .............................. 93
Managing AIX V4 on PCI-Based RS/6000 Workstations
## Tables

1. PowerPC and Bus Specification .......................... 32
2. Hard Disk Specification ................................... 41
3. RISC System/6000 Model 40P Performance Table .......... 44
4. Hard Disk Specification ................................... 49
5. RISC System/6000 Model 43P Performance Table .......... 52
6. RISC System/6000 Model 43P Model 100 with 256 KB L2 Cache ... 53
7. RISC System/6000 Model 43P Model 120 with 512 KB L2 Cache ... 53
8. RISC System/6000 Model 43P Model 133 with 512 KB L2 Cache ... 53
9. Device Configuration Database ............................ 101
10. Adapter Parameters ........................................ 114
11. Token-Ring Adapter: Switch Block 1 ...................... 116
12. Token-Ring Adapter: Switch Block 2 ...................... 116
13. Interrupt Level Switch Positions .......................... 125
14. X.25 Adapter: Switch Block 1 ............................ 125
15. Display Variables .......................................... 133
16. Graphic Adapter Combinations ............................ 134
17. Power-up Problems ......................................... 153
18. Filename Mapping Table ................................. 235
This publication is intended to help system engineers, system administrators, customer personnel and users to support, configure and manage the new PCI-based RISC System/6000 systems, RISC System/6000 Model 40P and RISC System/6000 Model 43P Series. The information in this publication is not intended as the specification of any programming interfaces that are provided by AIX Version 4.1. See the PUBLICATIONS section of the IBM Programming Announcement for AIX Version 4.1 for more information about what publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only IBM’s product, program, or service may be used. Any functionally equivalent program that does not infringe any of IBM’s intellectual property rights may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment specified, and is limited in application to those specific hardware and software products and levels.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 10594 USA.

The information contained in this document has not been submitted to any formal IBM test and is distributed AS IS. The use of this information or the implementation of any of these techniques is a customer responsibility and depends on the customer’s ability to evaluate and integrate them into the customer’s operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will be obtained elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.

Reference to PTF numbers that have not been released through the normal distribution process does not imply general availability. The purpose of including these reference numbers is to alert IBM customers to specific information relative to the implementation of the PTF when it becomes available to each customer according to the normal IBM PTF distribution process.

The following terms are trademarks of the International Business Machines Corporation in the United States and/or other countries:

- AIX
- AIX/6000
- AIXwindows
- Current
- IBM
- InfoExplorer
- Micro Channel
- OS/2
- PAL
- Personal Computer AT
- PowerPC
- PowerPC 601
- PowerPC 603
- RISC System/6000
- RS/6000
- ThinkPad
- Ultimedia
- Ultimotion
- Ultimotion
- VoiceType
The following terms are trademarks of other companies:

Windows is a trademark of Microsoft Corporation.

PC Direct is a trademark of Ziff Communications Company and is used by IBM Corporation under license.

UNIX is a registered trademark in the United States and other countries licensed exclusively through X/Open Company Limited.

C-bus is a trademark of Corollary, Inc.

CorelDRAW
FrameMaker
Lotus 1-2-3, Lotus Organizer
Freelance Graphics, Lotus Notes
Harvard Graphics
NetWare
Macintosh, LocalTalk
Motif, DCE
NuBus
SmartSuite
Paintbrush
Paradox, Quattro Pro
Pentium
PKZIP
PostScript
Quicken
SCSI
Solaris, WABI
WordPerfect
X Windows
X/Open

Corel Systems Corporation
Frame Technology, Incorporated
Lotus Development Corporation
Lotus Development Corporation
Software Publishing Corporation
Novell, Incorporated
Apple Computer, Incorporated
Open Software Foundation
Texas Instruments, Incorporated
Lotus Development Corporation
Z-Soft Corporation
Borland International, Inc.
Intel Corporation
PKWARE, Incorporated
Adobe Systems Incorporated
Intuit Company
Security Control Systems, Inc.
Sun Microsystems, Inc.
WordPerfect Corporation
Massachusetts Institute of Technology
X/Open Company Limited

Other trademarks are trademarks of their respective companies.
Preface

This document is intended to assist system engineers, customer engineers, system administration personnel, and customers in configuring, managing and using AIX Version 4.1 on the new PCI-based RISC System/6000 systems, RISC System/6000 Model 40P and RISC System/6000 Model 43P Series. It contains descriptions of processes which are unique to AIX Version 4.1 on a PCI-based RISC System/6000. Practical configuration and environment examples are provided as well as hints and tips to address “how-to” issues involving PCI-based RISC System/6000 clients.

How This Document is Organized

The document is organized as follows:

• Chapter 1, “PowerPC Reference Platform Specification”
  This chapter presents an overview and the main components of the PowerPC Reference Platform Specification (PReP), Version 1.1. It also includes a section on the PowerPC Microprocessor Hardware Reference Platform (HRP): A System Architecture document.

• Chapter 2, “Introducing the Hardware”
  This chapter provides an introduction to the PCI-based RISC System/6000 workstation hardware components. This includes an overview on the Peripheral Component Interconnect (PCI) and the Industry Standard Architecture (ISA). An overview on the Personal Computer Memory Card Internal Association (PCMCIA) bus architecture is also provided.

• Chapter 3, “Boot Support”
  The same AIX Version 4.1 runs on three different RISC System/6000 platforms: the Microchannel-based uniprocessor RISC System/6000, the RISC System/6000 Symmetric Multiprocessor (SMP) RISC System/6000 systems and the PCI-based RISC System/6000 Workstation systems. This chapter discusses the challenge of booting the same operating system on three different platforms, the hardware and software components involved within the AIX boot process on PCI-based RISC System/6000 systems, the boot image specific to this platform, and the boot process itself.

• Chapter 4, “AIX Version 4 Network Installation”
  This chapter provides a step-by-step procedure for setting up and starting the AIX installation on PCI-based RISC System/6000 systems using a Network Installation Manager (NIM) master.

• Chapter 5, “Device Configuration on RSPC Systems”
  This chapter provides you with technical background on the enhancements made to the AIX Device Configuration Database in order to support PCI-based RISC System/6000 systems and includes step-by-step procedures on how to configure devices.

• Chapter 6, “AIX Version 4.1.3 Power Management”
  This chapter describes the power management functions specified in the PowerPC Reference Platform Specification and implemented in AIX Version 4.1.3.
Chapter 7, "Troubleshooting and Miscellaneous"

There are several sections included in this chapter. First, a discussion is included about how to interpret the Problem Solving Guide and Reference product manual, which has been written for the Microchannel-based RISC System/6000 platform, and how to apply it to the PCI-based systems. Then the visual and audible signals provided by the system during the booting process are described in order to help service personnel in identifying and isolating booting problems. Finally, some hints and tips are provided that may help you when using or supporting the PCI-based systems.

Chapter 8, "HUMAN-CENTERED Technology"

This chapter includes an introduction to the evolutionary and exciting HUMAN-CENTERED technology, its components and application areas. The goals of HUMAN-CENTERED computing as well as the current implementation are discussed.

Chapter 9, "Ultimedia Services"

The RISC System/6000 Model 40P software package includes the IBM Ultimedia Services 2.1 for AIX Version 4.1 License Program Product (LPP). This chapter presents an introduction to this product, its components and the multimedia capabilities incorporated on the PCI-based RISC System/6000 workstation systems.

Chapter 10, "Running Windows Applications"

A demo license of the Insignia SoftWindows software is included in the RISC System/6000 Model 40P software package. This chapter includes a description of the software and provides hints and tips to start using it.

A second part is included that describes the WABI Version 2.0 for AIX License Program Product (LPP).

Finally, a comparison of both products and their environments is included as well as a discussion about the areas where they could be used.

Related Publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this document.

- AIX Version 4.1 Network Installation Management Guide and Reference
- WABI 2.0 for AIX: User’s Guide, SC23-2765-00
- SoftWindows for UNIX User’s Guide, call 1-800-848-7677 in USA or in Europe call 44-1494-459426

International Technical Support Organization Publications

- AIX Version 4.1 Problem Solving Guide and Reference, GG24-2513
- AIX/6000 X.25 LPP Cookbook, GG24-4475-00

A complete list of International Technical Support Organization publications, with a brief description of each, may be found in:

International Technical Support Organization Bibliography of Redbooks, GG24-3070
To get a catalog of ITSO technical publications (known as “redbooks”), VNET users may type:

```
TOOLS SENDTO WTSCPOK TOOLS REDBOOKS GET REDBOOKS CATALOG
```

### How to Order ITSO Redbooks

IBM employees in the USA may order ITSO books and CD-ROMs using PUBORDER. Customers in the USA may order by calling 1-800-879-2755 or by faxing 1-800-284-4721. Visa and Master Cards are accepted. Outside the USA, customers should contact their local IBM office.

Customers may order hardcopy ITSO books individually or in customized sets, called GBOFs, which relate to specific functions of interest. IBM employees and customers may also order ITSO books in online format on CD-ROM collections, which contain redbooks on a variety of products.

### ITSO Redbooks on the World Wide Web (WWW)

Internet users may find information about redbooks on the ITSO World Wide Web home page. To access the ITSO Web pages, point your Web browser (such as WebExplorer from the OS/2 3.0 Warp BonusPak) to the following:

```
http://www.redbooks.ibm.com/redbooks
```

IBM employees may access LIST3820s of redbooks as well. Point your web browser to the IBM Redbooks home page:

```
```

### Acknowledgments

This project was designed and managed by:

Miguel Crisanto  
International Technical Support Organization, Austin Center

The authors of this document are:

Hernan Laffitte  
IBM Argentina

Guenter Rieker  
IBM Switzerland

Nobuhiko Watanabe  
IBM Japan

Miguel Crisanto  
ITSO Austin

This document is based on the “AIX V4.1 on RSPC Systems” workshop documentation developed by:

Fabiane Aquino  
IBM Brazil
Jean-Philippe Chabaud  
IBM France  

Gert Lacko  
IBM Germany  

This publication is the result of a residency conducted at the International Technical Support Organization, Austin Center.  

Thanks to the following people for the invaluable advice and guidance provided in the production of this document:  

Matt Cronck  
IBM USA  

Simon Yen  
IBM USA  

Marcus Brewer  
Editor  
International Technical Support Organization  
Austin Center
Chapter 1. PowerPC Reference Platform Specification

The RSPC hardware is quite different from the “classical” RISC System/6000 hardware. As yet, microchannel is not available, but the PCI, ISA and PCMCIA bus architectures have been implemented on the new type of machines. The hardware is fully independent of the software, and there is no assumption about which operating system is going to run on top. Some RISC System/6000 users might have been surprised by the introduction of a new hardware architecture, some might ask, “why?” The RSPC hardware is an implementation based on the PowerPC Reference Platform (PReP) Specification, which adopts many industry standards and technologies.

In this section, we will discuss the PReP Specification, why such a specification was necessary, the PowerPC Hardware Reference Platform (HRP) Architecture, and the rationale for such an architecture.

1.1 Why Have a PowerPC Reference Platform Specification?

Computer systems today span a wide range of environments, from hand-held portables to room-size mainframes. The largest percentage of systems are based on the IBM PC/AT, Apple Macintosh or a variety of workstation-level RISC architectures.

These machines cover the needs of personal productivity, entry engineering design, entry commercial data management, information analysis, and database, file, and application servers. Today, despite their high levels of performance and functionality, existing architectures limit the system designer’s ability to add innovative new features without jeopardizing operating systems and applications. These limitations restrict the use of hardware and software enhancements which promise improved user interfaces, faster system performance, and broader operating environments. Many times, system designers must carry obsolete hardware structures to maintain compatibility.

Figure 1 shows the old compatibility model where the software communicates directly with the hardware. Changes applied to the hardware require changes to software and vice-versa, as shown in Figure 2 on page 2.
To be sustainable and continue to grow, the computer industry must define computer architectures which allow system and application designs to utilize the latest silicon, interface, storage, display, and software technologies. The key of these new computer architectures is the ability of the software to abstract the hardware from the operating system kernel and applications without sacrificing compatibility or performance.

Figure 3 shows the new model specified in the PowerPC Reference Platform Specification. An abstraction layer separates the hardware from the software. The advantage of this model is that hardware designers now have room to innovate without jeopardizing the ability of their platform to run as many operating systems as possible.
Figure 4 shows that changing the hardware, for example, from hardware level 1 to hardware level 2, only requires a change in the abstraction layer. No changes are required in the operating system or in the application itself.

Independent software vendors (ISV) would like to develop for a large, installed base of hardware systems and on as few operating system platforms as possible. For this to happen, an industry standard computer architecture is required. The time has come to define a new architecture in this area which has the following key features:

- The ability to allow hardware vendors to differentiate
- The ability to use industry standard components and interfaces
- The ability to support optimization of application performance

### Compatible Operating Systems

This type of open system architecture allows hardware system vendors to develop differentiated, yet compatible, systems. Each system is able to run any of the compatible operating systems as well as the applications written for these operating systems and system architecture.

## 1.2 The PowerPC Reference Platform (PReP) Specification

The PowerPC Reference Platform Specification provides a description of the devices, interfaces and data formats required to design and build a PowerPC-based industry standard computer system. It is written to create a hardware, which when coupled with the hardware abstraction software provided by the operating system or hardware system vendors, allows the computer industry to build PowerPC systems which all run the same shrink-wrapped operating systems and the same shrink-wrapped applications for those operating environments.
It gives system developers the freedom to choose the level of market differentiation and enhanced features required in a given computer environment without carrying obsolete interfaces or losing compatibility.

This specification defines the minimum functional requirements needed for a compliant PowerPC Reference Platform implementation. It also provides a list of recommended hardware subsystems, devices and interfaces.

Operating system vendors may use this specification as a reference to determine the level of functionality required in a hardware abstraction layer. The specification shows the hardware subsystems that are likely to change and therefore may need hardware abstractions.

PowerPC Reference Platform Specification is written primarily for system developers. It contains operating-system-specific descriptions and references to their hardware abstraction approach.

This specification also describes a reference implementation which is a fully functional PReP system design supporting all operating systems and applications that are being ported to this reference platform. This reference implementation provides an example to which system developers can compare and gives them a better understanding of their own design goals.

This specification supports all 32-bit PowerPC processors and is intended to cover the following systems:

- Portables
- Medialess
- Desktop
- Workstations
- Servers

Because PReP requires machine abstractions, the specification accommodates the evolution of software and hardware technologies without losing system compatibility. The PReP Specification covers:

- Hardware Configuration (see section 1.3, “Hardware Configuration”)
- Architecture (see section 1.4, “Architecture” on page 7)
- Machine Abstraction (see section 1.5, “Machine Abstraction” on page 8)
- Boot Process and firmware (see section 1.6, “Firmware” on page 12)
- Reference Implementation (see section 1.7, “PReP Reference Implementation” on page 18)
- Power Management (see section 1.8, “Power Management” on page 20)

### 1.3 Hardware Configuration

The hardware configuration defines the minimum and recommended hardware standards and capacities required to be PowerPC Reference Platform-compliant and compatible with targeted operating environments. The PowerPC Reference Platform-compliant hardware consists of the following subsystems.

1. **Processor Subsystem**
This subsystem contains the processor(s) that operate on the data and the instructions of the applications and operating systems.

The processor subsystems for all compliant systems must comply fully with the PowerPC architecture.

2. Memory Subsystems

Six memory subsystems are described:

- **System Memory**
  The point of the memory map for a system where executable instructions and data for applications and operating systems reside. System Memory is normally attached to a memory controller which is located on the local primary processor bus. Expansions to System Memory are added directly to the same bus. System Memory and expansions to System Memory may be located elsewhere as long as coherency (as specified in the PowerPC architecture) is maintained.

- **System ROM**
  This contains the power-on and boot firmware, along with some data required by the system. It can be done in ROM, EPROM or Flash ROM.

- **Non-volatile Memory (NVRAM)**
  This is used to save system configuration and error indications across system boots. It must be at least 4 KB in size. It must be readable and writeable by the system processor.

- **I/O Memory**
  This refers to the area of the memory map of a system where memory for devices resides (examples include graphics buffers and communication buffers). This memory is accessed by a system processor using load and store instructions.

- **System I/O**
  This part of the memory subsystem is configured to handle the addressing and communications for I/O devices.

- **External Cache**
  This is any cache residing between the on-chip cache and the System Memory. It must be transparent to the software. It must follow the PowerPC architecture rules for maintaining coherency and serialization.

3. Storage Subsystem

The storage subsystem consists of four subsystems:

- **Hard Disk Subsystem (Mandatory)**
  A system requires a hard disk or hard disk capability (which is provided remotely via a network). Minimum capacity is 120 MB.

- **Floppy**
  If provided, it must support 3.5 inch, 1.44 MB MFM-format floppies.

- **CD-ROM**
  If provided, it must support at minimum ISO 9660 standard. The CD-ROM should be capable of double speed and a transfer rate of at least 300 KB per second. Interface can be done via SCSI or IDE.
• Storage System Interface
  The PReP Specification strongly recommends the use of SCSI-2 interfaces to support hard disk and CD-ROM.

4. Human Interface Subsystem

Human interface is the interface which arbitrates a user and a system.

• Alphanumeric Input Device
  The PReP Specification recommends the keyboard as the alphanumeric input device.

• Pointing Device
  It is the mouse, tracking device, tablet, or touch screen.

• Audio
  A system must provide at least two inputs and two outputs. One input channel should be a monaural microphone, and one output channel should be a stereo microphone.

• Graphics
  A PReP-compliant system must support at least a 640 x 480, direct mapped, 8-bit-per-pixel frame buffer. It is recommended that the graphic subsystem support a color depth of 8, 16 or 24 bits and higher resolutions of at least 1024 x 768. The PReP definition regarding graphics focuses on the graphics adaptor and (the usage of) the frame buffer — not the physical display itself.

5. Real-Time Clock

A system must include a Real-Time Clock (RTC) subsystem. The RTC must operate in the absence of primary power and provide the necessary information to determine year, month, day, hour, minutes, and seconds.

6. Expansion Bus(es)

In the PReP Specification, PCI, ISA and PCMCIA are recommended for the external bus. For more information, refer to 2.1, "Introducing the PCI Bus Architecture" on page 27, 2.2, "Introducing the ISA Bus Architecture" on page 32, and 2.3, "Introducing the PCMCIA Bus Architecture" on page 33. Other buses (VME, EISA, NuBus, and MCA) could be used with modification to the abstraction software of each hosted operating system.

7. Additional Subsystems

There are other subsystems required in most computer system implementations. These subsystems include DMA, interrupt controller, timer, and system configuration registers.

8. Industry Interface Standards

There is a strong intention to follow industry interface standards for:

• SCSI
• IDE
• Ethernet
• Token-Ring
• Serial Ports
1.4 Architecture

The system architecture defines the minimum and recommended hardware-system attributes required to design a compatible computer system. This section describes the key hardware and software architecture attributes and restrictions defined for PReP compliance.

1.4.1 System Topology

Figure 5 is the general implementation of a PReP-compliant system.

The following are mandatory components:

- Processor Subsystem
- L1/L2 Cache
- Primary Bus
- System Memory
- Bus Bridge
- Secondary Bus
- I/O Subsystem

Optional components are:

- Another Processor Subsystem(s)
- Bus Bridge (Secondary bus to Tertiary bus)
- Tertiary Bus(es)
- I/O Subsystem(s)
The processors are linked over the Primary Processor Bus to each other, to System Memory and to a Bus Bridge. Usually, I/O devices do not connect to the PowerPC processor’s bus. The Bus Bridge connects to a Secondary Bus (first expansion bus) which has I/O Subsystems connected to it. In turn, another Bus Bridge may be employed to a Tertiary Bus with additional I/O Subsystems connected to it. Typically, the bus speeds and throughput decrease, and the number of supportable loads increases as one progresses from the Primary Processor Bus to the Tertiary Bus.

To emphasize that it is designed for Symmetric Multiprocessor systems, the architecture shows a processor subsystem. The hardware will assure consistent data for the following transactions only:

- Transactions between any Processor and System Memory
- Transactions between an I/O Subsystem and System Memory

PReP-compliant multiprocessor systems have a symmetric, shared-memory model.

### Variations

The Secondary Bus may be implemented as two or more parallel expansion buses for performance reasons. Similarly, the Tertiary Bus may be two or more parallel expansion buses.

The Bus Bridge and/or memory controller may be integrated into the processor chip. In the case where the Bus Bridge is integrated into the processor chip, the Primary Processor Bus would not be the PowerPC processor bus; it would be an expansion bus (for example, PCI). I/O Subsystems would normally be attached to the Primary Processor Bus in this case. If this bus is the only bus coming from the processor chip, then the System Memory would continue to be attached to the Primary Processor Bus. If the memory controller was integrated into the processor chip, then the System Memory would be attached to the processor chip.

### 1.5 Machine Abstraction

To enable the same operating system to run on different PReP-compliant platforms, the operating system must be designed to use abstraction software to interface with the hardware.

Abstraction software concentrates operating system hardware-dependent code into a collection of code that has well-defined interfaces with the operating system kernel and may be modified to meet the hardware interface.

#### 1.5.1 Machine Abstraction Achievements

A platform vendor and an operating system vendor that comply with PowerPC Reference Platform Specification will benefit from the following achievements:

- One operating system running on several different hardware platforms
  PReP-compliant machines can be really different, unlike PCs today.
- One hardware platform can support several different operating systems.
- Customers can buy the operating system they want right off the shelf.
1.5.2 Machine Abstraction Requirements

For an operating system (OS) to be PReP-compliant, it must have the following qualities:

- The OS must provide a mechanism to allow the abstraction software to be replaced by other vendors
- The OS must provide a mechanism to allow the replacement abstraction software to be merged with the distributed OS and to run with that OS
- The OS abstraction process must not require access and recompilation of portions of the OS outside the abstraction software

1.5.3 Abstraction Example

Figure 6 shows that a different set of abstraction software is used to support Operating System A. Note that the abstraction software is different among PReP-compliant systems that support this platform.

---

**Abstraction Software**

The PReP Specification defines the functions that must be abstracted, but it does not define the interface to the operating system, nor does it define the way the functions are collected into usable services.

---

In this example, if Platform 1 has hardware that is different from that in Platform 2, another implementation of the abstraction software must be supplied to support the execution of Operating System A. The hardware vendor would supply the abstraction software that allows it to run on Platform 1.

---

*Figure 6. Architecture-Machine Abstractions*
1.5.4 Abstraction Software Components

The abstraction software components are:

- Boot-Time Abstraction Software (BTAS)
- Run-Time Abstraction Software (RTAS)

1.5.4.1 Boot-Time Abstraction Software (BTAS)

BTAS is a collection of firmware and software which abstracts the hardware that a platform's boot program (for example, firmware) uses at boot time. It also abstracts the hardware that the operating system loader uses to load an operating system.

Examples of the hardware that the BTAS must abstract are devices such as ASCII terminals, graphic monitors and keyboards. These devices allow the loader to interact with a user during the loading of the operating system. The BTAS must abstract mass storage and network devices so that the operating system binary can be loaded.

The boot program first initializes the hardware and performs a Power-On Self Test (POST). Then it determines the hardware configuration. It identifies the operating system boot devices and loads the operating system loader and the loadable abstraction software. If necessary, the boot can perform an Endian switch.

![Boot-Time Abstraction Software Diagram]

*Figure 7. Boot-Time Abstraction Software*

Figure 7 shows the components. They are divided into two parts:

- The Operating System Independent-Abstraction Software
- The Loadable-Abstraction Software

**The Operating System Independent-Abstraction Software contains:**

- The boot-time device drivers
- A mechanism to access the configuration data in NVRAM
• The ability for an Endian mode switch
• The ability to perform POST

The Loadable-Abstraction Software contains:
• The device driver support for the operating system loader
• The ability to perform virtual memory management for the operating system loader
• The ability to do an Endian switch

1.5.4.2 Run-Time Abstraction Software (RTAS)

The RTAS is a collection of data and software that abstracts hardware from the operating system kernel. It consists of abstraction software and device drivers. Some system abstraction software may be used to abstract device drivers from hardware (for example, the interrupt controller and the cache configuration).

The software that implements RTAS is unique for each combination of operating system and hardware platform. Initial versions of RTAS were distributed by an operating system vendor and adapted to a certain system by the system vendor.

There is a minimum set of data and abstractions that RTAS has to provide or handle. Some of them are:

• Data
  The RTAS passes and stores data to and from the NVRAM and the residual data area.

• Processor Initialization
  If the initialization of the CPU is not performed by the OS loader, RTAS must initialize it.

• Cache Management
  The RTAS must manage the cache in the system. PowerPC processors may have different sizes of cache; a single cache may combine data and instruction, or the processor may have separate caches for data and instructions.

• Interrupt Handling
  The RTAS must provide services to acknowledge the interrupts and to enable and disable interrupts from devices used on the platform.

• I/O Addresses
  Providing a device driver with the physical address of a device.

• Power Management
  If Macro Power Management is supported by the operating system, the abstraction layer must provide a means to change device and subsystem power states.

• Hardware Fault
  Notifying the operating system in case of memory, I/O device or bus time-out errors.

• Device Drivers
  Rewrite device drivers to use RTAS services and to be Endian aware.
1.6 Firmware

The system firmware is the program code that controls a computer before the operating system has begun execution. Typically, firmware is stored in read-only memory (ROM) or programmable read-only memory (PROM) so that it may be executed immediately after the computer is turned on. It is typically soldered to or socketed to the system planar board.

The system firmware takes the system from the power-on state to a state where an operating system loader is in memory, ready for execution.

The main jobs of the firmware are to test and initialize the required machine hardware and to boot the operating system, usually from a mass storage device or from a network. The operating system may also require other services from the firmware. Subsystems that commonly need to be initialized, verified (tested) and/or provide services include:

- processor
- memory
- cache
- diskette
- SCSI
- IDE
- network
- keyboard
- mouse
- serial
- parallel
- video
- audio
- password
- interrupts
- time-of-the-day

Finally, firmware often provides some support for interactive hardware and software debugging. In addition to the main operating system, other programs, such as diagnostic operating systems, may utilize firmware services.
1.6.1 firmware Problems

In an open-systems environment, the job of loading the operating system is greatly complicated by the possibility of user-installed I/O devices. There are two identified problems:

• **Added bootable devices**

  If the firmware developer knows in advance the complete list of I/O devices from which the operating system may be loaded, the software drivers for those devices may be included in the firmware. If, however, new bootable devices (devices from which the operating system may be loaded) may be added to the system later, the firmware must have a way to acquire boot drivers for those devices. The obvious solution of shipping a complete set of system firmware with each new device quickly becomes impractical as the number of devices and systems grows.

• **Added display devices**

  A similar situation applies to the devices used for displaying messages showing the progress of the testing and booting processes. The firmware must have a driver for each device on which it wishes to display messages. One solution is to require every display device to emulate some baseline device. This solution works, but the constrains that it imposes on hardware can increase costs and stifle innovation.

Since the firmware can be considered, in some sense, to be part of the hardware, the firmware can sometimes make the operating system’s task of autoconfiguration (adapting to a minor hardware differences) easier, either by hiding the differences or by reporting the hardware characteristics to the operating system so it does not have to guess.

---

**Important**

It is the goal of the PReP developers to implement “Open Firmware”, the IEEE standard P1275-1994 for Boot Firmware, in order to solve the problems described above.

---

1.6.2 The Solution: Open Firmware

The Open Firmware architecture is specified in IEEE 1275-1994 Standard for Boot (Initialization, Configuration) Firmware. A draft version of the document is available, for a fee, by calling 1-800-678-IEEE and specifying IEEE order number DS02683.

Open Firmware solves the problems described in 1.6.1, “firmware Problems,” and in addition, provides extensive interactive features for hardware and hardware debugging.

The design of Open Firmware is processor-independent, and every effort was made to eliminate knowledge of machine details from the specification of its interfaces.

The following Open Firmware features are notable:

• **Plug-in Device Drivers**

  New devices may be added to an Open Firmware system and used for booting or message display without modification to the main Open Firmware
system ROM. Each such device has its own plug-in driver, usually located in a ROM on the device itself. Thus, the set of I/O devices supported by a particular system may evolve without requiring changes to the system ROM.

- **FCode**
  Plug-in drivers are written in a byte-coded, machine-independent, interpreted language called FCode. FCode is based on Forth semantics. Since FCode is machine-independent, the same device and driver can be used on machines with different CPU instruction sets. Each Open Firmware system ROM contains an FCode interpreter.

- **Device Tree**
  The set of devices attached to the system, including permanent install devices and plug-in devices, is described by an Open Firmware data structure known as the device tree. The operating system may inspect the device tree to determine the hardware configuration of the system. Any type of device, and any kind of information that needs to be reported about the device, can be accommodated.

- **Modularity**
  Some Open Firmware features (such as booting) are required, and others are optional. The set of Open Firmware features supported on a particular system may be chosen to meet the goals and constraints of that system.

- **Programmable User Interface**
  The Open Firmware user interface is based on the industry-standard interactive programming language, Forth. Sequences of user commands can be combined to form complete programs, thus providing a powerful capability for debugging hardware and software; Open Firmware is a very good tool for the initial "bring-up" of new hardware and software.

- **FCode Debugging**
  The Open Firmware user interface language (Forth) and the FCode language share a common interpretation mechanism; so it is easy to develop and debug FCode programs with built-in Open Firmware tools.

- **Operating System Debugging**
  Open Firmware has commands for debugging operating system code.
A PowerPC Open Firmware implementation must perform the following steps during the boot process:

1. Initialize and test built-in devices
2. Configure the non-Plug and Play ISA devices stored in NVRAM
3. Locate, initialize and test plug-in devices
4. Switch Endian mode (if necessary)
5. Load and execute the client program (for example, the operating system)

1.6.3 RSPC Firmware (System ROS)

The system firmware used within the currently available PowerPC Personal Systems, or RSPC systems, is not yet an Open Firmware implementation. It is a compromise of Open Firmware ideas and what can be done with reasonable efforts, taking into consideration that AIX does not yet support Open Firmware.

The RSPC firmware is also called System ROS and is under permanent development. It can be replaced on a machine by loading a new version from diskette (Flash update). The current version, 1.26, of RSPC firmware does not support device Plug and Play capabilities.

RSPC firmware is specific to each machine type. It contains information about which devices are present and initializes them. After initializing the devices, RSPC firmware posts the device’s information to the residual data area. Except for the System Memory, RSPC firmware does not test a device for functionality. It assumes a device to be operational after it is initialized.
Currently, there are no callback services. Unlike the Open Firmware definition, an operating system cannot use System ROS capabilities after it has taken over control. RSPC firmware is alive only during the very first boot phase. When the operating system takes control, it is wiped out.

In case of a graphics device, RSPC firmware provides a list of supported adaptor IDs. RSPC firmware reads the address space of the PCI bus and tries to find a match within this IDs.

The RSPC firmware is organized into three sections, as shown in Figure 10:

- **Boot Block**
  Used to reload the soft-executable image of the firmware from a Flash Recovery diskette after a failed Flash update or when a Flash update has been interrupted.

- **Firmware Core**
  Responsible for bringing the system up to a point where the compressed image of the firmware is decompressed and running in memory.

- **Virtual Disk**
  It contains all the pluggable modules required to support the individual hardware subsystems.

**1.6.4 Bi-Endian Support**

A system that runs operating systems and applications software and uses data that are stored either Big-Endian (that is, big end first &em dash. most significant byte first) or Little-Endian (that is, little end first — least significant byte first) is referred to as Bi-Endian.

The Bi-Endian requirement in the PReP Specification does not mean that simultaneous operation of Big-Endian and Little-Endian, is required. This
capability, also called *Mixed-Endian*, may become practicl, but currently the synchronization at mode switching time degrades the performance.

**PowerPC Processor Endian**

The current set of PowerPC processors (PowerPC 601, PowerPC 603, PowerPC 604) assume that storage is Big-Endian.

At power-on, or after a system reset, the processor is in Big-Endian mode. Each Little-Endian operating system must perform an Endian mode switch during the boot process. The particular instructions to perform an Endian mode switch are processor and hardware-system dependent and are provided by the abstraction software for each Little-Endian operating system.

Figure 11 shows the mapping of a Little-Endian 32-bit value to a Big-Endian 32-bit value.

![Figure 11. 32-bit Big/Little-Endian Values](image)

The current implementation of Little-Endian in the PowerPC chips reduces internal processor complexity by moving some of the Bi-Endian support out of the processor. This implementation has two disadvantages:

- The PowerPC processor chip expects data represented in Big-Endian order. This impacts cost, complexity and chip portability. Without this restriction, the processor chip could be incorporated into Little-Endian designs without modification to that design.
- The processor in Little-Endian mode interrupts when it encounters unaligned loads and stores, multiple loads and stores, and string loads and stores. This has a performance and portability impact.

Future versions of the architecture may permit PowerPC processor chips to support a true implementation of the Little-Endian mode. In this true Little-Endian
mode, data would go to the processor in Little-Endian format and be addressed from the processor with the Little-Endian address.

1.7 PReP Reference Implementation

In this section, the PReP Specification describes a reference implementation of a PReP-compliant system. This description may be used as a high-level design for vendors waiting to produce a compatible system, or it may be used as an example for vendors who want to produce a different system.

Six implementation examples are included in the PReP Specification in appendix A. They are implementations for:

- A portable system
- An energy-managed workstation
- A medialess workstation
- A technical workstation
- A server system
- A multiprocessor system

1.7.1 Portable System

The portable configuration uses the PowerPC 603 processor and provides one serial port, one parallel port, various audio jacks, built-in microphone and speakers, one keyboard/mouse port, one video graphics port, one SCSI-2 port, and two type-2 PCMCIA sockets.

1.7.2 Energy-Managed Workstation

The energy-managed workstation uses the PowerPC 603 processor and provides a SCSI external port, two serial ports, one parallel port, business audio with stereo microphone jack, stereo earphone jack, video graphics, four PCMCIA slots, and other features. There are no ISA or PCI expansion card sockets.

Refer to 1.8.2, "Implementation for Energy-Managed Systems" on page 22 for more information on energy-managed system implementation.

1.7.3 Medialess Workstation

The medialess workstation has no data storage capability. It can only boot the system as a diskless client.

The medialess system requires a network connection. The network would supply storage for the operating system, including its boot-up code, for applications and for data.

A variation of the medialess system is a dataless system. In this system, a hardfile is placed in the configuration and used for system support (for example, paging), but most of the software and data reside on the network.
1.7.4 Technical Workstation

It is a high-performance workstation intended to support graphic-intensive work.

Figure 12 shows the reference implementation for the technical workstation. This implementation is divided into the I/O Complex and the Processor Complex.

The Processor Complex consists of a PowerPC 601 microprocessor, a memory controller, PCI bridge, System Memory, and an open slot for a second level of cache (for example, L2 Cache) or a processor upgrade to a higher-speed PowerPC 601 microprocessor or PowerPC 604 microprocessor chip. The Processor and I/O Complexes are connected via the PCI bridge and PCI bus. Designs based on the current system could have a processor running at 50, 66, 80, or 100MHz.

The I/O controller is a bridge to the ISA bus and ISA adaptors that supply the remainder of the I/O ports. NVRAM is located with the non-volatile RTC and battery on the ISA bus.

The System Memory could have up to eight memory slots and, depending on the choice of memory SIMMs, may have memory ranging from 8 MB to 256 MB.
1.7.5 Server System

The server system has improved error-detection circuits and peripherals, such as disk arrays. There are three server types:

1. Compute Server
   A compute server should have the fastest PowerPC processor available, and that processor should run the highest frequency specified for it.

2. Data Server
   A data server should have increased direct-access storage, typically starting at 2 GB. RAID technology could provide this storage and additional fault tolerance.

3. Print Server
   A printer server should have the enhanced parallel port. Minimum configuration should be one with options for several additional parallel ports.

1.7.6 Multiprocessor System

For multiprocessor environments, the PowerPC Reference Platform Specification intends to focus primarily on Symmetric Multiprocessor (SMP) systems. The processors are connected through L2 caches to a system bus shared with the system memory controller and PCI bus bridge.

If the system bus is similar in design to the PowerPC processor bus, peak data bandwidths of greater than 400 MB/sec are possible. With an efficient L2 cache and memory system design, the system bus utilization for the two processors is manageable. SMP designs utilizing more than two processors may require greater system bandwidth and a more efficient memory system design.

Error detection, error isolation, error reporting, and error recovering are important considerations in a multiprocessor system. Errors occurring in one processor or L2 cache should not be allowed to propagate to system memory or to other processors or L2 caches.

1.8 Power Management

Power Management is used for saving electronic power. There are two types of Power Management techniques:

• Micro Power Management
  This is hardware-managed power control.

• Macro Power Management
  This uses system software to control the hardware. Macro Power Management is, by far, the more powerful technique and thus is the basis for the PReP Power Management model.

1.8.1 Macro Power Management Model

Figure 13 on page 21 shows the Macro-Power Management model recommended in the PReP Specification. The abstraction software and device drivers provide the connection between the operating system and hardware. This software is aware of hardware power-management capabilities and translates operating system power-management requests into specific device and
subsystem controls. It also passes information provided by hardware to the operating system to help it perform power management.

Figure 13. Macro Power-Management Model

The PReP Specification describes the following requirements and recommendations for the Power Management model implementation:

Requirements
If a hardware platform supports Power Management, its power management features must be controllable by system software.

Abstraction software and device drivers must provide the necessary functions to support the Power Management features of its target operating system.

Recommendations
It is strongly recommended that systems incorporate Power Management.

It is recommended that system software and hardware work effectively together to provide the necessary functions to implement a Macro Power Management model similar to that shown in Figure 13. In this model, the following is true:

- The operating system is the Power Management control hub.
- Power Management policy is set by the user through an application interface.
- The operating system implements Power Management policy through the abstraction and device driver interfaces.
- The operating system supports Power Management-aware applications.

Abstraction software and device drivers provide the connection between the operating system and hardware. This software is aware of hardware Power

Chapter 1. PowerPC Reference Platform Specification 21
Management capabilities and translates operating system Power Management requests into specific device and subsystem controls. It also passes information by hardware to the operating system to help it perform Power Management.

### 1.8.2 Implementation for Energy-Managed Systems

Figure 14 shows a diagram of the components of a PReP-compliant, energy-managed workstation. The basic hardware consists of a system board, power supply, diskette drive, SCSI disk drive, CD-ROM, cables, keyboard, monitor, and mechanical package.

The system board contains most of the electronics for the system. Major subsystems are connected to main memory through the PCI bus. The memory controller, system I/O and SCSI are located on this bus. The video card is attached to the PCI bus through a special socket, allowing for future upgrades.

![Figure 14. Implementation for Energy-Managed Systems](image)

The energy-managed workstation features a power management controller. Power management for the energy-managed workstation can put the system into one of four states:

- **Operational**
- Default state
• Maximum system performance
• All system resources are turned on and available for immediate use
• 100 percent power consumption rate

Standby
• Active power management on local device controls
• Potentially reduced system performance at a given instance
• Devices are powered on demand

Suspend
• Maximum system power savings after a short period of inactivity while maintaining the capability to instantaneously return to operations
• Most devices are either in a low-power mode or actually powered off
• The processor may have the clock stopped
• System state information is maintained along with System Memory contents
• Most interrupts return the system to operational

Hibernation
• The system enters hibernation after a longer period of inactivity or a hibernation event has occurred
• Most devices are powered off
• System state information is stored on the system hardfile for later retrieval
• Resuming operation will take longer than “suspend” due to the restoration of the system hardfile
• Maximum power savings while still being able to wake up by some external event

Figure 15. Power Status
1.8.2.1 Support for Suspend and Hibernation System States
The PReP Specification does not mandate particular system power states or
algorithms for translation between states. Two states, however, will likely be
implemented in most systems. These states require special consideration when
designing hardware, abstraction software, device drivers, and operating systems:

- Suspend
  It is characterized by very low power dissipation and fast recovery to full
  function. Resumption from suspend generally occurs on receiving an I/O
  interrupt resulting from mouse or keyboard activity, communication events or
  when opening the lid of a laptop system. In most systems, the contents of
  system memory will remain active while in the suspend rate.

- Hibernation
  It is defined as the system being turned off, with the system state being
  written to non-volatile storage, such as hard disk. Recovery from hibernation
  would generally not be as quick as that from suspend, but it saves the time
  of loading the operating system and brings the system back to its state
  before it hibernated. Resumption from hibernation would occur when the
  system is powered back on.

1.8.2.2 Device and Subsystem Power Management
Some devices and subsystems may implement Micro Power Management
techniques in addition to any Macro Power Management capabilities they
provide. A good example of this is the PowerPC 603 microprocessor’s
management of the floating point unit. It will run the floating point unit off and on
based on the instruction being executed.

1.9 The PowerPC Hardware Reference Platform (HRP) Architecture
This section will introduce the PowerPC Hardware Reference Platform
Architecture document as well as the purposes and the goals of this document.

Before talking about the document itself, we want to give you a brief introduction
about the history, rationale and reasons why this document had to be developed.

1.9.1 HRP Architecture - Introduction and History
The PowerPC family of microprocessors, which is being jointly developed by
Apple, IBM and Motorola, is the foundation for an established and rapidly
expanding market for RISC-based systems. Apple Computer has shipped well
over one million Power Macintosh computers since March 1994. IBM has made
major announcements for a full line of PowerPC systems, thus completing its
successful PowerPC-based workstation and server products. Motorola has
introduced a broad range of desktop and server systems. Other companies, such
as Bull, Canon and FirePower, have announced or shipped PowerPC-based
systems.

The PowerPC systems shipped by Apple retain many legacy characteristics of
Macintosh hardware and software. The PowerPC systems shipped by IBM and
Motorola retain many legacy characteristics of Intel-based PC design. The
operating systems on which the applications run are not compatible with the
other type of hardware platform. This incompatibility causes hardware
manufacturers and software developers to have to choose platform families and
limits the options available to users.
To correct the problems facing customers and developers, Apple, IBM and Motorola looked at various ways of combining the two hardware architectures into a common system architecture. Finally, in November 1994, the solution was found.

1.9.2 The HRP Architecture Document

In November 1994, Apple Computer, Inc., International Business Machines Corporation and Motorola, Inc. agreed to develop a specification for a common hardware platform with the purpose of defining a system which will become the pervasive open industry standard for single users through server configurations.

The document, currently called *PowerPC Microprocessor Hardware Reference Platform: A System Architecture, draft version 0.4*, is the result of the work of many people in several companies. The primary responsibility for writing sections fell on employees of Apple, IBM and Motorola. Industry review was solicited from such companies as Canon, FirePower and Toshiba. A considerable portion of this document has been carried over from the PowerPC Reference Platform Specification.

### HRP Architecture Document

The HRP Architecture document is a superset of the PowerPC Reference Platform Specification, Version 1.1, the Apple RISC Architecture (Power Macintosh) and IBM RISC server systems.

1.9.3 Purpose of The HRP Architecture Document

The purpose of this document is to define the architecture requirements and minimum system requirements for a PowerPC Hardware Reference Platform. These requirements are precise enough to assure software compatibility for several operating environments, broad enough to cover mobile systems through server platforms in single or multiprocessor configurations and forward-looking enough to allow evolution, including 64-bit addressing.

These requirements were developed by Apple Computer, IBM and Motorola to define a system which is intended to become the pervasive open industry standard for single user through server configurations. Systems built to these requirements will have PowerPC processor(s), will share components with the Apple Macintosh family and Intel-based personal computers and will be capable of running various operating systems, including Apple Mac OS, IBM AIX, IBM OS/2 for PowerPC, Microsoft Windows NT, Novell NetWare, and Sun Solaris.

For hardware platform developers, this book defines the architectural requirements for an HRP-compliant implementation. Operating system vendors will use this specification as a definition of the platform hardware interface and the devices which are required to be supported.

1.9.4 HRP Architecture Goals

The goals of this specification are as follows:

- To create an open industry standard to be used for the implementation of PowerPC based systems
- To provide an architecture which can evolve as technology changes
- To leverage existing and future industry-standard buses and interfaces
• To allow compatible differentiation of device drivers and abstracted hardware interfaces
• To provide address map relocation
• To document the minimum configuration requirements of the operating systems which port to this architecture
• To minimize the support cost for multiple operating systems through the definition of common hardware abstraction techniques
• To transition from the current boot environment to an Open Firmware boot environment
• To allow control of power management by the operating system
• To provide for error handling, error reporting and fault isolation

1.9.5 HRP Brand and Certification

Currently, a team is in place to address the HRP brand and certification process. The main goal is to find means for verifying compliance with the architecture and to support the establishment of the PowerPC Hardware Reference Platform as an open standard.

The scenario could be the following:
• One or more independent laboratories will be qualified to provide the certification for systems
• Operating systems and applications which have been ported to the HRP reference implementations may brand themselves as “HRP Ready”
• Application software should indicate the operating system under which the application runs
• No certification of operating system or application software
• Systems certified as HRP-compliant will be permitted to use the brand and must identify the specific operating systems which they support

Again, the details for certification have not been yet worked out, but it is necessary to assure that the standard is followed. Let’s see what the team working on this topic comes up with.
Chapter 2. Introducing the Hardware

In this chapter, we will introduce the PCI-based RISC System/6000 systems currently available. However, before discussing the RISC System/6000 Model 40P and the RISC System/6000 Model 43P Series hardware, we want to present the hardware components which makes up the biggest difference between RSPC and "classical" RISC System/6000 systems - the bus architectures.

The RISC System/6000 Model 40P and the RISC System/6000 Model 43P include the Peripheral Component Interconnect (PCI) and the Industry Standard Architecture (ISA) bus architectures. Although the Personal Computer Memory Card Internal Association (PCMCIA) bus architecture is not implemented in either of the above mentioned PCI-based RISC System/6000 systems, we want to include an introduction to this emerging bus architecture for completeness.

2.1 Introducing the PCI Bus Architecture

Multimedia applications and the intense use of computer networks represent a big challenge on today’s PC and workstation architectures. Processors are growing more and more powerful. High-resolution graphics, full-motion video and CD-quality sound are moving from high-end workstations to everyday desktop PCs. But the data bottleneck is the slow host bus.

The Peripheral Component Interconnect (PCI) is a specification standard for computer bus implementation developed by a group of industry leaders, led by Intel, in order to meet this ever increasing demand for I/O bandwidth. As an open standard supporting complete processor independence, the PCI bus is well suited to become the industry’s dominant I/O bus for high-speed data transfer.

**PCI Information Sources**

The ftp server ftp.pci.on.ca is intended to support users of PCI’s products, and it provides a mechanism to allow users to share code and ideas.

In addition to this, PCI produces a number of software packages that are available as freeware or as demo versions. The server can also be accessed via the World Wide Web at URL ftp://ftp.pci.on.ca/index.html.

2.1.1 PCI Local Bus Overview

Figure 16 on page 28 shows a typical PCI Local Bus system architecture. In this example, the processor/L2 cache/memory subsystem is connected to PCI through a PCI Bridge. This bridge provides a low latency path through which the processor may directly access PCI devices mapped anywhere in the memory or I/O address spaces. It also provides a high-bandwidth path allowing PCI bus masters direct access to main memory. The bridge may optionally include such functions as data buffering/posting and PCI central functions (for example, arbitration).
Typical PCI Local Bus implementations will support up to three add-in board connectors though expansion capability is not required. The PCI add-in board connector is a Micro Channel-style connector. The same PCI expansion board can be used in ISA-, EISA- and MC-based systems.

It is assumed that typical low-bandwidth, after-market add-ins will remain on the standard I/O expansion buses, such as ISA, EISA, or MC. One component (or set of components) on PCI may generate the standard I/O expansion bus used in the system.

2.1.2 PCI Features and Benefits

The PCI bus architecture has many advantages involving the following:

- High data transfer speed
- Processor independence
- Cross-platform compatibility
- Multiple bus support
- Plug and Play
- Investment protection
**High Data Transfer Speed**

At 33 MHz, the synchronous PCI Local Bus transfers 32 bits of data at up to 132 Mbytes/sec. A transparent 64-bit extension of the 32-bit data and address buses can double the bus bandwidth (264 Mbytes/sec).

The high-speed data transfer is implemented by the following functions:

- **Buffering and asynchronous data transfer**
  The PCI chip can support the processing and buffering of data and commands sent from the processor or from the peripherals in case the peripheral or the processor is not yet ready to receive the information.
  This function permits the subsystems, processor and peripherals, to send the data to the PCI bus and to begin the next task without waiting until the target subsystem becomes ready to receive it.

- **Burst mode transfer**
  Variable length linear or toggle mode bursting for both reads and writes improves write-dependent graphics performance.

- **Caching**
  To reduce the access time, the PCI bus architecture supports caching of data which is frequently used.

- **DMA**
  The Direct Memory Access (DMA) function is used to enable peripheral units to read from and write to memory without sending a memory request to the processor. This function is very useful for peripherals that need to receive large amount of data, such as video adapters, hard disks and network adapters.

**Processor Independence**

Processor independence allows manufacturers to implement PCI buses on any computer, whether it’s based on a Pentium, Alpha or PowerPC processor. Any PCI-compliant peripheral will work on any PCI-compliant bus implementation, sparing manufacturers and system integrators the work of designing different products for different buses and processors. This processor independence add-in capability also ensures efficient transition to future processor generations.

**Cross-Platform Compatibility**

The key to cross-platform compatibility is processor independence. Until PCI, different systems used different buses, such as ISA, EISA, NuBus, and so forth. Now, different systems can use one bus. Where before manufacturers, resellers and users needed to work with various bus implementations, the PCI bus will work across multiple platforms.

Further, the PCI bus architecture provides backward compatibility; it means that the PCI bus architecture provides bridges to various industry standards, such as: ISA, EISA, MCA, and NuBus (see Figure 17 on page 30). These bridges allow users to use adapters built for different systems.
An important aspect of PCI-based system architecture is support for multiple PCI buses operating transparently to existing software. Multiple buses are used for several reasons:

- To isolate the bandwidth of a high-speed device from the rest of the system
- To allow an intelligent controller to have a local PCI bus
- To support more devices which can be directly connected to one PCI bus

Multiple PCI buses are organized in two different ways: as peers of each other or hierarchically. Figure 18 on page 31 shows the multiple PCI buses’ implementations.
Bridges 0 and 4 are peers, as are bridges 1 and 3. Bridge 0, bridge 1 and bridge 2 are arranged hierarchically. The bridge number corresponds to the PCI bus beneath it. This hard-coded bridge numbering convention allows the software to operate transparently across multiple PCI buses.

**Plug And Play Support**

Plug and play is another feature of the PCI standard. PCI peripherals following the PCI standard, load the appropriate set of installation, configuration and booting information to the host CPU without user intervention. This provides a greater ease of use for the system integrator or end-user.

**Investment Protection**

The PCI bus architecture is designed for 64-bit addressing support.

Both 5 volt and 3.3 volt signaling environments are specified. The voltage migration path enables smooth industry transition from 5 volts to 3.3 volts.
2.2 Introducing the ISA Bus Architecture

The Industry Standard Architecture (ISA) bus is the most widely used system bus in the PC industry. Originally, the ISA bus was referred to as the PC-AT bus, and there were no official definition or standards for it. Later on, its specifications were defined by the IEEE standards group. The ISA bus, if implemented, allows a transfer rate of up to 8.3 MB/s. Transfers over the ISA bus are synchronized around 8 MHz, and they usually take a minimum of two cycles of the bus clock to perform a data transfer. Since the data path of an ISA bus is 16 bits wide, up to two bytes may be transferred during each transaction.

2.2.1 Why ISA Support?

Since ISA is the most widely bus architecture used in the PC industry, it makes sense to provide users with the possibility to use hardware peripherals they already use with other systems, rather than having to expend additional money for these peripherals. This is especially convenient when the peripherals attached to this bus do not require increased performance.

Also, supporting the ISA bus architecture, the system provider has access to a wide spectrum of adapters and devices already available in the marketplace and does not have to wait for adapters to be built for an specific bus system. He just has to ensure that the device driver for his specific operating system is also available.

2.2.2 How to Connect to the PowerPC

The problem when connecting the processor to the ISA bus directly is that the processor’s speed has to be reduced to match the slow ISA bus speed; thus, the system cannot take advantage of a fast processor.

Table 1 shows the bus specification for diverse architectures and compares them to the PowerPC processor’s speed.

<table>
<thead>
<tr>
<th>Specification</th>
<th>PowerPC</th>
<th>ISA(8)</th>
<th>ISA(16)</th>
<th>EISA</th>
<th>PCI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Speed (601-604)</td>
<td>66-132</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Databus</td>
<td>64</td>
<td>8</td>
<td>16</td>
<td>16/32</td>
<td>64</td>
</tr>
<tr>
<td>Address Bus</td>
<td>32</td>
<td>20</td>
<td>24</td>
<td>24/32</td>
<td>64</td>
</tr>
<tr>
<td>Bus Clock</td>
<td>-</td>
<td>4.77 MHz</td>
<td>8.33 MHz</td>
<td>8.33 MHz</td>
<td>33 MHz</td>
</tr>
<tr>
<td>Interrupts</td>
<td>-</td>
<td>6</td>
<td>11</td>
<td>11</td>
<td>4</td>
</tr>
<tr>
<td>DMA Channels</td>
<td>-</td>
<td>3</td>
<td>7</td>
<td>7</td>
<td>busmaster</td>
</tr>
</tbody>
</table>

The solution to the problem is to use the PCI Local Bus as the primary system bus and the ISA bus as an expansion bus. In this way, the system can take advantage of the high-speed data transfer provided by the PCI bus when communicating with the processor and memory. On the other side, through the PCI-ISA Bridge, the bus clock can be reduced to match the ISA bus requirements (see Figure 19 on page 33).
2.3 Introducing the PCMCIA Bus Architecture

Although the RISC System/6000 Model 40P and RISC System/6000 Model 43P do not implement the Personal Computer Memory Card Internal Association (PCMCIA) bus architecture, the newly announced IBM ThinkPad Power Series 850 and IBM ThinkPad Power Series 820, which are also able to run AIX Version 4.1.3, include the PCMCIA bus architecture. For this reason, we want to introduce this emerging industry standard.

The PCMCIA standard defines the physical requirements, electrical specifications and software architecture for the 68-pin cards and their sockets. Release 1.0 cards and sockets of the PCMCIA supported only memory operations and no I/O capabilities. Release 2.0 and later releases of the specification allow the full range of I/O capabilities.

PCMCIA cards are the new standard for credit-card-size peripherals. In the future, they may become a standard feature for portable and desktop systems. Figure 20 on page 34 shows a PCMCIA reference implementation as included in the PowerPC Reference Platform Specification.
The main benefit of using PCMCIA cards is the capability of “hot insertion” and “hot removal”. This means that adapters, and with them devices, can be added or removed while the system is up and running. Full PCMCIA support will allow automatic configuration and removal of adapters and devices when the up and running operating system detects the insertion or removal of the card.

The PCMCIA interface consists of three standardized functional units:

- PCMCIA Cards
- PCMCIA Socket
- Software Services
2.3.1 PCMCIA Cards

The PCMCIA specification defines three different type of cards:

Type 1 Card Type 1 cards are 3.3 mm thick, 85.6 mm in length and 54 mm wide. They use a 34-pin connector and are the smallest PCMCIA cards. Examples of these type of cards are: non-volatile memory and sound cards.

Type 2 Card Type 2 cards are 5 mm thick, 85.6 mm in length and 54 mm wide. They use a 68-pin connector. Examples of these type of cards are: LAN adapters, fax/modems, and SCSI adapters.

Type 3 Card Type 3 cards are 10.5 mm thick, 85.6 mm in length and 54 mm wide. They use a 68-pin connector. They are mostly used for 1.8 inch IDE drives.

2.3.2 PCMCIA Socket

The design of the PCMCIA slot, or socket, reflects the intentions of the standard: small size and hot insertion. The slot itself is male and has pins of three different lengths. These length difference allows sequential activation of various parts of the card as the card is inserted. The longest pin is the power pin. It is followed by a shorter, general interface pin. The smallest pins are the card detection pins. The purpose of the different lengths or pin configurations is to maintain a steady-state signal level during physical removal or insertion of the card. Some cards and components are sensitive to power surge and arcing. When this is a concern, power application will be controlled by the detection pins. Because the detection pins are connected last, they can act as a switch so that power is not applied until all circuits and ground are connected. This action prevents power surges and arcing.
2.3.3 Software Services

The most important feature of the PCMCIA bus architecture is the support for hot insertion of adapters. Besides hardware awareness of card insertion and removal, the software, including operating system and applications, must support the PCMCIA specification. The PCMCIA software architecture has the following three key elements:

- Socket Services
- Card Services
- Card Enabler

2.3.3.1 Socket Services

Socket Services is a hardware-dependent interface that masks the socket’s actual hardware implementation from higher-level software components that utilize it. Socket Services includes the following functions:

- Specify the socket interface type
- Programming memory address and I/O windows
- Mapping the PCMCIA card’s interrupts to the system interrupts
- Enabling power conservation features
- Controlling socket power switching
- Controlling Error Detection Control (EDC) generator

2.3.3.2 Card Services

Card Services is a software layer that sits above the Socket Services, coordinating access among the cards, the sockets and system resources, such as interrupt and memory map. Card Services accesses cards via Socket Services. The card drivers interact with the cards via Card Services. Card Services is generally operating-system dependent.

2.3.3.3 Card Enabler

The Card Enabler is part of the PCMCIA software that deals with configuration details when a new card is hot-inserted into the system. The Card Enabler performs the following functions:

- Sets up the interrupts
- Provides configuration memory
- Creates the PCMCIA to Host Memory Map
- Sends information on the new card to the operating system
- Supports dynamic driver loading and unloading

2.4 Plug and Play

Since all the bus architectures presented in this document include Plug and Play technology support, we want to introduce this emerging technology. Therefore, we will discuss what Plug and Play is, the benefits it provides and the requirements for its implementation.
2.4.1 What is Plug and Play?
Plug and Play is a technology jointly developed by PC product vendors that will dramatically improve the integration of PC hardware and software. It allows a PC to adapt itself dynamically to its environment; devices can be plugged into or unplugged from a machine without the user having to do anything special—the machine just works. Plug and Play is a general framework that advances that state of the PC architecture by defining how the software communicates with any device connected to the PC.

2.4.2 Plug and Play Benefits
Plug and Play technology enables installation and configuration of add-on devices without user intervention. Plug and Play will make it possible for a consumer to turn a standard desktop system into a great multimedia machine by just “plugging” in a Plug and Play sound card and CD-ROM, turning on the system and “playing” a video clip. Plug and Play can enable new system designs that can be dynamically reconfigured. For example, imagine a docking station that enables you to remove the portable system while it is still running so that you can take it to a meeting, and the system automatically reconfigures to work with a lower-resolution display and adjusts for the absence of the network card and large disk drive. Or imagine an IR-enabled subnotebook that automatically recognizes, installs and configures an IR-enabled printer when you walk into the room, so your applications are ready to print to that printer.

Plug and Play can also save development and support costs for the product manufacturer. Today, as many as 50 percent of support calls received by operating system and device manufacturers are related to installation and configuration of devices. With Plug and Play, device driver development is simplified because device manufacturers can write one driver that works across multiple bus types by using the universal driver model specified by the Plug and Play architecture. Today, device manufacturers have to include bus-specific code in each of their drivers. With Plug and Play, specific bus configuration data is contained in “bus drivers”. Also, operating system preinstallation and configuration are simplified for OEMs because Plug and Play devices will automatically install and configure during setup.

2.4.3 Plug and Play Hardware and Software Requirements
To deliver all of the above benefits, the Plug and Play technology requires changes to devices and drivers, the BIOS and the operating system. Three fundamental capabilities are required for a system to provide Plug and Play functionality:

- A unique identifier for every device on the system
- A procedure for the BIOS and operating system to install and configure that device
- A mechanism for the system and applications to recognize that a configuration change has occurred while the system is running

All the changes to devices and drivers, the BIOS and the operating system are defined by a series of specifications for the Plug and Play architecture. The Plug and Play architecture is an open, flexible and cost-effective framework for designing Plug and Play products.
The Plug and Play architecture was jointly developed by a working group of leading vendors who reviewed design proposals with hundreds of companies in the industry at conferences and through online forums. Plug and Play can be implemented by any operating system vendor and any hardware manufacturer. IBM has announced support for Plug and Play in OS/2.

The Plug and Play architecture is flexible because it provides a framework that works on multiple types of bus architectures (ISA, SCSI, PCMCIA, VL, PCI, and so on), and it is extensible to future bus designs.

The Plug and Play architecture is also cost-effective because it requires little or no incremental cost for vendors to implement in their products.

### 2.5 RISC System/6000 Model 40P

The Model 40P delivers the performance of the PowerPC processor and the reliability of the AIX operating system at a price that is competitive with many personal computers. It is a highly affordable workstation that can handle both the demanding applications in commercial sectors, such as retail, finance, insurance, and the complex technical applications in development environments, such as drafting, design and software development.

The Model 40P also offers a range of graphics solutions, from entry level to high-performance 2D. With the optional software, Softgraphics, you can also run entry level 3D graphics.

*Figure 22. RISC System/6000 Model 40P*

Figure 23 on page 39 shows the RISC System/6000 Model 40P system diagram. Notice that the peripheral units are separated from the PowerPC processor, the L2 cache and memory through the Processor-PCI Bridge/Memory Controller chip. This allows the Processor Local Bus to run at 66 MHz, while the PCI bus runs at 33 MHz. The upgrade slot can be used to install either the 256 KB Level 2 cache or the PowerPC 604 processor upgrade (see announcement letter 195-185).
System memory is provided through six slots for 168-pin, 64-bit SIMM industry standard memory cards, which allows for up to 192 MB memory.

The 512 KB Flash ROM and the on-board SCSI-2 Interface Controller are directly connected to the PCI bus, which also provides two slots for additional PCI adapters. One of these slots is occupied by the PCI graphics adapter featured with the standard configuration.

The secondary ISA bus is connected through the PCI-ISA Bridge and allows for the connection of on-board ISA subsystems, such as audio and standard I/O. Three ISA slots are provided for the connection of ISA adapters.

![System/6000 Model 40P System Diagram](image)

**Figure 23. RISC System/6000 Model 40P System Diagram**

### 2.5.1 RISC System/6000 Model 40P Features and Benefits

The RISC System/6000 Model 40P provides the following features:

- **PowerPC 601 Architecture**
  
  Offers outstanding integer and floating-point processing

- **Up to 192 MB of memory**
Provides ample room for growth

- Level 2 (L2) cache (256 KB optional)
  Increases system performance

- Two performance options (one slot)
  Provides for additional performance (optional L2 cache) or an upgrade to the PowerPC 604 processor

- Two PCI and three ISA slots
  Incorporates industry standard personal computer slots that will support a range of third-party adapters

- Three PCI graphics adapters
  - Accommodate PC I/O adapters
  - Provide entry, mid-range, and advanced graphics adapters
  - Offer the lowest cost 8-bit, 2D color adapter in RS/6000 family
  - Offer capability to run entry level 3D graphics in the AIXwindows System environment using 2D graphics adapters when optional 3D graphics software products are installed

- Binary compatibility
  Provides a standard, enterprisewide AIX environment allowing most AIX 3.2.5 applications already running on other RS/6000 systems (POWER-, POWER2-, or PowerPC-based) to run unmodified

- AIX
  - Comes preinstalled with AIX Version 4
  - Lets you exploit the full power of the Model 40P by providing a wealth of business and technical features, including extensive communications and networking technologies
  - Provides compliance with major standards and includes extensions for a highly robust operating system
  - Incorporates an integrated desktop based on the Common Desktop Environment along with Motif and AIXwindows

- IBM’s Ultimedia Services
  - Comes preinstalled at no extra charge
  - Is accessible from the desktop
  - Allows capturing, editing and playing of multimedia material

- Insignia Solutions’ SoftWindows product
  - Is provided in a try-and-buy format, allowing customers to evaluate the product for sixty days before purchasing it
  - Allows users to run Windows and DOS applications from their RS/6000
2.5.2 RISC System/6000 Model 40P Hardware Characteristics

A detailed description of the RISC System/6000 Model 40P hardware components can be found in the announcement letter 194-338.

In this section, we want to emphasize the most important characteristics and include our experiences regarding the hardware.

Processor and Memory Subsystems

The RISC System/6000 Model 40P features the PowerPC 601 microprocessor running at 66 MHz with a 32 KB Level 1 cache. To obtain higher performance, an upgrade slot is provided that can be used to install an optional 256 KB Level 2 cache. Optionally, this slot can be used instead for a processor upgrade to a PowerPC 604 microprocessor with a 256 KB standard L2 cache running at 120 MHz. The processor upgrade will require an AIX software upgrade to AIX Version 4.1.3 (see announcement letter 195-185).

Up to six memory modules might be installed in the six memory slots provided on the system board. The RISC System/6000 Model 40P uses 8 MB or 32 MB, 70-ns, 168-pin parity memory modules. Any combination of 8 MB and 32 MB memory modules is allowed.

Storage Subsystem

A maximum of three SCSI-2 devices are supported internally. The system features an SCSI-2 port for the attachment of up to two external SCSI-2 devices. The optional internal SCSI-2 CD-ROM drive is a double-speed Toshiba, 5.25″ slim-line, 680 MB drive. The 2 GB and 4 GB, 4 mm tape drives are the only tape drives internally supported.

Important

Although an optional feature, it is strongly recommended to order an internal CD-ROM drive with the RISC System/6000 Model 40P. Since AIX cannot be booted from tape on the 40P, a CD-ROM remains the only media to boot from when booting from hard disk fails.

Table 2 shows the type of hard disks internally supported in the 40P and their specifications.

<table>
<thead>
<tr>
<th>Formatted Capacity</th>
<th>364 MB</th>
<th>540 MB</th>
<th>728 MB</th>
<th>1 GB</th>
<th>2 GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Media data (MB/sec)</td>
<td>44.6</td>
<td>44.6</td>
<td>44.6</td>
<td>48.0</td>
<td>94</td>
</tr>
<tr>
<td>Rate (MB/sec)</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Average Seek Time (ms)</td>
<td>13</td>
<td>13</td>
<td>13</td>
<td>8.8</td>
<td>9.3</td>
</tr>
<tr>
<td>Average Latency ms</td>
<td>6.67</td>
<td>6.67</td>
<td>6.67</td>
<td>5.56</td>
<td>4.17</td>
</tr>
<tr>
<td>Sector Interleave</td>
<td>1:1</td>
<td>1:1</td>
<td>1:1</td>
<td>1:1</td>
<td>1:1</td>
</tr>
<tr>
<td>Interface</td>
<td>SCSI-2</td>
<td>SCSI-2</td>
<td>SCSI-2</td>
<td>SCSI-2</td>
<td>SCSI-2</td>
</tr>
<tr>
<td>Write Cache</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Audio Subsystem

The RISC System/6000 Model 40P features an integrated audio subsystem to support multimedia applications. The following components are included:

- Business audio
- Line input
- Microphone input
- CD-DA input
- Line output
- Headphone output
- System speaker output

Refer to 9.6, “Multimedia Hardware” on page 209 for more information about the multimedia hardware components.

Input Devices

A keyboard port and a mouse port are provided. A keyboard and a three-button mouse are included within the system package. Keyboards are PS/2-style keyboards.

Although keyboard attachment is not necessary to boot AIX on the 40P, you will need to have a proper keyboard connected to the keyboard port if you want to access the System Management Services diskette.

Connectivity

Two 9-pin serial ports and one 25-pin parallel port are provided. Furthermore, two PCI slots (one of them normally used for the graphics adapter) and three ISA slots are provided for connection to Local Area Networks (LAN) using ISA token-ring or ISA/PCI Ethernet adapters or for connecting to Wide Area Networks (WANs) using ISA X.25 adapters.

The IBM 8-Port Asynchronous ISA Adapter is also available for connectivity purposes.

The PCI and ISA slots are contained in a riser assembly. While installing ISA adapters can be easily done after removing the system’s cover, installation or removal of PCI adapters will require the removal of the riser assembly. The same applies if you want to install or remove the battery.

Configuring several ISA network adapters within a system must be done manually and requires the user to provide conflict-free adapter parameters. Refer to Chapter 5, “Device Configuration on RSPC Systems” on page 99 for detailed information about how to configure adapters.

Graphic Adapters

The following PCI graphic adapters are supported:

- IBM E15
  An entry level, low-cost graphics adapter which uses the 64-bit S3 Vision864 graphical user interface accelerator and the 16-bit S3 SDAC.
• IBM S15
  A high-performance, VRAM-based graphics adapter with integrated video
  coprocessor which uses the Weitek 9100 graphical user interface accelerator.

• IBM GXT150P
  This is an 8-bit adapter that provides the highest-level 2D graphics
  performance. When coupled with the IBM Softgraphics software, it also
  provides entry level 3D graphics.

Refer to 5.6, “Configuring PCI Adapters” on page 129 for information about
which combinations of PCI graphics adapters are supported.

**Graphic Displays**

The following graphic displays are supported:

• POWERdisplay 20
• POWERdisplay 17
• IBM 17S/S Sight and Sound Monitor
• IBM P50 Color Monitor
• IBM P70 Color Monitor
• IBM P200 Color Monitor
• 6324 family
• 6325 family
• 6327 family
• 9521 family
• 9524 family
• 9525 family
• 9527 family

The IBM 631x family of monitors are not supported. Connecting a 631x monitor
could result in permanent damage to the monitor.

### 2.5.3 RISC System/6000 Model 40P System Performance

Values shown here are the results of development-level systems. All
performance data was obtained in a specific environment and is presented “as
is” for illustrative purposes only. While these values should be indicative of
generally-available systems, no warranties or guarantees are stated or implied
by IBM. IBM recommends application-oriented testing for performance
predictions and offers the commonly reported benchmarks only as an initial
indicator. Additional information on these tests are available from your IBM local
Branch Office or IBM Authorized Reseller. AIX 4.1.1 was used with each of the
benchmarks.

Table 3 on page 44 shows the system performance of the RISC System/6000
Model 40P.
Notes:

1. IBM C Set++ for AIX/6000 3.1 and AIX XL FORTRAN Version 3.2 were the
   compilers used in these tests. The preprocessors used in the tests include
   KAP 2.5 for FORTRAN and KAP/C 1.4 from Kuck & Associates, VAST-2
   X.03h28 from Pacific-Sierra Research. The preprocessor products are
   purchased separately.

2. SPECint92: Geometric mean of six integer tests which comprise the CINT92
   benchmark suite. All of these are written in C language. Baseline SPECint92
   results are included in the detailed results.

3. SPECfp92: Geometric mean of fourteen tests that represent the CFP92
   benchmark suite. Five of the tests are single precision while the remaining
   nine are double precision. Two tests are written in C language, and the rest
   are written in FORTRAN. Baseline SPECfp92 results are included in the
   detailed results.

4. Linpack DP: Double Precision, n=100 results with AIX XL FORTRAN
   compiler, with optimization. Units are megaflops (MFLOPS).

5. Linpack SP: Single Precision, n=100 results with AIX XL FORTRAN
   compiler, with optimization. Units are megaflops (MFLOPS).

6. Linpack TPP: Toward Peak Performance, n=1,000 results with AIX XL
   FORTRAN compiler, with optimization. Units are megaflops (MFLOPS).

7. tpm reflects IBM’s estimate of complex commercial transactions per minute.

8. The Xmark93 rating is a weighing of 532 tests executed in the X11 perf suite
   and is an indicator of 2D graphics performance in an X environment.

---

Table 3. RISC System/6000 Model 40P Performance Table

<table>
<thead>
<tr>
<th>Workstation</th>
<th>RISC System/6000 Model 40P</th>
<th>RISC System/6000 Model 40P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>PowerPC 601 microprocessor</td>
<td>PowerPC 601 microprocessor</td>
</tr>
<tr>
<td>Clock rate</td>
<td>66 MHz</td>
<td>66 MHz</td>
</tr>
<tr>
<td>L2 cache</td>
<td>-</td>
<td>256 KB</td>
</tr>
<tr>
<td>Benchmarks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPECint92</td>
<td>63.7</td>
<td>75.1</td>
</tr>
<tr>
<td>SPECfp92</td>
<td>67.8</td>
<td>77.0</td>
</tr>
<tr>
<td>Linpack DP (in MFLOPS)</td>
<td>9.5</td>
<td>13.7</td>
</tr>
<tr>
<td>Linpack SP (in MFLOPS)</td>
<td>16.9</td>
<td>20.0</td>
</tr>
<tr>
<td>Linpack TPP (in MFLOPS)</td>
<td>46.7</td>
<td>49.2</td>
</tr>
<tr>
<td>Graphical Benchmarks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Xmark93 with IBM E15</td>
<td>4.08</td>
<td>46.3</td>
</tr>
<tr>
<td></td>
<td>graphic accelerator</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.24</td>
<td>8.94</td>
</tr>
<tr>
<td></td>
<td>with IBM S15 graphic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>accelerator</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9.36</td>
<td>10.16</td>
</tr>
<tr>
<td></td>
<td>with IBM POWER GXT150P</td>
<td></td>
</tr>
<tr>
<td></td>
<td>graphic accelerator</td>
<td></td>
</tr>
</tbody>
</table>
2.5.4 RISC System/6000 Model 40P Limitations

The following limitations apply to the RISC System/6000 Model 40P:

• RISC System/6000 Model 40P has six memory slots. The minimum memory configuration is 16 MB, and the maximum memory configuration is 192 MB, using 8 MB or 32 MB memory modules.

• The three ISA slots can accommodate three full ISA cards. However, if the system contains an L2 cache or 604 upgrade card, the lowest card of ISA must be restricted to ISA cards less than 171 mm in length.

• Maximum data transfer rate of the CD-ROM is 300 KB/sec.

• Maximum of five SCSI-2 devices can be attached, three internal and two external.

• Keyboards are PS/2-style keyboards.

• Software Security Features:
  − Security modes may be set in software under password control. A mechanical keylock is provided to secure the cover only.
  − The External SCSI port can be disabled for C2 security compliance.

• Ports:
  − Serial ports use the compact 9-pin format in place of the 25-pin format.
  − Tablet connections must be made via serial ports.

• Diagnostics:
  − On-screen diagnostics provide less cryptic messages than LEDs.
  − No LEDs for failure information or error code readout.
  − Diagnostics diskettes are provide with the system unit. Diagnostics cannot be run from the hard disk drive or while the normal operating system is running.

• Data Protection and Reliability:
  − Parity memory provides data protection. Previously announced RS/6000 models used Error Checking Correction (ECC) memory.
  − A UPS or surge protector can increase data reliability in the event of a power outage. The Emergency Power Off Warning signal (EPOW) which alerts the operating system to power failures is not provided.

2.6 RISC System/6000 Model 43P

The RISC System/6000 Model 43P Series are full-size desktop workstations based on the PowerPC 604 microprocessor. The 43P Series is designed from the ground up to adhere to industry standards, such as Peripheral Component Interconnect (PCI), Industry Standard Architecture (ISA) and Small Computer System Interface (SCSI-2), allowing users to exploit PC components that adhere to these formats (AIX drivers are required).

There are three models in the 43P Series based upon the performance levels of the PowerPC 604 microprocessor and L2 cache:

• Model 100
  Based on the 100 MHz version of the PowerPC 604 microprocessor, and it comes standard with a 256 KB asynchronous L2 cache.

• Model 120
Based on the 120 MHz version of the PowerPC 604 microprocessor, and it comes standard with a 512 KB synchronous L2 cache.

- **Model 133**

  Based on the 133 MHz version of the PowerPC 604 microprocessor, and it comes standard with a 512 KB synchronous L2 cache.

The 43P Series handles multitasking capabilities and concurrently running processor-intensive applications, such as CAD applications, securities analysis, desktop publishing, spreadsheets, database applications, and presentation graphics. It is an ideal workstation for commercial UNIX workstation uses and 2D technical workstation applications.

---

**Figure 24. RISC System/6000 Model 43P**

Figure 25 on page 47 shows the RISC System/6000 Model 43P system diagram. Similar to the RISC System/6000 Model 40P, the peripheral units are separated from the processor, L2 cache and system memory units through the Processor-PCI Bridge/Memory Controller chip. The Processor Local Bus runs at 66 MHz, while the PCI bus runs at 33 MHz. In difference to the 40P, the 43P includes an integrated L2 cache. A processor upgrade socket is also provided.

System memory is provided through six memory slots although the SIMM cards used in the 43P are different than the ones used in the 40P. Memory cards on the 43P are 72-pin, 36-bits wide compared to 168-pin, 64-bits on the 40P.

Flash ROM on the 43P is 1 MB compared to 512 KB on the 40P. An Ethernet network connector and the S3 graphic accelerator are integrated on the system board on the 43P.

Three ISA slots and two shared ISA/PCI slots are provided.
2.6.1 RISC System/6000 Model 43P Series Features and Benefits

The RISC System/6000 Model 43P Series provides the following features:

- Fastest integer performance in the RS/6000 line

  Means faster application and graphics performance (overwhelming majority of applications are integer bound).

- Industry’s leading 2D entry level workstation (Xmark93)

  Provides immediate system response and reacts faster without interrupting processes with long pauses while you wait for the system to draw an image.

- Softgraphics 3D APIs
- Run production 3D CAD applications with 2D hardware, POWER GXT150P accelerator
- Do not require additional user training from one RS/6000 workstation to another
- Help lower cost because you need only one workstation instead of two
- Provide better user-to-user communication with color-sensitive applications, such as industrial design

• Three levels of processor speeds
  Let you purchase the performance you need.

• Superior expansion capability
  Offers great investment protection and very competitive expansion capabilities supported through:
  - Three ISA and two PCI or ISA slots (shared)
  - 16 MB to 192 MB system memory
  - 540 MB to 5 GB internal SCSI-2 hard disk
  - Five bays for internal diskette, SCSI-2 CD-ROM, SCSI-2 hard disks, and tape drive
  - External SCSI-2 connection to support attachment of external SCSI-2 devices

• LAN attachment options
  Let you select from the most popular LANs and provide maximum flexibility for new installations or when installing or integrating workstations into existing networks.

• Industry standard I/O (ISA and PCI slots)
  Helps lower your business costs by providing slots for both IBM and third-party adapters.

• Complete workstation I/O
  Results in a no-compromise, no-excuses workstation at surprisingly low price points.

• Standard integrated business audio
  Helps lower the cost of multimedia solutions.

• Binary compatibility
  Provides an environment where most AIX Version 4 applications running on other POWER, POWER2 or PowerPC-based RS/6000 systems can run unmodified.

• AIX
  - Can be optionally preinstalled on these workstations (AIX Version 4)
  - Provides a wealth of business and technical features, including extensive communications and networking technologies, to exploit the full power of the workstations
  - Complies with major standards and has extensions for a highly robust operating system
2.6.2 RISC System/6000 Model 43P Series Hardware Characteristics

A detailed description of the RISC System/6000 Model 43P hardware components can be found in the announcement letter 195-181.

In this section, rather than duplicating this information, we want to emphasize the most important characteristics.

**Processor Subsystem**

The RISC System/6000 Model 43P Series features the PowerPC 604 microprocessor processor, which is a 32-bit implementation of the PowerPC architecture, running at 100 MHz, 120 MHz or 133 MHz, depending on the model.

The 604’s integrated L1 cache is split into separate instruction and data caches. Both the instruction and data caches are 16 KB.

**Memory Subsystem:** The memory subsystem can support up to 192 MB of system memory on six 72-pin industry standard SIMM sockets. Each SIMM socket can support a 4 MB, 8 MB, 16 MB, or 32 MB of 70ns parity SIMM and must be installed in pairs. The memory cards are different than the ones used on the 40P.

The SIMM pairs are 1-2, 3-4 and 5-6. SIMMs within a pair must have the same capacity and pairs can be populated in any order.

**L2 Cache Subsystem**

The L2 Cache subsystem is integrated onto the system board and is always present in the base system.

Two different L2 Cache types are used: 256 KB asynchronous SRAM module on the 43P model 100 and 512 KB synchronous Burst RAM module on the 43P model 120 and 43P model 133.

**Storage Subsystem**

A maximum of four SCSI-2 devices are supported internally. The system features an SCSI-2 port for the attachment of up to two external SCSI-2 devices. The standard CD-ROM drive is a 5.25 inch, 680 MB, quad-speed, SCSI-2 CD-ROM drive which supports Photo-CD applications.

Table 4 shows the type of hard disks supported in the 43P and their specification.

<table>
<thead>
<tr>
<th>Table 4 (Page 1 of 2). Hard Disk Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatted Capacity</td>
</tr>
<tr>
<td>Average Media Data (MB/sec)</td>
</tr>
<tr>
<td>Rate (MB/sec)</td>
</tr>
<tr>
<td>Average Seek Time (ms)</td>
</tr>
<tr>
<td>RTM</td>
</tr>
</tbody>
</table>
The 4 GB, 4 mm SCSI-2 tape drive is the only tape drive internally supported.

**Audio Subsystem**

Enhanced business audio is provided through the Crystal Semiconductor CS4232 audio chip.

The system provides for stereo capture and playback. Compression and decompression are supported in hardware. The audio output is to a single speaker mounted in the cabinet. Also supported are four rear-mounted 3.5 mm jacks for:
- Stereo earphones
- Stereo microphone input
- Stereo line in
- Stereo line out

There is also a planar mounted connector for direct playback from the CD-ROM.

**Input Devices**

A keyboard port and a mouse port are provided. A keyboard and a three-button mouse are included within the system package. Keyboards are PS/2-style keyboards.

Although keyboard attachment is not necessary to boot AIX on the 40P, you will need to have a proper keyboard connected to the keyboard port if you want to access the System Management Services diskette.

**Connectivity**

Two 9-pin serial ports and one 25-pin parallel port are provided. The 43P also provides Ethernet connectivity integrated on the system board through the PCnet Am79C970 chip which is connected to the PCI bus. The connector is a 10BaseT twisted-pair connector.

Furthermore, three ISA slots and two PCI or ISA slots (shared) are provided for attachment of the token-ring, additional Ethernet and X.25 adapters.

The IBM 8-Port Asynchronous ISA Adapter is also available for connectivity purposes.

The PCI and ISA slots are contained in a riser assembly. While installing ISA adapters can be easily done after removing the system's cover, installation or removal of PCI adapters will require the removal of the riser assembly. The same applies if you want to install or remove the battery.

Configuring several ISA network adapters within a system must be done manually and requires the user to provide conflict-free adapter parameters.
Refer to Chapter 5, “Device Configuration on RSPC Systems” on page 99 for detailed information about how to configure adapters.

**Video Subsystem and Graphic Adapters**

The 43P has video integrated on the system board. The video subsystem includes the S3 864 DXP graphics accelerator chip, a 16-bit S3 SDAC and 2 MB of video DRAM memory that allows for the same capabilities as provided by the optional IBM E15 graphics adapter.

The following PCI graphic adapters are supported:

- **IBM E15**
  - Entry level, low-cost, graphics adapter which uses the 64-bit S3 Vision864 graphical user interface accelerator, the 16-bit S3 SDAC and 2 MB of video DRAM memory.

- **IBM S15**
  - High-performance, VRAM-based graphics adapter with an integrated video coprocessor that uses the Weitek 9100 graphical user interface accelerator.

- **IBM GXT150P**
  - This is an 8-bit adapter that provides highest-level 2D graphics performance. When coupled with the IBM Softgraphics software, it also provides entry level 3D graphics.

Refer to 5.6, “Configuring PCI Adapters” on page 129 for information about which combinations of PCI graphics adapters are supported.

**Graphic Displays**

The following graphic displays are supported:

- **POWERdisplay 20**
- **POWERdisplay 17**
- **IBM 17S/S Sight and Sound Monitor**
- **IBM P50 Color Monitor**
- **IBM P70 Color Monitor**
- **IBM P200 Color Monitor**
- **6324 family**
- **6325 family**
- **6327 family**
- **9521 family**
- **9524 family**
- **9525 family**
- **9527 family**

The IBM 631x family of monitors are not supported. Connecting a 631x monitor could result in permanent damage to the monitor.
2.6.3 RISC System/6000 Model 43P System Performance

Values shown here are the results of development-level systems. All performance data was obtained in a specific environment and is presented “as is” for illustrative purposes only. While these values should be indicative of generally-available systems, no warranties or guarantees are stated or implied by IBM. IBM recommends application-oriented testing for performance predictions and offers the above commonly reported benchmarks only as an initial indicator. Additional information on these tests is available from your IBM local Branch Office or IBM Authorized Reseller.

Table 5 shows the system performance of the RISC System/6000 Model 43P AIX Version 4.1.3 was used with each of these benchmarks. IBM C Set++ for AIX/6000 3.1.2 and AIX XL FORTRAN 3.2.2 were the compilers used in these tests.

<table>
<thead>
<tr>
<th>Benchmark</th>
<th>43P-100</th>
<th>43P-120</th>
<th>43P-133</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPECint92</td>
<td>128.1</td>
<td>157.9</td>
<td>176.4</td>
</tr>
<tr>
<td>SPECfp92</td>
<td>120.2</td>
<td>139.2</td>
<td>156.5</td>
</tr>
<tr>
<td>SPECbase_int92</td>
<td>104.3</td>
<td>127.1</td>
<td>142.2</td>
</tr>
<tr>
<td>SPECbase_fp92</td>
<td>104.8</td>
<td>129.0</td>
<td>146.2</td>
</tr>
<tr>
<td>LINPACK DP (in MFLOPS)</td>
<td>25.5</td>
<td>27.8</td>
<td></td>
</tr>
<tr>
<td>LINPACK SP (in MFLOPS)</td>
<td>27.9</td>
<td>48.2</td>
<td>51.7</td>
</tr>
<tr>
<td>LINPACK TPP (in MFLOPS)</td>
<td>56.4</td>
<td>61.0</td>
<td>67.5</td>
</tr>
</tbody>
</table>

Notes:

1. The pre-processors used in the above tests include the KAP 2.5 for FORTRAN, the KAP/C 1.4.2 from Kuck & Associates and the VAST-2 X.03h28 from Pacific-Sierra Research. The preprocessor products are purchased separately from these vendors.

2. SPECint92: Geometric mean of six integer tests which comprise the CINT92 benchmark suite. All of these are written in C language. SPECbase_int92: same tests as CINT92 with restrictive compiler options.

3. SPECfp92: Geometric mean of fourteen tests that represent the CFP92 benchmark suite. Five of the tests are single precision while the remaining nine are double precision. Two tests are written in C language, and the rest are written in FORTRAN. SPECbasefp92: same tests as CFP92 with restrictive compiler options.

4. LINPACK DP: Double precision, n=100 results with AIX XL FORTRAN compiler, with optimization. Units are megaflops (MFLOPS).

5. LINPACK SP: Single Precision, n=100 results with AIX XL FORTRAN compiler with optimization. Units are megaflops (MFLOPS).

6. LINPACK TPP: Toward Peak Performance, n=1,000 results with AIX XL FORTRAN compiler, with optimization. Units are megaflops (MFLOPS).

Table 6 on page 53, Table 7 on page 53, and Table 8 on page 53 show the graphic performance of the 43P model 100, 43P model 120 and 43P model 133, respectively. AIX Version 4.1.3 was used for these graphics benchmarks.
Table 6. RISC System/6000 Model 43P Model 100 with 256 KB L2 Cache

<table>
<thead>
<tr>
<th>Graphic Benchmark</th>
<th>E15</th>
<th>S15</th>
<th>GXT150P</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPC/XPC results Xmark93</td>
<td>5.57</td>
<td>11.76</td>
<td>13.76</td>
</tr>
<tr>
<td>GPC/PLB results (graPHIGS)</td>
<td>PLBwire93</td>
<td></td>
<td>22.5</td>
</tr>
<tr>
<td></td>
<td>PLBsurf93</td>
<td></td>
<td>21.6</td>
</tr>
<tr>
<td>GPC/OPC results</td>
<td>CDRS-02</td>
<td></td>
<td>2.55</td>
</tr>
<tr>
<td></td>
<td>DX-02</td>
<td></td>
<td>0.70</td>
</tr>
</tbody>
</table>

Table 7. RISC System/6000 Model 43P Model 120 with 512 KB L2 Cache

<table>
<thead>
<tr>
<th>Graphic Benchmark</th>
<th>E15</th>
<th>S15</th>
<th>GXT150P</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPC/XPC results Xmark93</td>
<td>6.24</td>
<td>12.61</td>
<td>14.75</td>
</tr>
<tr>
<td>GPC/PLB results (graPHIGS)</td>
<td>PLBwire93</td>
<td></td>
<td>30.0</td>
</tr>
<tr>
<td></td>
<td>PLBsurf93</td>
<td></td>
<td>21.9</td>
</tr>
<tr>
<td>GPC/OPC results</td>
<td>CDRS-02</td>
<td></td>
<td>3.08</td>
</tr>
<tr>
<td></td>
<td>DX-02</td>
<td></td>
<td>0.77</td>
</tr>
</tbody>
</table>

Table 8. RISC System/6000 Model 43P Model 133 with 512 KB L2 Cache

<table>
<thead>
<tr>
<th>Graphic Benchmark</th>
<th>E15</th>
<th>S15</th>
<th>GXT150P</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPC/XPC results Xmark93</td>
<td>6.70</td>
<td>13.61</td>
<td>15.69</td>
</tr>
<tr>
<td>GPC/PLB results (graPHIGS)</td>
<td>PLBwire93</td>
<td></td>
<td>33.0</td>
</tr>
<tr>
<td></td>
<td>PLBsurf93</td>
<td></td>
<td>24.1</td>
</tr>
<tr>
<td>GPC/OPC results</td>
<td>CDRS-02</td>
<td></td>
<td>3.30</td>
</tr>
<tr>
<td></td>
<td>DX-02</td>
<td></td>
<td>0.85</td>
</tr>
</tbody>
</table>

Notes:

1. The Xmark93 rating is the weighed geometric mean of 447 tests executed in the x11perf suite and is an indicator of 2D graphics performance in an X environment. Larger values indicate better performance. Tests were executed on configurations with 16 MB of system memory.

2. PLBwire93 and PLBsurf93 are geometric means of literal and optimized Picture Level Benchmark (PLB) tests for 3D wireframe and 3D surface tests, respectively. The benchmark and tests were developed by the Graphics Performance Characterization (GPC) Committee. The results shown use the graPHIGS API. Larger values indicate better performance. Tests were executed on configurations with 32 MB of system memory. Tests ran with 8-bit visuals.

3. The GPC/OPC composites are derived from the weighted geometric mean of the individual Viewset metrics. The composites have been endorsed but not yet published by the OPC committee. The above data was measured by IBM. The composites were computed by IBM. The composites have a unit of frames/second. Larger values indicate better performance. Tests were executed on configurations with 32 MB of system memory. The GXT150P configuration included a screen resolution of 1024x768. Tests ran with 8-bit visuals.
2.6.4 RISC System/6000 Model 43P Limitations

The following limitations apply to the RISC System/6000 Model 43P Series:

- The 43P Series has six memory slots. The minimum memory configuration is 16 MB and the maximum memory configuration is 192 MB, using 4 MB, 8 MB, 16 MB, or 32 MB memory SIMMs installed in pairs.
- The three ISA slots can accommodate two full cards and one short ISA card.
- The 43P Series supports two PCI or two additional ISA slots (one long and one short).
- The maximum data transfer rate of the CD-ROM is 600 KB/sec.
- A maximum of six SCSI-2 devices can be attached (four internal and two external).
- Keyboards are PS/2-style keyboards.
- Software Security Features:
  - Security modes may be set in software under password control. A mechanical keylock is provided to secure the cover only.
  - The external SCSI port can be disabled mechanically for security.
- Ports:
  - Serial ports use the compact 9-pin format in place of the 25-pin format.
- Diagnostics:
  - On-screen diagnostics provide less cryptic messages than LEDs.
  - No LEDs for failure information or error code readout.
  - Diagnostics diskettes are provided with the system unit.
  - Diagnostics cannot be run from the hard disk drive or while the normal operating system is running.
- Data Protection and Reliability:
  - Parity memory provides data protection. Previously announced RS/6000 models used Error Checking and Correction (ECC) memory.
  - A UPS or surge protector can increase data reliability in the event of a power outage. The Emergency Power Off Warning signal (EPOW) that alerts the operating system to power failures is not provided.
- Requires AIX Version 4.1.3, or later.
- The Ethernet coax connection will not work in the top, short slot.
- Audio support requires IBM Ultimmedia Services Version 2.1 for AIX.
- The internal audio subsystem does not support attachment of a second CD-ROM.
- Display required for all configurations.
- Diskless and dataless system configurations are not supported.
- AIX-concurrent diagnostics do not work on the 43P series.
- Applications with high loads on the ISA Ethernet and token-ring adapters may show degraded performance.
- The X.25 Interface Co-processor card requires the AIX 4.1 Server.
- The 2.0 GB SCSI-2 hard disk drive is not supported in a 5.25-inch bay.
Chapter 3. Boot Support

The newly announced PowerPC Personal Systems, including the RISC System/6000 Model 40P and RISC System/6000 Model 43P, have a different architecture than the classical RISC System/6000 systems. This architecture includes hardware which is independent of the operating system running on it. No assumptions have been made about which operating system, and which requirements specific to an operating system, must be satisfied for the operating system to boot on the PCI-based hardware.

The firmware on the “classical”, microchannel-based RISC System/6000 hardware provides AIX with the information required for booting. The firmware on the PCI-based RISC System/6000 systems is not specific to AIX; thus the boot process on a PCI-based RISC System/6000 system is different than the one on a “classical” RISC System/6000.

This chapter discusses the challenge of booting the same AIX operating system on three different hardware platforms (“classical” RISC System/6000, Symmetric Multiprocessor RISC System/6000, and PCI-based RISC System/6000), the hardware and software components involved within the AIX boot process on PCI-based RISC System/6000, the boot image specific to this platform, and the boot process itself.

3.1 Multiple-Platform Boot

While AIX Version 3 provides boot images for the “classical” RISC System/6000 platform only, AIX Version 4 provides support for generating different boot images for different platforms and cross boot images. These boot images are platform specific and are built using platform-specific components.

<table>
<thead>
<tr>
<th>Platform Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>The names used for the different platforms are:</td>
</tr>
<tr>
<td>rs6k</td>
</tr>
<tr>
<td>rs6ksmp</td>
</tr>
<tr>
<td>rspc</td>
</tr>
</tbody>
</table>

To create platform-specific boot images, AIX provides support for the following two issues:

- Recognition of the platform type
  The given platform is specified in the IPL control block set up by Software ROS. The boot utility command `bootinfo -T` inspects the IPL control block and prints the platform type to the standard output.

- Specifying the platform type
  The platform type can be specified in the `bosboot` command with a `-T` switch to generate the boot image for the target platform. If the platform type is not specified, this command defaults to the current platform type the system is running on and generates the boot image for that type.
Explicitly specifying the platform type allows cross-platform boot images to be built.

3.1.1 Platform-Specific Components

As in AIX Version 3, in AIX Version 4, the AIX boot image is created using the bosboot command; however, in AIX Version 4, this boot image is specific to one of the supported platform types. The following platform-specific components are required to create the AIX boot image:

- Base Proto and Proto Extension Files
- RAM Filesystem
- ODM Predefined Database

3.1.1.1 Base Proto and Proto Extension Files

Base proto and proto extension files are used to dynamically create the prototype files needed for building the RAM file system which is used during booting the system.

The prototype files include device configuration methods and device drivers that are specific to a given machine’s device configurations. In general, only the packages of those devices which exist on the machine are installed, and the prototype file needs configuration methods and drivers for those devices only.

The bosboot command builds the prototype file dynamically by combining the base proto file with proto extensions to include the installed methods and drivers (See Figure 26).

![Relation Map of Base Proto File and Proto Extension Files](image)

Figure 26. Relation Map of Base Proto File and Proto Extension Files

**Base Proto Files:** The base proto files are platform specific. They contain libraries, non-device related commands and ODM data files relevant to a specific platform. They are named with the platform type as their prefix:

- For “classical” RISC System/6000 systems:
rs6k.disk.proto, rs6k.tape.proto, rs6k.cd.proto, rs6k.tok.proto, rs6k.ent.proto, rs6k.fddi.proto

• For SMP systems:
  rs6ksmp.disk.proto, rs6ksmp.tape.proto, rs6ksmp.cd.proto, rs6ksmp.fddi.proto, rs6ksmp.tok.proto, rs6ksmp.ent.proto

• For RSPC systems:
  rspc.disk.proto, rspc.cd.proto, rspc.tok.proto, rspc.ent.proto

Note!

There is no rspc.tape.proto proto file. Booting AIX from a tape drive is not supported on the RSPC platform.

Proto Extension Files: Combined with the base proto files, proto extension files are also used for dynamically creating the prototype file. The platform-specific information is incorporated so that only those extension files relevant to the given platform type are used. However, some of the extension files are used for more than one platform, and some are used for only one specific platform.

To specify which platform needs which types of extension files, they are placed in groups specified as part of their file names. The platform-specific specific information for the proto extension file groups are maintained in a configuration file which has a .pcfg extension. The .pcfg file is prefixed with the platform type, and it contains the list of device groups which are valid for a given platform.

Proto Extension Configuration File

As an example, for the PCI-based RISC System/6000 platform, the file is called rspc.pcfg and is located in the directory /usr/lib/boot/protoext.

The content of the /usr/lib/boot/protoext/rspc.pcfg file is:

base.
isa.
pci.
scsi.disk.
sys.pci.

The set of proto extension files covered by each entry in the .pcfg file for RSPC systems is:

<bootdevice>.proto.ext.base.*
<bootdevice>.proto.ext.isa.*
<bootdevice>.proto.ext.pci.*
<bootdevice>.proto.ext.scsi.disk.*
<bootdevice>.proto.ext.sys.pci.*

In general, the proto extension file names have the following format: `<boot device>.proto.ext.<entry-in-.pcfg>.*`

On RSPC systems, a current valid `<boot device>` is one of:

cd
disk
3.1.1.2 RAM File System

When the bosboot command is run, it determines the type of platform and the boot device for which to generate the boot image. It builds the prototype file based on the information provided by the base proto and proto extension files (see 3.1.1.1, “Base Proto and Proto Extension Files” on page 56 for more information on the base proto and proto extension files). Once the prototype file is built, the boot image generation proceeds as in AIX Version 3, where the RAM filesystem is first created and put together with the stripped kernel image.

The structure of the RAM file system is defined in the base proto files. The RAM file system must contain all data, commands, libraries, and ODM objects required during the boot and before the real filesystems are mounted from disk, network or another device.

3.1.1.3 ODM Predefined Database

In AIX Version 3, the Device Configuration Database consists of Customized and Predefined objects for all devices supported by AIX. Predefined objects contribute a major portion of the device database and contain information about all possible types of devices that can be defined for the system. However, the complete Predefined Database is not needed, nor is it desirable due to its large size. During boot or installation, only subsets of device information are needed. The problem is that these subsets are different, depending on the boot and installation devices and the different phases of the boot process.

In AIX Version 4, the Device Predefined Database is customized to the configuration of the given system thus reducing the overall size of the Device Configuration Database. The whole Predefined Database on a given system is small enough to fit into the boot image providing consistent device information for boot and install across different devices and eliminating the need for subsets and stanzas files.

<table>
<thead>
<tr>
<th>ODM Predefined Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>The ODM Predefined Database (PdDv and PdAt) on an RSPC contains definitions and attributes relevant to RSPC systems only.</td>
</tr>
</tbody>
</table>

3.1.2 Impact on Boot Utilities, Commands and Scripts

The following commands were changed in AIX Version 4 to support multiple platform boot:

- /usr/sbin/bootinfo
- /usr/sbin/bosboot
- /usr/sbin/mkboot
- /sbin/rc.boot

The command below was added:

- /usr/lib/boot/mkmboot
Refer to 3.3.3, “Modifications to the Boot Commands” on page 70 for an explanation on the changes introduced to these commands.

3.2 Boot Components Specifically for AIX on RSPC Systems

The firmware (also called System ROS) on the “classical” RISC System/6000 is sophisticated enough to build the IPL control block needed by the AIX boot image, find a boot device, load the AIX boot image from this boot device, and pass control to it.

On RSPC systems, however, the firmware is simple and generic, meaning independent of the operating system running; therefore it does not build the IPL control block for AIX, but finds the boot device, locates the operating system bootstrap code on it and passes control to it, regardless which operating system it is.

Modifying the AIX code to compensate for the simplified firmware on RSPC systems would have required a dramatic effort. Therefore, in order to create the IPL control block and perform the initialization needed by the AIX boot image, a new, intermediary software component has been added to the boot process on RSPC systems, the Software ROS.

The components involved within the AIX boot process on RSPC systems take control in the following order:

1. RSPC firmware
2. Software ROS for AIX
3. AIX Boot Image

![AIX Boot Sequence on RSPC](image)

*Figure 27. AIX Boot Sequence on RSPC Systems*
### 3.2.1 RSPC firmware

The RSPC firmware is the first code to execute when the computer system is powered-on. Firmware takes the system from the power-on state to a state where an operating system loader is in memory, ready for execution.

The RSPC firmware performs the following steps:

1. Initialize processor registers
2. Initialize memory controller
3. Establish active RAM area
4. Copy decompress code to RAM
5. Decompress compressed area into RAM
6. Establish execution environment (stacks, and so on)
7. Initialize console
8. Display graphic-logo on console
9. Initialize individual subsystems
10. Locate and load operating system boot code

The RSPC firmware also provides functions that were already incorporated in the firmware of "classical" RISC System/6000. Among these are the Power-On-Self-Test (POST). The POST checks basic hardware, such as processor, native I/O and system memory. It makes a list of the working hardware it recognizes.

Contrary to firmware on the "classical" RISC System/6000, the RSPC firmware has its own boot device order list and cannot be changed by AIX. When booting, it tries to locate a valid boot device, which is a device that has a valid boot image on it (this is determined by reading the first 512 bytes on a device).

When a valid boot image has been found, it is loaded into memory, and the firmware passes control to it. The RSPC firmware does not have to be aware of the type of code it loads, whether this code is Software ROS or the kernel of an operating system. In the case of AIX, it is Software ROS.

### 3.2.2 Software ROS for AIX

Software ROS for AIX is an intermediary software that implements the Boot-Time Abstraction Software (BTAS) specified in the PowerPC Reference Platform Specification (see 1.5.4.1, “Boot-Time Abstraction Software (BTAS)” on page 10). Software ROS is the bootstrap code loaded into memory by the RSPC firmware.

Software ROS starts by copying the content of the physical NVRAM (located on the ISA bus, not on the processor bus) into system memory.

When the RSPC firmware executes after power-on or re-IPL, it scans the system for basic working hardware and stores the information into memory as residual data. Residual data is used by conventional firmware to pass system data collected by the firmware to the operating system, in our case to Software ROS. It is stored in Little-Endian format and must be converted to Big-Endian as required by AIX.
Software ROS converts the residual data into Big-Endian format and handles all the differences in formats and structures so that the AIX kernel will be able to use this data at a later time. Prior to locating the AIX boot image, Software ROS updates the IPL control block to mention the memory address of the converted residual data.

Finally, Software ROS locates the AIX boot image, loads it into memory and passes control.

### 3.2.2.1 NVRAM initialization by Software ROS

Because of the difference in size and usage conventions of the NVRAM on the RSPC platform versus the “classical” RISC System/6000, it is necessary for Software ROS to initialize the NVRAM image used by the AIX operating system.

Software ROS allocates a section of memory at the end of the IPL control block to use as the NVRAM buffer. Software ROS copies and reformats the information contained in the physical NVRAM into this buffer. The respective data is updated in the IPL control block to reflect the size and location of the NVRAM buffer.

### 3.2.2.2 Construction of the IPL Control Block

On taking control of the system, Software ROS forms an IPL Control Block, which is compatible with AIX. The input for this control block comes from three sources:

- **Defined values**: Hardware-specific information that is model dependent (for example, number of slots).
- **Computed values**: Information which is taken by calling query routines against the platform for values (for example, amount of L2 cache).
- **Residual information**: Information which is made available by the RSPC firmware as residual data (for example, device names).

### 3.2.2.3 Locating and Transferring Control to the AIX Boot Image

Currently, Software ROS uses the `boot record` to locate the AIX boot image (see 3.2.4.1, “Boot Record Structure on RSPC Systems” on page 65).

Whatever code is at the beginning of the AIX boot image, Software ROS passes control to it. Since in AIX Version 4 the boot image may be compressed or uncompressed depending on the options selected with the `bosboot` command, this code is the **Boot Expand Code** (compressed image) or the **AIX kernel** (uncompressed image). When Boot Expand Code is present, it decompresses the AIX kernel and RAM file system and then passes control to the AIX kernel.

Once the AIX boot image has been loaded, offset pointers for passing control are computed based on the contents of the boot record, and a call is made to pass control to the image.

Before actually passing control of the image, Software ROS creates a relocator module immediately preceding the IPL control block in high memory. This relocator is used to move the loaded boot image to begin at address zero as required by AIX.
3.2.3 Non-Volatile RAM (NVRAM)

NVRAM is a non-volatile memory backed up with a battery. It stores system configuration data for use by firmware and the different operating systems that may be run on the system.

On RSPC systems, the NVRAM is located on the ISA bus together with the Real-Time Clock (RTC) and the battery. Therefore, NVRAM on RSPC systems has to be handled as an I/O device. On "classical" RISC System/6000, the NVRAM is mapped into the memory address map and is directly addressable and accessible by the operating system. On RSPC systems, reading from and writing to NVRAM requires that the address be gated into a register pair and the data accessed from a data register one byte at a time.

The NVRAM is divided into three major areas:

- Global Environment Area (GEArea)
- Operating System Specific Data (OSArea)
- Configuration Data for Non-Native ISA Devices Area

Additionally, the NVRAM contains a header that describes the location and length of the three main sections.

The NVRAM space is shared and dynamically adjustable; thus it allows for larger NVRAM parts to be used without bumping the version number. Furthermore, functions that add information where there is no room can attempt to readjust the balance and move the data as necessary.

![Figure 28. NVRAM Layout](image)

**Global Environment Area (GEArea):** The GEArea contains definitions of global environment variables which can be updated and used by the different operating systems.

Global variables are used mainly by the RSPC firmware for cached data or by operating systems to communicate with the RSPC firmware.

Currently, there are seven global variables:

**ClientIPADDR**  IP address of the machine
ServerIPADDR  IP address of the boot server
GatewayIPADDR  IP address of the gateway
NetMask  Network mask
boot-file  Name of the file to be loaded by the RSPC firmware
boot-device  Selected boot device
boot-path  Ordered list of the boot devices that the RSPC firmware searches during boot

**Operating System Specific Data Area (OSArea):** The OSArea is allocated for operating system-specific data. The data in this area is preserved between boots of the same operating system only. If a different operating system is booted, it may overwrite the information in the OSArea.

**Configuration Data for Non-Native ISA Devices Area:** This area stores configuration data for ISA devices which are not integrated on the system board. Data in this area is stored and used by operating systems to configure Plug and Play devices. The data must be represented in the format of the compressed Plug and Play configuration packet. The RSPC firmware passes this configuration data to the operating system upon boot by using residual data.

This area is located at the tail of the NVRAM and grows toward lower addresses.

### 3.2.3.1 NVRAM Utilization on RISC System/6000 vs RSPC

The challenge for AIX on RSPC systems is to fit the NVRAM information requiring more than 32 KB on a “classical” RISC System/6000 into the 4 KB space available on the RSPC systems.

Outlined below are the primary areas of NVRAM utilization for the RISC System/6000. For each of the areas described, the handling of that area for RSPC systems is described:

- LED access and LED string output
  The RSPC platform has no LED and no mechanism to display LED information during normal run-time. Therefore, the LED information is discarded.

- IPL device list for normal and service modes
  The IPL device list is not used to control boot order on some RSPC systems (for example, on the 40P). The RSPC firmware maintains its own boot order and provides user interface facilities (*System Management Services*) for controlling that boot order.

#### bootlist Command on RSPC Systems

Currently, the `bootlist` command in AIX Version 4.1.3 does not interface with the NVRAM copy of the boot order list maintained by the RSPC firmware on the RISC System/6000 Model 40P; thus the `bootlist` command cannot be used to modify the boot devices order list on the 40P.

The `bootlist` command works on the RISC System/6000 Model 43P.

- Last device IPL done from
This information is maintained in the NVRAM on RSPC systems. Software ROS takes care of presenting this data to AIX via the IPL control block.

- **Dump status data**
  This information is mapped to the RSPC NVRAM location.

- **Network Boot Support**
  Network boot (for installation purposes) for RSPC systems is handled by the RSPC firmware. The RISC System/6000 NVRAM mapping for Network Install Boot support is not required. However, a read-only copy is made available through the NVRAM by mapping the RSPC NVRAM environment information to the RISC System/6000 NVRAM representation.

- **Error log entry**
  The last error log entry is written to NVRAM by the error log device driver.

- **Remaining area of NVRAM utilization by RISC System/6000**
  All remaining areas of NVRAM utilization used by the RISC System/6000 are disabled. RSPC systems do not contain an OCS (On-Chip Sequencer) and the diagnostics strategy does not require RISC System/6000 NVRAM mapping.

### 3.2.4 Hardfile Layout for RSPC Systems

Figure 29 shows the hardfile layout on a “classical” RISC System/6000. The disk is dedicated to the operating system. Block 0 of the disk is expected to contain the boot record. The Logical Volume Manager (LVM) supports volume groups made up of multiple hardfiles.

![Hardfile Layout](image)

**Figure 29. Hardfile Layout on a “Classical” RISC System/6000**

The hardfile layout on RSPC systems is designed to allow transportable media between various processor types (for example, Intel and PowerPC 60x); the hardfile layout is similar as now found on a system running DOS or OS/2. It implements the concept of disk partitions as specified in the PowerPC Reference Platform Specification. Following this architecture, the AIX disk image would reside in one of those partitions, as shown in Figure 30 on page 65.
Figure 30. Hardfile Layout on RSPC Systems

Other partitions could hold other operating systems or a second instance of AIX.

The problem with this implementation is that both the Master Boot Record and the AIX Boot Record are required to start on disk block zero. To satisfy this requirement, the boot record on RSPC systems is a combination of both an AIX boot record and a Master Boot Record as shown in Figure 31.

Figure 31. AIX Hardfile Layout on RSPC Systems

Important

Partitioned disks are not supported in the current release of AIX Version 4. Currently, AIX requires all disks used by AIX to be dedicated disks.

3.2.4.1 Boot Record Structure on RSPC Systems

The boot record is the first sector on the boot device. The desire to remain compatible with PC-style media has resulted in a boot record format consistent with the existing PC structure. As shown in Figure 32 on page 66. The PC-style boot record contains 446 bytes of program code, a four-entry partition table totaling 64 bytes and two signature bytes.
Figure 32. Boot Record Structure on RSPC Systems

When an RSPC system is rebooted, the RSPC firmware reads one or more records from the target device until at least 512 bytes have been loaded. The partition tables start at address 1BE, 1CE, 1DE and 1EE, respectively, and each of them occupies sixteen bytes. Figure 32 also shows the layout of one of the partition table entries. The meaning of the various components of the partition entry is as follows:

**Boot ind. (Boot Indicator)** This byte shows whether the partition is active or not. If the byte contains 0x80, then the partition is not active and will not be considered as bootable. If the byte contains 0x00, then the partition is considered active.

**Sys int. (System Indicator)** An RSPC boot record is identified by the 0x41 value in this field.

**0xff** The fields filled with 0xff are ignored by the RSPC firmware.

**Partition Entry Offset** This is the zero-based relative block address of the first sector of the partition. This 32-bit value is coded in Little Endian format (lowest significant byte first).

**Length of partition in sectors** The number of sectors allocated to the partition. This 32-bit value is coded in Little Endian format. This value reflects the number of sectors that must be read to load Software ROS and pass control to Software ROS. When Software ROS is executing, it is able to determine the size and location of the AIX boot image, which is stored in another location on the disk.
Figure 33 on page 67 is an extract of an RSPC hardfile’s first sector. It shows the boot record on RSPC systems and how the AIX and Master Boot Record requirements are satisfied.

![Figure 33. Boot Record on RSPC Systems](image)

When the system boots, the boot record is checked to find offsets to the boot partition. When AIX is executing, it expects to find a valid AIX boot header on the disk. To allow both of these functions to be performed, the boot record on RSPC systems is a combination of both an AIX boot record and a Master Boot Record.

The PC-style partition table occupies the space from offset 1BE to 1FD of block zero of the disk. The last two bytes in the sector (1FE and 1FF) contain the signature (Masters Magic) number, indicating that this is a RSPC-style disk. AIX identifies the disk as an AIX disk by reading the first four bytes, which contain the AIX Magic Number (0xc9c2d4c1 or "IBMA" in EBCDIC representation).

The structure of the AIX Boot Record is described in the `/usr/include/sys/bootrecord.h` header file.

### 3.3 RSPC Systems Boot Image

The boot image on RSPC systems is different than the one on “classical” RISC System/6000 systems. Additional boot process components (see 3.2, “Boot Components Specifically for AIX on RSPC Systems” on page 59) required to satisfy the independence of the hardware platform from the operating system, as specified in the PowerPC Reference Platform Specification, have to be accommodated; support of the “classical” AIX boot image is still needed.

The new component, Software ROS (see 3.2.2, “Software ROS for AIX” on page 60), which is included in the RSPC boot image, not only executes the complex initialization required by AIX, but it is also capable of extracting the AIX boot image from the RSPC boot image.

In this section, we will discuss the following aspects:
3.3.1 Structure of the RSPC Boot Image

The RSPC boot image is a combination of a PReP-compliant partition image and a standard AIX Version 4 boot image, as shown in Figure 34.

When the system is booted, the RSPC firmware loads the first sector containing the Master Partition Header, which includes the AIX boot record and the partition table. The Partition Entry Offset and the Length of Partition In Sectors, extracted from the first partition entry in the table (see Figure 32 on page 66), indicates where to find the next partition to be loaded and the size of the partition, respectively. This partition contains the Software ROS code.

After Software ROS takes control and performs the appropriate initialization, it locates the AIX Version 4 boot image and loads it at address zero as required by AIX.

Figure 35 on page 69 shows the structure of the RSPC boot image. Areas Reserved 1 and Reserved 2 are reserved for padding purposes.
3.3.2 RSPC Boot Image Creation

To support boot image creation for RSPC systems, several commands involved within the boot support process were changed in AIX Version 4. The changes were limited to a minimum, and the main idea is to still use the bosboot command to generate a boot image. Some options have been changed in bosboot to support the new platforms (SMP and RSPC systems). In fact, most of the changes are hidden to the user. The command bosboot -a will create a boot image for the platform type of the system running the command.

Cross Boot Image

Creation of boot images for a different target platform is possible on servers which have installed the required base proto and proto extension files and the predefined database for the target platform.

When using the Network Installation Manager (NIM), all the devices’ software packages are installed, and NIM handles different boot images according to the target platform type.

Figure 36 on page 70 shows the components and commands involved within the process of creating the AIX Version 4 boot image.
When the \texttt{bosboot} command is started, it creates a RAM file system and calls the \texttt{mkboot} command to create the boot image as normal for an AIX system. Upon detection of a RSPC systems, the \texttt{bosboot} command calls the \texttt{mkmboot} routine to encapsulate the AIX Version 4 boot image into the RSPC boot image.

### 3.3.3 Modifications to the Boot Commands

To support RSPC systems, the following commands and utilities have been modified or added to AIX Version 4:

- \texttt{bootinfo}
- \texttt{bootlist}
- \texttt{bosboot}
- \texttt{mkboot}
- \texttt{mkmboot}
3.3.3.1 bootinfo
The bootinfo command uses the device configuration databases in information searches. For more information, the bootinfo command uses the values stored in the NVRAM.

bootinfo has been extended to allow for rspc as a recognized system type. The -T option displays the platform type of the running machine. Currently, the following platform types are supported:

- rs6k: “classical” RISC System/6000
- rs6ksmp: Symmetric Multiprocessor RISC System/6000
- rspc: PCI-based RISC System/6000

3.3.3.2 bootlist
The bootlist command is useless on the RISC System/6000 Model 40P. The bootlist command updates the Boot Device Order List in the NVRAM on the classical RISC System/6000, RISC System/6000 SMP systems and on the RISC System/6000 Model 43P.

On the 40P, the Boot Device Order List is directly managed by the RSPC firmware and does not provide an interface for the bootlist command.

Changing the Boot Device Order List
To modify the Boot Device Order List on the 40P, you have to reboot the system and use the System Management Service diskette.

3.3.3.3 bosboot
The bosboot command has been extended to allow for detection and specification of the different RISC System/6000 platform types and to construct boot images specific for these platforms. For this purpose, the new option -T has been added. If the -T is not specified, the default is to create a boot image for the platform type of the system running the bosboot command. The -T option can be used when you want to create a boot image and store it in a file, not in a boot logical volume.

The type of boot devices supported differ according to the platform type. On RSPC systems, booting from tape devices is not supported (see 3.4, “Supported Boot Devices on RSPC Systems” on page 72).

3.3.3.4 mkboot
The mkboot command is called by bosboot. This command actually creates the AIX Version 4 boot image and the boot record. To support the PC-style partition table, which is defined in the PowerPC Reference Platform Specification, mkboot -c has been modified. This option is used to clean up the boot record that resides in sector zro on the boot disk. It zeroes out the 512 byte block, except for the AIX boot signature and VID. On RSPC systems, the last 66 bytes are used as PC-style partition table and signature. These need to be left untouched when the mkboot -c clears the boot record.

For RSPC systems, mkboot calls the mkmboot to encapsulate the AIX image into a RSPC boot image, which is finally written to disk.
3.3.3.5 mkmboot
To support the hardfile layout on RSPC systems, a new command, mkmboot, has been added to AIX Version 4. As explained in 3.3.1, “Structure of the RSPC Boot Image” on page 68, the standard AIX Version 4 boot image has to be incorporated in the RSPC boot image before being written to the disk. This is done by the mkmboot command. The mkmboot command provides the following services:

- Concatenates the AIX boot image to Software ROS
- Updates the header in Software ROS with the AIX boot image offset
- Updates the base customize database offset in the same header
- Stores the RSPC boot image to disk
- Updates the Master Boot Record (first sector on disk)

3.3.3.6 rc.boot
The rc.boot script file is the main script during the AIX booting process. This script has been modified to use platform neutral commands, which allow for the use of the different platform types. In AIX Version 3, during network install boot, rc.boot configured the network by running platform-specific configuration methods, such as defsys and cfgsys. In AIX Version 4, these commands are replaced with platform neutral commands (such as cfgmgr).

3.4 Supported Boot Devices on RSPC Systems

In AIX Version 4, support for boot images of different boot devices on different platforms is provided. However, the list of supported boot devices is not the same among the different platform types.

The following boot devices are supported on RSPC systems:

- Hard disk
  The boot sequence for AIX on RSPC systems is identical to the boot sequence on other platforms, except for the changes to the boot image.
- CD-ROM
  A separate boot image with support for install from the CD-ROM is added to the CD-ROM for RSPC systems.

Network Install Boot

On RSPC systems, AIX network boot is supported for installation purposes only (when a NIM master has been configured). RSPC systems cannot boot from the network as diskless or dataless clients. RSPC systems are designed as stand-alone workstations.

Booting from tape devices is not supported on RSPC systems. In order to install a system backup on this type of machine, you have to boot from a CD-ROM device and access the installation menu first, before selecting the tape drive as the installation device.
3.4.1 Supported External Boot Devices

On RSPC systems, booting AIX from external hard disk and CD-ROM drive SCSI devices is possible. However, not all SCSI devices are supported, and there is no list of the supported device types and models.

We found that while booting from external IBM SCSI disks worked fine, booting from certain CD-ROM drive types was not possible. Figure 37 shows two different types of the same SCSI CD-ROM drive IBM 7210 Model 001. While booting from the type B drive was successful, the type A drive could not be configured. The type B drive is the one with the eject button below the CD cartridge.

![Type A Drive Bezel](image1)

Type A Drive Bezel

![Type B Drive Bezel](image2)

Type B Drive Bezel

*Figure 37. IBM 7210 Model 001 CD-ROM Drive Types*

Booting from the CD-ROM drive IBM 7210 Model 005 is possible.

**Important**

Avoid any SCSI ID conflicts when attaching external SCSI devices to RSPC systems. By default, the internal CD-ROM drive has the SCSI ID 3, and the internal hard disk has the SCSI ID 6, while the ID of the SCSI controller is 7.

To boot from an external SCSI device, you will have to change the boot device order list using the System Management Services diskette as described in 3.4.2, “Selecting Boot Devices.”

3.4.2 Selecting Boot Devices

The default boot order list sequence on RSPC systems is as follows:

1. Diskette drive (not supported in AIX Version 4)
2. Internal CD-ROM drive
3. Internal hard disk
4. Network adapter
The first boot device in the order list is the diskette drive; however, booting from diskette is not supported in AIX Version 4.

If you want to change the sequence of this boot order list or if you want to specify a boot device (internal or external) where the system should boot from, you have to use the System Management Services diskette.

---

**Note**

The boot order list cannot be changed with the `bootlist` AIX command on the 40P. When used on the 40P, this command will not return either a system message or an error message.

---

To select the boot devices using the System Management Services diskette, you will have to perform the following steps:

1. Either reboot or power-on the system.
2. When the PowerPC logo appears on the screen, press the F4 key (you have to press F4 before the last icon is displayed).
3. If the System Management Services diskette is in the diskette drive, the System Management Services menu will be displayed. If the System Management Services diskette is not in the diskette drive, a message asking for the diskette will be displayed. Insert the diskette and press Enter.

4. When the System Management Services menu appears, use the arrow keys to move the cursor to **Select Boot Devices** and press Enter. The Boot Sequence Selection submenu will appear.
In this submenu, you may display the current boot device order list, restore the default settings, configure individual boot devices, or specify a device to boot from. For example, if you want to boot from an external attached SCSI device, you may configure this device as the 3rd boot device, assuming that the first and second devices do not contain valid boot records.


This submenu contains the internal and external devices attached to the SCSI bus which could be configured by the RSPC firmware and also the diskette drive and network devices, if any.

In this example, we have an external SCSI disk with the SCSI ID 4, which is attached to the SCSI bus.

6. If we select the external disk with the SCSI ID 4, it will be configured as the third boot device in the order list.
7. Press the ESC key to return the System Management Services menu.

8. Press F9 to restart the operating system.

The RSPC firmware will first look for a valid boot record on the first boot device (for example, diskette drive), then on the second boot device (for example, CD-ROM); and if not found, it will finally look for a valid boot record on the external disk with SCSI ID 4 configured as the third boot device.

You may also select option 7, **Boot Other Device** in step 5, to boot from the external disk without changing the current boot device order list.
Chapter 4. AIX Version 4 Network Installation

Both a token-ring and an Ethernet adapter can be used to install AIX Version 4 on RSPC systems over a Local Area Network (LAN). On AIX Version 4, this is supported by the Network Install Management (NIM) software.

Network Booting

Booting over a LAN adapter is possible; however, it is supported for installation purposes only. RSPC systems cannot be configured as diskless or dataless clients.

The task of installing AIX Version 4 on RSPC systems over the network is divided into the following parts:

1. Preparing the Network Environment
2. NIM Master Configuration
3. Client RSPC Configuration
4. Performing the Installation

NIM Documentation

Before starting an AIX Version 4 network installation for the first time, make sure you have the AIX Version 4.1 Network Installation Management Guide and Reference manual available. This manual will provide you with more information about the AIX Version 4 NIM environment.

In this chapter, we will use a NIM environment to install AIX Version 4 on an RSPC client. The network topology used in this example is shown in Figure 41.

4.1 Preparing the Network Environment

The NIM environment utilizes TCP/IP and NFS for communication and file transfer; thus, before starting the NIM configuration, the TCP/IP and NFS environments have to be configured and tested. This configuration involves:

1. Drawing a picture of the network topology

We strongly suggest that you make a drawing of your network environment. This will avoid confusion, especially regarding the gateways.
2. Choosing the NIM Master

Refer to the manual *AIX Version 4.1 Network Installation Management Guide and Reference* for information about the factors you should consider when selecting a NIM Master.

3. Configuring and testing TCP/IP on the NIM Master and gateways

Be aware that, in AIX Version 4, the default value of the network option `ipforwarding` is 0 (disabled). On gateway machines, you will have to change this value to 1 (enabled). Use the following command:

```
no -a ipforwarding=1
```

4. Configuring NFS on the NIM Master

5. Collecting IP Addresses and IP Names of NIM Master, gateways and NIM Clients

During the NIM configuration, you will be prompted for information regarding all of the network entities concerning the NIM installation. These include IP addresses and names of the gateways, the NIM Master and NIM Clients.

6. Collecting hardware addresses and interface types of NIM Clients

You will also need the hardware address and interface type of the network adapter used at the NIM Client site.

### 4.2 NIM Master Configuration

The procedure of configuring the NIM Master consists of the following steps:

1. Installing the NIM Master filesets
2. Filesystems creation
3. NIM Master activation
4. NIM network objects definition
5. NIM Client machines definition
6. Resource objects definition
7. Resource allocation to machine objects
8. Initiating the BOS installation

#### 4.2.1 Installing the NIM Master Filesets

The following filesets are needed and must be installed in the NIM Master system:

- `bos.sysmgt.nim.master`
- `bos.sysmgt.nim.client`
- `bos.sysmgt.nim.spot`
- `bos.net.nfs.server`

When the `bos.sysmgt.nim.server` fileset is installed, the client fileset is installed automatically. Additionally, you will need to install `bos.sysmgt.nim.spot` and `bos.net.nfs.server`. 
4.2.2 Filesystems Creation

We suggest that you create three filesystems to store the data handled by NIM in order to avoid enlarging the / and /usr filesystems. By default, NIM will automatically expand the needed filesystems; thus, you may chose to create the filesystems with a minimum size of 4 MB (8192 512-byte blocks), and let NIM increase the filesystems’ sizes as required. The filesystems to be created are:

- /export
- /inst.images
- /tftpboot

**The /export Filesystem:** The /export directory is the standard location for resources that are NFS-exported for use by the Client. Most of the resources used by NIM Clients (for example, SPOT, dump, root, and paging) are normally located in the /export directory on the server machine.

RSPC systems cannot be used as diskless or dataless clients; thus, the /export filesystem will be used only during the network installation and can be removed later, if no longer needed.

When AIX Version 4.1.3 is used and the filesystem is not using the compression algorithm, the /export filesystem will take approximately 225 MB of disk space.

**Important**

When the NIM Master is activated, the nim_script resource, represented by the /export/nim/scripts directory, is created. If the /export filesystem is created after the installation of the NIM Master, this resource is hidden by the mounted /export filesystem. For this reason, you should create and mount the /export filesystem before you activate the NIM Master.

**The /inst.images Filesystem:** The /inst.images filesystem contains the software packages (filesets) that are used in software installation operations. You will specify the mount point of this filesystem when defining the /pp_source object.

When AIX Version 4.1.3 is used and the filesystem is not using the compression algorithm, the /inst.images filesystem will take approximately 295 MB of disk space to store the filesets used in this example (see “Defining the lpp_source Resource Object” on page 86).

**The /tftpboot Filesystem:** The /tftpboot filesystem contains the network boot images.

When AIX Version 4.1.3 is used and the filesystem is not using the compression algorithm, the /tftpboot filesystem will take approximately 25 MB of disk space.

4.2.3 NIM Master Activation

Prior to NIM Master activation, do not forget to mount the previously created filesystems.

To activate the Master, you will need to supply the following information:
Network Object Name

Specifies the unique identifier you wish to name the object that NIM creates to represent the network to which the Master’s primary interface connects. Once this network object has been created, the name you specify identifies the network in all subsequent NIM operations.

You can use any name you like, and you should choose a name which is meaningful to you.

Primary Network Install Interface

The name of the network interface that the Master will use as its primary interface (either trX or enX).

Port Number

Specifies the port number for NIM network communications between the NIM Master and its clients. For example, the port number might be 1058. Select a port number that is not being used. Check the /etc/services file for potential conflicts before selecting a port number.

Ring Speed (Token-Ring)

Specifies the ring speed of the network to which the NIM Master’s primary network interface is connected, either 4 MB or 16 MB.

Cable Type (Ethernet)

The type of Ethernet cable used. Possible values are bnc or dix.

You can use the SMIT interface or the command line to activate the NIM Master. For example:

```
smitty nimconfig
```

The following screen will appear:
Configure Network Installation Management Master Fileset

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[Entry Fields]
* Network Object Name [intinim]
* Primary Network Install Interface [tr0] +
* Port Number for Network Install Communications [1058] #
Ring Speed [4] +
Cable Type

F1=Help    F2=Refresh    F3=Cancel    F4=List
F5=Reset   F6=Command    F7=Edit      F8=Image
F9=Shell   F10=Exit      Enter=Do

Figure 42. NIM Master Configure Menu

After successful activation, the system will display the following screen:

COMMAND STATUS
Command: OK     stdout: yes     stderr: no

Before command completion, additional instructions may appear below.
0513-071 The nimesis Subsystem has been added.
0513-071 The nimd Subsystem has been added.
0513-059 The nimesis Subsystem has been started. Subsystem PID is 24512.

F1=Help    F2=Refresh    F3=Cancel    F6=Command
F8=Image   F9=Shell      F10=Exit    /=Find
n=Find Next

Figure 43. NIM Master Successful Activation

Refer to the AIX Version 4.1 Network Installation Management Guide and Reference manual for information about details on what happens when the NIM Master is activated.
4.2.4 NIM Network Objects Definition

In the previous step, when you activated the NIM Master, a network object was defined representing the network to which the NIM Master’s primary interface is connected. When this network is the only physical network you have, or the master and the clients are attached to the same network, you do not have to define any additional network objects. If, however, the NIM Master and the NIM Clients are not attached to the same physical network, you must define additional network objects.

Consider the network topology presented in Figure 44. To know whether or not a gateway must be defined to the NIM environment, take the route that is used to communicate between the NIM Server and the NIM Client. If, on this particular route, the gateway is immediately connected to the network containing either the NIM Master or NIM Client, then this gateway must be defined to the NIM environment.

![Network Topology](image)

*Figure 44. Network Topology. Not All Network Objects Need to be Defined.*

In our network topology example shown in Figure 41 on page 77, the NIM Master and the NIM Client are in different physical networks. They use a gateway to communicate. Both the second network and the gateway must be defined to the NIM environment.

To perform the definition of the second network, use the following command:

```
smitty nim_mknet
```

After the SMIT screen appears, enter the required information.
Define a Network Object

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

* Network Object Name [ItscNIM]
* Network Object Type tok
* Network IP Address [9.3.1.0]
* Subnetmask [255.255.255.0]

Figure 45. Defining the Second Network

To check to see if you need any other network object definition, you may enter the command:

`lsnim -l ItscNIM`

ItscNIM:
- class = networks
- type = tok
- net_addr = 9.3.1.0
- smm = 255.255.255.0
- missing = route to the NIM master
- Nstate = information is missing from this object's definition
- prev_state =

Look for any missing entry. In our example, the definition of the route to the second network is missing. We will add the definition using the command:

`smitty nim_mkroute`

Select the Originating and Destination Network Object Names; in our example, the first and the second networks, respectively.
4.2.5 NIM Client Machines Definition

RSPC Systems can be installed over the network as stand-alone machines only. They cannot run as diskless or dataless systems.

Before starting with the NIM Client’s definition, ensure that the physical connection to the NIM Client is operational. You must test the NIM Master/Client communication on the RSPC client by using the ping utility provided with the System Management Services diskette. This is option 11 in the System Management Utilities menu. You will also have to use the System Management Services diskette to look up the network adapter hardware address (option: Adapter Parameters).

The Client’s IP Address and IP Name must be contained in the name server database or in the NIM Master’s /etc/hosts file.

RSPC systems do not need the IPL ROM Emulation Device.

Start the NIM Client’s definition with the following command:

   smitty nim_mkmac

The following screen will appear:
The platform type to be chosen is **rspc**. After this selection, only one machine object type is displayed: **., stand-alone**. Press Enter.

In our example, the following screen appears:

The network to be selected here is the network to which the NIM Client’s primary interface connects; in our case, we must select **ItscNIM**. The following SMIT screen will be displayed. The information used in our example is shown in bold type.
Define a Machine Object

Type or select values in entry fields. or select values in entry fields. Press Enter AFTER making all desired changes.

[Entry Fields]

* Machine Object Name [rspcNIM]
Hardware Platform Type rscp
Machine Object Type stand-alone
Primary Network Install Interface
  Network Object Name ItscNIM
* Host Name [rspl]
* Network Adapter Hardware Address [08005ac231b9]
  Network Adaptor Logical Device Name []
* Ring Speed [16] #
IPL ROM Emulation Device []
CPU Id [] #
Comments []

F1=Help F2=Refresh F3=Cancel F4=List
F5=Reset F6=Command F7=Edit F8=Image
F9=Shell F10=Exit Enter=Do

Figure 47. Machine Object Definition Menu

Check the object entry with the following command:

lsnim -1 MachineObjectName

4.2.6 Resource Objects Definition

The following resources are required for a stand-alone installation:

- lpp_source
- spot

Defining the lpp_source Resource Object

When defining the lpp_source object, we will use the /inst.images created previously (see 4.2.2, “Filesystems Creation” on page 79).

The /inst.images directory will contain the software packages which may be copied from tape or CD-ROM. This filesystem can also be made available from another server, using NFS.

The following set of packages is referred to as support images, and these are required for the NIM operation. The packages’ names should be specified in the Names of Option Packages field.

- bos
- bos.rte.up
- bos.rte.mp
- bos.diag
- bos.net
- bos.sysmgt
To define the `lpp_source` resource object, proceed as follows:

1. Ensure the `/inst.images` filesystem is mounted.
2. Enter the following fast path command:
   
   ```bash
   smitty nim_mkres
   ```
3. Select the `lpp_source` as the resource type.
4. Enter the resource-specific information as required.
This will copy the required files from device rmt0 to the filesystem mounted on /inst.images. The NIM operation will automatically expand the /inst.images filesystem as required.

**Defining the Shared Product Object Tree (SPOT) Resource Object**

The SPOT resource is required for bos_inst operations for stand-alone machine configurations. This resource type represents a SPOT, which is a directory containing the BOS run-time files and optional packages required for most NIM operations.

The machine serving the SPOT resource must have the bos.sysmgt.nim.spot fileset installed.

To define the SPOT resource object, proceed as follows:

1. Ensure the /export filesystem is mounted.
2. Create the /export/exec directory.
3. Enter the following fast path command:
   ```sh
   smitty nim_mkres
   ```
4. Select the spot resource object type.
5. Enter the resource-specific information as required.
Installing Additional Software into the SPOT Resource

There are some prerequisite filesets which are needed by some of the packages we have installed in the lpp_source resource object and we didn’t install yet. The reason for this decision is that these filesets are contained in large software packages, and we didn’t want to use more disk space than necessary on the NIM Master.

The required filesets are:

- X11.fnt.coreX
- X11.fnt.iso1
- X11.fnt.defaultFonts
- X11.loc_en_US.Dt.rte
- X11.loc_en_US.base.lib
- X11.loc_en_US.base.rte
- bos.txt.spell
- bos.txt.tfs

The packages containing these filesets, X11.fnt, X11.loc and bos.txt, require 21 MB, 22 MB and 11 MB of additional disk space.

In order to have a SPOT with all the software we want to have on the RSPC client (including the CDE package), we need to install the filesets listed above. This can be done with the cust operation on the SPOT resource. This operation can be performed using the following SMIT fastpath:

```
smitty nim_res_op
```
Then select the SPOT resource object (spotNIM in our case), and finally the cust operation. Enter the fileset names listed above.

If the operation was successful, you will be able to install the X11.Dt (Common Desktop Environment) filesets into the SPOT. To do this, you will have to run a new cust operation on the SPOT, but this time you will select lpp_source as the “Source of Install Images” and enter X11.Dt in the “Fileset Names” field.

4.2.7 Allocating Resources for the Stand-Alone Installation

Before initiating the NIM Client installation, you have to allocate the resources for the specific client. Once resources have been defined and allocated to an RSPC client, you an use NIM to start the bos_inst operation for the RSPC client. At least, you have to allocate a SPOT resource and an lpp_source resource.

To allocate resources to the NIM Client, proceed as follows:

1. Enter the following fast path command:
   ```sh
   smitty nim_alloc
   ```

2. Select your RSPC client from the list of defined machines (in our case, rspcNIM).

3. When the list of available resources for the client is displayed, select one or more of the resources by using the F7 key (in our example, spotNIM and imagesNIM).
4.2.8 Initiating the BOS Installation

The network installation for an RSPC system cannot be initiated from the NIM Master. This means, to perform network installation, manual intervention is required on the RSPC system that will be installed. However, the NIM operation requires a set of variables which are set when the NIM installation procedure is started on the NIM Master.

Perform the following steps on the NIM Master to initiate the NIM operation:

1. Enter the following fast path command:
   
   smit nim_mac_op

2. Select the object name of the RSPC machine (rspcNIM).

3. Select bos_inst from the list of operations.

4. Select the source where the BOS run-time files will come from. These files are used to populate the target’s /usr filesystem.

In this NIM environment, we have two sources to chose from:

- **rte**
  
  This value is used for the lpp_source NIM resource. This image contains only the BOS run-time files; it does not contain any optional software packages. Using this, the installed target may have more free disk space than if the SPOT source is used.

- **spot**
  
  Choosing this value will copy all the files that exist in the SPOT. A SPOT has many optional products already installed into it, thus it may need a too large disk space on the target system.

Once the NIM operation is initiated, the Master will try to contact the NIM Client. After time out, the following warning will appear:
NIM Warning!

warning : 0042-134 m_bos_inst : unable to initiate network boot on "MachineObjectName"

The warning means NIM was unable to force the target to load the network boot image. Loading the network boot image must be initiated from the RSPC client as described in the next section.

4.2.9 Client RSPC Configuration

The configuration of the RSPC client involves the configuration of a Subnet Mask and the IP Addresses for:

- Client machine
- Server machine
- Gateway machine

To configure the RSPC client, perform the following steps:

1. Insert the System Management Services diskette into the drive.
2. Power-on the system unit.
3. When the logo screen appears, press the F4 key.

   **Note:** You must press the F4 key before the last icon is displayed at the bottom of the screen.

4. Select the **Utilities** option from the System Management Services menu. Use the Down Arrow key to highlight the option, and then press the Enter key.
5. Select the **Remote Initial Program Load Setup** option from the System Management Utilities menu.

6. Select the **Adapter Parameters** option from the Network Parameters submenu. Select the corresponding LAN adapter (IBM LAN Adapter for Ethernet or IBM Token-Ring Adapter). Select the **View Parameters** option and the **Hardware Address** option. Check to see if the hardware address is correct. Use the Esc key to return to the Network Parameters submenu.
7. Select the **IP Parameters** option from the Network Parameters submenu, and enter the Client IP Address, Server IP Address, Gateway IP Address, and Subnet Mask. Press Enter to save the network addresses.

8. Use the Esc key to return to the Network Parameters submenu.

9. Check the physical connection and the TCP/IP communication with the *ping* function provided in System Management Utilities.
If you don’t use a gateway between both systems, the Gateway IP address should be the same as the Server IP address.

10. If the ping operation was successful, use the Esc key to return to the Network Parameters submenu.

11. Use the Esc key again to return to the System Management Services menu. Select the **Select Boot Devices** option from the menu.

12. Select the **Boot Other Device** option and then the corresponding **Network Adapter** option. Press Enter for the system to initiate a BOOTP request to the NIM Server.
Figure 56. Boot Device Selection Sub Menu

After two minutes (it seems longer), the bottom of the screen will become white. Two minutes later, the screen will become black, and a green cursor will appear on the upper left corner. Finally, the installation selection screen will appear, and you will be able to use the normal AIX installation procedures to install the software.

4.2.10 Post Installation Operations

After the RSPC client is initially installed, you may want to use NIM to install additional software on the client. This is possible, but it must only be done by using the `lpp_source` resource object. You cannot use the SPOT for this purpose. This means that only software packages can be installed and no individual filesets.

The software packages you want to install must have been previously installed in lpp_source. To install additional packages to the lpp_source resource object, you can use the `bffcreate` command, and specify the lpp_source directory (in our example, `/inst.images`) as the "DIRECTORY for storing software packages).

You should run a `check` resource operation on the lpp_source resource after installing the additional software. For this, you can use the SMIT fastpath:

```
smitty nim_res_op
```

Select the `lpp_source` resource and then the `check` operation.

To install additional software on the client, login as root on the client and perform the following steps:

1. Enter the following SMIT fastpath command to allocate the NIM resources:
   ```
   smitty nim_alloc
   ```

2. From the displayed list, select the `lpp_source` resource. After the resource has been allocated, exit SMIT.
3. Enter the following SMIT fastpath command on the client to perform the installation operation:
   smitty nim_install

4. Select the **cust** operation. A screen similar to the following will appear; enter the values:

   ![Perform a Network Install](image)

   **Note:** You will have to reallocate the NIM resource (steps 1 and 2) if the cust operation fails.

### 4.2.11 RSPC Systems Network Installation Limitations

The following limitations apply when using NIM to install RSPC clients:

- RSPC systems can only be installed as stand-alone machines, not as diskless or dataless workstations.
- The network installation procedure can only be started from the RSPC Client, not from the NIM Master.
- The /usr filesystem cannot be used as a SPOT for RSPC network installation unless all required software packages have been installed on the NIM Master.
- Currently, only LAN adapters (token-ring, Ethernet and FDDI) can be used for the NIM installation. NIM does not support the X.25 adapter.
Chapter 5. Device Configuration on RSPC Systems

RSPC systems include support for new buses, such as the Peripheral Component Interconnect and Industry Standard Adapter (PCI, ISA), as well as for new devices which are different than the ones that are supported on the “classical” RISC System/6000 systems.

While the AIX System Configuration architecture and methodology using the Object Data Manager (ODM) database and information provided by System ROS has been maintained, the configuration of devices which do not support automatic configuration, for example, non-native ISA devices, has to be performed in a different way than when configuring microchannel devices.

The methods that are used by the AIX operating system to manage devices include:

• Device Nodes
• Device Classes
• Device Configuration Database
• Device States

This chapter provides you with technical background on the enhancements made to the Device Configuration Database and includes step by step procedures on how to configure devices on RSPC systems. Please refer to the AIX Version 4.1 product documentation for more information on device management.

A list of devices currently supported by the RISC System/6000 Model 40P can be obtained from your IBM representative or by entering the following command on a VM screen:

TOOLCAT MKTTOOLS GET 40PDEVS PACKAGE

or

TOOLS SENDTO USDIST MKTTOOLS MKTTOOLS GET 40PDEVS PACKAGE

For your convenience, a list of the devices supported by June 1995 is included in Appendix A, “Devices Supported on the RISC System/6000 Model 40P” on page 257.

5.1 Device Configuration

RSPC systems support attachment of devices via the following buses:

• PCI
• ISA
• SCSI

Provided the device support software is installed, PCI and SCSI devices are configured automatically whenever the Configuration Manager program, `cfgmgr`, is run at system boot or run-time and when no conflict (for example, the same SCSI ID for two SCSI devices) is found.
Non-native ISA devices will have to be configured manually, and you may even need to change some of the device’s predefined or customized attribute values, especially when configuring two or more ISA devices of the same type, for example, two ISA token-ring adapters. This chapter includes procedures that can be followed to perform this task.

Before starting with the actual device configuration and in order to understand which attributes are relevant for a conflict-free configuration of devices on RSPC systems, we want to describe the different components of the Device Configuration Database used by AIX to configure devices.

5.2 Device Configuration Database

Device information is contained in a predefined database or a customized database that makes up the Device Configuration Database managed by the Object Data Manager (ODM).

The predefined database contains configuration data for all possible devices configurable to the system.

The customized database contains configuration data for all currently defined and configured devices in the system.

The device information stored in the Device Configuration Database allows the automatic configuration of microchannel devices on “classical” RISC System/6000 systems and PCI devices on RSPC systems whenever the Configuration Manager (cfgmgr) program is run at system boot and run time.

As for non-native ISA devices, the information data contained in the predefined part of the configuration database is not sufficient to perform automatic, conflict-free ISA device configuration. Thus, the user needs to manually customize some values to be used by the ISA device (for example, interrupt level, shared memory address, and so forth) when configuring the device for the first time. We will explain this in detail later in this chapter.

The Device Configuration Database that is currently used by the system is located in the directory that is specified by the ODMDIR environment variable, normally the /etc/objrepos directory.

<table>
<thead>
<tr>
<th>Device Information in the Device Configuration Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device information in the predefined database is stored when the corresponding software packages necessary to support the device are installed.</td>
</tr>
</tbody>
</table>

In AIX Version 3, all device software was installed when the operating system was installed. In AIX Version 4, only those software packages for devices that were detected at installation time are automatically installed. Exceptions are the software packages for ISA devices. They are systematically installed during system installation on RSPC systems.
5.2.1 Database Object Classes

Table 9 lists the Object Classes that actually make up the Device Configuration Database.

<table>
<thead>
<tr>
<th>Object Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PdDv</td>
<td>Predefined devices</td>
</tr>
<tr>
<td>PdAt</td>
<td>Predefined attributes for predefined devices</td>
</tr>
<tr>
<td>PdCn</td>
<td>Predefined connection/dependencies</td>
</tr>
<tr>
<td>CuDv</td>
<td>Customized devices</td>
</tr>
<tr>
<td>CuAt</td>
<td>Customized attributes for customized devices</td>
</tr>
<tr>
<td>CuDep</td>
<td>Customized dependencies</td>
</tr>
<tr>
<td>CuDvDr</td>
<td>Customized device driver resources</td>
</tr>
<tr>
<td>CuVPD</td>
<td>Customized vital product data (MCA)</td>
</tr>
<tr>
<td>Config_Rules</td>
<td>Configuration methods for cfgmgr</td>
</tr>
</tbody>
</table>

Although all Object Classes listed in the previous table contain device configuration data, the most likely to contain the information you need when performing problem analysis are the following:

- PdDv
- PdAt
- CuDv
- CuAt

Information about a device’s predefined and customized values can be displayed using `ls`-type high-level commands, such as, `lsdev` and `lsattr`. However, when configuring devices or performing problem analysis, you may need to directly access device information that is stored in the ODM database. For this reason, the next examples show you where to find device-specific information using the `odmget` command and how to interpret this information.

5.2.1.1 PdDv (Predefined Devices)

The following command can be used to list all devices in the Predefined Device Object Class. Each device is followed by a short description.

`lsdev -P -H`

You may also query the description for a specific device, for example, the ISA token-ring adapter, by entering the following command:

`lsdev -P -c adapter -s isa -t tokenring -H`

The system will display information similar to the following:

```
class    type     subclass description
adapter  tokenring isa IBM 16/4 PowerPC Token-Ring Adapter (isa)
```

However, if you need information about the predefined values for the device, you will have to use the `odmget` command. The following syntax can be used to display information on specific devices, for example, an ISA token-ring adapter:
odmget -q type=tokenring PdDv

PdDv:
  type = “tokenring”
  class = “adapter”
  subclass = “isa”
  prefix = “tok”
  devid = “”
  base = 1
  has_vpd = 1
  detectable = 1
  chgstatus = 0
  bus_ext = 0
  fru = 1
  led = 1866
  msgno = 30
  catalog = “devices_tok.cat”
  DvDr = “isa/itokdd”
  Define = “/usr/lib/methods/define_rspc”
  Configure = “/usr/lib/methods/cfgisatok”
  Change = “/usr/lib/methods/chgisatok”
  Unconfigure = “/usr/lib/methods/ucfgcommo”
  Undefine = “/usr/lib/methods/undefine”
  Start = “”
  Stop = “”
  inventory_only = 0
  uniquetype = “adapter/isa/tokenring”

Figure 57. Predefined Devices

Figure 57 shows predefined entries for the ISA token-ring adapter. Among others, the device configuration methods that are used with the adapter are listed.

5.2.1.2 PdAt (Predefined Attributes)
The following syntax can be used to display information on the predefined attribute values for a specified device, for example, an ISA token-ring adapter:

odmget -q uniquetype=adapter/isa/tokenring PdAt
Figure 58. Predefined Attributes

Figure 58 shows predefined attributes for ISA token-ring adapters. Besides other information, the default value and the valid values for each attribute are listed.

5.2.1.3 CuDv (Customized Devices)

The following command can be used to display a short description of all customized ISA adapters in the system:

```
lsdev -Cc adapter -s isa
```

```
sio0 Available 00-00 Standard I/O Planar
ent0 Available 00-1X IBM ISA Ethernet Adapter
tok0 Available 00-1X IBM 16/4 PowerPC Token-Ring Adapter (isa)
```

By using the logical name displayed with the previous command, the following can be used to display the ISA token-ring adapter’s customized device data:

```
odmget -q name=tok0 CuDv
```
Figure 59. Customized Devices

Figure 59 shows customized data for the token-ring device with the logical name *tok0*. Status = 1 means that the device is available. The device driver is "isa/itokdd". The device is connected to "bus1" which is the ISA bus.

No Slot Information

The system cannot provide information on the slot number the adapter is installed on. This is represented by the X in the value location = "00-1X".

5.2.1.4 CuAt (Customized Attributes)

The list of attributes that are configured for a specific device, for example, *tok0*, can be displayed by issuing the following command:

```
lsattr -l tok0 -E
```

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Description</th>
<th>Customization</th>
</tr>
</thead>
<tbody>
<tr>
<td>intr_level</td>
<td>9</td>
<td>Bus interrupt level</td>
<td>True</td>
</tr>
<tr>
<td>intr_priority</td>
<td>3</td>
<td>Interrupt priority</td>
<td>False</td>
</tr>
<tr>
<td>bios_addr</td>
<td>0xdc000</td>
<td>Address of bus memory used for BIOS</td>
<td>True</td>
</tr>
<tr>
<td>xmt_que_size</td>
<td>96</td>
<td>TRANSMIT queue size</td>
<td>True</td>
</tr>
<tr>
<td>bus_io_addr</td>
<td>0xa20</td>
<td>Bus I/O address</td>
<td>True</td>
</tr>
<tr>
<td>shared_mem_addr</td>
<td>0xd0000</td>
<td>Bus memory address</td>
<td>True</td>
</tr>
<tr>
<td>shared_mem_leng</td>
<td>0x8000</td>
<td>Width of shared bus memory</td>
<td>True</td>
</tr>
<tr>
<td>ring_speed</td>
<td>16</td>
<td>RING speed</td>
<td>True</td>
</tr>
<tr>
<td>attn_mac</td>
<td>no</td>
<td>Receive ATTENTION MAC frame</td>
<td>True</td>
</tr>
<tr>
<td>beacon_mac</td>
<td>no</td>
<td>Receive BEACON MAC frame</td>
<td>True</td>
</tr>
<tr>
<td>use_alt_addr</td>
<td>no</td>
<td>Enable ALTERNATE TOKEN RING address</td>
<td>True</td>
</tr>
<tr>
<td>alt_addr</td>
<td>0x</td>
<td>ALTERNATE TOKEN RING address</td>
<td>True</td>
</tr>
</tbody>
</table>

Figure 60. Device Attributes

The value True or False indicates either the attribute can, or cannot, be customized. However, the information provided by the previous command includes data retrieved from the predefined and customized databases. To display only the entries in the customized database, you can enter the following command:

```
odmget -q name=tok0 CuAt
```
5.2.2 Enhancements to the Configuration Database

System configuration on RSPC systems follows the AIX configuration architecture. The configuration process is still *data driven*, but some minor changes were made to the System Configuration Database to describe the system differences for this platform.

The System Configuration Database was extended to include an additional *uniquetype* entry for RSPC systems and to hold its corresponding attributes. This can be displayed with the following command:

```
odmget -q uniquetype=sys/node/rspc PdDv
```

*Figure 61. Customized Attributes*
5.3 Preparing ISA Adapter Configuration

When configuring ISA adapters, you will have to configure some adapter hardware parameters. The values you assign to the parameters are used by AIX to communicate with the adapter; thus, it is important they are selected carefully in order to perform a conflict-free configuration.

For this reason, before configuring any ISA adapters, you should carefully plan and document the configuration. This topic includes procedures that will help you to document your current configuration and a table with suggested parameter values that allows conflict-free configuration of up to three ISA adapters.

The preparation of an ISA adapter configuration involves the following steps:

- Recording the settings of ISA adapters already configured
- Selecting the parameter values for ISA adapters

5.3.1 Recording Settings of ISA Adapters Already Configured

When configuring new ISA adapters, you will have to provide parameter values for these adapters. These parameter values should not already be in use by other adapters that may already exist in your system. For this reason, and to better perform problem analysis, you should record the parameter settings for any ISA adapter already installed in your system.
Having the previously installed adapter parameters documented allows better planning for the installation of additional ISA adapters and enables you to start with a set of conflict-free definitions. To obtain a list of ISA adapters already configured in your system, enter the following command:

```bash
lsdev -Cc adapter -s isa
```

The following procedures show you how to obtain the parameter settings of already installed ISA adapters. If AIX is up and running, you may first want to record the settings at AIX level for all your ISA adapters before shutting down and powering-off the system. If the system is powered off, you may first inspect the settings at hardware or firmware level by looking at the switches or by using the System Management Services diskette.

### 5.3.1.1 Recording ISA Ethernet Adapter Settings

1. On AIX, use the `lsattr` command to display a list of the attribute values that are set at AIX level. Enter the following command to display the values for the device `ent0`:

   ```bash
   lsattr -l ent0 -E -H
   ```

   ![Figure 63. Attributes for ISA Ethernet Adapters](image)

   **Note:** The value in the `user_settable` field indicates if the parameter can be customized (`True`) or not (`False`).

   Write down the values of: `bus_intr_lvl`, `bus_mem_addr`, `bus_io_addr` and `media_type`.

2. The IBM LAN Adapter for Ethernet (ISA bus) has no switches. Hardware parameters are set at firmware level using the System Management Services diskette. In order to obtain the parameter values, refer to the procedure that are explained in 5.4.4, "Testing ISA Adapter Configuration" on page 119.

### 5.3.1.2 Recording ISA Token-Ring Adapter Settings

1. Use the `lsattr` command to display a list of the attribute values that are set at AIX level. For example, for the `tok0` device, enter the following command:

   ```bash
   lsattr -l tok0 -E -H
   ```
attribute | value | description | user_settable
--- | --- | --- | ---
intr_level | 9 | Bus interrupt level | True
intr_priority | 3 | Interrupt priority | False
bios_addr | 0xdc000 | Address of bus memory used for BIOS | True
xmt_queue_size | 96 | TRANSMIT queue size | True
bus_io_addr | 0xa20 | Bus I/O address | True
shared_mem_addr | 0xd0000 | Bus memory address | True
shared_mem_length | 0x8000 | Width of shared bus memory | True
ring_speed | 16 | RING speed | True
attn_mac | no | Receive ATTENTION MAC frame | True
beacon_mac | no | Receive BEACON MAC frame | True
use_alt_addr | no | Enable ALTERNATE TOKEN RING address | True
alt_addr | 0x | ALTERNATE TOKEN RING address | True

Figure 64. Attributes for ISA Token-Ring Adapters

Note: The value in the user_settable field indicates whether the parameter can be customized (True) or not (False).

Write down the values of: intr_level, bios_addr, bus_io_addr, shared_mem_addr, shared_mem_length and ring_speed.

2. If your token-ring adapter has switches (the one officially supported on RISC System/6000 Model 40P), find out how the switches are set. Do so by either inspecting them physically and referring to Table 11 on page 116 and Table 12 on page 116 or by following the procedure that is explained in 5.4.4, “Testing ISA Adapter Configuration” on page 119.

If you are using the IBM Auto 16/4 Token-Ring ISA Adapter, which does not have switches, obtain the parameter values using the System Management Services diskette. Refer to the procedure explained in 5.4.4, “Testing ISA Adapter Configuration” on page 119.

5.3.1.3 Recording ISA X.25 Adapter Settings

1. Use the lsattr command to display a list of the attribute values set at AIX level. For example, for the ampx0 device, enter the following command:

   `lsattr -l ampx0 -E -H`

attribute | value | description | user_settable
--- | --- | --- | ---
bus_intr_lvl | 7 | Bus Interrupt Level | True
intr_priority | 2 | Interrupt Priority | False
bus_io_addr | 0x2a0 | Bus I/O address | True
bus_mem_addr | 0xe0000 | Bus memory address | True
window_size | 0x2000 | Bus memory window size | False

Figure 65. Attributes for X.25 Adapters

Note: The value in the user_settable field indicates if the parameter can be customized (True) or not (False).

Write down the values of: bus_intr_lvl, bus_io_addr and bus_mem_addr.

2. To find out how the switches of your IBM X.25 Co-Processor/1 adapter are set, you have to physically inspect them and refer to Table 14 on page 125 because the test procedure for X.25 adapters described in 5.4.4, “Testing ISA Adapter Configuration” on page 119 will only display the I/O Port address.

For this adapter, no parameters are set at the firmware level.
5.3.2 Selecting Parameter Values for ISA Adapters

Your system will work without problems only if there are no conflicts among the parameters for the different ISA adapters in the system. Figure 66 on page 110 and Figure 67 on page 111 provide you with suggested configuration parameters to successfully configure any combination of three ISA adapters for token-ring, Ethernet and X.25 communication on the RISC System/6000 Model 40P and RISC System/6000 Model 43P, respectively.
<table>
<thead>
<tr>
<th>Adapter to Install</th>
<th>Type</th>
<th>Already Installed IRQ</th>
<th>I/O Port Address</th>
<th>Shared Memory Address</th>
<th>Shared Memory Length</th>
<th>BIOS Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Adapter</td>
<td>TR</td>
<td>9</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xd0000</td>
</tr>
<tr>
<td></td>
<td>ET</td>
<td>11</td>
<td>0xa300</td>
<td>0xc8000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td></td>
<td>X25</td>
<td>11</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td>Second Adapter</td>
<td>TR</td>
<td>7</td>
<td>0xa24</td>
<td>0xc0000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td></td>
<td>ET</td>
<td>9</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td></td>
<td>X25</td>
<td>9</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td></td>
<td>TR</td>
<td>11</td>
<td>0xa300</td>
<td>0xc8000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td></td>
<td>ET</td>
<td>5</td>
<td>0xa240</td>
<td>0xc4000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td></td>
<td>X25</td>
<td>5</td>
<td>0xa300</td>
<td>0xc8000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td>Third Adapter</td>
<td>TR</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>ET</td>
<td>7</td>
<td>0xa24</td>
<td>0xc0000</td>
<td>0x8000</td>
<td>0xc0000</td>
</tr>
<tr>
<td></td>
<td>X25</td>
<td>7</td>
<td>0xa24</td>
<td>0xc0000</td>
<td>0x8000</td>
<td>0xc0000</td>
</tr>
<tr>
<td></td>
<td>ET</td>
<td>9</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xdc000</td>
</tr>
<tr>
<td></td>
<td>X25</td>
<td>7</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xc0000</td>
</tr>
</tbody>
</table>

Figure 66. Suggested Parameter Values for ISA Adapters on the 40P

Managing AIX V4 on PCI-Based RS/6000 Workstations
<table>
<thead>
<tr>
<th>Adapter to Install</th>
<th>Type</th>
<th>First Adapter</th>
<th>Second Adapter</th>
<th>IRQ for New Adapter</th>
<th>I/O Port Address</th>
<th>Shared Memory Address</th>
<th>Shared Memory Length</th>
<th>BIOS Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Adapter</td>
<td>TR</td>
<td>9</td>
<td>11</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xdc000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ET</td>
<td>11</td>
<td></td>
<td>0x300</td>
<td>0xc8000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>X25</td>
<td>11</td>
<td></td>
<td>0x2a0</td>
<td>0xe0000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Second Adapter</td>
<td>TR</td>
<td>11</td>
<td>7</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xdc000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ET</td>
<td>9</td>
<td>0x340</td>
<td>0xc4000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>X25</td>
<td>9</td>
<td>0x300</td>
<td>0x8000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Third Adapter</td>
<td>TR</td>
<td>11</td>
<td>7</td>
<td>0xa20</td>
<td>0xd0000</td>
<td>0x8000</td>
<td>0xdc000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ET</td>
<td>9</td>
<td>0x340</td>
<td>0xc4000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>X25</td>
<td>9</td>
<td>0x300</td>
<td>0x8000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* In this case, the value of the Ethernet or X.25 adapter needs to be changed.

The tables in Figure 66 on page 110 and Figure 67 must be read as the following examples describe:
1. If this is the first ISA adapter to be configured in the system, and this is an Ethernet adapter, then you should use the following values: IRQ=11, I/O Port=0x300, and Shared Memory Address=0xc8000.

2. If you want to configure a third ISA LAN adapter in the system, this adapter is a token-ring adapter, and you have two Ethernet adapters already configured with values consistent with these tables, you should use the following values: IRQ=9, I/O Port=0xa20, Shared Memory Address=0xd0000, Shared Memory Length=0x8000, and BIOS Address=0xdc000.

5.4 Configuring ISA Adapters

Configuring ISA adapters involves up to three different configuration levels:

- **Hardware Level**
  
  Some adapters, such as the IBM 16/4 ISA-16 Token-Ring Adapter, have switches to set operating system parameters, such as the interrupt level, ring speed and ROM address.

  When using those adapters, you’ll have to refer to the adapter documentation to set the switches according to your environment and according to the predefined values in the configuration database.

- **Firmware (System ROS) Level**

  Some adapters, such as the IBM LAN Adapter for Ethernet (ISA bus) and the IBM Auto 16/4 Token-Ring ISA Adapter (available for the RISC System/6000 Model 43P), do not have switches. The hardware parameters on those adapters must be configured by using the System Management Services diskette that is provided with your system.

- **AIX Level**

  After the hardware parameters have been set, you have to configure the adapter under AIX by using SMIT or with the `mkdev` command.

5.4.1 Using SMIT or Command Line

The SMIT ISA adapter configuration support has been improved with each modification level of AIX Version 4.1. In AIX Version 4.1.3, the SMIT panels support configuration of several ISA adapters of the same type. This was not the case in AIX Version 4.1.2.

In AIX Version 4.1.2, only the first ISA adapter could be configured using SMIT. SMIT used the values stored in the predefined database; thus, configuration of a subsequent ISA adapter had to be preceded by a change in the predefined database using the `odmchange` command. After the changes have been made, SMIT can be used to configure the subsequent adapters.

A second method to configure the ISA adapter attributes is accomplished by using the `mkdev` command. In this case, you can specify the attributes directly on the command line and do not need to change the predefined database.
5.4.2 Configuring ISA Ethernet Adapters

The IBM LAN Adapter for Ethernet (ISA bus) has no switches to set the operating system parameters to be used with the adapter. This procedure shows you how to set operating system parameters at firmware level, and how to configure the adapter at AIX level.

Matching Parameters

It is very important to understand that some parameters, such as the IRQ and I/O Port, are set at both the firmware and AIX level, and the settings must be identical.

5.4.2.1 Configuring ISA Ethernet Adapters at Firmware Level

The following procedures apply to the RISC System/6000 Model 40P and the RISC System/6000 Model 43P:

1. If there are any ISA adapters that are already installed in your computer, record their settings for later reference (see 5.3.1, “Recording Settings of ISA Adapters Already Configured” on page 106).

2. If your computer is up and running, shut the operating system down, and turn the power off.

3. Remove all existing ISA adapters from the machine.

4. Install the first new ISA Ethernet adapter, and insert the System Management Services diskette in the diskette drive.

5. Power-on your computer.

6. Access the services by pressing the F4 key as soon as the first screen appears. For additional information on the System Management Services, refer to the System User’s Guide that is shipped with your system.

7. Use the Up Arrow and Down Arrow keys to select Utilities, and press Enter.

8. Select Remote Initial Program Load Setup and press Enter.


10. Select IBM Lan Adapter for Ethernet, and press Enter.

   Note

   The Ethernet adapter entry will be displayed only if the interrupt level set on the adapter does not conflict with the any interrupt level used by the computer. For example, if your Ethernet adapter is set to interrupt 5 and you install it on a 43P, the entry for the adapter will not be displayed and you will not be able to change the parameters. In this case, you will have to use a PC or a 40P to change this parameter. Refer to the System User’s Guide shipped with the computer for a list of the interrupt-level (IRQ) assignments on your system.

11. Select View or Set Parameters, and press Enter.

   The system will display the parameters that can be viewed or changed. Those parameters are shown in Table 10 on page 114.
The only parameters you can change are the I/O Port, the Connection Type and the Interrupt Level parameters. However, when selecting new parameter values, make sure that these values are not used being by any other ISA adapter that are already configured in the system.

To help you select the appropriate parameters, two sources are available: the document you created following the procedure explained in 5.3.1, “Recording Settings of ISA Adapters Already Configured” on page 106 and the tables in Figure 66 on page 110 or in Figure 67 on page 111, depending on your system type.

The settings of your previously installed ISA adapters might be different than the settings recommended in Figure 66 on page 110 and Figure 67 on page 111. If this is the case, you will have to change the table to reflect your values, or you will have to change the configuration of your ISA adapters to match the recommended values in the table.

12. If you change any parameter, you will have to press the F2 key to save the new values.

13. If you want to install additional new ISA Ethernet adapters, power-off the system, and repeat steps 3 through 11 for each new ISA Ethernet adapter you want to install.

14. Install any adapters that were removed earlier in this procedure.

15. Test the hardware parameter configuration following the procedure that is described in 5.4.4, “Testing ISA Adapter Configuration” on page 119.

16. If the test was successful, continue with 5.4.2.2, “Configuring ISA Ethernet Adapters at AIX Level”; otherwise, perform problem analysis.

### 5.4.2.2 Configuring ISA Ethernet Adapters at AIX Level

After the hardware parameters for the newly installed ISA Ethernet adapters were successfully selected and tested, you will have to tell AIX to use these parameters. You can do so by either using the SMIT ISA menu or by using the mkdev command. Refer to 5.4.1, “Using SMIT or Command Line” on page 112 for an explanation about the differences involved when using either method.

The procedure that is presented in this document uses the mkdev command:

1. Power-on your system, and boot the AIX operating system.
2. Log in as the root user.
3. Verify the status of your ISA adapters. Enter:
   ```
   lsdev -Cc adapter -s isa
   ```
If you are using AIX Version 4.1.3, the first Ethernet adapter should be available, all other Ethernet adapters will be defined.

4. Enter the following command for the adapter in state available:

   chdev -l entX -a bus_mem_addr=MEM

   where MEM is the shared memory address (0xc0000, 0xc4000, 0xc8000, ...)

   The reason for the command above is that, by default, all ISA Ethernet devices are created with the shared memory address 0xe4000.

5. Enter the following command to configure your second Ethernet adapter:

   mkdev -l entY

   After this command, the status of the adapter should be available. Check it with the command from step 3.

6. Repeat steps 4 and 5 for all adapters.

7. If an Ethernet adapter device is not listed or if you removed the device with the rmdev -l entX -d command, you may use the following command to select the previously set and tested parameters:

   mkdev -c adapter -s isa -t ethernet -a bus_intr_lvl=IRQ \
   -a bus_io_addr=IO -a bus_mem_addr=MEM \ 
   -a media_type=TYPE -p bus1

   where:
   • IRQ is the interrupt level (5,7,9, or 11)
   • IO is the I/O address (0x240, 0x280, 0x300, ...)
   • MEM is the shared memory address (0xc0000, 0xc4000, 0xc8000, ...)
   • TYPE is the type of cable connection you will be using (bnc, dix, tp ...)

8. Verify the results with the following command:

   lsdev -Cc adapter -s isa

   If the configuration was successful, the adapter will be available, and the system will display information similar to the following:

   ent0 Available 00-1X IBM ISA Ethernet Adapter

9. Once the adapter status is available, you may proceed to configure the network interfaces by using the smitty inet fastpath. If an adapter device was available after rebooting the system, its network interface is probably already created.

   Note: In AIX Version 4, the default setting of the ipforwarding network option is 0 (disabled). If this machine has more than one network adapter, and you want it to function as a gateway, enter the following command:

   /usr/sbin/no -o ipforwarding=1

5.4.3 Configuring ISA Token-Ring Adapters

The IBM 16/4 ISA-16 Token-Ring adapter is equipped with switches to set the operating system parameters. The procedure that is described below shows you how to set the operating system parameters at hardware level and how to configure the adapter at AIX level.
Matching Parameters
It is very important to understand that some parameters, such as the IRQ and BIOS address, are set at both the hardware and AIX level, and the values must be identical.

5.4.3.1 Configuring ISA Token-Ring Adapters (With Switches) at Hardware Level
You need to configure the switches on your ISA token-ring adapter before you install it in your system.

If you purchased your adapter separate from your system, the switches description can be found in the *IBM 16/4 ISA-16 Adapter, 73G2038*, book provided with the adapter. However, if you order the adapter with the system, you will not get the book. For this reason, we have included a short description of the switches in Table 11 and Table 12.

1. If there are any ISA adapters that are already installed in your computer, record their settings for later reference (see 5.3.1, “Recording Settings of ISA Adapters Already Configured” on page 106).

2. If your computer is up and running, shut the operating system down, and turn the power off.

3. Set the switches on your new IBM 16/4 ISA-16 Token-Ring Adapter.

Table 11 and Table 12 show the parameter values you may want to select for a conflict-free configuration of your first and second ISA token-ring adapters. This assumes that any ISA adapters that are already installed in the system have been configured using the values in the tables in Figure 66 on page 110 or Figure 67 on page 111, depending on your system type.

<table>
<thead>
<tr>
<th>Table 11. Token-Ring Adapter: Switch Block 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dip Switch #</strong></td>
</tr>
<tr>
<td><strong>First Adapter</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 12 (Page 1 of 2). Token-Ring Adapter: Switch Block 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dip Switch #</strong></td>
</tr>
<tr>
<td><strong>First Adapter</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
</tbody>
</table>
The adapter documentation uses the words *on* and *off* to indicate the position of the switches. We have preferred to use *down* and *up* to avoid confusion. The mapping is:

- **up** = **off**
- **down** = **on**

If you are installing only one token-ring adapter, you can use a 64 KB shared RAM space for a slightly better performance. But don’t forget to set it back to 32 KB if you ever install a second token-ring adapter.

4. Install your new token-ring adapter(s) in the computer.

5. Test the hardware parameters configuration following the procedure described in 5.4.4, “Testing ISA Adapter Configuration” on page 119.

6. If the test was successful, continue with 5.4.3.3, “Configuring ISA Token-Ring Adapters at AIX Level” on page 118; otherwise, perform problem analysis.

### 5.4.3.2 Configuring the Auto 16/4 Token-Ring ISA Adapter at Firmware Level

The Auto 16/4 Token-Ring ISA Adapter has no switches to set the operating system parameters to be used with the adapter. There are two possible ways to set the parameters.

#### On the RISC System/6000 Model 40P

The current System Management Services utilities (Version 1.27) on the RISC System/6000 Model 40P do not include configuration support for this type of adapter. If you want to use this adapter on the 40P, you will have to install and configure the adapter in a PC using the software provided with the adapter, before installing the adapter on the 40P.
On the RISC System/6000 Model 43P

The RISC System/6000 Model 43P System Management Services utilities include the support needed to configure the adapter at firmware level. The configuration of the adapter is similar to the configuration of the ISA Ethernet adapter explained in 5.4.2.1, “Configuring ISA Ethernet Adapters at Firmware Level” on page 113. Follow steps 1 through 9, then select **Search for Other Adapters**. The system will load the configuration software from the System Management Services diskette.

Two paths are available for the configuration of the Auto 16/4 Token-Ring ISA Adapter. The path **Run all configuration files** will display a series of menus that show all possible values for each configuration option.

The second path **Configure Token-Ring adapter** provides an entry field that will accept parameters for each option that is being modified.

After setting the parameters and saving the values, you should test the configuration following the procedure described in 5.4.4, “Testing ISA Adapter Configuration” on page 119.

**Note:** The current System Management Services, Version 1.04 on the 43P, does not support the configuration of two token-ring adapters.

### 5.4.3.3 Configuring ISA Token-Ring Adapters at AIX Level

After the hardware parameters for the newly installed ISA token-ring adapters are successfully selected and tested, you will have to tell AIX to use these parameters. You can do so by either using the SMIT ISA menu or by using the mkdev command. Refer to 5.4.1, “Using SMIT or Command Line” on page 112 for an explanation about the differences involved when using either method.

The procedure that is presented in this document uses the mkdev command:

1. Power-on your system, and boot the AIX operating system.
2. Log in as the root user.
3. Verify the status of your ISA adapters:
   ```bash
   lsdev -Cc adapter -s isa
   ```
   If you are using AIX Version 4.1.3, your adapter will probably be available (assumed you selected the appropriate parameters). If you are using AIX Version 4.1.1, you will have to perform step 4.
4. Enter the following command if the hardware parameters were selected and tested previously:
   ```bash
   mkdev -c adapter -s isa -t tokenring -a intr_level=IRQ \ 
   -a bus_io_addr=IO -a shared_mem_addr=MEM \ 
   -a shared_mem_leng=LEN -a bios_addr=BIOS \ 
   -a ring_speed=SPEED -p bus1
   ```

   where:
   - **IRQ** is the interrupt level (3, 6, 7, or 9)
   - **IO** is the I/O address (0xa20, 0xa24, ...)
   - **MEM** is the shared memory address (0xc0000, 0xd0000)
   - **LEN** is length of the shared memory (0x2000, 0x4000, 0x8000)
   - **BIOS** is the ROM memory address (0xcc000, 0xdc000)
   - **SPEED** is speed of the network ring (16, 4)
5. Verify the results with the following command:
   `lsdev -Cc adapter -s isa`
   If the configuration was successful, the adapter will be available, and the system will display information similar to the following:
   ```
   tok0 Available 00-1X IBM 16/4 PowerPC Token-Ring Adapter (isa)
   ```
   If the adapter is not available but defined, you will have to use the `rmdev` command to delete the configuration, check the parameters you selected and repeat the procedure.

6. Once the adapter status is available, you may proceed to configure the network interface by using the `smitty mkinet` command.

   **Note:** In AIX Version 4, the default setting of the `ipforwarding` network option is 0 (disabled). If this machine has more than one network adapter, and you want it to function as a TCP/IP gateway, enter the following command:
   ```
   /usr/sbin/no -o ipforwarding=1
   ```

### 5.4.4 Testing ISA Adapter Configuration

1. If your computer is up running, shut the operating system down, and switch the power off.

2. Insert the System Management Services diskette into the diskette drive, and switch the system on.

3. As soon as the first screen appears, press the F4 key.

4. Use the Up Arrow and Down Arrow keys to select **Test the Computer**, and press Enter.

   A list of devices that are installed in your computer appears. The list will be similar to Figure 68.

   ![Installed Devices]

   **Figure 68. Installed Devices**

5. Use the spacebar to select the device you want to test.

6. Press the F6 key to run the test on the selected device.
   - For an Ethernet adapter, the displayed configuration will look similar to Figure 69 on page 120.
For a token-ring adapter, the displayed configuration will look similar to Figure 70.

The test program for the ISA X.25 adapters does not produce the attributes list.

7. If all of your ISA adapters are listed and they all passed the test, then you have a conflict-free configuration at the hardware and firmware levels.

5.5 Setting Up and Configuring an X.25 Network

In this section, we will use a simple “Back-to-Back” X.25 connection to describe how to set up an X.25 network and how to configure the IBM ISA X.25 Co-Processor/1 adapter. For more information on the AIX Version 4 support for X.25 networks, refer to the AIXLink/X.25 1.1 for AIX: Guide and Reference, SC23-2520.

X.25 Redbook

The AIX/6000 X.25 LPP Cookbook, GG24-4475, redbook explains the X.25 concepts and provides procedures to set up an X.25 network.

5.5.1 X.25 Introduction

The X.25 network provides the ability to transmit data between remote machines. It is a set of recommendations from the International Telegraph and Telephone Consultative Committee (CCITT). These recommendations define a standard network access protocol for attaching different types of computer equipment to a packet-switched data network (PSDN). A PSDN is an interconnecting set of switching nodes that enables subscribers to exchange data using a standard protocol and packet-switching technology. Such a network carries messages that are divided into packets over circuits that are shared by many network users. A packet consists of a sequence of data and control elements in a format that is always transmitted as a whole. The network packet size is commonly 128 bytes, but can vary from 16 to 4096 bytes.
You can use X.25 communications to provide a network service for higher-level protocols, such as Transmission Control Protocol/Internet Protocol (TCP/IP) and System Network Architecture (SNA). Or you can use an X.25 network directly, either by using the xtalk command or by using an application programming interface (API) to write your own applications.

5.5.2 X.25 Terminology

Before setting up the X.25 connection, we want to present some X.25-specific definitions. Figure 71 shows the components in a simple X.25 network.

![Figure 71. X25 Components](image)

DTE (Data Terminal Equipment)
- A computer that uses a network for communications.

DCE (Data-Circuit Terminating Equipment)
- A device at the point of access to the network.

DSE (Data-Switching Equipment)
- A switching node in a packet-switched data network.
Notes:
1. Every DTE must have an associated DCE.
2. DTE and DCE are functional definitions; they need not correspond to specific items of equipment. For example, a single device may be a DSE and may also provide multiple DCE interfaces.

5.5.3 Planning Your X.25 Configuration
Before you can start configuring your X.25 adapters, you need to do some preliminary planning with information that is obtained from your X.25 network provider. The information you need includes the number of PVCs (Permanent Virtual Circuits), the number of SVCs (Switched Virtual Circuits), and the bandwidth, depending on the type of X.25 traffic generated.

In the example described in this section, we do not need to obtain this information because we are using a so-called back-to-back connection which is similar to using the X.25 protocol over a leased line.

X.25 Software

In AIX Version 3, the base X.25 support is included within the operating system software package. In AIX Version 4, the base support and all X.25 support functions are provided with the AIXLink/X.25 Version 1.1 LPP (Licensed Program Product), feature code 5696-926.

5.5.4 Installing the X.25 Support Software (AIXLink/X.25)
In AIX Version 4, support for X.25 communication is provided with the AIXLink/X.25 Version 1.1 LPP, feature code 5696-926.

You may check to see if the LPP is already installed by entering the following command:
ls1pp -1 | grep sx25

If the LPP is already installed, a list similar to Figure 72 on page 123 will be displayed.
<table>
<thead>
<tr>
<th>Fileset</th>
<th>Level</th>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sx25.adt.comio</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 Appl. Dev. Toolkit-COMIO Support</td>
</tr>
<tr>
<td>sx25.adt.npi</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 Appl. Dev. Toolkit-NPI/DLPI Support</td>
</tr>
<tr>
<td>sx25.adt.rte</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 Appl. Dev. Toolkit-Runtime Env.</td>
</tr>
<tr>
<td>sx25.info.en_US.usr_gd</td>
<td>4.1.0.0</td>
<td>COMMITTED</td>
<td>X.25 User Guides - U.S. English</td>
</tr>
<tr>
<td>sx25.msg.En_US.rte</td>
<td>1.1.0.0</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 Messages - English IBM-850</td>
</tr>
<tr>
<td>sx25.msg.en_US.rte</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 Messages - English</td>
</tr>
<tr>
<td>sx25.npi</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 NPI and DLP Support</td>
</tr>
<tr>
<td>sx25.pad</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 Triple-X Ass./Disass. (PAD)</td>
</tr>
<tr>
<td>sx25.rte</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 Runtime</td>
</tr>
<tr>
<td>sx25.server</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 Server Supp</td>
</tr>
<tr>
<td>sx25.tcpip</td>
<td>1.1.0.3000</td>
<td>COMMITTED</td>
<td>AIXlink/X.25 TCP/IP Supp</td>
</tr>
</tbody>
</table>

Figure 72. AIXLink X.25/6000 LPP Filesets

If the X.25 LPP is not yet installed, you will have to install it by either using the installp command or by using the SMIT support for software installation. The files making up the LPP are divided into a number of sets that may be installed independently. Installation of the X.25 run-time is a prerequisite for installation of any of the other X.25 options. The following options are available:

All
COMIO Compatibility Support and Applications
NPI and DLPI Support
Run-time Environment
TCP/IP Support
Triple-X Packet Assembler/Disassembler (PAD)

Note: The AIXLink/X.25 V1.1 LPP requires AIX Version 4.1.1 with updates. The required updates are already included in AIX Version 4.1.2.

After the software is installed, you will have to configure the total number of virtual circuits that are allowed to the system. This is specified on the X.25 license option you purchased. Use the following SMIT sequence:

smit licenses
→Manage X.25 Server License Database
5.5.5 Configuring ISA X.25 Adapters

The IBM X.25 Co-Processor/1 adapter is equipped with switches to set the operating system parameters. The procedure that is described in this section shows you how to set the operating system parameters at **hardware level** and how to configure the adapter at **AIX level**.

### Matching Parameters

It is very important to understand that some parameters, such as the IRQ and I/O Port, are set at both the hardware and AIX level, and the values must be identical.

Figure 73 shows the back-to-back configuration we used to test our X.25 communication. This type of connection allows you to perform tests using PVCs and SVCs; however, it does not reflect the customizing problems you may experience on a real network.

**Note:** With this type of configuration, you can benefit from the automatic DTE/DCE detection feature. If this feature has been disabled, you must define one system as DTE and the other as DCE.

---

Figure 73. Two RISC System/6000s Connected Back-to-Back

### 5.5.5.1 Configuring ISA X.25 Adapters at Hardware Level

Before you install your ISA X.25 Co-Processor/1 adapter in your computer, you need to configure the switches on the card. The switches are described in the document *X.25 Interface Co-Processor: Guide to Operations*, part number 06H1845. For your convenience, we have included a short description of the switches in Table 13 on page 125 and Table 14 on page 125.

1. If there are any ISA adapters that are already installed in your computer, record their settings for later reference (see 5.3.1, “Recording Settings of ISA Adapters Already Configured” on page 106).
2. If your computer is up and running, shut the operating system down, and turn the power off.
3. Set the switches on your new IBM X.25 Co-Processor/1 adapter.
Table 13 on page 125 and Table 14 on page 125 show the parameter values you may want to select for a conflict-free configuration of your first, second and third ISA X.25 adapters. This assumes that any ISA adapters that are already configured in the system have been configured by using the values in the table in Figure 66 on page 110 or Figure 67 on page 111, depending on your system type.

### Table 13. Interrupt Level Switch Positions

<table>
<thead>
<tr>
<th>Dip Switches</th>
<th>Interrupt Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 down</td>
<td>3</td>
</tr>
<tr>
<td>1 up</td>
<td>4</td>
</tr>
<tr>
<td>2 down up</td>
<td>7</td>
</tr>
<tr>
<td>2 up</td>
<td>2 or 9</td>
</tr>
<tr>
<td>3 down</td>
<td>10</td>
</tr>
<tr>
<td>3 up</td>
<td>11</td>
</tr>
<tr>
<td>4 down</td>
<td>12</td>
</tr>
<tr>
<td>4 up</td>
<td>15</td>
</tr>
</tbody>
</table>

### Table 14. X.25 Adapter: Switch Block 1

<table>
<thead>
<tr>
<th>Dip Switch #</th>
<th>Position</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>First Adapter</td>
<td>Second Adapter</td>
</tr>
<tr>
<td>1</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>2</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>3</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>4</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>5</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>6</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>7</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>8</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>9</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
<tr>
<td>10</td>
<td>[ ]</td>
<td>[ ]</td>
</tr>
</tbody>
</table>

**Notes:**

The adapter documentation uses the words on and off to indicate the position of the switches. We have preferred to use down and up to avoid confusion. The mapping is:

- up = off
- down = on

**a** This switch is factory set to indicate the size of RAM installed on the adapter. Verify that the position of this switch is down to reflect a RAM size of 512 KB.

**b** Indicates whether a one-edge (62-pin) or a two-edge (62-pin and 36-pin) connector is used to hold your adapter. down = two-edged / up = one-edged
Sets the bus width and should generally be set to 8-bit.
down = 8-bit / up = 16-bit

4. Install your new ISA X.25 adapter(s) in the computer.

5. Test the hardware parameters configuration following the procedure
described in 5.4.4, “Testing ISA Adapter Configuration” on page 119.

6. If the test was successful, continue with 5.5.5.2, “Configuring ISA X.25
Adapters at AIX Level”; otherwise, perform problem analysis.

5.5.5.2 Configuring ISA X.25 Adapters at AIX Level

After the hardware parameters for the newly installed ISA X.25 adapters were
successfully selected and tested, you will have to tell AIX to use these
parameters.

1. Power-on your system, and boot the AIX operating system.
2. Log in as the root user.
3. Use the following SMIT sequence to add your adapter:
   smit clxmpx
   →Add an X.25 Adapter
   Select the parent bus, bus1 (ISA), and fill in the SMIT panel with the adapter
   parameters as shown in the example in Figure 74.

   **Figure 74. Adding an X.25 CoProcessor/1 Adapter**

   ISA Virtual Connection - The X.25 device driver supports both single-port
   and multiport adapters. For the ISA X.25 Co-Processor/1, which is
   a single-port adapter, you must select port 0.

   ISA Interrupt Level - You have to enter the interrupt level you selected with
   the switches on the adapter card.
Bus I/O Address - You have to enter the Bus I/O Address you selected with the switches on the adapter card.

Bus Memory Address - Refer to Figure 66 on page 110 or Figure 67 on page 111 for the suggested value for this parameter.

4. Verify whether the X.25 device has become available. Enter:
   
   ```bash
   lsdev -Cc adapter -s isa
   ```

   If the adapter has been successfully configured, the system will display device information similar to the following:

   ```bash
   ampx0 Available 00-1X N/A
   ```

5. Verify that the attributes are customized for the adapter. For example, for the device `ampx0`, enter:

   ```bash
   lsattr -l ampx0 -E
   ```

   A list similar to the following will appear:

   ```bash
   bus_intr_lvl 11 Bus Interrupt Level True
   intr_priority 2 Interrupt Priority False
   bus_io_addr 0x2A0 Bus I/O address True
   bus_mem_addr 0xE0000 Bus memory address True
   window_size 0x2000 Bus memory window size False
   ```

6. Now, you have to configure the X.25 device driver. Use the following SMIT sequence:

   ```bash
   smit cx25str_dd
   ```

   → Add a Device Driver

   Select the parent adapter, and press Enter.

   Enter the following command to verify the availability of the driver:

   ```bash
   lsdev -C -l twd0
   ```

   A line similar to the following should appear:

   ```bash
   twd0 Available 00-1X-00 ARTIC Adapter Driver
   ```

7. After the driver has become available, you can configure the X.25 LPP port. For this task, you will need to obtain the details about your X.25 network subscription. Contact your X.25 network provider or your X.25 network administrator.

   To start the X.25 port configuration, enter:

   ```bash
   smit cx25str_mp
   ```

   → Add Port

   Select the parent adapter driver, and provide the required information in the SMIT panel. Figure 75 on page 128 reflects the values that are used in our back-to-back configuration.
Add an X.25 Port

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

<table>
<thead>
<tr>
<th>Entry Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Adapter Driver</td>
</tr>
<tr>
<td>* PORT number</td>
</tr>
<tr>
<td>* Local network user address (NUA)</td>
</tr>
<tr>
<td>* Network identifier</td>
</tr>
<tr>
<td>Country prefix</td>
</tr>
<tr>
<td>PVC - lowest logical channel number</td>
</tr>
<tr>
<td>PVC - Number of logical channels</td>
</tr>
<tr>
<td>Incoming SVC - lowest logical channel number</td>
</tr>
<tr>
<td>Incoming SVC - number of logical channels</td>
</tr>
<tr>
<td>Two-way SVC - lowest logical channel number</td>
</tr>
<tr>
<td>Two-way SVC - number of logical channels</td>
</tr>
<tr>
<td>Outgoing SVC - lowest logical channel number</td>
</tr>
<tr>
<td>Outgoing SVC - number of logical channels</td>
</tr>
</tbody>
</table>

**Figure 75. Add an X.25 Port**

PORT number - The physical port on the adapter’s expansion cable that is to be used. For the X.25 Co-Processor/1 adapters, this must be 0.

Local network user address (NUA) - This is usually supplied by the network provider, and it must agree with the subscription that is obtained. For a back-to-back connection, just select any number similar to the one in the example.

Network identifier - On networks that implement X.121 addressing, the country prefix uniquely identifies the country. In some cases, this can be used to identify default characteristics of the network. In some countries, there is more than one network type, and though they share the same country code, they have differing characteristics. If the identification for the local network is listed then that should be selected. Otherwise, select other public and provide the country code in the Country prefix field if attached to a standard network. Select other private if the network’s addressing scheme is different from X.121.

8. Enter the following command to verify whether the X.25 port has become available:

   `lsdev -C -t stx25 -H`

   The system will display information similar to the following:

   ```
   name  status  location  description
   sx25a0 Available 00-1X-00-00 X.25 Port
   ```

9. You may test the X.25 communication following the procedure that is described in 5.5.6, “Basic X.25 Communication Tests” on page 129.
5.5.6 Basic X.25 Communication Tests

The easiest way to test the X.25 communication is to use the xtalk program that is included in the COMIO option of the AIXLink/X.25 V1.1 LPP (see Figure 72 on page 123) between two systems attached to an X.25 network.

Perform the following steps to test the X.25 communication:

1. Add the COMIO emulation to the port by using the following SMIT path:
   
   ```bash
   smit cx25str_mp
   → Add Comio Interface to Port
   ```
   
   Select the X.25 port you wish to add the COMIO interface to, and press Enter.

2. Verify the operation. For example, for port x25s0, enter the following command:
   
   ```bash
   lsdev -C -l x25s0
   ```
   
   The system should display information similar to the following:
   
   ```text
   x25s0 Available 00-1X-00-00-00 AIX V.3 X.25 Emulator
   ```

3. Also, a network interface, for example, xs0, should have been created. Enter the following command to verify its availability:
   
   ```bash
   lsdev -Cc if
   ```
   
   The system should display:
   
   ```text
   xs0 Available 00-1X-00-00-00 LPP X.25 Network Interface
   ```

4. Repeat this procedure on your second system.

5. Start the xtalk program on both systems with the following command:
   
   ```bash
   xtalk -s -l IBMXTALK
   ```
   
   Refer to the product documentation or to the AIX/6000 X.25 LPP Cookbook redbook for more information about the xtalk program.

**Note:** If xtalk was the only reason that you configured COMIO to your port, you may delete the COMIO configuration after you have successfully tested your X.25 connection. Enter:

```bash
smit cx25str_mp
→ Remove COMIO Interface from Port
```

---

### TCP/IP Configuration on X.25 Ports

Refer to “Managing TCP/IP Configuration” in the AIXLink/X.25 1.1 for AIX: Guide and Reference, SC23-2520, for information on how to add TCP/IP support to an X.25 port.

---

5.6 Configuring PCI Adapters

The following PCI adapters are currently supported on RSPC systems:

**E15 Graphic Adapter** - Low-cost, medium performance, DRAM-based adapter for use as an entry 2D graphics solution. This functionality is integrated on the system board on RISC System/6000 Model 43P systems.

**S15 Graphic Adapter** - High-performance, VRAM-based adapter with integrated video co-processor for use as a premium 2D graphics solution.
GXT150P Graphic Adapter - Is an 8-bit, 2D graphics adapter and offers IBM's highest level of 2D graphics performance available for RSPC systems. Using IBM's Softgraphics 3D API support with this adapter, you can run many common 3D applications, including production 3D CAD.

3COM Ethernet Adapter - Maximized throughput due to Parallel Tasking Architecture that allows multiple tasks to be performed at the same time. The 3COM Ethernet adapters can be attached to ISA or PCI buses and are available in three different models.

- 3COM Ethernet ISA, BNC/AUI
- 3COM Ethernet ISA, Twisted Pair only
- 3COM 10/100 MB Ethernet PCI, Twisted Pair only

Olicom Token-Ring PCI 16/4 Adapter - A PCI token-ring adapter that can plug into any free PCI expansion slot.

See Appendix A, “Devices Supported on the RISC System/6000 Model 40P” on page 257 for a list of currently supported adapters and devices.

5.6.1 Configuring Non-Graphic PCI Adapters

Configuring PCI adapters is very easy because they are actually configured automatically when their driver software is installed and the cfgmgr program is run.

The easiest way to configure “non-graphic” PCI adapters (such as LAN adapters, and so on) installed after IPL is to proceed in the same way as with microchannel adapters. For example, using the SMIT support, enter:

```
smit devices
→Install/Configure Devices Added After IPL
```

You may have to provide a source for the device driver software package for the new PCI device if it is not yet installed.

---

**Important**

Do not use the above procedure if you want to add or replace graphic adapters because if anything goes wrong (for example, a required device driver is not yet installed, and so on), you will end up in front of a blank screen.

To add or change PCI graphic adapters proceed as described in 5.6.2, “Configuring PCI Graphic Adapters.”

---

If, for whatever reason, you need to install software, but you are unable to boot from hard disk, or you have no working display, you may install the software while in maintenance mode.

5.6.2 Configuring PCI Graphic Adapters

The procedures that are described in this section are intended to avoid a blank screen because something went wrong when configuring PCI graphic adapters. Although this is not a big problem if you already have configured an ASCII terminal or if you can access the system over the network, you are going to lose a lot of time if you have a stand-alone system, and you do not have a working display.
Install Device Driver before Adapter

The most important step when planning to configure or change PCI graphic adapters is to install the adapter software before installing the adapter.

To verify if the software for your graphic adapter has already been installed, you may enter one of the following commands, depending on your adapter type:

```
lslpp -l | grep E15
lslpp -l | grep S15
lslpp -l | grep GXT150P
```

If, for whatever reason, you need to install software, but you are unable to boot from hard disk, or you have no working display, you may install the software while in maintenance mode.

### 5.6.2.1 Configuring/Replacing the First PCI Graphic Adapter

Since on RISC System/6000 Model 43P systems the E15 graphic functionality is integrated on the system board, the situations that are discussed in this section apply to the RISC System/6000 Model 40P systems only. Refer to 5.6.2.2, “Configuring Two PCI Graphic Adapters (Multihead)” on page 132 if you want to add a PCI graphic adapter to your RISC System/6000 Model 43P system, and you want to use the multihead support.

Your RISC System/6000 Model 40P system comes with a PCI graphic adapter already installed and configured. However, one of the following situations may arise:

1. You have a RISC System/6000 Model 40P system without a graphic adapter and you want to configure the first graphic adapter.
2. You want to move your graphic adapter to a different PCI slot.
3. You want to replace your graphic adapter with one of a different type, for example, an E15 with an S15.

In all cases, you have to make sure that the adapter support software (device driver) is installed before the adapter.

In cases 2 and 3, you may want to record the following display settings before moving/replacing the adapter:

- Display size
- Display type
- Display resolution and refresh rate

The above settings are displayed by using the following SMIT command:

```
smit g_display
```

Now you can shut down AIX, power-off the system, physically install, move or replace the adapter, and power-on the system. The adapter should be automatically configured. For information on installing PCI adapters, refer to the *System User’s Guide* that is provided with your system.

In cases 2 and 3, you may enter the *smit g_display* command to verify or change the display settings as required.
5.6.2.2 Configuring Two PCI Graphic Adapters (Multihead)

Configuring and using two graphic displays on the same RSPC system is possible. However, not all combinations are supported. For detailed information on multihead support, refer to 5.6.4, “Adapter Combinations for Multihead Support” on page 133.

1. If the graphic display you are already using will be used after the configuration of your second adapter, you will have to record the following display settings:
   • Display size
   • Display type
   • Display resolution and refresh rate

   Use the following SMIT command to obtain the current settings:

   ```
   smit g_display
   ```

2. Install the required software support (device drivers) for all your graphic adapters.

3. Shut down AIX, and power-off the system.

4. Physically install the graphic adapters (refer to the System User’s Guide that is provided with your system).

5. Power-on the system.

   During the RSPC firmware boot phase (see Chapter 3, “Boot Support” on page 55), both monitors will display the same: the PowerPC logo and the devices’ icons.

   After the AIX bootimage takes control in the boot process, the system will present the following message on one screen:

   ```
   ******* Please define the System Console *******
   ```

   Type the F1 key and press Enter to use this display as the system console.

   The following message will appear on the second screen:

   ```
   ******* Please define the System Console *******
   ```

   Type the F2 key and press Enter to use this display as the system console.

   Subsequent reboots will not present the messages shown above.

   A list of the configured graphic adapters and information on the default display is obtained with the following command:

   ```
   lsdisp
   ```

   Information similar to the following will be displayed:

   ```
   DEV_NAME SLOT BUS ADPT_NAME DESCRIPTION
   =========== ==== === ========= ===========
   gga1 01 pci S15 IBM Personal Computer Power Series S15 Graphics Adapter
   iga1 02 pci E15 E15 Graphics Adapter
   ```

   Default display = gga1

6. Use `smit g_display` to verify or change the display settings, as required.
You should now be able to move with your mouse pointer from one display to the other, display X-clients on the second screen and so on. See 5.6.3, "Accessing the Second Display" on page 133 for more information on how to access the second monitor and its resources.

5.6.3 Accessing the Second Display

It is beyond the scope of this redbook to provide indepth information on defining X-resources in a multiheaded environment (refer to InfoExplorer or the AIX Version 4 product documentation). However, we want to help you get started.

We will show you how to set the DISPLAY variables for your second monitor correctly, an easy way to manipulate some of your second display’s AIXwindows resources and where the AIXwindows Desktop stores this information.

The last digit in the DISPLAY variable determines on which monitor the X-client is going to be displayed. This is shown in Table 15.

<table>
<thead>
<tr>
<th>DISPLAY Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISPLAY=’hostname:0.0’</td>
<td>Displays on default monitor</td>
</tr>
<tr>
<td>DISPLAY=’hostname:0.1’</td>
<td>Displays on second monitor</td>
</tr>
</tbody>
</table>

To display X-clients on the second monitor, you may either:

1. Change the DISPLAY variable to ’hostname:0.1’, or
2. Start the X-client with the -display ’hostname:0.1’ option

The AIXwindows Desktop Style Manager makes it easy to manipulate the X-resources of the second display. For example, with the next steps we will change the Backdrop of the second display to OldChars:

1. Start the Style Manager as follows:
   `/usr/dt/bin/dtstyle -display ’hostname:0.1’`
2. Use the left mouse button to select:
   - Backdrop, then
   - OldChars (from the pull down window), then
   - Apply, then
   - Close
3. Exit the Style Manager

5.6.4 Adapter Combinations for Multihead Support

Graphic multihead environments are supported on RSPC systems; however, there are some specifics you should be aware of which are described in this section.

Note: On RISC System/6000 Model 43P systems, the E15 functionality is integrated on the system board.

Table 16 on page 134 shows the supported combinations:
In AIX Version 4, AIXwindows running as multihead is the default. This is different from AIX Version 3.2, where multihead is not the default. The -P option is still available in AIX Version 4.

There are no specific settings on any adapters for the multihead environment.

1 Needs AIX Version 4.1.3.

2 The GTX150P adapter has a Dip Switch that you need to set up for the monitor. The Dip Switch is documented in Appendix B, “IBM GTX150P Configuration Tables” on page 259 and in the Installation Instructions document that comes with the adapter.

5.7 Configuring SCSI Devices

Both, the RISC System/6000 Model 40P and the RISC System/6000 Model 43P feature one integrated SCSI-2 Fast Interface. On the RISC System/6000 Model 40P, a maximum of three internal and two external SCSI-2 devices are supported. On the RISC System/6000 Model 43P, a maximum of four internal and two external SCSI-2 devices are supported.

The process of configuring SCSI devices on RSPC systems is exactly the same as it is in any other RISC System/6000 system. This means you can use the SMIT support to configure devices that are added after IPL, enter the cfgmgr command, or reboot the system. However, remember that unlike with AIX Version 3.2, on AIX Version 4, the software support for the device you are adding may not yet be installed. Thus, check to see if the device driver for your SCSI device is installed. If not, use SMIT to configure the device, and provide an input device or directory where the installation software can be accessed.

Note: If for any reason you need to change the SCSI ID number of the integrated SCSI controller, you will have to reboot the system and use the System Management Services diskette.

<table>
<thead>
<tr>
<th>Table 16. Graphic Adapter Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adapters</strong></td>
</tr>
<tr>
<td>Two E15</td>
</tr>
<tr>
<td>One E15 and one S15</td>
</tr>
<tr>
<td>One E15 and one GXT150P</td>
</tr>
<tr>
<td>Two S15</td>
</tr>
<tr>
<td>One S15 and one GXT150P</td>
</tr>
<tr>
<td>Two GXT150P</td>
</tr>
</tbody>
</table>
Chapter 6. AIX Version 4.1.3 Power Management

Both the PowerPC Reference Platform Specification (PReP) and the PowerPC Hardware Reference Platform (HRP) Architecture define the support for Power Management as an important new feature. Although initially the goal was the extension of useful operational time for mobile computing, the scope of Power Management has been broadened to include energy conservation in non-mobile computers and servers.

Both documents place the responsibility for power management squarely on the operating system. The operating system, as the central service in the computing system, has the best opportunity to optimize energy usage while maintaining overall system responsiveness and/or computational throughput.

Power Management has been introduced to the RISC System/6000 systems with AIX Version 4.1.3. Currently only the RISC System/6000 Model 43P and the mobile Power Series systems provide system planars with the Power Management controller which uses the AIX Version 4.1.3 Power Management functionality.

Additionally, in an attempt to minimize the power consumption of the system, AIX Power Management controls other features, such as auto power-on and off, a software-controlled power switch.

Three levels of Power Management have been defined:

**Micro Power Management**

This is a hardware-level power management that the operating system and application software cannot control. More and more devices are featured with this capability; therefore, the PReP Specification and the HRP architecture define requirements for these kinds of devices.

**Device-Level Power Management**

This is controlled by the individual device drivers and can work together with the system-level power management.

Device drivers for both integrated and add-in devices require extensions to handle requests from the Power Management executive to effect the transition of a device between its supported device power states. The device driver must understand the capabilities of the device it services.

Since most devices do not retain their operational state when power is removed, the device driver is responsible for restoring the operational state of a device after a period when power has been removed.

**System-Level Power Management**

This is the heart of the AIX Version 4.1.3 Power Management functionality.

Power Management state transitions introduce different environments to application programs. For this reason, it may be necessary for some application programs to know the power management state transitions. For example, since
all processes are frozen at the suspend or hibernation states, some processes might want to save data in a file before entering suspend or hibernation. Also, some application programs might need to control Power Management state transitions.

6.1 AIX Version 4.1.3 Power Management Components

Figure 76 shows the AIX Version 4.1.3 Power Management system components.

**PM Core**

The power management (PM) "core" resides in the kernel and two kernel extensions. One extension, `pmmi`, is machine independent, and therefore is the same on any power managed system. The second extension, `pmmd`, is machine-dependent. Currently, there are two implementations of the `pmmd` kernel extension, one for the 43P and one for the IBM ThinkPad Power Series models 820 and 850.

The PM core controls all state transitions and notifies all registered PM-aware device drivers of state transitions. The state transitions can be the result of a
user action, an external event or the expiration of a system timer. It also maintains idle counts for each device in the system, as well as for the system as a whole.

The PM core is a coordinator for PM-aware device drivers. It informs the device drivers of various PM events and also requests some of the drivers to enter a low-power mode if they seem to be idle. Because Power Management features are completely dependent on each machine, the role of the PM core is to abstract the difference between the machines.

**PM Daemon**

The Power Management daemon, `pmd`, handles all user or application requests for PM information or state transitions. It interfaces with the PM core to accomplish this.

**PM Aware Device Drivers**

PM-aware device drivers are responsible for handling Power Management-related operations for corresponding devices. The drivers handle commands, such as device idle, suspend, hibernate, and enable, from the PM core. The PM-aware driver then takes device-specific action appropriate for the command. For example, if the device driver receives a device idle request, the driver places the device into a low-power mode or even into an off state.

The PM-aware device driver can reject a command from the PM core if the driver is unable to perform the request. For example, if the device has an outstanding operation that does not complete for several seconds, the PM-aware device driver can reject the request from the PM core. If there is an outstanding command that will complete within a second or two, the PM-aware device driver waits for completion of the outstanding command and returns successfully to the PM core.

The PM-aware device driver maintains an activity flag to inform the PM core whether the device driver is busy.

**PM Kernel Services**

There are three kernel services provided with the Power Management system in AIX Version 4.1.3:

- `pm_register_handle`
  
  The `pm_register_handle` kernel service registers and unregisters a PM handle to the PM core.

- `pm_planar_control`
  
  The `pm_planar_control` kernel service allows a device driver to request planar-level Power Management control of its device regardless of the current platform.

- `pm_register_planar_control_handle`
  
  The `pm_register_planar_control_handle` kernel service allows the actual planar control function of the PM core to be extended.
**PM Library**

The AIX Version 4.1.3 Power Management system provides an application programming interface (API) to allow users to make their applications PM-aware. This allows an application to be notified before any state transition and to initiate state transitions itself. The library subroutines provide the following functions:

- Controlling or querying PM parameters (pm_control_parameter)
- Controlling or querying PM states (pm_control_state)
- Querying PM events (pm_event_query)
- Controlling or querying battery information (pm_battery_control)

**PM Commands and User Interfaces**

The Power Management system includes the following three types of user interfaces:

- Command line
- SMIT
- A GUI (xpowerm)

The user interface allows the user to change the PM parameters or to initiate state transitions. The functions provided are shown in the following screen:

```
Power Management

Move cursor to desired item and press Enter.

Enable / Disable Power Management State Transition
Configure / Unconfigure Power Management
System State Transition from Enable State
Change / Show Characteristics of Power Management
Power Management Timer
Display Power Management
Power Management Characteristics of Each Device
Battery

F1=Help       F2=Refresh       F3=Cancel       F8=Image
F9=Shell      F10=Exit        Enter=Do
```

If you want to use SMIT as interface, the path is:

```
smit
  ==> Performance and Resource Scheduling
  ==> Power Management
```

Or you may use the SMIT fastpath:

```
smit pm
```
The GUI interface (/usr/bin/X11/xpowerm) presents an icon with the following options:

- Move to standby state
- Power Management Parameter Setting Menu

Figure 78 on page 143 shows the Parameter Settings Menu displayed when the “Power Management Parameter Setting Menu” button is clicked.

### 6.2 Power Management States

AIX Version 4.1.3 includes four different Power Management states which allows for different levels of power consumption. The PM states are:

**System Full-on**

All devices are powered-on. The system runs as if there was no power management.

**Device Local Standby**

Moves a device to a low-power mode if the device is idle. In certain cases, low power mode just turns the device off locally. For example, power to a hard disk drive can be stopped by using a standard or unique command if it has not been accessed for a while.

**System Suspend**

Powers-off everything on a power-managed machine, except the system memory, the memory controller and some Power Management-related logic. Therefore, all the volatile data in the remaining system devices is lost. All the device drivers that directly access those devices must have an appropriate routine to retrieve the data at the start of the suspend state. In certain cases, the device drivers may need to perform some operations before the corresponding device is turned off as a result of entering suspend.

Since system memory, including the private memory area of the device driver, is preserved during the suspend state, each device driver can retrieve the previous device context by using the data in its own private memory area.

**Hibernation**

During the hibernation state, all power sources, except the special logic for turning the system on again, are shut off. At the restart from hibernation, the volatile data of all the devices is lost. System main memory, however, is saved or restored by the Power Management kernel extension by using nonvolatile storage, such as the hard disk.

There is no difference between the suspend and hibernation states for device drivers whose device data was lost during those Power Management states.
6.3 Power Management Software Installation and Configuration

Before configuring and using the AIX Version 4.1.3 power management system, you should be aware of how the system works and how it may affect your environment and your applications.

Important!

Refer to 6.4, “Possible Power Management Problems and Warnings” on page 143 for a discussion of the problems that may arise when configuring and using the Power Management system.
6.3.1 PM Installation

The Power Management software is included with the operating system and is auto-installed on any platform with a Power Management controller chip. Currently, it is only on the RISC System/6000 Model 43P and the ThinkPad Power Series models 820 and 850.

Part of the installation procedure is to create a hibernation logical volume the same size as real memory, which is necessary to support hibernation.

Power Management can also be force-installed on any platform. However, it does not make any sense because, due to the lack of the Power Management controller, none of this code will be configured or run.

To install the PM software manually, proceed in the same way as you do when installing any filesets in AIX Version 4.1. The PM fileset name is bos.powermgt.rte, and it contains the following files:

- /usr/bin/mkpmhlv
- /usr/lib/drivers/pmmi
- /usr/bin/checkpmc
- /usr/lib/boot/enable_hibernation
- /usr/lib/boot/disable_hibernation
- /usr/bin/battery
- /usr/lib/drivers/pmmipin
- /usr/lib/drivers/pmwakeup
- /usr/lib/methods/startpm
- /usr/bin/pmd
- /usr/bin/pmctrl
- /usr/lib/libpm.a

6.3.2 PM Configuration

You can configure the PM systems using the command line or by using the following SMIT fastpath:

```
smitty pm
```  

```bash
==>Configure / Unconfigure Power Management
   ==>Configure Power Management
```

After successful configuration, you will see the following message:

```
pmc0 Available
/usr/sbin/mklv -y pmhibernation -t pmhibernation -b n -r n rootvg 8 hdisk0
```

First, the PM controller logical device pmc0 is configured. Then the pmhibernation logical volume is created. The number 8 means eight physical partitions (PPs) are allocated for this logical volume. In our case, the system uses eight PPs because we have 32 MB real memory, and we are using the default PP size, (4 MB).

**Note:** In our environment, (pre-GA level hardware, AIX Version 4.1.3 golden code), the logical volume was not created, and the daemon didn’t get started.
After the SMIT operation. We could solve this problem by entering the command: `/usr/sbin/pmd`.

---

**PM Enabled**

When PM is successfully configured, the system is PM-enabled by default.

---

After system reboot, the pmd daemon will not be restarted automatically although the system is PM enabled. Any attempt to obtain PM parameters information or set PM parameters will fail. Also PM-aware applications will not be able to communicate with the PM core. This is probably a bug that will be fixed in the future.

If you want the pmd daemon started each time you reboot the system, you may add the following line to the `/etc/inittab` file:

```
pm:2:once:usr/bin/pmd # Start power management daemon
```

A list of all current PM settings can be obtained with the following command:

```
# pmctrl -v
```

Current system state is enable.
List of registered PM aware DDs is as follows:
- rcm0
- mouse0
- kbd0
- fd0
- cd0
- lft0 (DPMS)
- ent0
- ent1
- tok0
- sa1
- sa0
- ppa0
- fda0
- pau0
- hdisk0
- scsi0
- ide1
- ide0
- rscpios

System idle timer is set to 20. (in minutes).
Duration of suspend to hibernation is set to disabled.
Action for notebook-lid close is ignored.
Action for main power switch pressed is transition to shutdown.
Action for low battery condition is ignored.
Action for system idle timer expiration is transition to standby.
Maximum state authorized for general users is set to standby.
Beep setting is set to on.
Resume password setting is set to on.
Ringing resume setting is set to off.
LFT termination setting is set to off.
TTY termination setting is set to off.
Syncd termination setting is set to off.
Timer for hibernation is set to disabled.
Timer for resume is set to disabled.
The PM GUI (xpowerm) can be used to control power management only after the PM system was successfully configured. The best way to have an overview of the PM functions you can control is using the PM GUI. See Figure 78 on page 143.

![Power Management Parameter Setting Menu](image)

Figure 78. Power Management Graphical User Interface

### 6.4 Possible Power Management Problems and Warnings

Before using the AIX Version 4.1.3 Power Management system, you should be aware of how the system works and how it may affect your environment and your applications (your music CD may just stop playing).

The possible problems and warnings listed here should help you recognize the problems:
Problems When Changing Configuration While Hibernating

Changing the physical configuration of the system while it is hibernated is not supported. This could result in a failed hibernation and a normal boot if the change is detected, for example, when adding or removing memory or when adding or removing an ISA adapter, and unpredictable results may occur if the change is not detected.

By default, the sync daemon is killed when entering standby so that the disk can spin down. This could cause data loss if the system loses power unexpectedly.

Booting From CD-ROM Directly After Hibernation

Accessing the filesystem by booting from CD-ROM after a hibernation (without "waking up" the system and performing shutdown before) will most likely result in file corruption when resuming from hibernation.

Requirements for Device Drivers to Support Hibernation

All device drivers must be PM-aware to support suspend or hibernation. Any device that IBM ships that is not PM-aware will come with a warning that the user should run the following command:

```
/usr/lib/boot/disable_hibernation
```

The command turns off the suspend and hibernation capability. This still allows other Power Management capabilities, such as system standby. If the non-PM-aware device driver is removed or replaced, hibernation and suspend can be re-enabled by using the following command:

```
/usr/lib/boot/enable_hibernation
```

Third-party drivers may not come with this warning; so unless the users read the Power Management pubs, they may not be aware of this restriction.

Possible Network Problems

No guarantees are made concerning network connections. The network adapters are powered off during suspend or hibernation. Although the adapter will be restored to its same state when resuming from hibernation, the state of the external connections will depend on the protocol, the application and the length of time the system was disconnected from the network.

Hibernation Logical Volume

Hibernation requires a logical volume the same size as the physical memory. The name and type of this logical volume is `pmhibernation`. The pmhibernation logical volume is created when the Power Management system is configured the first time after installation. It is checked every time the system is booted to see if it needs to be re-created or expanded. It is possible that there may not be enough space to create or expand the logical volume, in which case hibernation will not be configured. In this case, it is up to the user to free-up enough space for the pmhibernation logical volume.

System Standby State

Because of the nature of UNIX, it is very difficult to prevent periodic filesystem accesses, and therefore disk accesses, even when in standby state. For this
reason, it is difficult to spin-down the disk and prevent it from spinning up a couple of minutes later. One way to help this is to leave the default option active to kill the sync daemon when entering standby.

**Power Switch Behavior**

The power switch is software controlled, and the action taken when the button is pressed is configurable by the user. The power switch will not turn off the power immediately. Generally, it will run shutdown or hibernate and then turn the power off. On a hung system, the behavior depends on the hang. If no interrupts are being handled, it will power-off two seconds after the button is pressed. If interrupts are being handled but the system still appears hung, it may appear to do nothing.

**Difference Between PM Enablement and PM Configuration**

The SMIT menus have one option to disable/enable Power Management and one option to configure/unconfigure Power Management. There is a subtle difference. When PM is disabled, the system is in “full-on” state, but the Power Management daemon and kernel extensions are still loaded and running. When PM is unconfigured, all of these are unloaded; therefore none are running.
Diagnosing *Inactive System* related problems, including power-up and booting problems, is not easier nor more complicated on PCI-based RS/6000 systems (also called RSPC systems in this document) than on the microchannel-based RISC System/6000 systems (also called “classical” RISC System/6000 in this document). It is simply different and therefore requires you to apply different troubleshooting techniques than the ones you might know from your experience with the “classical” RISC System/6000 family. This is not only because of the different hardware architecture used on the RSPC systems but also due to the absence of the three-digit LEDs. AIX Version 4.1, however, is the same on any of the different platforms supported; therefore software-related problems are handled in exactly the same manner on all RISC System/6000 models. This chapter will introduce you to the “*Problem Solving Guide and Reference*” manual and will point out the areas where the procedures therein cannot be applied to RSPC systems.

In a second section in this chapter, we will help you identify and tackle power-up and booting problems. We will discuss how to use the System Management Services diskette to test your computer and how to use the AIX Problem Solving Tools.

Finally, we will provide you with some hints and tips that may help you when using or supporting RSPC systems.

### 7.1 Problem-Solving and Reference Guide

The main tool for problem determination on RSPC systems as on “classical” RISC System/6000 systems is the “*Problem Solving Guide and Reference*”, SC23-2606 manual. In case of problems, you should follow the methods and principles described there. However, sometimes it is impossible to do what the manual asks for. Especially when it refers to the three-digit LEDs, which are provided on the “classical” RISC System/6000 but do not exist on RSPC systems. This section shows what information in the manual is applicable to RSPC systems and where you have to interpret it differently. For example, if the manual asks you to insert the diagnostic diskette and to run certain tests against a device, you cannot do so because AIX diagnostics is not supported on RSPC systems. But if it suggests that you list the devices known to AIX, you certainly can.

The “*Problem Solving Guide and Reference*” manual contains different chapters that can be grouped into the following two major areas:

- Problem-Solving Overview
- Problem Solving Tools

#### 7.1.1 Problem-Solving Overview

The Problem Solving Overview includes a Symptom Index which is provided as your problem solving starting point. It points you to the various chapters included in the manual. Generally, we can classified the chapters in the following manner:
inactive system

This chapter is hardware-related and does not apply to RSPC systems. Information regarding hardware problems for RSPC systems is included in the System User’s Guide that was shipped with your computer, the Hardware Maintenance Manual and 7.5, “Hardware Diagnostics” on page 156 in this redbook.

Terminal Problems

This chapter is AIX oriented and applies to RSPC systems.

Inaccurate System Clock

The first part “Test the System Battery” cannot be performed on RSPC systems. The second part is AIX oriented and therefore applies to RSPC systems.

Device Problems

Most of this chapter is AIX oriented and applies to RSPC systems.

Media Problems

This chapter is AIX oriented and applies to RSPC systems.

Network Problems

Most of this chapter is related to the supporting software and applies to RSPC systems; however, keep in mind, that you have to maintain consistency between the values set on your ISA adapters (switches, EPROM, and so forth) and the values stored in the customized device part of the ODM database.

Printing Problems

This chapter is AIX oriented and applies to RSPC systems.

7.1.2 Problem-Solving Tools

The Problem Solving Tools section of the manual includes chapters that apply to the “classical” RISC System/6000 only. They are:

Hardware Diagnostics

The AIX diag command cannot be used on RSPC systems. Hardware tests on RSPC systems are run by using the System Management Services diskette. Refer to 7.5.2, “Running Diagnostics Tests” on page 158 for more information about hardware diagnostics on RSPC systems.

Error Logging Facility

This chapter refers to the AIX error logging facility which is the same on RSPC systems. However, there are some particularities that we want to point out in 7.6.7, “Using the Error Logging Facility” on page 165.

Trace Facility

This chapter refers to the AIX Version 4.1 trace facility and can be used on RSPC systems.
7.2 Handling Power-Up Problems

This section provides some specific information to the power-up initialization process of RSPC systems. Since there are no LEDs to give an indication about which phase in the booting process is being currently executed, the RSPC firmware uses optical and acoustical signals to provide you with some useful information.

This means, if the initialization process is unable to complete successfully, you will consider the problem is related to the last signal posted or the next signal missing.

7.2.1 Power-Up Initialization

We define power-up initialization as the code run when you power-on the system; it runs until the AIX-related code takes control of the system. This code is the RSPC firmware.

The power-up initialization takes approximately 30 seconds to complete. For a better understanding and interpretation of the signals displayed during initialization, we have divided it into four phases:

- Phase 1: Processor and memory controller tests
- Phase 2: Initialize graphics
- Phase 3: Initialize subsystem drivers
- Phase 4: Audio subsystem initialization

7.2.1.1 Phase 1

In the first phase, the processor and the memory controller are tested because at least some system memory must be available to create a working memory subset.

**Phase 1 - Successful**

A “beep” sound, immediately after power-on indicates a successful completion of phase 1.

If you hear the “beep” right after power-on, it means:

- The processor is operational.
- The memory controller managed to find the firmware code.
- At least some memory is available.
- The processor was able to load firmware instructions and data to system memory.
• The RSPC firmware is not corrupted, so far.

The final instruction of phase 1 is an audible “beep”. Refer to 7.2.2, “Handling Power-Up Failures” on page 152 if your system didn’t pass phase 1.

### 7.2.1.2 Phase 2

During the second phase, all system memory will be checked, and all memory blocks found bad will be marked accordingly.

**Note:** Keep in mind that the RSPC firmware only needs 3 MB of contiguous system memory, and therefore this phase may be passed without error, even though most of the system memory is marked bad.

Of course, AIX Version 4.1 will not come up with such a small amount of system memory available. Running the System Management Services memory test, however, will highlight your memory problem.

In this phase, the system I/O and the graphics subsystem are initialized, and the PowerPC logo code is uncompressed and displayed.

---

**Phase 2 - Successful**

If you see the PowerPC logo, this indicates a successful completion of phase 2.

---

If you see the PowerPC logo, it means:

- The system memory has been checked completely.
- The bad blocks and the number and sizes of the SIMMs have been stored in the system registers.
- The system I/O has been initialized.
- The graphics have been unloaded from system ROS and uncompressed.
- The graphics device was found and initialized.

The final instruction of phase 2 is to display the PowerPC logo (see Figure 79). Refer to 7.2.2, “Handling Power-Up Failures” on page 152 if your system didn’t pass phase 2.

---

*Figure 79. Initialization Phase 2. PowerPC logo.*

### 7.2.1.3 Phase 3

During the third phase, the drivers for the different subsystems are initialized.

In this phase, the devices located on the system board are checked. If any on-board device error is found, an attention triangle and an error code are displayed. The error code is also stored in a system error log (which is not the AIX error log) for future viewing. The error codes are documented in the System User’s Guide manual shipped with the computer.
In this phase, you will see the device logos (see Figure 80 on page 151) displayed.

### Phase 3 - Successful

If you see the device logos appearing, this indicates a successful completion of Phase 3.

If you see the device logos, it means:

- The firmware was scanned for device information.
- Devices on the system planar are checked.
- Errors are posted in the residual data for future use by the operating system.
- The firmware is not corrupted, so far.

![Figure 80. Initialization Phase 3. Devices' logos appearing.](image)

If the system made it to this phase, it means no critical errors have been found. Any detected errors will be displayed, but the initialization will not be stopped. If your diskette drive and your keyboard are operational, you will be able to perform hardware diagnostics by pressing F4 and accessing the System Management Services. See 7.5, “Hardware Diagnostics” on page 156 for more information about hardware diagnostics.

### 7.2.1.4 Phase 4

During the fourth phase, the audio subsystem is initialized. After all device logos are displayed, you will hear another “beep”. This second “beep” is displayed by the audio subsystem.

**Note:** The firmware on Power Series systems displays a “welcome tune” instead of a “beep”.
Be aware that, although the system uses the same speaker in both cases, this second “beep”, unlike the one in phase 1, is produced by the audio subsystem and is the last signal provided by the RSPC firmware.

---

**Phase 4 - Successful**

If you hear the second “beep”, this indicates that phase 4 completed successfully, and the audio system is operational.

---

After phase 4 is passed, the RSPC firmware tries to find a boot image and passes control to it (see 7.3, “Software ROS Initialization” on page 153). If a boot image is not found on any of the devices in the boot device list, the RSPC firmware displays an animated figure asking for the System Management Services diskette.

---

7.2.2 Handling Power-Up Failures

Normally, a defect device does not stop the RSPC firmware from booting. The process is stopped only if a critical failure (for example, processor test failure, no memory, interrupt tests failure) is detected. If this is the case, it is likely to happen in phase 1 or phase 2.

Once the system has passed phases 1 and phase 2, any detected errors will be displayed and also logged in NVRAM; the system will continue with the initialization.

Table 17 on page 153 shows the possible power-up problems and the suggested actions to perform.
### 7.3 Software ROS Initialization

When the RSPC firmware completes the power-up initialization, it follows the boot order list to find a device with a valid boot image. In the case of AIX Version 4 on RSPC systems, this boot image is not the AIX boot image but Software ROS (see 3.2, “Boot Components Specifically for AIX on RSPC Systems” on page 59).

You can recognize that Software ROS has been located and loaded into memory if the device icons at the bottom of the screen dissapear, or if you are booting from System Management Services, the bottom of the screen turns white. This is the only signal displayed by Software ROS. The time between the second “beep” in phase 4 and the display of the white bottom is approximately five seconds for local disk booting.

After that, you should see the disk activity indicator flashing (you will also hear this activity).

The last activity performed by Software ROS is to load the AIX boot image and pass control to it. If this is successful, the screen will turn black.
7.3.1 Handling Software ROS Problems

If the bottom of the screen stays white, two reasons are probable; either Software ROS is corrupted, or it could not find a valid AIX boot image. Since both boot components are stored in the boot logical volume, the boot logical volume is corrupted.

To isolate the problem, you may perform the following:
1. Boot from an AIX CD-ROM or over the network.
2. Select option 3 to start AIX in maintenance mode.
3. Select option 1 to access the root volume group, and start a shell.
4. Display information about the boot logical volume by using the following command:
   `lsvg hd5`

   The information displayed should be similar to the following screen:

   ```
   # lsvg hd5
   LOGICAL VOLUME: hd5 VOLUME GROUP: rootvg
   LV IDENTIFIER: 003060078b726e87.9 PERMISSION: read/write
   VG STATE: active/complete LV STATE: closed/syncd
   TYPE: boot WRITE VERIFY: off
   MAX LPs: 128 PP SIZE: 4 megabyte(s)
   COPIES: 1 SCHED POLICY: parallel
   LPS: 1 PPs: 1
   STALE PPs: 0 BB POLICY: relocatable
   INTER-POLICY: minimum RELOCATABLE: yes
   INTRA-POLICY: edge UPPER BOUND: 32
   MOUNT POINT: N/A LABEL: None
   MIRROR WRITE CONSISTENCY: on
   EACH LP COPY ON A SEPARATE PV ?: yes
   ```

   If the no information is displayed or the information is corrupted as shown in the screen below, your boot logical volume may be corrupted.

   ```
   LOGICAL VOLUME: hd5 VOLUME GROUP: rootvg
   LV IDENTIFIER: 003060078b726e87.2 PERMISSION: ?
   VG STATE: active/complete LV STATE: ?
   TYPE: boot WRITE VERIFY: ?
   MAX LPs: ? PP SIZE: ?
   COPIES: 1 SCHED POLICY: ?
   LPS: ? PPs: ?
   STALE PPs: ? BB POLICY: ?
   INTER-POLICY: minimum RELOCATABLE: no
   INTRA-POLICY: edge UPPER BOUND: 32
   MOUNT POINT: N/A LABEL: None
   MIRROR WRITE CONSISTENCY: ?
   EACH LP COPY ON A SEPARATE PV ?: yes
   ```

5. Try to "repair" the boot logical volume by using the following command:
   `bosboot -a -l /dev/hd5 -d /dev/hdiskY`

   Where Y is your disk number.

6. If you get an error message, for example like this:
0301-108 /usr/sbin/mkboot: Unable to read file blocks. Return code: 0
0301-158 bosboot: mkboot failed to create bootimage.
0301-165 bosboot: WARNING! bosboot failed - do not attempt to boot device.
then create a new boot logical volume using the following commands:

```
    mklv -y hd5X -t boot -a e rootvg hdiskY
    bosboot -a -l /dev/hd5X -d /dev/hdiskY
```
Where Y is the number of your disk and X is any user-selected number.

7. Reboot the system

Note: You may want to run the bosboot command to override the boot image on
your boot disk even if the boot logical volume appears to be correct. The boot
image still may be damaged.

### 7.4 Handling AIX Boot Problems

Shortly after the screen turns black during the booting process, you should see
the familiar green characters displaying the AIX configuration information, or if
you have installed the Common Desktop Environment, you will see the message:

```
Starting Desktop Login............
```

The screen will turn black again. After a few seconds, the graphical AIX logo is
displayed.

<table>
<thead>
<tr>
<th><strong>CDE and Network Problems</strong></th>
</tr>
</thead>
</table>
| If there is any physical failure in your configured network, you will experience
| a very low start of the CDE environment (it almost seems to hang). If this is
| the case, do not use CDE. Use the “Command Line Login” option, and fix the
| networking problem before using CDE. |

Any problems found in this phase are AIX configuration problems and should be
determined as in any “classical” RISC System/6000. Following are some hints
and tips which may “refresh” your problem determination ideas:

1. Boot your system in maintenance mode following the procedure described in
   7.6.1.1, “Booting in Maintenance Mode” on page 160.
2. Access the root volume group by choosing option 2 to start a shell before
   mounting the file systems.
3. Use the `fsck -y` command to check and fix your file systems.
4. If errors are indicated from any of the `fsck` commands, run the following
   command:
   ```
   /usr/sbin/logform /dev/hd8
   ```
   The system asks you if you want to destroy your log. The answer should be
   yes. Then `logform` reformats the log logical volume.
5. Enter `exit` to continue the process of accessing the root volume group and mounting the file systems.

6. Check your `/etc/inittab` file.

7. Verify that there is sufficient space left in your filesystems. The most important filesystems to check are `/tmp` and `/var`.
   - If `/tmp` is full, make space available. Remember, no data in `/tmp` is required for your next reboot, but if there is no space left, you might not be able to boot.
   - If `/var` is full or near full, investigate the reason
     - `du -ka /var | more` shows the sizes in KB of all files in the `/var` directory.
     - If `/var/adm/ras/errlog` is unusually large (>1 MB), look at its contents, by using the `errpt -a | more` command, and if required, save the file to any filesystem that has sufficient space available.
     - Reduce the size of the `errlog` file by using the `errclear 2` command to delete all entries older than two days.

8. Check the error log. If there were any error messages posted during the boot process, take them as the entry point for your further problem determination.

9. Reboot your system with the command `shutdown -Fr`

10. If the problems persists and you still have no indication to the cause of your problem, continue as you would on any RISC System/6000 running AIX. This includes:
    - Calling your support structure
    - Reinstalling from your most recent backup

### 7.5 Hardware Diagnostics

Testing the RSPC systems hardware components must be performed in a different way than what you are used to from the “classical” RISC System/6000. The AIX Version 4.1 diagnostics package does not support RSPC systems. Instead, the `Test the Computer` option of System Management Services must be used.

The Test the Computer option provides two functions:
- Ability to display the RSPC error log
- Ability to run hardware diagnostics

#### 7.5.1 Displaying the Error Log

During firmware initialization, some system hardware components are tested. If the initialization process finds a non-critical hardware problem, the process does not stop but displays an error code and posts an entry in the error log stored in NVRAM. This error log is not the AIX error log.

The following procedure describes how to display the error log:

1. Insert the System Management Services diskette, and reboot the system.
2. When the first screen appears, press F4 (you may also press F1 to use the graphical version of System Management Services but the ASCII version has more diagnostics features).

3. Select option 3, Test the Computer. You will see that the hardware diagnostics files are loaded from the System Management Services diskette.

4. When the Select Device to Test menu appears (see Figure 82), press F9.
   
   If there are any entries in the log, you will see a display similar to Figure 83.

5. The error codes are documented in the System User’s Guide shipped with the computer and in the Hardware Maintenance Manual.
   
   Only two error entries can be displayed. An entry number x indicates that an entry has been overwritten. Of two entries, the second will always be overwritten.

   If there are no entries in the error log, it does not mean all the hardware components are working fine. It only means that no errors were detected during the basic initialization tests. In case of doubt, proceed to run the diagnostics as described in the next section.
7.5.2 Running Diagnostics Tests

Once you have displayed the error log and referred to the documentation to look up the error codes, if any, you may press the **Esc** button to return to the *Select Device to Test* menu.

The Select Device to Test menu will display all device subsystems detected by the computer for which diagnostics programs are available.

You can run tests on all subsystems or on specific subsystems which you can select by using the space bar. By pressing **F4**, you will be able to select test parameters for some subsystems. This is especially useful when testing network adapters. For example, test parameters are:

- Enable/disable interactive mode
- Enable/disable wrap mode
- Enable/disable stop on error
- Enable/disable loop mode

Pressing **F6** will run the test or present you with another selection menu, depending on the subsystem you selected. The subsequent menus are self explanatory.

If a device test failed, you will see an error message similar to Figure 84.

![Figure 84. Example Error Message from Device Tests](image)

Again, you can use the *System User’s Guide* or the *Hardware Maintenance Manual* for a description of the error codes displayed.

7.5.2.1 Base Diagnostics Supported

Hardware diagnostics are provided for the following system board integrated devices and additional subsystems:

- System board integrated subsystems
  - System board (processor, interrupts)
Memory
Serial and parallel ports
Business audio
SCSI controller
IDE controller
Diskette controller
PCI Ethernet

- Additional subsystems
  S15/E15/GXT150P video graphics
  Keyboard and mouse
  SCSI (hard disk, CD-ROM, R/W optical)
  IDE (hard disk, CD-ROM)
  Diskette
  L2 cache
  ISA token-ring, ISA Ethernet, ISA X.25

The System Management Services software provides for integration of additional diagnostics as they become available. This is especially useful when thinking of third-party device providers.

### 7.5.3 Hardware Test Limitations

The following limitations apply to the test environment:

- Where diagnostic coverage is as high as possible, intermittent or timing-related hardware errors seen at the operating system level may not be detected.
- Some hardware errors may prevent the diagnostic programs from being loaded.
- There are no tests for external attached devices.

### 7.6 Miscellaneous Hints and Tips

The hints and tips presented in this section are meant to assist you in answering questions specific to RSPC systems and in performing some basic administrative tasks.

#### 7.6.1 Starting System Management Services

The System Management Services programs are intended for system administrators and trained service personal who might be required to make technical changes to the system configuration and data. These programs are available in English only.

Although most of the System Management Services programs are already installed in flash ROM on the computer, to access the System Management Services programs, you need an System Management Services diskette with the same firmware version as the one currently installed on the system. To know which firmware version is installed, you can use any System Management
Services diskette and follow the procedure described below. The firmware version will be displayed in the upper-left corner.

If you have an System Management Services diskette with a different firmware version, you will still be able to use options 2 “Select boot devices” and 4 “Utilities”, but you may not be able to use option 1 “Manage the Configuration”.

Since option 3 loads diagnostics files from the System Management Services diskette, you may not be able to run tests on all subsystems. Thus, the recommendation is to use a System Management Services diskette with the same firmware version.

To access the System Management Services programs, proceed as follows:

1. Insert the System Management Services diskette into the diskette drive, and turn the power on or restart your computer.
2. As soon as the first screen appears, press F4. The RSPC firmware will access the diskette and display a menu similar to the one on Figure 85.

![Figure 85. System Management Services. Main menu.](image)

The menus provided with the System Management Services programs are easy to understand, and they are used in the chapters related to them in this book.

### 7.6.1.1 Booting in Maintenance Mode

Sometimes you need to boot the system in maintenance mode. Since on RSPC systems we don’t have switch keys to select different positions (normal, secure, and service) as we do on “classical” RISC System/6000 systems, accessing the maintenance mode is performed in a different way on RSPC systems.

You can access the maintenance mode by using a bootable AIX CD-ROM or over the network if you have set up a Network Installation Manager (NIM) environment. To access the maintenance mode, perform the following steps:

1. Access the System Management Services programs (see 7.6.1, “Starting System Management Services” on page 159)
2. Select **Boot Devices**.

3. Select the **Boot Other Device** option.

4. Select one the following two options:
   - CD-ROM - if you have an AIX CD-ROM
   - Network Adapter - if you have a NIM master and want to boot over the network

   In either case, the bottom of the screen should become white. When booting over the network, it can take up to two minutes before the bottom of the screen becomes white.

   Thirty seconds later (two minutes in the case of network booting), the screen will become black, and after some more seconds, the well-known AIX installation screen will appear.

5. Select the console you want to use.

6. Select the language you want to use.

   A screen similar to the following one appears:

   >>> 1 Start Install Now with Default Settings  
   2 Change/Show Installation Settings and Install  
   3 Start Maintenance Mode for System Recovery  

   Choice [1]: 3

   Figure 86. Installation and Maintenance Screen

   → Select 3 to Start Maintenance Mode for System Recovery

### 7.6.2 Handling Network Installation Problems

When performing network installation, the most difficult part is configuring the NIM Master and the resource objects for the client.

A step-by-step procedure and a list of the required filesets are provided in Chapter 4, “AIX Version 4 Network Installation” on page 77.

If the NIM Master setup is correctly, the only source for a problem will be physical connection. The System Management Services programs include a ping facility that can be used to test the physical connection. The way to access the ping facility is also explained in the Network Installation chapter. For the ping to be successful, the target system and all gateways must be running the TCP/IP protocol. If you are not using a gateway between your RSPC system and the NIM server, the gateway IP address should be the same as the server IP address.

### 7.6.3 Updating the Firmware

The RSPC firmware contains the initialization code necessary to bring up your system.

--- Careful When Updating the Firmware ---

This firmware code is crucial for the system; if corrupted the system planar may need to be replaced.
However, a firmware update may be necessary as it is when installing the RISC System/6000 Model 40P 604 PowerPC processor upgrade. In this case, you should use the firmware upgrade utility provided with the System Management Services programs.

Perform the following steps:

• Access the System Management Services (see 7.6.1, “Starting System Management Services” on page 159).
• Select option 4, Utilities
• Select option 7, Update System Firmware
• The system will display a message recommending that you create a firmware recovery diskette. Well, this is not only a recommendation; you should not risk anything at this point (imagine a power failure exactly at the wrong moment).
• Remove the System Management Services diskette, and insert a DOS formatted, write-enabled blank diskette, and press Enter.
• Once the recovery diskette is created, you may continue updating the firmware.

Firmware Recovery Diskette

The firmware recovery diskette does not a guarantee that the system will boot if the firmware upgrade process was interrupted, but it increases the chances of “saving” your system planar.

7.6.3.1 Recovery from a Failed Firmware Update

The firmware includes a boot block program which executes only when the system is powered-on after a failed firmware update or when a firmware update has been interrupted. The boot block program will reload a soft-executable image of the firmware from the recovery diskette.

To start the Recovery Operation, insert the firmware recovery diskette into the diskette drive and power-on the system. If you are lucky enough, the recovery process will be started automatically. There is no visible user indication that the Recovery Operation is in progress. If the system does not restart within two minutes, the system planar has to be replaced. No other recovery means are available.

If the Recovery Operation is successful, it does not mean that the firmware has been repaired. It just means that the system could start using a soft-copy of the firmware. In this case, you will have to reattempt a firmware update. If the firmware update fails repeatedly, the system planar will need to be replaced.

7.6.4 Setting the System Passwords

The System Management Services programs include the capability for setting two different passwords:

• Power-on password
• Supervisory password
The only way to reset the passwords, if you forget them, is by removing the battery for 30 seconds.

**Warning!**

When you remove the battery, you will lose other user-configured data as well, such as system configuration data, SCSI controller ID, date and time, and boot order list. All of these will be reset to the default values.

Be careful when removing the battery. The battery retainer is very fragile and breaks easily.

### 7.6.4.1 Power-On Password

When the power-on password is set, the system will ask for this password each time it is powered-on, unless the *Enable Unattended Start Mode* feature has been selected (see 7.6.4.2, “Unattended Start Mode”).

You have to enter the password, and press the Enter key. After three failed tries, you will have to power-off the system and restart again.

### 7.6.4.2 Unattended Start Mode

This mode is useful for computers, such as print servers or network servers, that operate unattended. If a power failure occurs, the computer automatically restarts and resumes normal operation without operator intervention when power returns. Of course, the *Unattended Start Mode* needs to be enabled only if you are using a power-on password. If you are not using a power-on password, the start mode is already unattended.

What is the point of setting a power-on password and going around it by enabling *Unattended Start Mode*? The purpose of this mode is to keep the keyboard and mouse locked. This works only until AIX takes control of the system.

Why do you want to lock the keyboard and mouse before AIX is started? This is done to prevent access to the System Management Services, but for this purpose, the supervisory password is provided. In other words, the *Unattended Start Mode* has no use when AIX is used as the operating system.

### 7.6.4.3 Supervisory Password

The supervisory password protects against the unauthorized access to the System Management Services programs. When a power-on password and a supervisory password is used:

- If you want to boot the operating system without accessing the System Management Services, only the power-on password is needed.
- If you want to access the System Management Services programs, only the supervisory password is needed after pressing F4 or F1. From there, you can start the operating system.
7.6.5 Setting the Machine Serial Number

Some (maybe most) RSPC systems come with a generic serial number FFFFFFFF instead of a unique serial number. The serial number used by AIX can be displayed with the `uname -m` command. The output of this command on the 40P will be similar to the following:

```
00FFFFFF4D00
```

On the 43P, it will be:

```
00FFFFFF4C00
```

The six F’s represent the system unique identifier (in this case not unique); 4D and 4C are model identifiers.

The System Management Services provide a utility to change this serial number to any specified value. The serial number is a 16-digit number which will be passed to AIX through the residual data. AIX takes the digits 11 thru 16 as the system unique identifier.

To change the serial number, proceed as follows:

1. Access the System Management Services
2. Select option 4, Utilities
3. Select option 9, View or Set Vital Product Data
4. When the menu appears, select Serial Number
5. Enter the serial number you want to assign to your RSPC systems

7.6.6 Entering the Kernel Debug Program

To access the kernel debug program when using RSPC systems, you will need an ASCII terminal, for example an IBM 3151, attached to one of the native serial ports. Perform the following steps:

1. Attach an ASCII terminal to one of the native serial ports, and configure it as a tty using the following values:
   - Baud rate 9600
   - 8-bit character, no parity, 1 stop bit
   - xon/xoff protocol
   - Enable LOGIN = share or enable

   After the tty is added, a login prompt should appear on the terminal.

2. The kernel debug program must be built into the kernel. This is done by invoking the following command:
   ```
   bosboot -a -D
   ```

   The above command will enable the kernel debug program in standby mode after the next reboot.

3. Reboot the system.

   The system will display the login prompt on both the console and the tty. You can log in and work as you normally do.

4. Go to the tty and press the combination Ctrl-.. This will invoke the kernel debug program. This key combination is also valid for most OEM terminals; however, on some IBM 3151 terminals using a cartridge, you have to press Ctrl-NumPad4.
5. When the kernel debug program is entered, the system is stopped. You can exit the program, and continue using your system by entering the `go` command on the ASCII terminal.

6. To eliminate the kernel debug program capabilities, you will have to enter the following command:
   
   `bosboot -a`

   and reboot the system.

   **Note:** To find out whether the kernel debug program is enabled on your system, you can use the following as a root user:
   
   `crash`
   
   `> od dbg_avail`

   If the `od` command returns a 0 or a 1, the kernel debug program is available. If it returns 2, the program is not available, and the `bosboot` command, as shown in step 2, has to be run to enable it.

### 7.6.7 Using the Error Logging Facility

Problem determination is much easier when you have some information about the nature of the problem you ran into. As a system administrator, the first task you should accomplish is to make sure the AIX error logging features are installed and configured.

The error logging features are provided within the `bos.sysmgmt.serv_aid` fileset. Use the following command to check to see if the fileset is already installed:

`lslpp -l bos.sysmgmt.serv_aid`

You may also want to run the Automatic Error Log Analysis features provided within the `bos.diag.rte` fileset. This includes the `diagela` command (see the *Problem Solving Guide* manual for details).

### 7.6.8 Using the System Dump Facility

The AIX dump facility is also included in the `bos.sysmgmt.serv_aid` fileset. By default, whenever a dump is generated, it is written to the paging space. The next time you boot your system, AIX will look for a dump in paging space, and if it finds one, you will be prompted to copy the system to tape or to diskette. On the other hand, it is also possible to define a directory into which AIX copies any dump that it finds in paging space at boot time.

If you have enough space on your hard disk, it would be a good idea to set up your system to automatically copy any generated system dump from paging space to a directory. To do this, perform the following steps:

1. Find out how much space your system dump requires. Enter the following command:
   
   `sysdumpdev -e`

2. Create a filesystem at least the size determined in the previous step, and mount it.

3. Use the following SMIT fastpath:
   
   `smit dump`

   `→ Change the Directory to which Dump is Copied on Boot`

   or enter the following command from the command line:
sysdumpdev -d filesystem mount directory

Starting a Dump

On RSPC systems, there are only two ways of forcing a dump generation. You can do it by using the SMIT fastpath, smit dump, or you can use the sysdumpstart command.

7.6.9 Information Sources

For more ideas and discussion about PowerPC-based systems, you may access the following sources:

- The PowerPC News under http://power.globalnews.com/ppchome.htm
- POWERPC forum in the IBMUNIX disk
- POWRPERS forum in the IBMPC disk
Chapter 8. HUMAN-CENTERED Technology

HUMAN-CENTERED technology is a new vision of computing centered around our natural senses and our way of working. A HUMAN-CENTERED system adapts to the user’s natural way of communicating and performing tasks, instead of imposing its own work patterns. This methodology requires less adaptation from users, and allows for shorter learning curves in addition to bringing a conversational and more engaging working environment.

The HUMAN-CENTERED technology is evolutionary in the sense that it follows the current trend towards more intuitive user interfaces. It is also revolutionary, as it can change dramatically the way we interact with computers, talking to them in natural language instead of through long sequences of commands or mouse movements. The intelligence and user-friendliness of HUMAN-CENTERED applications promises to increase our productivity, while it reduces the time and money spent in the process of adapting the user to the computer.

To increase the flexibility and ease of use of an application, we can involve more human senses in the man/machine interaction. The computer should respond to voice commands, be able to process video signal and receive touch input.

The HUMAN-CENTERED computing system conforms to people to make working with the computer more intuitive. You don’t have to learn complex commands or a series of computer-driven tasks. Instead, the computer should be capable of responding to voice commands, recognize your handwriting and react to your idiomatic words and gestures. If your command is ambiguous, it should ask for more information to specify your needs.

Using innovations in voice, touch and pen recognition, this technology might well replace the point-and-click interfaces of today. The goal is to use the processing power of the machine to make the computer easier to use, not just to run the standard applications faster.

One of the goals of HUMAN-CENTERED computing is the integration of the many diverse devices — fax, personal organizers, telephones, computers, even TV — that people use everyday in one desktop or portable computer. This means that you will use the computer to communicate with others in a richer way than you do today with the fax or telephone.

HUMAN-CENTERED applications, such as voice recognition and real-time video processing, can exploit the outstanding floating-point performance of the Power PC chip. This way, we can achieve better throughput without the need for expensive, specialized hardware. With the digital signal processing performed in software instead of hardware, PowerPC-driven machines can deliver HUMAN-CENTERED functions at very attractive prices.

8.1.1 Why HUMAN-CENTERED?

Making the human/machine interaction so much easier seems like an enormous task, but there are strong economic reasons which support this effort. A famous study by the Gartner Group shows that the larger cost of a computing systems is in the End User Operations (see Figure 87 on page 168).
This survey analyzes the lifecycle of an end-user computer (a Windows system, for example) from the time of acquisition through the asset disposal. We can see that the system costs (this is, hardware and software) comprise only the 17 percent of the total at the year of purchase. Five years later, the total cost of end-user computing has been almost duplicated, and the system cost percentage has dropped to 12 percent.

Trying to save only in the “system” area overlooks where the much larger costs reside: end-user costs. Total costs for end-user computing have skyrocketed over the years, while hardware costs have been continually declining.

Sixty percent of the end-user cost is in formal/casual learning and the “futz” factor — playing around with the system, making cosmetic changes to documents, users trying to make upgrades or changing their computing environment on their own (see Figure 88 on page 169). It is believed that HUMAN-CENTERED technology will greatly reduce these costs. Even if we can only reduce the costs of this segment by 10 percent, we will save more money than by cutting the “system” costs in half.

HUMAN-CENTERED systems adapt to the user’s needs. Users learn faster to use these systems because they are relieved from the burden of having to translate complex tasks into instructions for the computer.
8.1.2 Cutting the Underground Support Costs

Underground support is informal support independent of internal support provided by peers or by department-purchased outsourcing. This kind of support amounts to a 30 percent of the total end-user operations cost.

Informal support is a growing cost on nearly all companies. This used to be a hidden cost, but now a great deal of effort is being applied to measure it. Consultants, such as Gartner, Nolan, Norton and others, estimate that informal support is as big a cost as formal support.

If the computer could give you technical support and adapt itself to your way of working, then the costs of support (formal and informal) would be significantly reduced. Context-sensitive help and hands-on training software is a key area for applying HUMAN-CENTERED techniques.

If we hear about a new technical topic, we retain 20 percent of what we have heard. If we add the visual factor we will retain more. We will retain the most if we have "hands-on" interaction. Smart, interactive education software that lets us learn as we experience the new concepts is the way to achieve the fastest and most durable incorporation of ideas.

The revolution of the human/machine interface that HUMAN-CENTERED systems promise is a possible way to bring users into a faster learning and more productive work environment.
8.2 Examples of HUMAN-CENTERED Computing

HUMAN-CENTERED computing was forecast by major consultants at the beginning of the 90s, but was not achieved as soon as predicted. As faster processors, such as the PowerPC, become increasingly available, HUMAN-CENTERED functions can be made widely available instead of being restricted to niche-vertical applications.

Some areas that will benefit with the introduction of these new technologies are:

8.2.1.1 Security
Handwritten and voice signature. The system will be able to recognize signatures written with a pen on a sensitive monitor. The speech recognition system will be able to identify the speaker’s voice for authentication purposes.

8.2.1.2 Dictation
We can record court proceedings, medical reports, interview notes and meetings. The system will be able to understand our continuous speech and distinguish between homophones (such as “two” and “to”).

8.2.1.3 Voice Response Systems
Computers will be able to listen to the customer instead of requiring keypad responses. Customers will be able to buy goods by telephone, speaking directly to a computer which will be able to understand their commands and ask questions if needed.

Let your imagination fly and many more HUMAN-CENTERED applications will come to mind. We interact with other people in a myriad of different ways; HUMAN-CENTERED computing will enable us to make computers emulate some of these interactions.

8.2.2 HUMAN-CENTERED Collaborative Computing
Today, our working environment is overpopulated by a myriad of different devices. All of them have idiosyncrasies that we have to overcome in order to communicate effectively with others and get some work done.
The goal of collaborative computing is to use the computer like you use your telephone today. You call someone (or do a conference call) to work together. This technology allows multiple parties to work together over their computers and interchange information in many different formats.

Today, too many devices populate our desktops: fax, modem, telephone, computer, personal assistant and pager. The user interfaces of these appliances is usually restrictive and not very intuitive. Also, we have multiple communication paths (each one with its own codes and limitations) that we have to master in order to communicate effectively with others. For example, the loss of the voice inflections in today’s electronic mail often leads to the misinterpretation of the message’s content. Telephone conversation preserves the voice inflections but the body language is lost.

Collaborative computing has a lot of advantages over today’s E-mail interchange, fax and telephone conversations. Once the connection is established, you can talk to others and see them in your screen. You can use a whiteboard as a piece of paper to help you explain an idea.

You and your partner can jointly access and modify information; for example, two or more people could participate simultaneously in the editing of a document or write on a screen together. As information is interchanged in more formats and more senses are involved, the interchange of ideas is faster and less prone to misunderstandings.

The new PowerPC-based systems will be able, due to their higher processing throughput, to perform audio and video compression/decompression in software without the need of additional hardware. This makes for faster communication of these bandwidth-consuming data formats.
8.2.3 Conversational Applications of HUMAN-CENTERED Computing

Speech is perhaps the most universal way of human communication. One of the goals of HUMAN-CENTERED computing is to allow you to interact with your computer in the same way you interact with other human beings. The man/machine interface should be natural and intuitive, and speech is perhaps the most intuitive of all means of communication.

HUMAN-CENTERED technology will enable you to talk with your computer. In the near future, the machine will understand your continuous speech, take note of your commands and reply with appropriate questions to better understand your needs.

You will not need to translate your commands to keyboard and mouse; instead, the computer will understand your conversation or the gestures made with a pen or stylus. The performance of the PowerPC processor takes the speech and handwriting recognition technologies to a new price/performance level. Thus, PowerPC-based machines are the ideal platform to implement new ways of human/computer interaction.

For example, suppose that you want to read your electronic mail. A HUMAN-CENTERED system will try to sort your mail list in a predetermined order and ask you if you want your manager’s note first. If your answer is yes, the next time your manager’s mail will be the first of the list without your having to ask for it. This kind of interaction, where the computer takes intelligent decisions based on your past behavior and asks you when it needs more information is perfectly suited to be carried verbally.

Another use for the conversational systems will be telephony agents that can respond to spoken commands from the users instead of requiring touchpad keystrokes.
8.3 Intelligent Agents

The HUMAN-CENTERED interface is based on intelligent agents. Agents are capable of working on their own, and they run on the background of software programs. Every agent is responsible for one kind of application (managing E-mail, keeping a list of “hot” work items, managing the communications subsystem). Agents will interchange information between themselves without requiring the user’s explicit demand. Based on Artificial Intelligence, agents will enable the computer to understand natural language commands and responding with a complex series of tasks.

Intelligent agents will not only act on instructions, they will also learn to manage your workload. While you are working with the system, an agent will record your activities, remembering the system’s behavior and learning from it. The agent can even appear on the screen as an animated character or “actor” incarnating your computing experience. The agents will try to interpret your actions and tailor the working environment to better fit your needs. This represents a radical departure from the classical command line interface or even the most advanced of today’s GUIs.

8.3.1 Speech Recognition

Speech recognition techniques allow us to speak directly to the machine, instead of resorting to the keyboard or mouse. This will enable even the casual or uninitiated user to interact with the computer easily and productively.

8.3.1.1 Navigation

You can use speech as input to control your system. With your voice, you can tell the computer which object you want to work with and perform operations on it.

8.3.1.2 Dictation

This function enables you to dictate letters, documents, and so on, to the computer. The system is capable of understanding your speech and writing down what you have said. This kind of application can be useful to record court proceedings, interviews and spoken word in general, without having someone to write them own or having to write them down yourself.

8.3.1.3 Speaker Dependent and Speaker Independent Applications

Some applications will be speaker-independent; that is, everybody will be able to access them. On the other hand, other applications will only be accessed only by authorized users.

The vocabulary of the machine (the number of words the machine can understand) will vary from one application to another. Speaker-dependent applications can have a larger vocabulary, while the number of recognized words for speaker-independent applications will certainly be smaller, as more processing is needed to recognize a spoken word without knowing the person speaking.
8.3.1.4 Continuous vs. Discrete Speech

Discrete speech requires a distinctive pause between words in order to recognize them. Continuous speech, on the other hand, recognizes our words as we speak normally. In a dictation program, continuous speech recognition will be preferred, since that is our usual way of speaking. Navigation utilities, on the other hand, will likely require a pause between each command we give the computer.

8.3.2 Actors in HUMAN-CENTERED Computing

We have been dealing with the concept of “talking to your computer.” In most of the occasions, this will involve the existence of a “talking head,” a visual representation on your screen that you will speak to.

![Image of an animated character](image.png)

**Figure 92. Actors.** An Actor is an animated character to embody the interaction between the human and the intelligent agent. The actor in this figure is Fred, a talking head included as part of the IBM Ultimedi Services 2.1.2 demos.

These visual representations are called “actors,” and they personify the computer system. The user can talk to the actor so he has the impression of talking to a person instead of a machine. The actual work is done by the agent, and the actor is just a picture to make the uninitiated user feel more comfortable.

Actors will be able to answer questions you ask them, and also ask questions to better understand your requirements. Then, they will pass this information to the agent beneath, who will use it to accomplish your requirements.

Many mundane tasks could be done by actors and agents that are done today by humans, including several low-level secretarial chores. Some examples are sorting your electronic mail, organizing your calendar, extracting interesting information from newsgroups or bulletin boards, and so on.
8.3.3 Touch/Pen

The pen is an alternate method to the keyboard for inputing information into the computer. The handwriting recognition technology is able to recognize words as you write them. You can write directly on a touch-sensitive display screen and easily send your drawings or handwritten letters to other users.

Pen is a promising technology that seems well suited for a number of specific applications and environments, such as command and control, handwriting recognition, recognition of gestures, and freehand drawing. It is a natural and intuitive way of communicating to a computer and can be preferable to a mouse in certain applications.

In the future, displays with dual sensing modes will be able to receive written input from a pen or sense the touch of a finger. Also, gestures made with a pen will become a natural way to navigate through the information space.

8.4 Evolution of HUMAN-CENTERED Technology

The introduction of HUMAN-CENTERED technology is a logical step on the evolution of computer interfaces. The user/machine communication has evolved from the teletypes and character-based terminals of the past to today’s Graphical User Interfaces. HUMAN-CENTERED systems follow this trend in the pursuit of a more intuitive and productive computing experience.
However, from the point of view of computer users, the HUMAN-CENTERED systems appear as a revolutionary advance in the way we interact with computers. Users will no longer have to adapt themselves to a variety of machines and learn lots of commands ranging from the cryptic to the bizarre.

Graphical User Interfaces are more intuitive and easy to use, but research indicates that most of the users require more flexibility. Double- or triple-clicking on a mouse, or dragging a lightbulb onto a filesystem to mount it might not be intuitive enough for the uninitiated. The concept of users being able to make choices instead of computer imposing work patterns is the essence of HUMAN-CENTERED computing.

It is also important to expand the number of human senses involved in the computing experience (sight, sound, touch) and the range of media to work with (alphanumeric text, sound, images, even full-motion video). HUMAN-CENTERED computing promises to give us a more natural interaction between us and our computers and increase our productivity. It promises us a working environment in which we can make decisions and have our computer act according to them instead of being forced to following complex protocols to have our work done.
When the computers can understand our idiomatic expressions, respond to our gestures and ask us questions to eliminate ambiguity, the way we work with computers, and finally the way all our work is done, is likely going to become dramatically improved.
Chapter 9. Ultimedia Services

The RISC System/6000 Model 40P software package includes the IBM Ultimedia Services 2.1 for AIX Version 4.1. This software is not included with the RISC System/6000 Model 43P Series although it is required to exploit the 43P’s multimedia capabilities.

IBM Ultimedia Services 2.1 provides the desktop tools and utilities you need to add audio and video support to AIX. It provides device control for the business audio input/output devices included in the PCI-based RISC System/6000 and in the Power Series workstations. The newly announced IBM Ultimedia Services 2.1.2 includes the following additional support:

- Video monitor and capture support for the IBM Video Capture Enhancement adapter. Now available also for the 40P/43P.
- An application programming interface (API) and image viewing tools for Kodak Photo CD image technology.
- MPEG1 movie player using IBM’s soft MPEG technology.
- Player and API support for INDEO 3.2.

The IBM Ultimedia Services 2.1 object library provides facilities for working with audio and video at three levels. The first is the ability to play digital media, and the second is the ability to edit that media. The third level is for programmers writing their own applications and accessing service objects. Service objects provide playback of digital media, file access, video compression and decompression, filtering of audio data, and device access. These objects can be used to write more powerful applications.

The first two levels of media access can be achieved through Graphical User Interfaces (GUI) which support video and audio services. The third level is accessible through the IBM Ultimedia Services 2.1 application programming interface (API) based on the System Object Model (SOM) technology.

In this chapter, we will introduce some concepts about the basic operation of the graphical user interfaces (GUIs). The programmer can find more information about the APIs in the Ultimedia Services Version 2.1.2 for AIX: Programmer’s Guide and Reference manual. This manual covers important topics about Ultimedia Services objects and the services they provide for accessing and modifying audio and video files.

The Graphical User Interfaces included in IBM Ultimedia Services 2.1 for AIX Version 4.1 are divided in three groups:

- Multimedia Tools
- Multimedia Demos
- Speech Tools

The goal of these graphical utilities is to provide intuitive, easy-to-use multimedia recording, editing and playback for the AIX Version 4.1 user. They automatically recognize attributes, such as media types, data formats and compression schemes. Designed to support industry-standard audio and video formats from PC and workstation environments, these applications promote the
sharing of audio and video information while protecting the investment in
existing hardware, software and media content.

9.1 Installing Ultimedia Services

When you buy a RISC System/6000 Model 40P, you should also receive two
CD-ROMs with the package:

1. AIX Version 4.1 for Clients
2. IBM Ultimedia Services 2.1 for AIX

In the case of the RISC System/6000 Model 43P, IBM Ultimedia Services 2.1 is an
optional License Program Product (LPP).

Before installing IBM Ultimedia Services 2.1, you will have to install the bos.som
fileset which is stored in the AIX Version 4.1 for Clients CD-ROM. This fileset
contains support for the System Object Model, which is a prerequisite for
installing the Demo packages and the Ultimedia Services object library. Once
this fileset is installed in the machine, you will be able to install IBM Ultimedia
Services 2.1 which is contained in the second CD-ROM provided with the
package.

To install the bos.som fileset and the IBM Ultimedia Services 2.1 software,
proceed in the same way as installing any AIX LPP software. You can either use
SMIT or the Visual System Manager tool.

9.2 Multimedia Tools

The Multimedia Tools provided with IBM Ultimedia Services 2.1.2 include:

**Media Player**
For playing audio, video and still images (AIX Version 4.1 only)

**Movie Editor**
For editing movie (video) files

**Audio Editor**
For editing audio files

**CD-Audio Player**
For playing Audio CDs through your computer’s audio system

**MPEG Player**
For playing Motion Picture Expert Group (MPEG) movie and audio files (AIX Version 4.1 only)

**Master Volume and Audio Mixer (Master Settings)**
For controlling your computer’s audio inputs and gains, master volume and
master mute

**Video Monitor (NTSC and PAL)**
Provides video input monitoring in a window

Additionally, IBM Ultimedia Services 2.1.2 provides a HUMAN-CENTERED
installation tool to install the UMS Master Settings application in your desktop’s
front panel when the Common Desktop Environment (CDE) is used.
IBM Ultimedia Services 2.1 provides two versions of each application: one that runs on non-desktop environment (Motif only) and one which is integrated with the AIX Common Desktop Environment.

The Motif versions are located in the $UMSDIR/bin directory (by default $UMSDIR is /usr/lpp/UMS). The desktop-enabled versions are located in the $UMSDIR/dt/bin directory. The desktop-enabled utilities support AIXwindows Desktop capabilities, such as drag-and-drop zones and session management (if you log off when running these applications, at the next logon they will appear again). This does not happen with the non-desktop-enabled utilities. Both versions of each application can be invoked from the command line. For example:

- The Motif version:
  
  /usr/bin/run_ums movie_editor
  
- The desktop version has the letters dt in front of the application’s name:
  
  /usr/bin/run_ums dtmovie_editor

Also, the Multimedia Tools toolbox contains icons for the desktop-compatible ones. To call one of these utilities, you only have to double-click on the icon representing it.

The mmApps.dt and mmFile.dt files in the $UMSDIR/dt/appconfig/types/C directory control the behavior of the CDE-based applications. You can copy these files into your $HOME/.dt/types directory, and edit them to customize the behavior of the Ultimedia applications.

### 9.2.1 Movie Editor

With the IBM Ultimedia Services 2.1.2 Movie Editor, you can play-back and edit Audio/Video Interleaved (AVI) files with Ultimotion Matinee, Motion Joint Photographic Experts Group (MJPEG) or Indeo video compression. Movie playback and editing capabilities are provided by Ultimedia Services System Object Model (SOM) objects. Video recording capabilities are also provided if the video capturing hardware is installed. Using the advanced compression and decompression schemes the above mentioned video formats provide, the Movie Editor relies on the processing power of the CPU instead of using specialized hardware. No add-on devices are needed for playback and editing.
There are two versions of the Movie Editor. The dtmovie_editor program is fully integrated with the AIXwindows Desktop. It supports drop zones: you can drag an icon of a movie file and drop it into the editor. It also supports session management, which means that when you log off a session and log back in, the session manager will maintain this editor on your workspace.

The movie_editor, which is the Motif version, has the same functionality of dtmovie_editor, but it does not take advantage of the AIXwindows Desktop features.

To start the AIXwindows Desktop-enabled Movie Editor from the Applications Manager, you have to select the Multimedia Tools icon. Then, when the Application Manager - Multimedia Tools window appears, you can double-click on the MovieEditor icon.

You can also start it from the command line by entering:

dtmovie_editor [-f filename] [-play] [-volume value] [-noAudio]

To start the Motif version of the Movie Editor, enter:

movie_editor [-f filename] [-play] [-volume value] [-noAudio]

Where:
- `f filename` Loads the file `filename` into the editor.
- `play` Begins playing the file.
- `volume value` Sets the volume level to `value` (between 0 and 100).
- `noAudio` Does not play the audio track of the movie.

Figure 95. Movie Editor. To play a video file, you can drag it from the File Manager and drop it into the Movie Editor. Then, click on Play and presto!
9.2.1.1 Playing a Video File

To play a file, you can use the Open option on the File menu to load a movie file. Once the file is loaded, the first frame of the movie will appear in the screen. You can then select the Play button to see the movie and hear the sound.

The DTE-enabled version of the Movie Editor also supports drop zones where you can drop the icon of a movie you want to edit. When you do this, the editor loads the file and displays the first frame of the movie.

There are some sample movie files on the $UMSDIR/Samples directory; they all come in AVI format and therefore have the .avi extension.

The File menu provides the usual functions for file loading and unloading (New, Open, Save, Save as, Exit) and a Statistics option which shows some characteristics of the video file we are working with:

<table>
<thead>
<tr>
<th>File Name</th>
<th>The name of the file we are working with.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Size</td>
<td>Number of bytes of the file.</td>
</tr>
<tr>
<td>File Format</td>
<td>The format in which the file was recorded. Possible formats are AVI, Ultimotion Matinee and Motion JPEG.</td>
</tr>
<tr>
<td>Movie Length</td>
<td>The number of frames in the movie.</td>
</tr>
<tr>
<td>Video Compression</td>
<td>Supported formats are Ultimotion, Motion JPEG and Indeo 2.1, 3.1 and 3.2.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>The number of frames per second.</td>
</tr>
<tr>
<td>Audio Format</td>
<td>Supported formats are PCM, WAV and SND.</td>
</tr>
</tbody>
</table>

There are several controls for playback and recording, which you can access through the Control menu or by clicking on the respective button. These controls are:

- Play
- Stop
- Pause
- Record
- Step Forward
- Step Backward
- Scan Forward
- Rewind
- Mute

You can also use the sliding bar to move to a certain frame of the movie.

The Movie Editor allows you to modify some playback options. To do that, select the Playback Options entry from the Options menu. The following parameters can be modified:

- Audio It can be turned on or off.
- Viewing size You can choose between normal and double size.
What to do at end of movie: You can go back to the beginning of the file (Rewind option), stay at the end (Stop option) or play the movie again (Auto repeat).

Playback speed: It can be changed between 0 percent and 100 percent of the normal speed.

For more information on the operation of the Movie Editor, refer to Ultimedia Services Version 2.1.2 for AIX: User's Guide.

9.2.1.2 Editing a Movie
The Movie Editor provides cut-and-paste capabilities to work with segments of a movie. You can mark the segment you want to work with using the Mark current position option of the Edit menu. Having marked the desired segment, you can delete it, copy it as many times as you want or move it to other part of the movie. These actions can be performed using the Cut, Copy, Paste, and Undo options on the Edit menu. To play the selected segment, you can use the Preview marked area option. To unmark the selected segment, use the Clear marks option.

You can also replace the audio of a film using the Insert audio option. The Extract audio to file option allows you to write the sound of the film to a file to work with later.

You can also merge two movies together, provided they have the same frame size and rate. To do this, use the frame slider to go to the point where you want to include the new movie, and select the file you want to read using the Insert file option from the Edit menu.

9.2.1.3 Recording a Movie
To record a movie, you need a video capture adapter installed and configured on your RISC System/6000. When you record, video and audio are captured from the specified inputs to a special temporary file. When you stop recording, the temporary file is automatically loaded into the movie editor for previewing and/or editing. If you select the Save option, the movie will be saved in standard AVI format.

To record a movie, you will have to pull down the Options menu and select Equipment to set up the audio and video adapters. When using PCI-based RISC System/6000 systems, you don’t need an audio adapter. Audio is provided on the system board.

As audio input, one of the following can be chosen:

High-Gain Microphone: Choose this if your microphone provides some amplification.

Low-Gain Microphone: This is for microphones that don’t have their own amplification.

Line in: This is used to provide line input for recording.

The video input can be Composite (interleaved) or S-Video (non-interleaved). For both video inputs, the PAL and NTSC standards are supported.

Once you have selected your audio and video sources, additional setup can be done via the Record option menu. The options you can change are:
Audio and video monitoring You can switch them on to preview the input of the audio and video adapters before recording.

Audio Settings You can select compression type (PCM 8- and 16-bits, A-Law and Mu-Law) and sampling rate (8000, 11025, 22050 and 44100 Hz). You can also select mono or stereo sound.

Image quality This parameter indicates how much information is saved per frame. For a higher quality, the file size will be bigger, and the image will be less grainy.

Motion quality This sets the number of frames per second.

For more information on the operation of the Movie Editor, refer to Ultimedia Services Version 2.1.2 for AIX: User’s Guide.

9.2.2 Audio Editor

The IBM Ultimedia Services 2.1.2 Audio Editor gives you the ability to play, record and edit audio files on your RISC System/6000. It provides support for several popular sound file formats including NeXT/Sun SND and RIFF WAVE files. Both formats contain a header at the beginning of the file that describes how the audio data was recorded. There are several options for data compression methods, number of samples, sampling frequency, and mono or stereo recording that can be used on these audio files. Raw audio data (that is, without headers or compression) is supported in the Sun AU file format.

As with the Movie Editor, the Audio Editor comes in two versions: the dtaudio_editor command, which uses the AIXwindows Desktop libraries and supports drag-and-drop and session management and the audio_editor command which does not. Both versions can be called from the command line; you can also invoke the AIXwindows Desktop-compatible version by clicking on the AudioEditor icon in the Multimedia Tools window of the Application Manager.

![Audio Editor](image)

Figure 96. Audio Editor. Audio editing and playback for the Risc System/6000.
9.2.2.1 Playing an Audio File
To play an audio file, load it using the File → Open option. You can also load a file by dragging its icon from the File Manager window and dropping it into the Audio Editor window (provided that you are using the version with drag-and-drop capability). Sample audio files can be found in the $UMSDIR/Samples directory. They have the .WAV and .snd extensions for RIFF WAVE and NeXT SND files, respectively.

Once the file is loaded, a visual representation of it will appear in the Audio Editor window. There are two areas that graphically display the sound file. The Total File area shows the waveform of the entire file. The Play Segment area is used to store a section of the file you want to work with. The duration of each area (in seconds) appears in the upper-right corner. When you click on the Play button, only the Play Segment will be played.

Initially, the entire audio file will appear in the Play Segment area. To select a fragment of the audio file to be played, position the pointer on the Total File area, click and hold the left mouse button, and highlight the segment you want to select. When you depress the left mouse button, the selected area will become your new Play Segment. The duration of this segment will be indicated in the upper-right corner of the pane. To load the entire file on the Play Segment area, go to the Total File area, and press the left mouse button once.

You can view information about a sound file by selecting the Statistics option on the File menu. This will show you the following information:

File The name of the file you are working with.
File format This information is gathered by the Audio Editor by reading the header of the file. Possible formats are SND and WAVE.
File size Number of bytes of the file, including the header.
Data format This is the compression method used when recording the audio file. Some possible methods are PCM, Mu-Law and A-Law.
Sampling rate Indicates the number of samples per second.
Channels 1 for mono, 2 for stereo.

9.2.2.2 Editing an Audio File
The Edit menu gives you the following options:
Cut, Copy, Paste You can select a sound segment with the mouse, and cut it or move it around. Copy and paste of short segments can be used to get weird echo effects.
Select all Selects all the audio in the Play Segment window.
Deselect Removes the selected segment from the editing buffer.
Insert file This allows you to merge two or more files.

The file format and sample rate of the file to be inserted is converted to the format and sample rate of the file you are working with.
9.2.2.3 Recording Sound

The incorporated industry-standard audio subsystem of the RISC System/6000 Model 40P and RISC System/6000 Model 43P allows you to record your own digitized sounds without the need of extra hardware. You just need to plug your microphone (keyboard, electric guitar) into the microphone input or your CD-player into the line input, and press the Record button (represented by a circle).

To record sound, select the location where you want the recorded data to be inserted; then click on the Record button. The Audio Editor begins recording from the audio input you have selected. Clicking on the Stop button (represented by a square) stops the recording. After you have finished recording, you can use the editing capabilities of the Audio Editor.

Section 9.2.2.4, “Recording and Playback Options” and 9.2.6, “Audio Mix and Master Volume” on page 191 explain in more detail how to select and customize your audio input devices.

9.2.2.4 Recording and Playback Options

With the Options → Record... option you can set several parameters that affect the sound recording:

- If you turn the Monitor Record option on, you will be able to listen what you are recording. If you select this option, beware of the microphone feedback.
- You can also modify the sample rate. Available rates are 8000, 11025, 22050 and 44100 samples per second.
- Finally, you can select mono or stereo recording.

Using the Options → Input Devices menu, you will be able to chose your input device. Make sure the input device you chose coincides with the physical input that is being used (see Figure 97). If you select the Audio Mixer entry in this menu, you will start the Master Settings application (for more details, see 9.2.6, “Audio Mix and Master Volume” on page 191).

![Figure 97. Audio Inputs for the RISC System/6000 Model 40P and the RISC System/6000 Model 43P](image-url)
9.2.3 CD-Audio Player

The IBM Ultimedia Services 2.1 CD-Audio Player is a graphical interface similar to that of a home CD player. With the Ultimedia Services (UMS) CD Player, you can select the sequence tracks you want to play with the Program button. You can also use the Random feature that randomly chooses the next track to play.

![CD Player Interface]

*Figure 98. CD Player. Play your favorite music while working on your favorite machine.*

There are two versions of the CD-Audio Player:

- dtcd_player: This application is fully integrated with the AIXwindows Desktop and AIX. It supports drag-and-drop zones and session management.
- cd_player: This application is compatible with AIXwindows, but does not take advantage of any of the AIXwindows Desktop features.

Note: dtcd_player can be accessed from the Application Manager window.

9.2.4 Media Player

The IBM Ultimedia Services 2.1 Media Player plays both audio and video files. It also displays still images and provides a basic record feature for audio that is suitable for annotating files or for incorporating them into an electronic mail message.

The Media Player can play audio files recorded in NeXT/Sun SND or RIFF WAVE formats. Data formats include 8- or 16-bit PCM, Mu-Law or A-Law. Audio data is recorded with a Mu-Law data format and written into a NeXT/Sun SND file when the file is saved. Movie file formats supported include AVI with Ultimotion Matinee, Motion Joint Photographic Experts Group (MJPEG) and Indeo video compression. Image formats supported include Kodak Photo CD Overview, Image Pac files and Joint Photographic Experts Group (JPEG).

There are two versions of the Media Player:

- dtmedia_player: This application is fully integrated with the AIXwindows Desktop and AIX. It supports drag-and-drop zones and session management.
- media_player: This application is compatible with AIXwindows, but does not take advantage of any of the AIXwindows Desktop features.

Note: dtmedia_player can be accessed from the Application Manager window.
The Media Player is able to recognize whether the file is an audio, image or video file at the time you open the file. If you load a video or an image file, an additional window will be used to display the movie or image. The main Media Player window will remain the same between both audio and movie files.

You can use the horizontal sliding bar to move to any point in the file. The vertical sliding bar controls the audio volume of the file being played. The playback controls include Play, Stop and Rewind, and the Options menu gives you certain control over the audio recording procedure.

9.2.5 MPEG Player

The IBM Ultimedia Services 2.1.2 MPEG Player provides play capability for any MPEG-1 compliant file. This includes MPEG files containing video and audio sequences, audio-only sequences and video-only sequences. MPEG is an international standard (ISO-11172-X) that specifies the format for moving pictures and associated audio stored on digital storage media. MPEG refers to the Motion Pictures Experts Group, the name for the group that helped write the standard.

There are two versions of the MPEG Player:

- **dtmpeg_player** Fully integrated into the AIX Common Desktop Environment, dtmpeg_player uses the AIX Common Desktop Environment libraries and supports drop zones and session management. Drop zones enable you to drag an icon of an MPEG file onto the mpeg_player.

- **mpeg_player** Compatible with the AIX Common Desktop Environment, but does not take advantage of any of the AIX Common Desktop Environment features.

To start the MPEG player, enter:

```
mpeg_player [-f filename]
```

or

```
dtmpeg_player [-f filename]
```

Or double-click the MPEGPlayer icon in the Application Manager - Multimedia Tools windows.

Figure 100 on page 190 shows the main window which is displayed each time you start the MPEG player.
9.2.5.1 Playing an MPEG File

There are two ways of loading a file. You can either drag and drop the icon of an MPEG file on to the MPEG player, or select File → Open... from the File pull-down menu.

After loading a file, the label to the right of the position slider will indicate the length of the file. If the file contains video, then a movie window will appear with the first frame of the movie displayed in it.

Clicking on the Play button begins playing the MPEG file. To stop play temporarily, click on the Pause button. Clicking on the Stop button stops the MPEG file and rewinds it to the beginning.

Using the File -> Statistics option from the File pull-down menu, a text window will appear displaying information pertinent to the MPEG file.

The Setup pull-down menu enables you to select options on how the next file will be played. The options can only be selected while no file is loaded. These options include: play Audio and Video, Audio-only, Video-only, and display a speed slider.

The Options pull-down menu enables you to select the following options related to playing back MPEG files:

- Video size
- Audio quality
- Audio mode (mono or stereo)
- MPEG quick video
- Auto repeat
9.2.6 Audio Mix and Master Volume

The IBM Ultimedia Services 2.1 Master Volume and Audio Mixer graphical interface enables you to control output volume and how audio input sources are mixed together on a systemwide basis. The Master Volume controls the output volume for all applications. The Audio Mixer allows you to combine multiple audio inputs together at the same time for play or record.

To start the Master Settings applications, enter:

```
master_settings -device path [-volume value] [-audiomixer]
```

Where:

- `-device path` Specifies the device path of the audio device. For example, `/dev/baud0`.
- `-volume value` Sets the initial master volume to `value`.
- `-audiomixer` Displays the Audio Mixer.

You can also start it by clicking on the `MasterSettings` button in the Multimedia Tools window of the Application Manager.

![Figure 101. Audio Mixer and Master Volume. Control the volume of the different audio sources. The figure shows a typical “Karaoke” setting. We are mixing the microphone input with the sound signal from the CD Player.](image)

The sliding bar in the Master Volume window enables you to control the output volume of all your multimedia applications. It puts a ceiling, or maximum value, as a percentage on which an application’s volume can be set. You can also disable the sound output of all applications by clicking on the `Mute` button.

To access the Audio Mixer, click on the `Audio mixer...` button. You can use this application to control the volume and balance of the several audio sources. Use the check box along each source name to add or remove an input source for mixing. The sliding bars control the volume of each audio input.

There is an On/Off switch to enable the Audio Mixer. When enabled, the Audio Mixer selects the audio input source or sources for the multimedia applications. When it is disabled, the application can select its audio source.

Also, you can direct the audio output to the internal speaker, to the line output or to the headphone output.
9.2.7 Video Monitor
The Video Monitor requires a video capture adapter to be installed on your RISC System/6000 Model 40P or your RISC System/6000 Model 43P. This application provides video input monitoring on a window. The Video Monitor comes in PAL and NTSC versions for compatibility with the video hardware you are using.

9.2.8 HUMAN-CENTERED Installation Tool
IBM Ultimedia Services 2.1.2 provides a tool to install the UMS Master Settings application in your desktop’s front panel when CDE is used. The Master Settings application provides a set of buttons you can use to control your system’s master volume, master mute and audio inputs.

This application also installs a HUMAN-CENTERED container which provides you with easy access to the Ultimedia Services applications and speech-related tools.

You can deinstall both the Master Settings application and the HUMAN-CENTERED container at any time by rerunning the application tool.

To start the installation tool, just double-click the InstallMe icon contained in the MultimediaTools windows in the Application Manager.

9.3 Speech Tools
The speech tools include the Speech Navigation application. Once installed, Speech Navigation gives you the ability to control the windows and applications by using speech input.

--- Speech Navigation ---
The Speech Navigation application requires the use of the AIX Desktop environment.

You can control several applications, such as aixterm and Movie Editor, without using the keyboard or mouse. With the built-in business audio sound system of the RISC System/6000 Model 40P and RISC System/6000 Model 43P, the only thing you need is a microphone to talk to your machine. The audio capture adapter will digitize your commands, and the voice recognition process will be carried out by the machine’s CPU, without the need for additional hardware.

9.3.1 VoiceType Navigator
The VoiceType Navigator enables the use of speech as input to control your system. When you start the VoiceType Navigator, two windows are displayed: the Speechbar window and the Navigator window.
9.3.1.1 Speechbar Window

The Speechbar window shows you the current status of the audio input and allows you to control it. The window is divided into four areas:

**Microphone icon**
indicates when VoiceType is listening. Click on it to switch between On and Off states. The green ")))" lines indicate that the microphone is on. The icon without the lines indicates that the microphone is off. You can disable the microphone input by saying *Go to sleep*. If you do this, the Navigator will enter into *sleep* mode and will only be awakened if you say *Wake up, please*. When VoiceType Navigator is sleeping, there is a Zz in the icon.

**The Recognized command area**
is in the center of the window. It displays the commands that VoiceType Navigator has recognized and carried out. The most recently recognized command is displayed at the bottom, and the list scrolls up as new commands are being entered. When sounds are not recognized (the sound of the microphone falling off your hand, for example), a < ??? > sign appears. Use this area to check if your commands were correctly recognized.

**The Input Volume display**
is placed to the right of the Speechbar window. When the microphone is activated, VoiceType Navigator displays how loudly it hears sounds. The design is similar to the LED volume meters in high-fidelity audio systems. The input should be in the green area; if only the yellow LEDs flash, you should raise the volume in the Audio Settings. If the input reaches red, decrease the audio level.
The Status Area is a line at the bottom of the Speechbar window that will display a short description of the object pointed at by your mouse. You can remove this area by deselecting Status Area on the Window pull-down menu.

The menu bar of the Speechbar window has the following menus:

- **Settings**
  - Audio Settings
    This option allows you to adjust the microphone input volume to the proper level. When invoked, it calls the Audio Settings window.
  - Current Settings
    This option is only used for the Text-to-Speech dictation tool.
  - Default Settings
    This option is only used for the Text-to-Speech dictation tool.

- **Recognizer**
  - Its only option, Microphone On/Off, allows you to enable or disable the audio input. If you turn the microphone off, no more of the audio input will be recognized until you turn it on again.

- **Window**
  - Title Bar
    You can use this option to toggle between the Speechbar window and the Title Bar.
  - Status Area
    You can use this option to display (or not) the Speechbar window Status Area.
  - Stay on the Top
    This option allows you to have the Speechbar window on the top of other windows, even when it is not the active window.

### 9.3.1.2 Audio Settings Window

This window appears when you select the **Settings → Audio Settings** option in the Speechbar window. This window gives you control over the microphone input signal and the output speaker location.
Figure 103. The Audio Settings Window

The following areas are presented:

**Input Source**
The source can be identified as Microphone, Line Left or Line Right, depending on where the sound signal will be coming from.

**Input Volume**
If the input volume display of the Speechbar window shows red, this means that the volume is too high, and the recognition system will probably not understand your commands. If the input volume display is yellow, the volume is too low, and your commands will not be recognized, either. This sliding bar gives control over the input volume of your audio source.

**Output Volume**
You can control the use of the internal speaker to monitor the audio input.

### 9.3.1.3 Navigator Window

This window displays the commands that VoiceType Navigator will be able to recognize in the current context and provides access to dialogs for creating and editing your own commands. Commands are grouped in *profiles*. There are three profiles that you should know about:

**Window commands**
These are the names of the windows in the current workspace. The window will be selected when you say its name. For example, if you say *Speechbar* the Speechbar window will become the active window. If you say the number of the workspace you are in, the Front Panel will become the active application. From it, you can call several applications that can be managed with the Navigator.

**Workspace commands**
You can switch workspaces by telling the name of the workspace you want to go to. The options are One through Four.

**Global commands**
These commands are stored in the `/usr/lpp/UMS/speech/speech_reco/langs/En_US/profiles/Global.prf` file. They include control actions you can perform on a variety of graphical user interfaces. For example,

- Left, Right, Up, Down
To move between items in a window.

- **Page Up, Page Down**
  To page up and down when the items occupy more than one page.

- **OK**
  The verbal equivalent of the Enter key.

- **Scroll Up, Scroll Down**
  Scrolls up and down the Navigator window when you are using other applications.

Also, several applications will have their own set of commands. For example, some commands for the Navigator are:

- **applications**
  It lists the applications that can be managed with VoiceType Navigator.

- **introduction**
  It opens a Help Viewer window showing some general information about the Navigator.

- **customize**
  It opens the Customize menu. If you say this command again, the menu is closed.

Some commands for the aixterm application are:

- **directory**
  It calls the `ls -l` command.

- **where**
  It calls the `pwd` command.

- **clear**
  It calls the `tput clear` command.

- **home**
  It calls the `cd` command, which changes the working directory to your home directory.

The Navigator window will display the set of commands available for the application that is currently selected. Application Commands are stored in the application profile in the `/usr/lpp/UMS/speech/speech_reco/langs/En_US/profiles` directory. Most of the applications that have a menu bar will have a command for each menu, and some will have a command for each option in each menu.

The **active commands** are the commands that the Navigator will recognize at a given time. The Global, Window and Workplace commands will be always recognized, as will the commands for the active application.

In Figure 102 on page 193, we can see the VoiceType Navigator being used to control an aixterm window. The first set of commands displayed in the Navigator window are the commands available for aixterm.
The Navigator is a scrolled window. Use the verbal commands **Scroll Up** and **Scroll Down** to scroll through the list of active commands. Note that using the mouse to scroll the Navigator window will change the active window, thus changing the list of active commands displayed.

The list of active commands in the Navigator window is displayed in this order:

1. Application commands
2. Window commands
3. Workplace commands
4. Global commands

If an application does not have any associated command, the list of active commands will begin with the Window profile.

### 9.3.1.4 Configuring VoiceType Navigator

The Navigator window menu bar presents several options that you can use to modify the behavior of this application.

Use the Customize menu to create or modify Navigator commands:

- **The Application option**
  It allows you to create or edit application-specific commands. Each application window has a stored profile (the application profile) that contains the list of commands that VoiceType Navigator can recognize when the application is the active window. These profiles reside in the `/usr/lpp/UMS/speech/speech_reco/langs/En_US/profiles` directory.

- **The Global Commands option**
  It allows you to create or edit commands that are recognized at any time.

- **The Train option**
  It allows you to enter the pronunciation of any command.

- **The Delete Pronunciation option**
  It presents a list of commands that can have their pronunciations deleted. You can only delete pronunciations for command words that you have added and trained.

The Options menu has the following entries:

- **The Navigator Settings dialog**
  It allows you to set options that are in effect when the navigation component of VoiceType Navigator is running.
    - The Profile’s Path indicates where the Navigator will look for the application profiles. By default, this path is `/usr/lpp/UMS/speech/speech_reco/langs/En_US/profiles`.
    - If the Move Pointer to the Window option is set, the pointer will move automatically if speech commands change.
    - If you select the Stay on top option, the Navigator window will remain visible even if it is not the current active application. The Speechbar will stay on top of the Navigator window if it also has the Stay on top option selected.
• The Go to sleep option

It puts the VoiceType Navigator into a sleep state. To wake it up, say **Wake up, please.**

The Views menu allows you to control which of the voice commands appears in the Navigator window. Commands appear grouped, and you can elect to display or suppress display of any group. The groups are:

• Applications
  Commands for the active window.
• Window
  Names of the windows in the active workspace. Saying the name of one of these windows will select it.
• Workspace
  Names of the AIxwindows Desktop (CDE) workspaces. You can say the name of a workspace to switch to it a any time.
• Global
  General commands, like **Go to sleep, Maximize, Next Window,** and **OK.**

Additionally you can display the Untrained commands (those without pronunciation) by turning on the Show Untrained choice. If this choice is not turned on, words without pronunciations will not be included in the groups above. When they are displayed, Untrained commands are marked with an asterisk in front of the command.

**9.3.1.5 Command Types**

VoiceType Navigator recognizes three kinds of commands:

• Keystrokes
• Internal actions
• CDE actions

**Keystrokes**

These commands send a specified series of keystrokes to the operating system.

An example of keystroke command is the **Directory** command for aixterm. The keystrokes associated with this command are: `[1] [s] [space] [minus] [1] [Return]`, and they correspond to the `ls -l` AIX command.

You can use several different strokes to form your commands, besides letters and numbers. We have used the `[space]`, `[minus]` and `[Return]` keystrokes in the example above. There are many other possible keystrokes. Among them:

[c d] Control-D.

[Down] The equivalent of pressing the Down key. The same holds for [Up], [Left], [Right].

[Escape] The Escape key.
**Internal Actions**

These commands do not affect the application window but the VoiceType Navigator itself.

Some examples of Internal Actions for VoiceType Navigator:

- **MicrophoneOff**: Turns the microphone off. This is equivalent to the Recognizer → Microphone On/Off option.
- **ScrollDown**: Scrolls down the list of active commands in the Navigator window.
- **ScrollUp**: Scrolls up the list of active commands in the Navigator window.

**CDE Actions**

These commands are commands for the CDE that operates in the CDE workspace. You can find a list of CDE actions by calling the `/usr/dt/bin/ddtypes` command and entering the `list` option.

Some CDE actions are:

- **OpenHelpManager**: Starts the Help Manager.
- **LockDisplay**: Locks the display.
- **Calendar**: Opens the Calendar application.

**9.3.1.6 Creating Your Own Commands**

The process of creating your own commands to be recognized by the VoiceType Navigator is shown in Figure 104 on page 200. The steps to follow are described below:
Figure 104. Creating New VoiceType Commands. The Navigator window and its descendants.

1. Select the Customize → Application option from the Navigator window. The Application window will be displayed.

2. Use the Application window to create a new application, or edit, delete or copy an existing application. The existing applications are displayed in the main window; select the one you into which you want to add a command, and click on the Edit button. The Application Commands window will appear with the name and description of the application you selected.

3. All the existing commands for the selected application will be displayed in the main window. There are several actions that can be performed: create a new command, edit an existing command (change what it does), delete a command from the application profile, make a copy of an existing command, or train a command pronunciation. Click on the Create button to create a new command. The Edit Command window will be displayed.

4. Once in the Edit Command window, type in the name and description for the new command. This name will be the word or phrase that you will say to
execute the command. It can be up to 79 characters long and can contain any keyboard characters and spaces.

5. Select the command type of the command you want to create (keystroke, internal action or CDE action — see 9.3.1.5, “Command Types” on page 198) by clicking on the button corresponding to the type.

If it is a keystroke command, you will have to enter the keystrokes to which the voice command should be translated to. Use the format shown in Figure 104 on page 200.

Click on the OK button to save the new command.

6. The command will appear in the list of valid commands for the selected application. Once there, you can click on Train... to train the pronunciation of the new command. The Train Command window will be displayed. Click on the Record button to record the pronunciation for the new command. Say the new command using the microphone, and click on the Stop button when you are done. You can play the pronunciation, and record it again if you want. Click on the OK button when you have finished this step.

You can now use the new command.

9.4 Multimedia Demos

The Demos available with the UMS package give you a taste of some of the HUMAN-CENTERED technologies that are still under development. These Demos include Speech Dictation and Text-to-Speech.

With Speech Dictation, you can dictate the contents of a document using speech input. The Text-to-Speech demo enables you to convert English text to computer-generated speech.

9.4.1 Speech Dictation

IBM Ultimedia Services 2.1’s Speech Dictation demo provides an example of how speech input can be used to dictate the contents of a document.

The IBM VoiceType product family includes Speech Dictation, which enables you to dictate and have your speech converted to text. While VoiceType Navigator does not have this capability, there is a demonstration application which is included in the MultimediaDemos folder.

To run this demonstration program, double-click on the SpeechDictation icon located in the MultimediaDemos folder. The demonstration application will present you with sample text in the Read From This Text window and a Dictionary Sample window in which the recognized words will appear as you dictate. The Navigator window and the Speechbar window will be displayed as well.
Figure 105. Multimedia Demos: Speech Dictation. As you speak to the microphone, the words you say will be written in the Dictation Sample window.

Steps to execute the Speech Dictation demonstration program:

1. Turn on the microphone by clicking on the microphone icon of the Speechbar window.

2. Say Dictate. The word dictating... will appear in the Dictation Sample window indicating that the VoiceType Navigator is ready for you to dictate some sample text.

3. You can speak any of the words in the Read From This Text window with a brief pause between each word (this is called isolated word speech). As you read, VoiceType Navigator will display the words it recognizes in the Dictation Sample window.

The sample program has a very limited vocabulary and does not provide you with the ability for adding words to it or for correcting words that were incorrectly recognized. In the actual VoiceType Dictation product, there are many additional features which enable you to enter and make use of dictated text.

9.4.2 Text-to-Speech

This is a demonstration application available from the Multimedia Demos window. To control the speaker volume, use the UMS Master Settings application available in the Multimedia Tools window. Text-to-Speech consists of several executable programs:

**Talking Head**

The talking head is animated and synchronized with the text that is being written. If you double-click on this icon, the talking head will be displayed. In order to read any file, you have to open the file. You can control the audio volume using the Master Settings application available from Ultimedia Tools.
There are five available talking heads. Use the \texttt{FACE} global variable to select which head you want to talk to.

\textit{Text-to-Speech Window}

In this window, you can enter a file name, and it will be read by the talking head. This window also supports drag-and-drop.

\textit{Type-n-Talk}

With this application, you can type any sentence, and press the \textbf{Speak} button to have it read out loud by the talking head of your choice. Use the Pitch and Tempo sliding bars to modify the characteristics of the voice. You can also import a file by selecting the \texttt{File \rightarrow Open File} option. Type-n-talk parses the text into paragraphs which are converted to audio samples as whole units. Thus, the pitch and tempo changes only take place within a paragraph.

\textit{TalkingBiff}

TalkingBiff is a talking head version of the xbiff mail box monitor. When new mail arrives, TalkingBiff will announce it by saying the name of the sender and the Subject: line. If you use the TalkingBiff program, you don’t need an additional head to use the other text-to-speech programs. They too can speak through the TalkingBiff head.

\textit{Dictionary Editor}

If the voice synthesizer does not pronounce a word correctly, you can add the word to the exceptions dictionary. The default dictionary is automatically loaded for editing; you can also create your own dictionary.

\begin{figure}
\centering
\includegraphics[width=\textwidth]{figures/09/tnt.png}
\caption{Multimedia Demos: Type-n-Talk. Write a sentence in the \texttt{tnt} window, click on the \textbf{Speak} button, and the talking head will read the sentence out loud.}
\end{figure}
9.5 Miscellaneuos Multimedia Software

In this section, we will introduce the NCSA Mosaic, an Internet Multimedia Browser, and we will explain how to download it from Internet and configure it on your machine. We will also refer to several image and video browsers that can be employed to complement Ultimedia Services, and how to configure them to work under AIXwindows Desktop.

9.5.1 Mosaic

NCSA Mosaic for the X Window System is a networked information discovery, retrieval and collaboration tool and World Wide Web browser developed at the National Center for Supercomputing Applications. NCSA Mosaic is copyrighted but free for academic and research use. You can retrieve copies of NCSA Mosaic in both source and executable binary form from NCSA’s anonymous FTP server, ftp.ncsa.uiuc.edu (IP 141.142.3.77).

In this section, we will show how to get a copy of the NCSA Mosaic, install it on your AIX Version 4.1 and put it to work.

9.5.1.1 Downloading Mosaic via FTP

NCSA Mosaic requires the following filesets be installed with AIX version 4.1 or higher on your RISC System/6000:

- bos.rte
- bos.net.tcp.client
- X11.base
- X11.motif

These filesets come preloaded in the RISC System/6000 Model 40P, but other systems would require you to install them before installing Mosaic.

To start the Mosaic World Wide Web browser, select the Information folder of the Application Manager. If the machine is new, NCSA Mosaic will not be installed on it. In this case, clicking on the NCSA_Mosaic icon will cause a dialog box to appear. This box will offer you information on obtaining a copy of NCSA Mosaic. If you click on the OK button, a Help Viewer window will appear, with the title “How to get an NCSA Mosaic executable.” This Help View window can also be started by calling /usr/dt/bin/dthelpview -helpVolume /usr/dt/appconfig/help/C/Dtmosaic/dtmosaic.sdl from the command line.

Following the Help Viewer instructions, you can retrieve a copy of this utility from one of several IBM FTP servers. The process is as follows:

1. Log in as root.
2. Create the directory /usr/lpp/mosaic/bin, and make it your working directory.
3. Open an anonymous FTP connection to one of the following nodes:
   - www.austin.ibm.com
   - ftp.aix.ibm.com
   - aix.boulder.ibm.com
4. Once connected to one of these nodes, get the file MOSAIC.README, and read it. Information on last-minute changes to these instructions can be found on it, if this information exists.
5. Go to the /Web/Mosaic/Unix/binaries directory and get the files README-binaries (it is an ASCII file) and mosaic.Z (download it in binary mode). Expect mosaic.Z to take some time to download; it is a large file (approximately 3 MB and can vary according to the version).

6. From the /Web/Mosaic/Unix/app-defaults directory, get the files app-defaults.color and app-defaults.mono.

9.5.1.2 Installing Mosaic

Once the NCSA Mosaic files have been downloaded from the FTP server, you have to perform the following steps:

1. Verify your current directory is /usr/lpp/mosaic/bin. It is required that you install Mosaic in this directory because this is where the Application Manager will look for it.

2. Execute the following commands:
   
   ```
   # uncompress mosaic.Z
   # chmod 755 mosaic
   ```

3. Copy the application default file to the system wide application default file directory. If you have a color display, you have to do:
   
   ```
   # cp app-defaults.color /usr/lib/X11/app-defaults/Mosaic
   # cp app-defaults.mono /usr/lib/X11/app-defaults/Mosaic.mono
   ```

   If you have a monochrome display, you have to do:
   
   ```
   # cp app-defaults.mono /usr/lib/X11/app-defaults/Mosaic
   # cp app-defaults.color /usr/lib/X11/app-defaults/Mosaic.color
   ```

9.5.1.3 Customizing Mosaic

There are some customizations you may choose to make to the application default files so that NCSA Mosaic works well in your environment:

- You can edit your $HOME/.profile file to add /usr/lpp/mosaic/bin to your $PATH environment variable so that you can type mosaic to start the NCSA Mosaic executable.

- You can copy the appropriate app-defaults file to your $HOME directory and make customizations to it.

  To copy the systemwide application default file to your $HOME directory, execute the command:

  ```
  cp /usr/lib/X11/app-defaults/Mosaic $HOME
  ```

The file $HOME/Mosaic controls the default behavior of NCSA Mosaic for one user. The system wide defaults are defined in the /usr/lib/X11/app-defaults/Mosaic file.

For example, to specify a different Home Page, you have to modify the homeDocument resource. To use the IBM Home Page, add the line:

```
Mosaic*homeDocument: http://www.ibm.com
```

You can find more information about the configuration of the $HOME/Mosaic file in the Help Viewer, in the volume How to Get NCSA Mosaic, under the chapter "Configuring NCSA Mosaic for the AIXwindows Desktop." You can also refer to section 9.5.1.4, "Mosaic’s Online Help" on page 206.
9.5.1.4 Mosaic’s Online Help

NCSA Mosaic comes furnished with its own online help. This help resides in www.ncsa.uiuc.edu; so you need Internet access to this host before using it.

The following topics are covered in the online help:

**About**
Introduction to the current version of NCSA Mosaic. Help on solving problems common to this utility.

**Manual**
Documentation on NCSA Mosaic. Guide for installing, using and configuring the product. Frequently asked questions and other technical information.

**What’s New**
Recent changes and additions to the universe of information available to Mosaic’s users. Resources that can be found on the World Wide Web.

**Demo**
This option will bring you to the NCSA Mosaic Demo Document, which includes examples of applications that can be accessed with Mosaic and how to use them.

**On version**
This entry tells you the version that you are using and gives you information specific to it.

**On Window**
How to operate NCSA Mosaic, its menus, options and hot keys.

**On FAQ**

**On HTML**
Introduction on writing documents in HTML, the language used by the World Wide Web.

**On URLs**
Quick reference on the different types of URLs and how to work with them.

**Mail Developers**
By clicking on this option, you will be able to send electronic mail to the developers of NCSA Mosaic.

The hypertextual nature of the Web pages that conform the NCSA Mosaic online help gives you the possibility to explore literally hundreds of connected documents. While these are relatively short texts, they are full of pointers to useful sources of Mosaic-related wisdom.

9.5.1.5 Configuring MIME Types for Mosaic

If you are a user of a MIME (Multimedia/Multipart Internet Mail Extension) mail reader or World Wide Web (WWW) browser, such as Mosaic, you can use the files in the /usr/lpp/UMS/Demos/mime, which are part of the IBM Ultimedia Services 2.1 demo package. Using these files, you can turn UMS’s audio and video applications into MIME readers. That means that you can use Ultimedia Services to play audio and video clips which are part of a WWW document or sent to you as MIME electronic-mail.

When a World Wide Web hyperlink points to a data file that is not in HTML format (for example, an image or video file), Mosaic attempts to use an external program to display the contents of the file (for example, show the image or play the movie). If Mosaic cannot find an appropriate external viewer, it will save the data to a file so the user can access it later. Mosaic will prompt the user for the filename before saving the data.

Mosaic uses a two-step process to determine what external viewer to use for every kind of data.
1. First, it determines the MIME type of the data according to the extension of the file or according to the document’s server specification.

2. Then, it displays the file with the external viewer assigned to the MIME type of the file.

For example, a video file can have different MIME types depending on its extension. It can belong to the video/mpeg type if it has extensions mpeg, mpg or mpe, or it can be of type video/x-ums-video if it has extension AVI or AVS. The analysis of the extension is case-independent.

Depending on the configuration, different digital video players can be assigned to different MIME types. You can use Ultimedia Service’s Media Player to play the AVI files and mpeg_play to show MPEG videos.

There are two configuration files:

mime.types Contains the appropriate lines to map file extensions, such as avi, to MIME types, such as video/x-ums-video.

mailcap Contains the appropriate lines to map MIME types, such as video/x-ums-video, to an executable program, such as UMS’s Media Player, which is capable of reading files of the specified MIME type.

The mailcap and mime.types files can be global (valid for all users) or local (restricted to a single user). Global mailcap and mime.types files reside usually in the /usr/local/lib/mosaic directory. Local files are located in the home directory of a user. They are generally named mime.types and mailcap.

Local files can override the mappings defined by global files. Use the X resources personalTypeMap and personalExtensionMap to tell Mosaic where your map files reside. For example, you can include the following lines in your .Xdefaults file:

Mosaic*personalTypeMap: /home/joeuser/.mailcap
Mosaic*personalExtensionMap: /home/joeuser/.mime.types

Sample mime.types and mailcap files reside in the /usr/lpp/UMS/Demos/mime directory. These files enable you to use the Ultimedia applications for displaying audio and video files of compatible format.

You can append the contents of this files to your personal map files by calling:

/usr/lpp/UMS/Demos/mime/setup_ums_mime

For more information on MIME types, map files and the structure of .Xdefaults files, refer to the NCSA Mosaic Online Help and its various linked publications.

### 9.5.2 Video and Image Viewers

IBM Ultimedia Services 2.1.2 for AIX does not provide support for some video file formats, such as QuickTime, and for image file formats, such as GIF or JPG. However, shareware video and image viewers are publicly available and can provide an effective solution for viewing these popular video and image file formats. In this section, we will describe some of these utilities.

For more information on Internet resources, you can refer to *The Whole Internet Guide and Reference*. The NCSA Mosaic online demo is also a good place to start browsing the Internet in search for shareware applications. Information on
how to integrate your image and video viewers to the AIXwindows Desktop can be found in AIX Version 4 Desktop Handbook.

9.5.2.1 XAnim
This is an X11 animation viewer that runs under several operating systems and supports many types of animation formats. It was written by Mark Podlipec. You can download the source code for this utility, along with a help file for compiling it, from ftp.shell.portal.com (156.151.3.4) at directory /pub/podlipec. Another FTP site for this program is ftp.univ-rennes1.fr (IP=129.20.254.1) in directory pub/images/ASTRO/anim/soft/x11.


The XAnim manual can be found at http://www.univ-rennes1.fr/ASTRO/fra/xanim.man.

XAnim currently supports the following animation types:

- FLI animations
- FLC animations
- IFF animations
- GIF87a, GIF89a files
- GIF89a animation extension support
- DL animations
- Amiga PFX(PageFlipper Plus F/X) animations
- Amiga MovieSetter animations
- Utah Raster Toolkit RLE images and anims
- AVI animations, supporting:
  - IBM Ultimotion
  - Microsoft Video 1
  - SuperMac Cinepak
  - Uncompressed
  - Run-length encoded
- Quicktime Animations

The sound support for AVI and Quicktime video files was still in the beta stage at the time this document was printed.

9.5.2.2 XV
This product allows you to view image files in various formats, including GIF, TIFF and JPEG. XV was written by John Bradley, and it is a shareware program. You will have to pay if you want to put it to commercial or institutional use, though.

The official distribution site for XV is ftp.cis.upenn.edu (directory /pub/xv). You can also download this product from ftp.upenn.edu (directory data/bradley) and ftp.duke.edu (directory pub/archive/xv).
9.5.2.3 2424.Xloadimage

This product can be used for viewing image files under X11. A variety of options are available to modify images prior to viewing. These options include clipping, dithering, depth reduction, zoom (either X or Y axis independently or both at once), brightening or darkening, and image merging. It can also load images onto the root window and dump processed images into one of several image file formats.

The formats supported by Xloadimage are:

- FBM Image
- Sun Rasterfile
- CMU WM Raster
- Portable Bit Map (PBM, PGM, PPM)
- Faces Project
- GIF Image
- Utah RLE Image
- JFIF-style JPEG Image
- X Window Dump
- McIDAS Areafile
- G3 FAX Image
- PC Paintbrush Image
- GEM Bit Image
- MacPaint Image
- X Pixmap
- X Bitmap

Xloadimage is available for anonymous ftp from ftp.x.org in directory /R5contrib. It is only distributed in source form, but compilation should only require calling the make command. Once Xloadimage is compiled, you can access the interactive help by calling xloadimage -help.

A World Wide Web page for this product is available at http://www.std.com/homepages/jimf/xloadimage.html. Xloadimage is covered under a modified version of the MIT X Consortium copyright and can be distributed freely, even for commercial use, providing the copyright notices remain intact. It was written by Jim Frost.

9.6 Multimedia Hardware

In this section, we will introduce the multimedia hardware characteristics of the RISC System/6000 Model 40P and RISC System/6000 Model 43P Series. These machines are specially well suited for multimedia application as they support ISA and PCI adapters, in addition to SCSI devices. Also, the PowerPC processor, due to its remarkable floating point performance, allows for digital image and audio processing without the addition of expensive dedicated hardware.
9.6.1 RISC System/6000 Model 40P

The RISC System/6000 Model 40P has been designed to maintain compatibility with adapters and devices which fully support the ISA and PCI interfaces. New cards from IBM, as well as third-party hardware vendors, are being added continually to the list of supported devices.

The RISC System/6000 Model 40P has three 16-bit ISA adapter sockets called expansion slots. You can use the bottom slot for a short adapter that is no longer than 171 mm (6.7 in.) to allow for microprocessor and cache upgrades. The machine also has two 32-bit, half-length PCI-bus adapter sockets. The PCI graphics adapter is already installed in one of these slots; the other slot is available for the customer.

The standard business audio sound system has stereo line in/out, stereo headphone out and microphone in. The analog/digital audio conversion is carried on by a Chrysal 4231 business audio chip which is connected to the ISA bus. The business audio chip provides simultaneous capture and playback with two independently controllable DMA channels. In addition, the audio chip provides compression and decompression and Big-Endian and Little-Endian sample modes. The audio subsystem does not include a digital signal processor. As such, it can play MIDI files, but is not a full-function MIDI system. One audio output is to a single speaker mounted in the cabinet.

There is also a planar mounted connector for direct playback from the CD-ROM device.

The Model 40P uses PCI-based graphics adapters and offers high performance for graphics-intensive applications. The adapter choices depend on the price/performance the user requires; supported adapters are IBM E15, IBM S15 and IBM GXT150P.

9.6.2 RISC System/6000 Model 43P

The RISC System/6000 Model 43P is equipped with an enhanced standard business audio sound system. The audio subsystem is based on the CS4232 audio codec chip. All audio capture and playback functions are through this chip. The system can play MIDI files. Compression and decompression are supported in hardware. The audio output is a single speaker mounted in the cabinet.

There is also a planar-mounted connector for direct playback from the CD-ROM device.

The RISC System/6000 Model 43P provides video capability incorporated on the system planar. The video subsystem includes the S3 864 DXP graphics accelerator chip, a 16-bit S3 SDAC and 2 MB of video DRAM memory. This provides the same graphics capabilities as the IBM E15 graphics adapter. The components of the on-board video subsystem are connected to the PCI bus.

Five expansion slots are available. Two slots are shared PCI/ISA slots (support either ISA or PCI adapters), and the remaining three slots support ISA adapters only.
9.6.3 Additional Multimedia Hardware

To expand the multimedia capabilities of the RISC System/6000 Model 40P and RISC System/6000 Model 43P, the following hardware is available:

- IBM Personal Microphone
- IBM Amplified Speakers
- IBM Graphic Adapters
- Video Capture Enhancement Adapter

9.6.3.1 IBM Personal Microphone

Headset microphones can be very useful in noisy environments. They are especially helpful if you are using a speech-recognition application because the microphone is always close to your mouth at a fixed angle. Also, the speaker that fits over your ear is convenient when privacy is a concern because the earpiece ensures that only you hear the audio.

This popular IBM microphone is now supported in the RISC System/6000 Model 40P and RISC System/6000 Model 43P. The IBM Personal Microphone is compatible with many IBM-developed applications and audio hardware. It can be used for a wide range of applications, but it is especially well suited for speech recognition programs (including dictation and navigation in an office environment).

The IBM Personal Microphone allows consistent performance by providing for an optimum distance between the voice source (that is, your mouth) and the microphone element and by providing concurrent feedback to the user via the personal headset.

The unit is composed by a lightweight microphone and a headset which conveniently mounts over and behind the user’s ear. The microphone element is attached to the earpiece with a tubular boom. The IBM Personal Microphone can be adjusted to position the headset and microphone for either the left or the right ear.

9.6.3.2 IBM Amplified Speakers

These speakers can be connected to your RISC System/6000 Model 40P or RISC System/6000 Model 43P to achieve premium quality stereo sound for your multimedia applications. The built-in amplifier provides 22 watts peaks per channel, with bass, treble and volume control. The IBM Amplified Speakers connect to the 40P or 43P audio subsystem through a 3.5 mm (1/8 inch) stereo jack on the back of the system.

9.6.3.3 Graphic Adapters

The following graphic adapters are supported in the RISC System/6000 Model 40P and RISC System/6000 Model 43P:

- IBM E15
- IBM S15
- IBM GXT150P

The IBM E15 graphics capabilities are provided on the RISC System/6000 Model 43P system planar.
**IBM E15 Graphics Adapter**

The IBM E15 Graphics Adapter is a low-cost, medium-performance, DRAM-based adapter for use as an entry graphics solution for PREP platform systems employing a PCI system bus. This adapter employs the 64-bit S3 Vision864 GUI accelerator and 16-bit 135MHz S3 SDAC. It comes standard with a 2 MB frame buffer, providing up to 1600x1200 resolution.

**IBM S15 Graphics Adapter**

The IBM S15 Graphics Adapter is a high-performance, VRAM-based PCI graphics adapter with integrated video coprocessor for use as a premium graphics solution for PowerPC Reference Platform systems. It comes in a 2 MB fixed version.

**POWER GXT150P Graphics Adapter**

This is an 8-bit, 256-color adapter that attaches the to the PCS local bus interface. It is designed for 3D applications, including desktop publishing, Xwindows applications, 2D mechanical drafting, CASE, chemical and biological applications, and electrical CAD. When used with the AIX Softgraphics software, the POWER GXT150P provides a cost-effective 3D platform.

**9.6.3.4 IBM Video Capture Enhancement**

This card allows video capture of still or motion video from standard video sources (camera, VTR, Laser disk). It was designed to be used in conjunction with the IBM S15 Graphics Adapter and requires the IBM Ultimedia Services 2.1.2 LPP. With this adapter, you will have the ability to capture and linearly scale the incoming video image from an NTSC, PAL or SECAM format source and monitor the video in a user-defined window.

The IBM Video Capture Enhancement occupies one ISA slot and attaches to the S15 via an internal ribbon cable. This way, you can have “live” video monitoring without any CPU interaction. For the technically minded, the digital video input to the S15 is of the type YUV 4:2:2 (16 bits).

The IBM Video Capture Enhancement has analog inputs for S-Video or Composite video sources. It also provides analog input for remote camera control (Y/C).

The card includes resizer/scaler circuitry so you can scale the image in both the X and Y directions. It also provides independent control for hue, saturation, brightness, and contrast.

The combination of the Video Capture Enhancement and the S15 provide the essential hardware components to support applications, such as:

- Video conferencing
- Video capture for desktop publishing and authoring
- Video stills and snapshots
- “TV” in a window
- Multimedia-based training
Chapter 10. Running Windows Applications

The ability to run Windows applications on AIX clients and workstations has been a longstanding customer requirement. IBM is responding with a dual-product strategy based on WABI and Insignia SoftWindows. The primary goal of WABI is to map the Windows function calls to X11 functions so the Windows applications will be able to run in the AIXwindows environment. SoftWindows, on the other hand, provides a complete emulation of a PC in an X11 Window for those customers who primarily require comprehensive Windows and DOS compatibility, including networking functions.

In this chapter, we will focus on these two applications. Insignia SoftWindows will be described in 10.2, “Insignia SoftWindows” on page 214, and we will refer to WABI in 10.3, “WABI for AIX” on page 232. The two software packages are compared in section 10.4, “Comparison of SoftWindows and WABI” on page 250.

10.1 The importance of Windows Emulation

In this section, we will discuss briefly why it is good to have the ability to run Windows applications on an AIX machine. Windows emulators have been developed for many operating systems, including Sun/OS, HP-UX, Macintosh, and Windows NT. This is related to the huge body of software developed for this platform that is already installed in most of today’s workplaces.

The following list gives us the main reasons why it is necessary to run Windows software in AIX:

A Bridge Between the AIX and PC Worlds

The RISC System/6000 Model 40P and RISC System/6000 Model 43P are designed for easy setup. Delivering the system with the AIX software preinstalled, the adapters preconfigured and providing the AIX Common Desktop Environment interface is intended to get users who have no previous experience on any UNIX-flavored system up and running on these platforms. This is the first time IBM has made a system that you just plug together, power-on and play. This is exactly what PC customers in the small office, home office (SoHo) market ask for.

Also, Windows emulations should be of interest for those midsize or large customers that have both Windows and AIX machines. This way, they can continue running their Windows applications while having, at the same time, all the processing power of a PowerPC-equipped machine to run the PowerPC native programs. The RISC System/6000 Model 40P and the RISC System/6000 Model 43P may satisfy needs for system managers as well as for end users in this kind of environment.

Available Application Software

Popular software, such as that used for word processing, spreadsheets, desktop publishing, graphic design, and many more applications, is currently being developed for use with Microsoft Windows, and will continue being developed. Software vendors may or may not invest on developing AIX versions of their programs in the future.
The AIX/UNIX community cannot step aside and wait for the independent software vendors to choose X11 or CDE as a major platform. Instead, it is necessary to have these popular programs run on AIX without modifications. This multiplies the available software solutions for the AIX environment in a market where content is everything.

**Attractive Packaging:** The RISC System/6000 Model 40P and the RISC System/6000 Model 43P contain all the hardware and software components a PC user would expect for an affordable price: the CPU, operating system, Common Desktop Environment, CD-ROM, audio equipment, and the promise of the outstanding performance of the PowerPC chip. The Windows emulation program give the customer a way to run Windows applications on AIX. This way, they have the convenience of being capable to run their existing applications on the new machine without being rushed into buying new software.

### 10.2 Insignia SoftWindows

The RISC System/6000 Model 40P software package includes a preinstalled evaluation copy (valid 60 days) of Insignia SoftWindows. This software is not included within the standard RISC System/6000 Model 43P software package and needs to be ordered separately.

Insignia SoftWindows is a product that allows UNIX users to run standard-mode Windows and MS-DOS applications without any modification. It is basically a PC emulator that incidentally comes with DOS and Microsoft Windows included. The current version of Insignia SoftWindows is 1.2, and it emulates a 80286-equipped IBM PC (version 2 promises to emulate an 80386 that can run in protected mode). The monitor can be configured to emulate a VGA, CGA, EGA, or Hercules with 16 or 256 colors. The size of the Windows display can be chosen at will; the DOS window has three possible sizes (in case the fonts are too small for you to see).

SoftWindows includes both Windows 3.1 and MS-DOS 6.21 and provides full compatibility with Windows and MS-DOS programs. Insignia has tested several hundreds of popular applications and ensures that you can also run them once you have installed your SoftWindows package. You will have to contact Insignia Solutions to know if the application you plan to run has been certified.

The networking support of SoftWindows includes TCP/IP, Novell NetWare and LAN Manager. Section 10.2.9, “Networking Support for Insignia SoftWindows” on page 228 explains this in more detail.

You can reach the World Wide Web home page of Insignia Solutions at [http://www.insignia.com/](http://www.insignia.com/) for more information. This document contains lists of frequently asked questions, solutions to common problems and news about the latest versions of the product for the various platforms it supports.

The document *AIX Version 4.1.x Release Notes Addendum* (x corresponds to the AIX modification level you are using) included in your system package gives you detailed indications on how to contact Insignia Solutions for getting product licenses, demo licenses and additional data regarding this product. This information is also displayed when you start Insignia SoftWindows for the first time as the root user.
10.2.1 Installing Insignia SoftWindows

This section will help you to understand how to install Insignia SoftWindows if it is not already installed on your system, how to request and install an Insignia SoftWindows license and how to initialize an Insignia SoftWindows user. Refer to AIX Version 4.1.3 Release Notes Addendum and SoftWindows Installation Guide from Insignia Solutions for detailed information on this topic.

First, enter the following command to verify that Insignia SoftWindows is already installed on your system.

```
ls1pp-l | grep SoftWindows
```

Insignia SoftWindows for AIX is installed in your system if the following packages are listed:

- SoftWindows.local 1.2.0.0—SoftWindows extra fonts
- SoftWindows.obj 1.2.0.0—SoftWindows executable
- SoftWindows.winfiles 1.2.0.0—Additional Windows 3.1 files

If these packages are not found, you must install them as you would any normal LPP by either using the `installp` command or the SMIT facility. You must be the root user to install the software. After installing the software, you will need to log out and log in again as the root user.

The preinstalled Insignia SoftWindows software includes:

- Microsoft DOS Version 6.21
- Microsoft Windows Version 3.1
- Novell NetWare 3.11 Client
- Windows Applications, such as:
  - Windows Idle Detection
  - Microsoft Editor
- Some Microsoft tools, featuring:
  - Anti-Virus
  - Backup
  - Undelete
- SmartCopy

This Insignia utility allows you to cut and paste from AIX to Windows and vice versa using your mouse, just as you do in regular X11 applications.

After installing the software package, you should take a look at the Insignia SoftWindows release notes. They are located in the $SWINHOME/README file. $SWINHOME is the directory where SoftWindows is installed; this is usually /usr/lpp/SoftWindows. The README file includes some useful system administrator information:

- Installing SoftWindows
- Deinstalling SoftWindows
- System Administration Notes
- Hints and Tips
10.2.2 Getting and Installing an Insignia SoftWindows License

After the software installation and before you are able to configure and use Insignia SoftWindows, you need to request and install an Insignia SoftWindows license.

When you purchased a RISC System/6000 Model 40P with preinstalled software, you also purchased a 60-day Insignia SoftWindows demonstration license. You must request the license key by following the information displayed the first time you enter the following command:

```
/usr/lpp/SoftWindows/bin/Install.sw
```

A window similar to Figure 107 will appear:

![Figure 107: Insignia FLEXlm License Manager. You get this window when starting SoftWindows for the first time.](image)

Upon contacting Insignia Solutions, you will receive a fax with the Authorization Code for your system. Enter this information in the corresponding field in the Welcome To SoftWindows window, and click on Install License.

The licensing system used by Insignia SoftWindows is called FLEXlm, a system used by many other software manufacturers. FLEXlm uses one workstation on the network as the license server which can provide licenses for several software products concurrently. The license server uses the lmgrd license daemon, which keeps all its data in a license data file. The license data file for Insignia Softwindows is usually located in $SWINHOME/FLEXlm/license.dat.

Note

If you are using an Insignia SoftWindows demo license, no FLEXlm license server is needed. For more information on the FLEXlm licensing system, refer to the FLEXlm User Guide, which is available from Insignia Solutions.

Upon license installation, the system will start the Insignia SoftWindows initialization for the root user. A warning message similar to Figure 108 on page 217 will be displayed.
Press the Default button to create a copy of the system default configuration file.

### 10.2.3 Initializing an Insignia SoftWindows User

The first time a user starts SoftWindows, the warning window shown in Figure 108 will appear. Upon pressing the Default button, a copy of the default system configuration file will be created. The configuration file `$HOME/.swinconfig` is saved after you exit the Insignia SoftWindows session. You may edit the file and change the configuration parameters to meet your needs. Refer to 10.2.5.6, "The .swconfig file" on page 223 for a description of the .swinconfig configuration file.

In addition to the .swinconfig file, the .Xdefaults.swin X11 resources file is created in the $HOME directory.

### 10.2.4 Starting Insignia SoftWindows

There are several ways to start Insignia SoftWindows. You can click on the SoftWindows icon on your Application Manager window, or call one of the following shell scripts:

- `$SWINHOME/bin/win` will start SoftWindows for AIX and automatically run Windows. This will fail if win is added to your autoexec.bat file. You can automatically launch a Windows application by using this file.

- `$SWINHOME/bin/dos` will start SoftWindows without calling Windows (you will only get the DOS prompt).

- `$SWINHOME/bin/winnet` will start the Windows emulation with the networking option to access the Ethernet adapter in your machine. Notice that only the Ethernet adapter is supported.

- `$SWINHOME/bin/dosnet` will start the PC emulator with the networking option without calling Windows.
10.2.4.1 Exiting Insignia SoftWindows

To exit from Insignia SoftWindows, you have to perform the following:

1. Save any open files you might have in your Windows applications.
2. Select the **File → Exit** option from the SoftWindows menu bar.
3. When the SoftWindows Exit window appears and asks you for a confirmation, press the **OK** button.
10.2.4.2 Files Modified by SoftWindows

Two files are modified by Insignia SoftWindows during use:

- $HOME/.swincmosram: This binary file stores program defaults.
- $HOME/.swinconfig: This text file holds the user's preferences (more information on 10.2.5.6, "The .swconfig file" on page 223).

If one of these files is accidentaly deleted, Insignia SoftWindows will recreate them from information held in the file $SWINHOME/sys.swinconfig. If $HOME/.swinconfig gets corrupted, SoftWindows could be unable to start.

10.2.5 Understanding SoftWindows

This section will introduce some concepts on how Insignia SoftWindows interacts with the AIX operating system, and some things you can do to make it suit your working environment.

SoftWindows integrates a single-user PC environment into a multiuser operating system, such as AIX. This integration poses some difficulties that must be fully understood in order to choose the best configuration for your system. These considerations include the workstation in which SoftWindows will run, the applications you plan to use, the network configuration, and so forth.

10.2.5.1 SoftWindows Container Files

A container file is a special file in the AIX filesystem. This file is formatted to look like a DOS-formatted SCSI hard disk to the SoftWindows PC emulator. When Insignia SoftWindows is started, its behavior will be like that of a DOS system when booting. It will first look for a bootable diskette, and then it will go for the C: hard disk drive.

The container file plays the part of a C: disk for the PC emulator. You can also use a container file as a D: drive, as explained later in this section.

Insignia SoftWindows container files are sparse files. Suppose you create a new 100 MB SoftWindows drive in your filesystem. Initially, the file will not occupy 100 MB but only the space occupied by your DOS and Windows files. As you write more data into the drive, the container file will grow, consuming more space from your filesystem, up to 100 MB. Once the file has expanded, it will not shrink again if you delete DOS data from it. Also, it will not occupy more space than what you originally assigned to it (the initial 100 MB). You can find more information about sparse files in the InfoExplorer database, under the title "File Space Allocation."

If your filesystem is full and your container file is unable to expand, you will receive error messages from DOS. If you try to create a DOS file under SoftWindows that doesn't fit in the remaining space, you will receive a message like this:

```
An unexpected file system error occurred while writing to a container file. Pressing Continue will retry the operation that failed. No space left on device.
```

You can try to make room in the filesystem, and click on the Continue button to retry the writing operation. If you click on Exit, SoftWindows will end — think twice before doing so.
Drive C: — The Booting Disk

By default, all users will have the $WINHOME/MS-WIN-31.hdf file as the booting device. This file is formatted as a DOS-compatible SCSI disk and has Microsoft DOS 6.21 and Microsoft Windows 3.1 preinstalled.

When you start your SoftWindows session, if another user is using this file, you will not be able to write to your C: drive. A Warning window will appear with the following message:

Warning: Hard disk read only

Also, when Windows starts, it will display the following warning:

System Error: Cannot write drive C:

This will require you to click on the Confirmation button.

This will usually not prevent you from booting, but you will not be able to modify any data in your C: drive. Thus, if two users have the same the file for drive C:, they will not be able to write to it at the same time.

This problem can be solved by having a different booting device for each user (see “Changing Your Booting Device”).

Changing Your Booting Device

To change the container file you use for booting the DOS in the Insignia SoftWindows PC emulator, you have to select the Options → Disk Drive → Open Drive selection from the menu bar. Once you have done this, you can change the field titled “Hard Disk Drive C: File Name.” Fill this field with the name of the container file you have created previously (refer to “Creating a D: Drive” for instructions on how to create a new container file).

Remember that you need write permissions for the container file in order to write data to your C: drive.

Creating a D: Drive

To create a new container file, go to the SoftWindows menu bar, and select the Options → Disk Drives → New Drive option. A newly created container file can be used as either a C: or a D: drive; D: is the default. You can have as many of these files as you want in your system.

Softwindows automatically assigns the newly created container file as your D: drive. The disk will have one partition and will be formatted as a DOS disk. SoftWindows will install MS-DOS on this disk, and make it a bootable device.

The New Hard Disk window has a field where you have to write the name of the new container file you want to create. It also has a slider to define the new hard disk size in megabytes. The possible values range from 8 MB to 300 MB; the default is 10 MB. When you provide the parameters required and press the OK button, a warning window appears indicating that the SoftWindows session will be terminated, and a new one will start. You have to save your data before pressing OK.

Once SoftWindows is restarted, the new container file will be configured as your D: drive.
You can use this file as the booting device for another user. To do this, select the Options → Disk Drive → Open Drive menu entry from the menu bar. You will notice that the newly created container file has been configured as your D: disk. Erase the name of this file from the Drive D: File Name field, and press OK. This will restart your SoftWindows session; therefore, remember to save your data before doing this.

To use the container file you have just created as a disk drive for another user, you will have to change its permissions. Otherwise, the other user will not be able to write to his C: disk. Everytime he intends to write to the disk, he will receive the well-known message:

General Failure writing to drive C:
Abort, Retry, Fail?

To avoid this, you have to change the owner of the container file, or grant AIX write permissions on the file to everybody.

You can specify which container files SoftWindows is going to use by choosing the Options → Disk Drives → Open Drive menu option.

The mkhd command can also be used for creating a container file. If you want to access it as the drive D:, you have to select Options → Disk Drives → Open Drive from the menu bar, and write the name of the new container file in the Hard Disk Drive D: File Name field. Once the container file is created, you have to make it available to the DOS. Use the DOS FDISK command for this purpose. You then have to format the new drive to be DOS-compatible by using the DOS FORMAT D: command.

10.2.5.2 File Sharing Architecture (FSA)
Insignia SoftWindows includes a software called File Sharing Architecture that allows you to access your AIX filesystem from the SoftWindows PC emulator as if it was a PC disk.

On a real PC, an FSA drive would be a filesystem exported from a UNIX machine, and Windows would access it through a software network driver. Files accessed this way can be either programs or data, and they can be managed both by SoftWindows and AIX.

More information on FSA drives can be found in the Insignia SoftWindows manuals and in the Insignia Solutions World Wide Web pages.

Defining Your E: Drive

By default, the drive E: of SoftWindows will be your home directory, as defined by the $HOME variable. You can change this drive to the directory of your preference; to do so, select the Options → Disk Drives → Open drive menu option. You will see a field named “FSA Root Directory Name.” Write the name of the directory you want to use as the drive E: in that field, and press OK. The directory you choose will become your E: drive, and you will be able to access the files on it from your DOS and Windows applications.

Setting AIX Directories as PC Drives: Insignia SoftWindows uses the FSA drives to access the filesystems of the machine it is running on. Using the built-in network capabilities of DOS, SoftWindows intercepts calls to network drives and interfaces them to AIX directories.
The net command can be used to mount additional directories. For example, to access the /home/joeuser as your drive K:, write

```
NET USE K: /home/joeuser
```

The CONFIG.SYS file in your drive C: should include the line:

```
LASTDRIVE=drive character
```

All characters between F and the drive character can be used as FSA drives.

### 10.2.5.3 Defining the Diskette Device

Insignia SoftWindows is not configured to access any floppy disk drive by default. To select the device you want to access as your drive A:, select the **Options** → **Disk Drives** → **Open Disk Drives** entry from the menu bar. This will open the Open Disk Drive window which has a field with the title *Floppy Drive A: device name*. Write in this field the name of your floppy disk. SoftWindows requires access to the raw floppy device; so your selection will be /dev/rfd0.

You will not be able to use the diskette drive from SoftWindows if someone else is using it. On the other hand, every time you launch SoftWindows, you will have to make sure that the diskette drive is empty, or else you risk receiving the infamous message:

```
Non-System disk or disk error.
Replace and strike any key when ready
```

**Wrong Diskette**

If the system Management Services diskette is mounted, you will receive an error message of the form

```
0S/2 !! SYS01475
0S/2 !! SYS02027
```

and DOS will not boot.

These problems can be solved by deactivating the diskette (via the **Actions** → **Activate** → **Drive A:** option) and restarting the PC emulator (via the **Actions** → **Restart** option). When you do that, the PC emulator will try to boot from your drive C:.

If you want to grant access to the diskette drive to other users, you have to deactivate it the same way. Once deactivated, the first user who starts a SoftWindows session will be able to get access to the floppy disk drive.

### 10.2.5.4 Defining the CD-ROM Device

Insignia SoftWindows allows you to access the CD-ROM device of your RS/6000 as the drive F:. To do so, you have to perform the following steps:

1. Activate the CD-ROM by selecting **Options** → **Disk Drive** → **Open Drive** and filling in the field named *CD-ROM Device File Name*. You have to write the name of the character device, using something like /dev/rcd0. Click on **OK** when you are ready.

2. Include the line

```
DEVICE=C:\INSIGNIA\CDROM.SYS
```

in your CONFIG.SYS file.
3. Call the C:\INSIGNIA\USECD.BAT command. If you plan to use the CD-ROM frequently, include a call to this command in your AUTOEXEC.BAT.

4. You can access your CD-ROM as the DOS drive F: now. To test the availability of the device, insert the AIX distribution CD-ROM. When issuing the DIR F: command, your output should be something similar to:

```
Volume in drive F is VOLUME_NAME
Directory of F:\

bosinst.dat  4,772 10-13-94  8:45p
image.dat   10,320 10-13-94  8:45p
root        <DIR>   10-13-94  8:45p
usr         <DIR>   10-13-94  8:46p
4 file(s)   15,092 bytes
0 bytes free
```

10.2.5.5 Sound Support
Sound support for the current version of Insignia SoftWindows only includes the initial beep when the PC emulator is started.

10.2.5.6 The .swconfig file
Each time SoftWindows is invoked, it will look for the .swinconfig file in the user’s home directory. This file contains the SoftWindows configuration preferences of the user. If this file is not present, it will be built from the system defaults.

Some user-definable parameters that can be set on this file are:

- **DRIVE_C_FILE_NAME**: This is the name of the booting device. By default, this driver is mapped to the container file $SWINHOME/MS-WIN-31.hdf.

- **DRIVE_D_FILE_NAME**: This is the name of the container file which corresponds to the D: drive.

- **DISPLAY_SIZE**: This parameter is a value by which the size of the application window will be multiplied. Allowed values are 1.0, 1.5 and 2.0.

- **DRIVE_FLOPPY_A_DEVICE_NAME**: This is the name of the device which will be used as a floppy disk. By default, its value will be /dev/rfd0.

More information on the Insignia SoftWindows configuration files can be found in the product manuals that are available from Insignia Solutions.

10.2.5.7 Configuring SoftWindows for Multiple Users
Having two or more users working with Insignia SoftWindows at the same time poses some difficulties that require some system administration work to be resolved. The flexibility of SoftWindows allows several ways in which multiple users can have PC emulation at the same time. Two possible solutions are:

- Each user can have their own drive C:

  This solution is obviously expensive in disk space, but allows each user write permissions over his bootable device. This way, each user can have their own Windows and DOS configuration, different starting sequence (this is AUTOEXEC.BAT and CONFIG.SYS), and so forth. This solution can be compared to having a PC for each user and is nearly as expensive in terms of disk and CPU usage.

- Several users can share the drive C:
And, additionally, each user can have their own D: and/or E: disks for writing their data. These users will share the booting sequence and Windows configuration. The drive C: can be used to contain the binary executables for the applications the users will be running. Each user can have their own FSA drive or container file with their data and the programs only they use. This way, there is no need for replicating the executable programs everybody runs, such as spreadsheets and text editors.

The system operator can choose the option that best fits his system configuration. Some important issues to consider are: number of users that will have access to the PC emulation, number of simultaneous users and the applications they will run.

10.2.5.8 Printing with SoftWindows

Choose Options → COM/LPT Ports → Printer Ports to define the three printer ports for the PC emulator. The ports are named, as in all IBM-compatible Personal Computers, LPT1, LPT2 and LPT3. Each printer port has an associated device type. Possible device types are:

- Pipe
- File
- Data Communications Port
- Printer
- Plotter
- None

Once you have selected the device type for the printer port, you have to select a value for it. For example, a Printer device must have a value of the type /dev/lp0 or something similar. A Pipe can be of the form enq -P lp0.

Example: ASCII Printing from DOS

In this section, we will see an example of the use of an ASCII printing queue to print from DOS.

First of all, create an AIX ASCII printing queue, and name it lp. Make sure the queue is working correctly.

To make the printer accessible from Insignia SoftWindows, follow these steps:

1. Call the dos command to get a DOS prompt in your SoftWindows Desktop window.
3. Once the Printer Ports window appears, go to the LPT1 port, and select Pipe as its Device Type.
4. Fill the Value Assigned field with the following command:
   enq -P lp0
5. Click on the OK button.

You have linked the LPT1 port of your PC emulator to the lp0 AIX printing queue. To test the link, issue the DIR > LPT1 command from your DOS prompt.
**Example: PostScript Printing from Windows**

This section contains an example of using an AIX PostScript queue to print from the Windows environment.

First, create an AIX PostScript printing queue and name it ps. Then, call the `win` command from your AIX command prompt to start Microsoft Windows in a SoftWindows window.

Once Windows has started, do the following:

1. Choose the **Printers** utility from the Control Panel.
2. Select the **PostScript Printer on LPT1** as the default printer.
3. Enable the Windows Print Manager by clicking on the button labeled **Use Print Manager**.
4. Click on the **Close** button to activate the selection you have made.
5. To test the printer queue, open a Microsoft Write document, and select the **File → Print** option from the menu bar.
6. Click on the **OK** button of the Print window to submit the print job. The first time a file is printed, the Print Manager will be started and continue its execution within the icon. Analog, you can print files from Paintbrush, Microsoft Word or any other application.

If you note that SoftWindows takes too much time to begin processing your print jobs, try the **Actions → Flush Ports → All** option from the SoftWindows menu.

**10.2.5.9 Remote Execution of SoftWindows**

If you try to run Insignia SoftWindows from a remote host or from an Xstation, a window will prompt displaying the following error message:

> The font files could not be opened by SoftWindows

This window has an OK button; if you press it, SoftWindows will end.

The cause of this undesirable behavior is that SoftWindows requires its own special set of fonts to run. These fonts are used to emulate the PC screen fonts, and reside in the `$SWINHOME/fonts/IBM` directory. All SoftWindows fonts files start with the letters `spc`.

If you are running on a remote system, you need to copy the appropriate fonts to your local system, or NFS mount the fonts to be locally available and then make them available to the local X server. You have to follow these steps:

1. Check the font path you are currently using by issuing the `xset -q` command.
2. To add another directory to the fonts path, run these commands:
   ```bash
   xset +fp directory_with_SoftWindows_fonts
   xset fp rehash
   ```
   You may want to add these commands to your `.xinit` file if you want to make the fonts directory to be added for every X11 session.

If you want to run SoftWindows from an Xstation, add the SoftWindows fonts directory of the host where SoftWindows is installed to the Xstation fonts path. For more information, refer to your Xstation documentation and to the *SoftWindows Users Manual* from Insignia Solutions.
Another problem you might experience when running SoftWindows is losing the autorepeat capability of your keyboard once the PC emulator is started. To correct this, run the \texttt{xset r} command from an AIX prompt.

\section*{10.2.6 SoftWindows-AIX Interaction}

Everytime you start SoftWindows, the PC emulator process, \texttt{swin}, will run, regardless of the shell script you used to start it. Section 10.2.4, “Starting Insignia SoftWindows” on page 217 details some of the scripts provided with SoftWindows to start the emulator.

If you are using a demo license, this process will be the only process you will have running while using SoftWindows. One instance of this program will be active for every SoftWindows session.

If you are using a FLEXlm-administrated license (full license), the license manager daemon (\texttt{lmgrd}) will have to be active to provide you a license. When started, the \texttt{lmgrd} daemon invokes a specific daemon, called \texttt{insignia}, for SoftWindows.

\subsection*{10.2.6.1 The RUNUX Command}

The \texttt{C:\INSIGNIA} directory contains the \texttt{RUNUX.COM} program, which can be used to run AIX commands present in your E: SoftWindows disk.

To run an AIX command, you have to write:

\texttt{RUNUX E:command}

This will make AIX execute \texttt{command}. The results of the command will be displayed in the AIX window from which you started SoftWindows. If the PC emulator is running in the foreground, it will also be able to read data from the keyboard (you have to activate the aixterm window first).

For example,

\texttt{RUNUX E:usr\bin\vi /u/joeuser/helloworld.c}

will start the \texttt{vi} editor in the aixterm window from which you called SoftWindows, and you will edit the \texttt{/u/joeuser/helloworld.c} file.

\section*{10.2.7 Insignia SoftWindows System Requirements}

You need at least 8 MB of RAM for running SoftWindows, and Insignia Solutions strongly recommends using 32 MB. As in all cases, the more memory you have, the better Insignia SoftWindows will run.

The hard disk space occupied by SoftWindows is 30 MB, but it will grow as you create more DOS and FSA files.

The minimum swap space requirements for SoftWindows is 36 MB or three times the amount of memory. If this requirement is not met, you risk going out of paging space and hanging your machine.
10.2.7.1 Changing the Memory Size
You can control the memory Insignia SoftWindows uses with the Options → menu entry. Calling this option will open the SoftWindows Memory window. This window has two sliders to select the amount of memory you want to use:

Main Memory Size (Mbytes) This value can range between 1 MB and 16 MB.

Expanded Memory Size (Mbytes) You can select between 1 MB and 32 MB of expanded memory.

The Memory window also has a button, labeled Replace the 256-640 Kbytes of conventional memory with expanded memory?, which you can use to increase your conventional memory.

10.2.8 Installing DOS and Windows Applications on SoftWindows
Usually, the DOS and Windows software is distributed in diskette or CD-ROM. If you have configured Insignia SoftWindows to access the diskette or CD-ROM, you will be able to install your PC applications the same way you install them on a regular PC.

For example, to install a Windows product, you can follow this path:
1. Select the File → Run option from the Program Manager menu bar.
2. The Run window will pop up; select the installation program you want to run.
   If you don’t know the name of the program, you can find it by choosing the Browse option. Do the following:
   a. Press the Browse button from the Run window.
   b. Select the drive where the software resides. If you are using the floppy disk drive, it will be drive A:. Drive F: corresponds to the CD-ROM.
   c. The list of executable programs of the selected drive will appear. Select the installing program you want to run, and press the OK button. This will bring you back to the Run window.
3. Press the OK button in the Run window to begin the installation sequence.

Refer to the installation manual of the product you want to install for more information.

To install a DOS product, you usually just have to type A:\INSTALL or A:\SETUP to begin the installation process. If the product is distributed in CD-ROM, you will have to use the drive F: instead of A:. Detailed installation instructions of the DOS product you purchased usually will be included in the installation manual that comes with it.

The File Sharing Architecture allows the installation of software from your hard disk or through the network by using an NFS filesystem. This is specially useful when you have to install the same product on several machines. You have to copy the installation diskettes into a directory of one of the systems, and remotely mount this directory on all the systems where you want the software installed. Accessing this directory as an FSA drive, you can install the software much faster than from a floppy disk.

Finally, if you want to install a product in your SoftWindows PC emulator, be sure it matches the hardware and software specifications. For example, Insignia SoftWindows Version 1.2 does not support 386 protected mode. If your product
requires it to be run in protected mode, you will need the Version 2 of Insignia
SoftWindows. By default, SoftWindows emulates a VGA display, but you can also
make it emulate a CGA, EGA or Hercules display to match the software you want
to run.

10.2.9 Networking Support for Insignia SoftWindows

SoftWindows includes a built-in module called SoftNode that implements its
networking functionality. This module allows you to run standard PC networking
software in the PC emulator. SoftNode is an ODI-compliant network driver. That
is, it emulates a network adapter with Novell’s ODI standard interface.

In the current version of Insignia SoftWindows, SoftNode is only able to interact
with Ethernet cards attached to the system. There is no token-ring support as
yet.

The degree of network support of SoftWindows varies depending on the
underlying operating systems. Supported networking products for AIX are:

1. Novell NetWare 3.x and 4.x
2. Banyan Vines
3. Microsoft LAN Manager 2.x
4. Novell LAN Workplace for DOS

Unfortunately, there are reported problems when running some other
ODI-compliant network products on AIX. These products are:

1. Sun PCNFS 5.0
2. FTP PC/TCP
3. Wollongong Pathway

10.2.9.1 Networking Commands for DOS

Insignia SoftWindows includes several networking commands in the C:\NOVELL
directory. These commands are mainly used to run the Novell client package
included with SoftWindows. However, some of them can be used to run other
network products.

Some of the commands included are:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LSL.COM</td>
<td>This command loads the Link Support Layer in the PC emulator memory.</td>
</tr>
<tr>
<td>ETHERSPC.COM</td>
<td>This command implements SoftNode’s ODI network driver.</td>
</tr>
<tr>
<td>IPXODI.COM</td>
<td>This implements the IPX protocol stack. It is part of the Novell NetWare client included with Insignia SoftWindows.</td>
</tr>
<tr>
<td>ODINSUP</td>
<td>This is the ODI-to-NDIS converter. You can use this program to run NDIS-compliant network applications on your PC emulator.</td>
</tr>
<tr>
<td>ETHER.BAT</td>
<td>This batch file starts the Novell NetWare client.</td>
</tr>
</tbody>
</table>

You can use these commands to run other software packages in addition to
Novell NetWare. For example, in 10.2.9.3, “Installing IBM TCP/IP for DOS” on
page 230, we used the ETHERSPC.COM driver as part of the ODI stack to run
IBM TCP/IP for DOS although we didn’t use the LSL.COM provided by
SoftWindows.
10.2.9.2 Using the Novell NetWare Client

A NetWare 3.11 client is installed, by default, in every container file created by SoftWindows. This client is located in the C:\NOVELL directory and occupies approximately 442 KB of disk.

To make the Novell software run on your PC emulator, you must have access to the Ethernet card. Perform the following steps:

1. Log in as the root user, and enter the following command before starting Insignia SoftWindows:
   ```
   strload -f /etc/dlpi.conf
   ```
   You can also include this command in your /etc/rc file if you want the Ethernet card to become available every time the machine is rebooted.

2. Make sure your CONFIG.SYS file includes the following line:
   ```
   LASTDRIVE=K
   ```
   This will allow Novell NetWare to use the drives following K: as Novell network drives.

3. Modify the C:\NOVELL\NET.CFG file in order to allow the IPX protocol to run over the Ethernet frame type you are using. The content of the NET.CFG file should be similar to the following:
   ```
   Link Support
     MemPool 4096
   Link Driver EtherSPC
     Frame ETHERNET_802.3
     Frame ETHERNET_II
     Protocol IPX 8137 ETHERNET_II
   ```
   This will allow IPX to run over Ethernet 802.3 and Ethernet II frames.

4. Start the Novell NetWare client on the PC emulator from the DOS prompt by using the following command:
   ```
   ETHER
   ```
   This will call the C:\NOVELL\ETHER.BAT program since the C:\NOVELL directory is included in your path by default.

   The ETHER.BAT DOS batch file calls the following programs to build the Novell NetWare protocol stack (all programs reside in the C:\NOVELL directory):
   a. LSL.COM, which loads the Link Support Layer. This program reads its configuration from the C:\NOVELL\NET.CFG file.
   b. ETHERSPXC.COM, which is the ODI driver provided by Insignia to interface with the RS/6000’s Ethernet card.
   c. IPXODI.COM, which provides an NDIS front-end to the upper levels, and translates their requests to the ODI packet driver in a lower level.
   d. Finally, ETHER.BAT calls the Novell NetWare shell redirector, NETX.EXE.

5. Once this program has been invoked, and if there were no error messages, you will be able to log in to the Novell server in your network. To do this, type the following on the DOS command line:
   ```
   L:
   LOGIN
   ```
In this case, your last drive was K:, as stated in your CONFIG.SYS file. The drive immediately following your last disk should contain your server’s login directory.

10.2.9.3 Installing IBM TCP/IP for DOS

SoftNode attempts to manage the IP packets the same way it manages the packets for the other protocols, such as IPX. It tries to present an ODI- or NDIS-compatible interface to the networking products whenever possible. Some operating systems, however, do not allow SoftNode to work with the IP packets at a level low enough to present the interface. Unfortunately, AIX is one of these operating systems. This means that not all TCP/IP products are supported under SoftWindows.

Insignia SoftWindows provides a TSR program, ISTCPIP.COM, that can be used to support Novell LAN Workplace for DOS on AIX. This package is supposed to provide TCP support for the PC emulator without any modifications. For more information on the installation and customization of this product, refer to SoftWindows for UNIX User’s Guide.

It is also possible to make IBM TCP/IP for DOS version 2.11 work under Insignia SoftWindows although the Windows TCP/IP applications won’t run for the version of SoftWindows tested. The DOS emulator will have an IP number different from the IP address under AIX, and you will be able to run DOS and AIX TCP/IP applications over the same Ethernet adapter at the same time.

To make IBM TCP/IP for DOS run on your PC emulator, you have to do the following:

1. Insignia needs the DLPI network interface to be loaded onto the AIX operating system. To activate it, log on as root, and issue this command from the AIX prompt:
   
   strload -f /etc/dlpi.conf
   
   You can add this command to your /etc/rc file in order to call it every time the machine is rebooted.

2. Before installing IBM TCP/IP, be sure that you have enough space on your filesystem to perform the installation. The IBM TCP/IP installation requires up to 8 MB of hard disk space.

3. Have your network administrator give you an IP number for your DOS emulator. This number should be different from the IP number used by AIX to access the Ethernet card.

4. Install IBM TCP/IP for DOS Version 2.11. To do this, you have to insert the first TCPDOS diskette in the drive, and type A:\INSTALL.EXE on your DOS prompt. Make sure the installation takes place on the default directory: C:\TCPDOS. Consult the IBM TCP/IP for DOS manuals for more information on installing the product although the installation process is rather straightforward.

5. Call the C:\TCPDOS\BIN\CUSTOM.EXE program to set up some initial values for the adapter.

6. Select the Configure → ODI Interfaces option from the CUSTOM menu bar. Enable the interface OD0, and fill the following fields:

   **IP Address**  
   In this field, write an IP number different from the IP address of the AIX machine on which SoftWindows is installed.
Subnet Mask  In this field, write your network’s subnet mask; for example, 255.255.255.0. Ask your network administrator for the subnet mask used in your network, or enter the `ifconfig en0` command to use the same mask the AIX is using.

Bound Adapter  Once positioned on this field, press the Down arrow to get a list of the possible adapters, and choose one of them, for example, IBM LAN Adapter for Ethernet. CUSTOM requires this field to be filled before saving the configuration, although we will not use any of the adapters supported by IBM TCPDOS.

7. Click on the OK button, and when back in the main menu, select Configure → Exit to save the options you have selected.

8. CUSTOM will write information on several configuration files in your DOS directories. Allow the program to write what it wants, and when asked for the number of files you want defined on your C:\CONFIG.SYS, set this number to 100. This will give TCPDOS enough resources to perform its network functions without interfering with the DOS.

9. Make sure that your C:\CONFIG.SYS file includes the line:

   DEVICE = C:\TCPDOS\BIN\DOSTCP.SYS

10. The CUSTOM program has created a NET.CFG file on your C:\TCPDOS\BIN directory. Edit it so that it has the following contents:

    protocol tcpip
    bind ETHERSPC
    Link Support
      Buffers 8 1920
    Link Driver EtherSPC
      Frame ETHERNET_II
      Protocol IP 800 ETHERNET_II
      Protocol ARP 806 ETHERNET_II

    CUSTOM has also created the TCPSTART.BAT on the C:\TCPDOS\BIN directory. You can edit it to change the TCP/IP startup procedure; we will leave it as it is for the moment.

11. Reboot the PC emulator by selecting the Actions → Restart option from the SoftWindows menu bar. This will make the changes in your CONFIG.SYS file effective.

12. From the DOS prompt, call the following sequence of commands:

    C:\TCPDOS\BIN\LSL.COM
    C:\NOVELL\ETHERSPC.COM
    C:\TCPDOS\BIN\TCPSTART.BAT

13. That should be enough to load the ODI stack in the PC emulator memory and start IBM TCP/IP for DOS. If you want to use SoftWindow’s LSL command instead of IBM’s, you should copy the C:\TCPDOS\BIN\NET.CFG file to the C:\NOVELL directory.

The network configuration is done. You can now try to access other machines on the network. For example, if there is a machine with IP number A.B.C.D in the same Ethernet network with you, try these commands:

    PING A.B.C.D
    FTP A.B.C.D
Note that some TCP/IP machines (such as PCs running IBM TCPDOS or some other TCP/IP implementation for DOS) are not configured by default to be ftp or telnet servers. However, you should always be able to ping them.

10.3 WABI for AIX

WABI is a Windows emulator which was made primarily for running Windows applications on top of AIX and other UNIX-like operating systems. Since AIX is more sophisticated than Windows, WABI was not designed to follow the behavior of this product in every detail. Instead, it uses AIX functions and camouflages them as Windows functions so the Windows applications can run without modifications. WABI maps Windows functions into AIX functions, such as drawing to the screen, writing to or reading from a file, accessing a diskette, and so on.

10.3.1 Installation of WABI for AIX

WABI for AIX Version 2.0 is a separate LPP consisting of the following filesets:

- **Wabi.Dt**: AIX Desktop Integration Files for WABI. It contains WABI icons and files that are needed to create the WABI group in your AIXwindows Desktop Application Manager window.
- **Wabi.fnt**: X11 fonts for WABI which are used to emulate the Microsoft Windows fonts.
- **Wabi.loc.***: Several filesets containing the locales for WABI.
- **Wabi.printers**: WABI printer support files (device drivers for Windows, mainly).
- **Wabi.rte**: WABI run-time environment.
- **Wabi.win**: Contains Windows fonts, executables and configuration files which are used in conjunction with the Microsoft Windows files.

WABI requires X11 Release 5 to function properly; it won’t work on an X11 Release 4 desktop.

WABI installs into the directory /usr/lpp/wabi. It also puts a symbolic link to the wabi executable program in the /usr/bin directory so you can access it without modifying your $PATH environment variable. The AIXwindows desktop integration files are placed in the /usr/dt directory.

10.3.1.1 Running WABI for the First Time

If the /usr/bin directory is present in your path, you only have to enter the following command to start WABI:

```
wabi
```

The first-time invocation causes WABI to create the $HOME/wabi directory, where it will store the files it needs for the day-to-day operation. The first thing WABI will do is build the font cache. This cache is used for performance purposes to avoid calling the X server too often (more on this topic in 10.3.9, “The Font Cache” on page 245). When the font cache is built, WABI will load the fonts (TrueType, bitmap and vector).
After that, the WABI Microsoft Windows 3.1 Install Program window will appear, requiring the installation of Microsoft Windows 3.1. WABI 2.0 needs Windows installed in order to be able to work. If you don’t install Windows now, everytime WABI is started, the Windows Installation Program will be invoked again.

The installation of Microsoft Windows requires 6 MB of free space in the filesystem where your $HOME directory resides. Every user running WABI will require Windows installed in his $HOME directory. It is not possible for different users to share the same copy of Windows; this way every user has write permissions over his C:\WINDOWS directory. Also, this is a way to enforce the purchase of one Microsoft Windows license per user.

Be sure you have read and write permission over the floppy disk device. If you don’t, WABI will not be able to access the device. You will notice that the diskette drive LED doesn’t blink as usual, and the installation process will fail and present the somewhat cryptic message:

```
Cannot find the A:\SETUP.INF file
```

The installation of Windows takes approximately five minutes. This is not a regular Windows installation: WABI copies certain files from the Windows diskettes and adds some files of its own. After Microsoft Windows 3.1 is installed, the usual Windows program groups, Accessories, Main and Games, are created in the Program Manager window. Also, WABI will place its own WABI Tools window. When everything is set up, WABI shuts down and restarts. You are now ready to use it.

This is a good moment for reading the WABI 2.0 Release Notes, which is located in the WABI Tools. It contains last minute information that is not present in the WABI 2.0 User’s Guide, such as:

- Actualized list of certified products
- Application-specific hints and tips
- How to upgrade from WABI Version 1

### 10.3.1.2 Files Modified by WABI

At installation time, WABI will create the $HOME/wabi directory. This directory will be the drive C: for the Windows applications you will run. Initially, it will contain the Microsoft Windows files in the windows subdirectory. The $HOME/wabi/fc directory contains the font cache files. The $HOME/wabi/tmp will be used by the Windows applications to store temporary data.

Also, the WABI Toolbox folder will be created in the AiXwindows desktop Application Manager. It will contain a folder for each Microsoft Windows program group that you have in your WABI Program Manager window. Initially, the folders will be:

- **Accessories** This folder is analogous to the Microsoft Windows Accessories program group. It contains small applications ("applets"), such as Calculator, Clock, Paintbrush, and Terminal.
- **Games** It contain the Windows games Solitaire and Minesweeper.
- **Main** Analogous to the Windows Main program group, this folder contains the following icons:
  - MS-DOS_Prompt

Chapter 10. Running Windows Applications 233
If you click on one of the program icons, the application will start its execution on foreground. For some of the applications, the wabiprog process will also be start to run, to provide them support. If WABI is already running, a second instance of WABI will not be started, but the application will be launched from the existing WABI Program Manager.

The WABI Toolbox folder also contains a WABI icon. Double-clicking on this icon, you will start WABI. If an instance of WABI is already active, you will not get a second instance, but the already existing WABI will become your active window.

The WABI installation process creates several files in your $HOME/.dt directory in order to make these changes in your desktop. The files and directories created are the following:

- $HOME/.dt/types/WABIApps.dt
- $HOME/.dt/icons/wabi
- $HOME/.dt/appmanager/WABIToolbox

### 10.3.2 WABI-AIX interaction

WABI was not designed to be just another operating system or to follow to the letter the PC behavior. When possible, WABI tries to take advantage of the superior capabilities of AIX to carry out the tasks the Windows applications require. Chores, such as memory management, networking functions and device access, are left to AIX to accomplish.

Windows API calls are translated into X calls, and Intel-specific instructions are passed to the CPU simulator. The resources usually found on an IBM-compatible PC are mapped to AIX services, for example:

- Graphical Window calls are translated into X Server calls
- File accesses are mapped to AIX file functions
- Windows memory is mapped into AIX virtual memory

### 10.3.2.1 Filename Mapping

The filename mapping follows the PC-NFS’s translation mechanism that we will now describe briefly.

DOS (and Windows) is very restrictive in the format of the file names. The rules for creating a valid DOS filename can be summed as follows:

1. The filename should be eight characters or less.
2. An extension of three characters is optional.
3. The following characters are not permitted:
   
   ```
   + [ ] * ? : \ / ; = < >
   ```

4. The single dot is only permitted as a file extension separator.
5. Only one filename extension is allowed.
6. Case is not taken into account.
7. Filename and file extension are separated by a dot “..”

WABI poses an extra limitation to the file names it will allow:
8. File names cannot include the tilde sign (“∼”) in the sixth character position.

This restriction is due to the technique used to map AIX file names into DOS file names. WABI employs the translation system used by Sun PC-NFS to convert the AIX names into DOS names. A tilde is placed in this position to indicate that the name of the file has been modified. WABI stores, in lowercase, the names of the DOS files it writes in its directories. Some applications, however, show the file names in uppercase characters. The translation mechanism tries to use as many characters of the “real” name as possible. If there are any remaining characters, the five characters of the name are left as they are, and the rest are used as an index into a translation table. The translation table returns two characters for each string entered. A tilde is used in the sixth position to separate the beginning of the file name from the two translated characters and to indicate that the file name has been changed by the translation process.

For example, the name “longername” would be translated into longe∼iu, where “iu” is the two-character sequence returned by the translation table.

The translation table uses a hashing mechanism that prevents having the same translation for two similar names. For example,

- The file similarfilename1 will be mapped to simil∼ax.
- The file similarfilename2 will be mapped to simil∼ay.

Also, names in uppercase will be mapped into lowercase names. For example,

- the file MALO.wri will be mapped to malo∼hd
- the file Malo.wri will be mapped to malo∼71
- the file malo.wri will be left unchanged

Multiple dots in a file name would also cause problems in the DOS environment. WABI has a mapping for these names, too. For example, “has.a.dot” will be translated into has∼a∼aw.dot. The “aw” is the result of using the hash translation table.

More examples can be seen in Table 18.

<table>
<thead>
<tr>
<th>AIX Name</th>
<th>WABI Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>abc123.def</td>
<td>abc123.def</td>
<td>No mapping required</td>
</tr>
<tr>
<td>a</td>
<td>a</td>
<td>No mapping required</td>
</tr>
<tr>
<td>A</td>
<td>a∼∼∼∼∼xx</td>
<td>Uppercase must be mapped</td>
</tr>
<tr>
<td>a_long_name</td>
<td>a_lon∼xx</td>
<td>First five characters are kept</td>
</tr>
<tr>
<td>AB.c</td>
<td>ab∼∼∼∼xx.c</td>
<td>Mapping and padding with ~</td>
</tr>
<tr>
<td>Ab.c</td>
<td>ab∼∼∼∼xy.c</td>
<td>Hash index xy is different than xx</td>
</tr>
<tr>
<td>abc.</td>
<td>abc∼∼∼xx</td>
<td>Dot only legal when followed by ext.</td>
</tr>
<tr>
<td>a.b.c</td>
<td>a∼b∼∼∼xx.c</td>
<td>Last dot for extension - others replaced</td>
</tr>
<tr>
<td>AIX Name</td>
<td>WABI Name</td>
<td>Notes</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>abcd.efgh</td>
<td>abcd~ ~ xx</td>
<td>Extension is illegal and not being used</td>
</tr>
<tr>
<td>.login</td>
<td>~ logi~ xx</td>
<td>Mapped and “hidden attribute” will be set</td>
</tr>
<tr>
<td>nina~</td>
<td>nina~</td>
<td>No mapping required</td>
</tr>
<tr>
<td>lorri~</td>
<td>lorri~ xx</td>
<td>Tilde can’t be in position number six</td>
</tr>
<tr>
<td>has.a.dot</td>
<td>has~ a~ aw.dot</td>
<td>“aw” used as index into the hashing table</td>
</tr>
</tbody>
</table>

### 10.3.2.2 DOS File Services Under WABI

Windows applications use DOS file services. The DOS file services can be invoked in three different ways:

1. Using the original INT 21H interrupt instruction
2. Using the “DOS3CALL”
3. Using windows subroutines functions, such as _lopen(), _lread() or _lwrite().

A Windows application under WABI can use any one of these three methods. All three methods invoke the same filesystem interface layer in WABI. This interface layer determines if the access is:

- To a diskette: in that case, WABI will use the DOS FAT-based filesystem itself.
- To an AIX filesystem: in that case WABI turns over the filesystem request to AIX. Based on the filesystem type, AIX invokes the appropriate function.

### 10.3.2.3 Record Locking and File Sharing

Record locking and file sharing are mechanisms to allow multiple users to access to the same drive. They can be defined as follows:

- **Record Locking** Prevents multiple users from accessing a file or a record at the same time.
- **File Sharing** Enables you to share a drive between several users, controlling which files are opened at a given time.

Record locking is not mandatory in WABI. Windows applications that are aware of this mechanism will respect record locking. All locks are cleared when you exit WABI or close a locked file. This includes files that are open when WABI is terminated unexpectedly.

File sharing is also advisory, not mandatory. Only applications that are aware of this mechanism will respect WABI file sharing. Several sharing modes are used by different applications to implement file sharing. One mode, for example, will allow other users to view a file that you are using, but won’t allow them to modify the file. File sharing is controlled every time a file is opened, and it works for whole files.

By default, file sharing is disabled for all drives to have a better performance. The overhead caused by sharing can affect the response time of the shared drive.
In DOS and Windows, the file sharing service is provided by a terminate-and-stay-resident (TSR) program, called SHARE.EXE. WABI has the file sharing capability built-in; so you don’t need to call SHARE.EXE to activate the file sharing on a drive. The only thing you have to do is click on the Sharing Enable checkbox of the Drive Connection dialog box.

All file sharing and record locking operations are converted by WABI to UNIX/Posix requests for locks through the lockf() and fcntl() system calls. If the file is remote, the request is sent to the lock daemon in the machine where the file resides.

10.3.2.4 Memory Management Under WABI
The memory management under WABI will appear to the applications the same as it is in a Microsoft Windows environment. WABI will answer the applications’ requests for memory through the usual window APIs. However, the internal memory management of WABI is very different that what we usually have in a Windows machine.

As it does with the graphical functions, WABI relies on the AIX memory management to provide memory to Windows applications. It does not pretend to manage the memory by itself, but instead it leaves it to the host operating system to administer the virtual memory and paging space. WABI uses the malloc() system call to obtain memory. This system call will not fail unless AIX runs out of paging space, which does not happen too often.

There are no “switches” (that is, shell variables, commands, flags, or parameters) that will control the way WABI obtains or grants memory. Given enough swap space, there are no limits on the amount of memory WABI can make available to the applications running under it.

WABI assumes that the paging space is unlimited. If, however, a call to malloc() fails because of lack of swap space available, WABI will tell the application that the system is out of memory. In that case, the application will return an “out of memory” message.

Unfortunately, this message will also appear on many other occasions. The “out of memory” messages are very frequent in “real” Windows, and they don’t necessarily mean that the system memory is exhausted. In fact, they don’t necessarily mean anything at all. Windows programs usually display “not enough memory” every time something goes wrong, not only memory space.

To make sure an application never runs out of memory, you have to increase your paging space. Applications will only run out of memory when the swapping space is exhausted. While there is paging space remaining, WABI will satisfy the applications’ requests for more memory. Usually, there are huge amounts of swapping space available on most of the UNIX systems. But in the Windows world, programs are restricted to use only the real memory, which is usually very small. Therefore, it is unlikely that an application will run out of memory in WABI.

This extreme memory availability will usually put to a test untested paths of the Windows applications. These untested parts of the programs can generate errors that would cause the “out of memory” message.
In WABI, as in all other AIX applications, the availability of memory depends on the size of the paging space. You only need to add more RAM if you want applications to run faster.

10.3.3 Configuring AIX Directories as PC Drives

Drives C: through Z: represent WABI drives, which are functionally equivalent to hard disk drives on a DOS machine. A WABI drive can be mapped to an AIX directory, which in turn can be a local directory, a remotely mounted filesystem or a CD-ROM drive.

To map an AIX directory to a WABI drive, use the Drive Connections utility (see Figure 111). This program is launched from the Configuration Manager, which can be found in the WABI Tools windows.

---

The Drive Connections dialog box includes three panels:

- **Drives**: This panel shows the list of all WABI drives and their assigned AIX directories. Drive letters that don’t have any assigned directory are available to use.

- **Available Directory Paths**: This box contains a list of the mounted filesystems and the subdirectories of the current directory. You can select the directory you want to use from this box. Double-clicking on a directory will show its subdirectories.

- **Directory Path for Selected Drive**: This panel has a field where you can write the name of the directory you want to link to a WABI drive. You can select the directory by using the Available Directory Paths box. This panel also contains two check boxes:
  - **Sharing Enabled**: Use this box to enable file sharing on the selected drive. By default, this option is in off since it affects the performance of the WABI environment. For more information on file sharing, refer to section 10.3.2.3, “Record Locking and File Sharing” on page 236.
• Network Drive

This box indicates if the drive will look like a network drive to the Windows applications running under WABI. All drives, except drive C:, should be defined as network drives if you want to access them.

Once you have selected an AIX path you want to link to a WABI drive, click on the Connect button of the dialog box. Press the OK button to save your selection, and you will be able to see the directory as a DOS disk.

Some directories are mapped to WABI drives and cannot be changed:
- The drive C: is mapped to the $HOME/wabi directory.
- The drive R: is mapped to the root (/) directory.
- The drive W: is mapped to /usr/lpp/WABI.

Some default drives can be changed:
- Drive E: is mapped to the $PWD directory.
- Drive H: is mapped to the $HOME directory.

To change a drive assignment, select the drive from the Drives box in the Drive Connection dialog box. Press the Disconnect button to clear the drive connection, and proceed to map any directory you want to the drive in question.

10.3.4 Defining Diskette Devices

WABI diskette drives are mapped to AIX devices. To map a diskette drive to a certain AIX floppy disk device, use the Diskette Connections utility. This program is launched from the Configuration Manager, which can be found in the WABI Tools windows.

Figure 112. WABI Diskette Connections Dialog Box. Use this utility to map WABI drives A: and B: to an AIX floppy disk device.

The Diskette Connections dialog box has several fields you have to fill in order to establish the connection to the desired floppy disk drive or drives:

**Diskette Drive A:** Use this field to select the device you want to access as drive A:. By default, this device is /dev/rfd0, which should be a good choice for most of the system configurations.
**Diskette Drive B:** This field controls the device assigned to drive B:. By default, no device is mapped to B:.

**Diskette Timeout** This is the time (in seconds) that WABI will wait to give up control of the diskette drive if it is not being accessed. This allows other programs to use the diskette device if the Windows applications are not using it.

Press the Advanced button to make the Advanced Diskette Drive Options pop up. This dialog box contains the directory where WABI looks for the diskettes and the regular expressions that a floppy disk device should match. WABI expects, by default, an AIX diskette device of the form /dev/rfd* since it needs to access the character special file.

The system defaults for the diskette devices can be restored by pressing the Defaults button.

### 10.3.5 Defining CD-ROM Devices

WABI allows access to a CD-ROM device, provided that AIX is capable of mounting it as an directory. A CD-ROM directory can be mapped into a WABI drive the same way a regular AIX directory is (see section 10.3.3, “Configuring AIX Directories as PC Drives” on page 238 for more information on the subject).

WABI does not support multimedia extensions yet; to play music from your CD-ROM, you should use the multimedia capabilities of AIX.

You may not be able to install an application that makes use of Microsoft CD-ROM extensions in the WABI environment. This is due to a protection mechanism that Microsoft has incorporated on much of its CD-ROM-based software. This mechanism ensures that a CD-ROM application cannot be installed from a network drive.

Because WABI accesses the CD-ROM as a directory in the local AIX machine, it will appear to the application as a network-mounted drive. This limitation cannot be overcome by disabling the Network Drive option on the Drive Connection dialog box.

### 10.3.6 Printer Support

The Printer Settings dialog box of the Configuration Manager allows you to set up the printer you will be using from your Windows applications.
The settings of the printer include the printer drive to be used, print job characteristics, such as paper orientation and number of copies, and the port to which the printer is connected. You can use the Port dialog box to connect a printer port with a printer command.

When you issue a printing command from a Windows application under WABI, the application will pass the print request to a printer driver. The printer driver, in turn, passes the request to its printer port. At this point, WABI intercepts the print job and redirects it to the AIX printing system.

10.3.6.1 Printer Configuration Example

In this example, we will set up a PostScript printer in the LPT1 port of our Windows emulator. The steps you have to follow are:

1. Set up a PostScript printing queue in your AIX system, and call it ps. Make sure the AIX queue is running properly (print some PostScript fancy graphics, for example) before proceeding with the next step.

2. Double-click on the **Ports** icon of the WABI Configuration Manager. The Port Settings dialog box will appear.

3. Select the port **LPT1** in the Port field.

4. Click on the **Connect** button. The Printer Output Connections dialog box will pop up. The Native Printer Name field will have the value `<Default Printer>`; leave it as it is.

5. On the Native Print Command field, write: `/bin/enq -P ps`

6. Press the **OK** button to save your selection. Press the **OK** button on the Port Settings dialog box also.
7. Double-click on the **Printers** icon of the WABI Configuration Manager. The Printer Settings dialog box will appear.

8. On the Installed Printer box, click the **Postscript Printer on LPT1:** to select it.

9. Click on the **Set as Default** button to set this printer as default. Click on the **OK** button to save your selection.

Now you can close your Configuration Manager, and test the printer from a Windows application (the Paintbrush program, for example, to ensure the PostScript graphics are laid out correctly). For more information on the WABI printing system, refer to *WABI 2.0 User’s Guide*.

### 10.3.7 WABI Tools

When you install WABI, the WABI Tools program group is created in your WABI Application Manager window. This program group is included in the Windows Program Manager when you install Windows 3.1.

![Figure 114. WABI Tools. Utilities for managing the WABI Windows emulator.](image)
The applications included in this group are the following:

- **Configuration Manager**
  
  This tool enables you to control a variety of WABI settings and its interaction with AIX. The icons on the Configuration Manager are related to different aspects of the application operation. These controls are:

  **Ports**
  Controls the behavior of the communication ports: baud rate, parity, flow control, and so on. It also controls the AIX printing command assigned to the printer ports.

  **Printers**
  Determines the default printer, printer driver, printer port assignment, and the characteristics of the printed output for your Windows programs.

  **Drives**
  Controls the AIX directories that are mapped to the WABI drives C: to Z::
Diskettes  Defines the floppy disk devices that will connected to WABI drives A: and B:.

Mouse  Swaps the assignment of the right and left buttons of the rodent.

Sound  Enables or disables the warning beeps for Windows application. These beeps are the only sound support that WABI has.

DOS  Sets the command you will use to call your DOS emulator.

Color  Lets you change the color of your WABI desktop. Among the choices available are Smooth Sailing, Blue Sky and Nouvelle Rouge. Cinnamon and Oregano are not implemented yet.

International  Allows you to customize your environment to use your favorite date and time formats, the decimal, comma or dot, and other international variable settings.

- **Windows Install**

  This application allows you to install Windows in your WABI emulator. It is called the first time you start WABI, and that should be the last time unless your Windows files become corrupted. If for any reason you should install Windows in your WABI directory, use this application. If you try to install Windows by any other means, important WABI files in your C:\WINDOWS directory may be lost.

- **DOS Session:**

  This application launches the DOS emulator. It is equivalent to the MS-DOS prompt program in the main program group.

- **File Viewer:**

  This utility lets you browse and print files in a way similar to the Microsoft write program.

- **WABI 2.0 release notes:**

  By calling this application, you will browse the /usr/lpp/WABI/wbin/readme.wri file with the file viewer we just mentioned.

### 10.3.8 Installing and Using the DOS Shell

WABI 2.0 does not include a DOS emulator, but you can start DOS applications/sessions from WABI by using a separate DOS emulator, such as PC-Simulator/6000 (PCSIM) or Insignia SoftWindows.

You must install a DOS emulator before you can run DOS applications from WABI. If the emulator is not installed, a warning message will appear each time you click on the MS-DOS Prompt icon:

**WABI Warning**

Running a DOS session requires a DOS emulator, which does not come with WABI.

To run DOS sessions:

1) acquire and install a DOS emulator
2) In the WABI Configuration Manager, click the DOS icon and enter the DOS emulator command.

To install the DOS emulator that we want to be launched from WABI, we have to follow the indications given by this message. To be more precise:

1. Install the DOS emulator (for example, Insignia SoftWindows).
2. Start WABI.
3. Open the WABI Tools program group, and double-click on the Configuration Manager icon.
4. When the Configuration Manager window appears, double-click on the DOS icon. The DOS Emulation Connection window will appear.
5. On the DOS Emulation Connection window, fill the DOS Emulation Command field with the name of the DOS emulator you will use. If the DOS emulator is on your $PATH, you don’t need to write the complete path to the command.
6. Click on the OK button.

To check to see if the DOS emulator is functioning correctly, double-click on the MS-DOS prompt of the main program group.

Refer to WABI 2.0 User’s Guide and your DOS emulator documentation for more information.

10.3.9 The Font Cache

Since X11R5 was released, the X windowing system provides a font service. The font service allows you to place the font files in a networked directory or file system. This file system has to be accessible by all the hosts in the network. The X servers running in the net can obtain all the font data they need from this directory.

The parsing of the font is done by the font servers; the X servers don’t need to parse the fonts themselves. Font servers export font data in a bitmap standarized format; so the X servers don’t need to do any additional calculations.

WABI needs to permanently receive lots of font information from the X server. To avoid the constant overhead of calling the X server all the time, WABI provides a font caching mechanism. When WABI detects a font server, it forks the mkwabifc program. This program communicates directly with the font server program and collects important metric information about all available fonts in the server. This way, each time WABI needs a font, it will get it from the font cache instead of having to call the font server.

WABI will create a font file for each X server it runs in. The name of the font cache file for X server display will be display0.fc. For example, if you run WABI in a machine called sabow and also in an Xstation with IP number 2.2.2.2, you will have the font cache files sabow0.fc and 2.2.2.20.fc. The fonts for the local X server are stored in the $HOME/wabi/fc/0.fc file.

WABI creates the font cache the first time it runs in a X server. When you start WABI a second time in the same display, it will use the font cache created.
When WABI is active, you will see two processes running at the same time: wabiprog, which provides the Windows emulation and wabifs, the WABI font server. These two processes work closely together.

At the beginning of its execution, WABI compares the current font path of the X display with the font path stored in the cache. If they don’t match, WABI builds a new font cache.

Sometimes, however, new fonts are added without modifying the font path. In that case, WABI will not rebuild the cache automatically, and the new fonts will not be available to WABI. You have to force a rebuild of the font cache; you can do that by creating an empty cache file. To create an empty cache file, use this command:

```bash
cat /dev/null > HOME/wabi/fc/display0.fc
```

where `display` is the name of your X server. The next time you run WABI, it will build a new font cache file.

The font cache stores the list of all available fonts and detailed metrics about each one. It does not, however, contain the pixelated images of each font. The bitmap images of the fonts are sent from the font server each time they are required. However, storing only the names and metrics of the fonts saves a lot of network overhead.

### 10.3.10 Remote Execution of WABI

Executing WABI remotely from another AIX machine or Xstation is straightforward. You have to use the `xhost` command to allow the remote machine access to the local X server, and set the `DISPLAY` variable on the remote machine prior to the execution of WABI, as you do when executing remotely any X11 command.

When WABI is started for the first time in an X server, it builds the font cache for that display. This process may take a couple of minutes, but it is only executed once. The next time you start WABI on that display, it will use the same font cache.

When you are executing WABI remotely, the diskette drives will be mapped to the floppy disk devices of the remote machine. There is no way to access your local diskette from a remotely executed WABI session since there is no way to access a remote diskette from AIX.

There cannot be two instances of WABI running on the same X server, even if they are launched by different users. If you start a second WABI process, both processes will coalesce into one single process, which will have the parameters of both processes combined. This also applies to Windows applications called by using the command:

```bash
wabi -s application
```

### 10.3.11 Running DOS and Windows Applications on WABI

In general, the installation and execution of Windows applications should be carried out the same way under WABI as it is under Windows. You can run applications from diskette or from an AIX directory. Taking advantage of the AIX networking functionality, you can use a local or remotely mounted directory.
### 10.3.11.1 Starting WABI and/or Windows Programs

There are three ways to start a Windows application using WABI:

1. Call `wabi` and launch the application from the WABI Program Manager.

2. Call `wabi application name`. This will start the application, and the WABI Program Manager icon will appear. For example, if you call `wabi c:\sol`, the WABI icon and the Solitaire windows will both appear. If you exit from the Solitaire, the WABI icon will remain. If you double-click on it, you will be able to access your WABI Program Manager and continue working on the Windows environment. This way of calling the applications is a shortcut for invoking WABI and then starting the application from it.

3. Call `wabi -s application name`. This will start only the Windows application. The wabiprog program (though you won’t see it) will be running in background to provide support for the application. The WABI icon will not appear, and when you exit the application, you will return to the AIX prompt.

### 10.3.11.2 Installing a Windows Application

As with the “real” Microsoft Windows machines, there are several ways of installing software in the WABI environment.

- **Diskette install:**

  To install software from diskette, choose the **Run** option from the File pull-down menu of the WABI Program Manager. The software is installed in the same way you do in the Windows environment. You can create program groups and program items by using the File → New option of the Program Manager as you do in Windows, to organize your programs in the Windows desktop.

- **Disk or network directory:**

  You can use a directory to install a product on several WABI instances residing on the same machine. To do that, you have to:

  1. Create one single directory under Windows.
  2. Use the File Manager to copy all the files from the installation media. This ensures that the file names will all be lowercase, as opposed to the dosread command.
  3. Map this directory to a virtual drive, for example, P.
  4. Install the application out of this directory.

  If you export the directory, you can remotely mount it from other machines, and use it to install the product over the network.

- **CD-ROM:**

  To access a CD-ROM device from WABI, you have to first mount it as an AIX CD-ROM filesystem, and then map the directory to a WABI drive. To do this, use the WABI Configuration Manager (it lives in the WABI Tools program group — see 10.3.5, “Defining CD-ROM Devices” on page 240).

  Once the CD-ROM can be accessed as a drive, you can install software the same way you would do it on a regular PC.

All drives, except drives A:, B: and C:, are network-mounted in WABI. Some products try to protect themselves from being illegally copied by not allowing installation from a networked drive. You will have to install these products from
the diskette. Fortunately, this is not frequent; if this happens, ask your software vendor for more information.

It is possible that the installation process of a non-certified application will fail. This does not mean that the application will not run under WABI; many products do run under WABI although their installation programs cannot be run properly. A possible workaround for this is installing the product on a windows machine and then copying all files created/modified by the product installation to your WABI directory. The installation of a product can modify some of the Windows configuration files; so this migration might be a difficult task.

When moving a Windows application from a PC to a RISC System/6000, look for:

- The application directory (and possibly some subdirectories).
- An application.INI file in your C:\WINDOWS directory.
- An application.GRP file in your C:\WINDOWS directory.
- A line near the end of the C:\WINDOWS\PROGMAN.INI file.
- Possibly some files with extension .DLL in your C:\WINDOWS\SYSTEM directory.

Move all these files to your AIX machine, and try to run the application under WABI.

10.3.11.3 Sharing Applications

Some applications provide a “network installation” option that allows the application to be shared among several users. Under WABI 2.0, you can take advantage of this option in whichever application it is present. Applications that do not have this option are often designed to be installed on a stand-alone, single-user machine.

As the Windows environment matures, more and more applications support the network installation feature. Consult your software vendor for more information on the applications you plan to run.

Several problems may arise when trying to share a single copy of an application among several users:

- Most Windows applications use the drive C: as the default drive for installing themselves. You have to change this drive if you want to share the application with other users.
- Applications create .INI and .DLL files in the C:\WINDOWS directory and otherwise modify your Windows configuration. Since drive C: is exclusive to each user, you have to make the same modifications on the drive C: for every user you want to run the application.
- Some applications create .INI files in the application directory. If several users try to access these files at once, the files can be corrupted, and the application will not run anymore.
- Finally, consult your software license. By allowing several users to access to a single copy of an application, you might be breaking the law!
10.3.12 Networking Support for WABI for AIX

The design philosophy of WABI is to rely on the underlying operating system (in this case, AIX) for support of most of the advanced functions. Following this philosophy, WABI will only employ the networking functionality of the host machine. If the host machine can access a network-mounted operating system or a remote printer, then this resource will be available to WABI. The file and record locking options of Windows are available to the applications running under WABI through calls to the lock daemons of the machines where the files are stored in the same way that file sharing and locking are performed in the local host.

Novell NetWare Client is not a certified application for WABI 2.0, but this doesn’t mean that you can’t access data from a NetWare server.

Files on a Novell NetWare server can be read, written to or executed from WABI if the host system can mount the NetWare drive as a network file system. This implies that you will have to install Novell NetWare Services for AIX, or install NFS NLM in your Novell Netware server. Either of the two solutions is equally good; as long as you are able to access the NetWare disk from the AIX, you will be able to access it from WABI.

The same can be said about NetWare printer servers. If you can define a Novell printing queue as a remote queue of your host, you will be able to access it from WABI. The idea is that WABI won’t allow you to do anything that you are not able to do from AIX.

If you tried to have access to Novell resources the other way around (accessing the resources through WABI, and then making them available to the rest of the operating system applications), that would add an unnecessary overhead on the system. From the point of view of the applications running under WABI, there is no apparent network support. No networking APIs, such as WinSock, can be accessed, and all drives look like local hard disks. On the other hand, from the point of view of the end user the system appears as network-rich, having the possibility of accessing remote disks and printers. Network-aware applications are not able to run under WABI. But in most cases, you won’t need them because the underlying operating system can provide all the networking functionality you may need.

10.3.12.1 WinSock Support

WinSock is an extension of the UNIX sockets networking API to allow its use under the tasking model of Microsoft Windows. This same extension is needed for accessing the TCP/IP sockets from a WABI application. The WinSock functionality is built into the wabiprog executable; so you won’t see the WINSTOCK.DLL file in your C:\WINDOWS directory. WABI supports the WinSock API only to the extent needed to support the certified applications. The only certified application that uses the WinSock API so far is Lotus Notes 3.0c client. This application can run under WABI without the need of any additional software.

The WinSock API is fully supported by WABI as long as the certified applications are concerned. This means that if you have an application that uses this API, other than Lotus Notes 3.0c client, and you are not able to make it run, you cannot call IBM to report a bug in the API. The WinSock API, and all WABI for that matter, was developed and tested to make sure the certified programs run. Other programs that use this API might be able to run under WABI, but there is no guarantee that all of them will work correctly.
10.4 Comparison of SoftWindows and WABI

In this section, we will discuss some differences between WABI and Insignia SoftWindows. Both products have different design philosophies and are intended for different, specific uses.

This list is intended to show the main issues that distinguish one Windows emulator from the other.

10.4.1.1 Look and Feel - Window Size

Both WABI and Insignia SoftWindows succeed in making the interaction with the Windows applications remarkably similar to what you have on the PC. There are some differences between approaches of both products, however.

Insignia SoftWindows emulates the PC environment in a AIXwindows desktop window. This window will be the equivalent of the PC monitor. You have three possible sizes for the DOS window, and you will be able to set the Microsoft Windows screen to the size of your preference.

All DOS and Windows applications will run into the Insignia window. This can be somewhat restrictive in terms of screen space if the window is too small. For the DOS applications, you can enlarge the window size. You have three possible sizes: 1.0, 1.5 and 2.0; experiment and choose the one that best fits your AIX monitor. To resize the DOS windows, proceed as with every other AIXwindows desktop application: Grab it from one of its corners and stretch it to the size you want.

The size of the Microsoft Windows screen is set when you start Windows on the Insignia SoftWindows PC emulator. A dialog box will pop up and tell you to resize your window. After that, the size of the Insignia window cannot be changed in the current session.

WABI, on the other hand, places the Windows applications in the AIXwindows desktop environment. As it translates the Microsoft Windows APIs to X11 functions, you will be able to set the Windows applications to your preferred size. Some applications that do not allow resizing on the Windows environment will not allow resizing under WABI, either.

If you are running your Windows applications under WABI in the Common Desktop Environment, you will be able to change the workspace the applications are located in. Insignia SoftWindows can be moved as a whole from one workspace to other, but you cannot change the workspace of an individual application. The main concept behind this is that the Insignia window is the monitor of a PC in which you are running Windows and DOS programs. WABI, on the other hand, is a launchpad from where to start Windows applications in an X11 environment.

10.4.1.2 Look and Feel - Mouse

In WABI, you use the mouse to control your Windows applications the same way you do in Windows. You can use it to change between Windows and AIX programs or to control your Windows applications.

When you are running SoftWindows, you can use the mouse to control DOS programs too. To do that, you have to attach the mouse to the Insignia SoftWindows window. You will not be able to use the mouse to control the AIX
programs while it is attached. To detach the mouse, press Control-Alt and the middle mouse button.

It is not necessary to attach the mouse to SoftWindows in order to use it to control the Windows programs running under it. You can move between the Windows and AIX environments without having to do any changes to your mouse configuration.

Both products allow you to perform cut-and-paste operations with the mouse. This way, you can cut some text from a Windows editor, and paste it into an aixterm window where you are running vi.

In the SoftWindows environment, as in Microsoft Windows, you have to click on a window to move it to the front. WABI windows, on the other hand, have to share the screen with other X11 windows. When you are using a Motif window manager, WABI has to manage the state of the window. If WABI detects that one of its applications has input focus, it moves that window to the front. When the application loses the input focus, the window is moved to the back again.

### 10.4.1.3 Emulation

Insignia SoftWindows was designed to emulate the behavior of a PC, while the designing philosophy of WABI was to use the AIX resources as much as possible to respond to the Windows applications’ requirements. Every program that runs on a PC and uses standard mode should run on SoftWindows. WABI, on the other hand, has official support only for “certified” programs. Other software products besides the certified ones may work under WABI, but they are not supported.

SoftWindows emulates the Intel processor one instruction at a time; WABI avoids this whenever possible and instead tries to map the Windows APIs to AIX resources. WABI only executes Intel instructions as a last resource; most of the time it is executing AIX calls to fulfill the applications’ requests. Originally, you didn’t need to install Microsoft Windows to make your Windows applications run under WABI. Today, WABI requires the installation of Windows (a subset of the original Windows 3.1 files, that is) to have the entire set of shared libraries available for the applications running under it.

This difference in the design show up in the performance of both utilities. Applications under WABI 2.0 (especially graphical ones) run slightly faster than under Insignia 1.2, and the graphical interface runs smoother. This situation, however, can change as new releases of both products become available. WABI 1.1 was a little slower than Insignia for processor-bounded applications, such as spreadsheets and database management, but this has changed and can change again with the new release of SoftWindows.

### 10.4.1.4 Protected Mode

The protected mode has not been implemented in WABI or in Insignia SoftWindows. Applications that need 386 protected mode to run have to wait until the next version of these products to be able to run on an AIX machine. When executing FrameMaker 4.0, for example, we got the “Not enough Memory” message. Other applications can give different messages (even useful ones) or cause your emulator to crash.
10.4.1.5 Multitasking
When emulating a single-user Personal Computer in a multitasking environment, several problems arise. What if several users try to write to the same files at the same time? This could cause data corruption of the files and produce catastrophic results in the behavior of the applications.

The container files of Insignia SoftWindows provide a method to prevent more than one user writing to the files that implement the drives C: and D: . If a SoftWindows session is using a container file, no other session will be able to write to it. Two or more users can share a single container file and use it as their C: drive; the AIX system will take care that no unauthorized user can write to it. Also, if a user starts a second SoftWindows session, he will only have read permissions for his C: drive.

WABI tries to avoid multiple accesses to the C: drive by enforcing one C: drive per user. This also implies that every user has to install Microsoft Windows 3.1 before being able to run WABI. Also, a user cannot run more than one instance of WABI on the same X server. This caution should be enough provided that the same user is not logged into the AIX system from different displays at the same time. Drives D: to Z: can be protected by turning on the file sharing and record locking options. The Windows applications that are aware of these mechanisms for resource sharing will not corrupt the data in the drives that are accessed concurrently.

10.4.1.6 Networking
Insignia SoftWindows and WABI have two radically different ways of providing network access to the applications running on top. Insignia assumes that the host machine has all the network capabilities that the Windows applications may ever need. WABI provides several device drivers to install network applications; so you are, in fact, able to access more things from SoftWindows than you can access from AIX. This is especially true about Novell servers. Since SoftWindows comes packed with a Novell NetWare Client license, you don't need to install any NetWare products for AIX to be able to get data from a Novell server.

With WABI, you cannot access any resource that is not available to the underlying operating system (the "host" operating system, as it is usually referred to in the WABI documentation). You can mount remote directories (be they NSF-mounted from some other UNIX machine or Novell drivers) as long as they are mounted as AIX directories. You can also redirect your printer jobs to remote printers as long as you can reach them as AIX remote printer queues.

With Insignia SoftWindows, you can do this and also get data from a remote NetWare server not accessible to AIX. This capacity is restricted to Ethernet networks and a few supported protocols, but nonetheless, it would be useful if, for example, you needed NetWare capabilities only for an emulated DOS application. With WABI, you would be forced to buy possibly expensive communications software, and configure it so you can read the Novell server disks from AIX. When you are using SoftWindows, Novell client access comes for free, and the configuration is done almost automatically.
10.5 Some Windows and DOS Software We Tested

In this section, we will summarize some experiences we had trying to make several DOS and Windows programs run under the AIX PC emulators. Our intention was to present the broadest possible selection of PC software, including games and demos, which are often the most demanding applications, and also to examine some of the “serious” products.

10.5.1 Games, Demos and Miscellaneous Software

WINMAZE3

This “amazing 3D Windows 3.1 and OS/2 2.1 demonstration maze” was created by Ray Trainer and is available on PCTOOLS. This demo program was selected primarily to test the ability of WABI for running noncertified software (and secondarily for self-amusement).

WINMAZE3 runs fine on both emulators although the translation of the Windows APIs on WABI results in a distorted image. The cells of the maze that are square in Windows (and in SoftWindows, too) appear as elongated rectangles in WABI.

Apart from this cosmetic issue, the game has the same behavior in both environments.

Another Windows utility we tested was GPSCLOCKW, a simple digital clock for Windows 3.x created by Gunnar P. Seaburg. This application is also available from PCTOOLS. GPSCLOCKW executed correctly on the two emulators, showing a tiny digital clock in the lower-right corner of the screen.

ISOMANDL 2.0

This demo program for DOS, written by John Watts (IBM UK), is available on PCTOOLS. Its main purpose is to generate 16-color fractal images. To this end, it calculates the Mandelbrot and Julia sets, and lets you zoom into the most interesting parts. It is also capable of swirling the colors of the generated picture to produce strange hypnotic effects.

ISOMANDL 2.0 runs nicely on SoftWindows’ DOS environment. The calculations for generating the Mandelbrot and Julia sets take a couple of minutes, and the color swirling is fast enough to make you dizzy.

When you invoke the program, the emulator window resizes to 640x480 pixels upon detecting the change to the video mode.

MANDEL87

This is another Mandelbrot set generator created by Steven M. Kipisz and available from PCTOOLS. It can zoom into your preferred zones of the set, but has no swirling colors. It runs OK in SoftWindows under the DOS emulation. Since it is a DOS application, it cannot run under WABI without a DOS emulator. Figure 109 on page 218 shows this application in action.

Castle of Doctor Brain (Demo Version)

Another DOS graphic program (this time a game demo) tested under SoftWindows. The full-screen animations run without trouble (even on an
Xstation), but there is no sound support. This is one of the two DOS programs tested where you can attach the mouse to the SoftWindows emulator. The other one is the Windows DOS editor, EDIT.

Once attached, the mouse works without problem, and you can select options in pop-up menus, and so on.

When making the list of the games we wanted to test, we also included the DOOM demo version. This DOS program is known for pushing the graphics capabilities of a machine to the extreme, and we were interested in seeing the performance of SoftWindows for this type of application (while shooting some Martians). Unfortunately, this program requires the CPU to be an Intel 80386 or higher, and SoftWindows 1.2 emulates an 80286; so the program could not be tested.

**PKZIP**

We also tested shareware compressor/decompressor for DOS, and it ran without problems under the WABI DOS emulation. The files compressed could be decompressed in a PC, and we could decompress .ZIP files generated by PKZIP in native DOS machines. The speed of the compression and decompression was equivalent to what we can achieve on a very good PC, compressing a 2 MB executable file in 37 seconds.

### 10.5.2 FrameMaker 4.0

Since this software runs in protected mode, we could not execute it under WABI or under SoftWindows. In both environments, this program has the same behavior. We could start it, but whenever we wanted to select an option from the menu bar (which is a prerequisite for having anything done), we got an “Not enough memory to start dialog box” message.

### 10.5.3 Lotus Freelance Graphics 2.01

This graphics package for Windows is a multimedia presentation editor capable of handling graphics and sound. Freelance is a member of Lotus SmartSuite and is designed for seamless data exchange with the other members of the suite, such as AmiPro and Lotus 1-2-3.

Lotus Freelance Graphics is certified to work under WABI 2.0 and can also be used under Insignia SoftWindows.

Due to the limited sound support of WABI and SoftWindows, we were unable to hear the sounds provided by the multimedia module of FrameMaker. We were able, however, to listen to them separately using the Media Player included in Ultimedia Services and concluded that the loss is not so terrible.

The installation of Freelance under WABI took less time than under Insignia. This made us think that it would be a good idea to perform some tests regarding the performance of the floppy disk operations for both PC emulators. We tried to write a 1 MB file to the diskette using several commands, with the following results:

1. The doswrite AIX command copied the file in 54 seconds.
2. The COPY command when issued from the SoftWindows DOS prompt took 54 seconds.
3. The File Manager utility took 56 seconds when issued from the WABI Application Manager.

4. The same utility took 2 minutes 15 seconds when issued from Insignia SoftWindows.

The startup time is shorter for WABI because it builds the Windows environment directly. It is even faster if you call wabi -s c:\flw\flw. On the other side, SoftWindows sets up the PC emulator, starts the DOS and finally invokes Microsoft Windows before letting you run Freelance.

In Insignia SoftWindows, it is not possible to resize the Freelance window beyond the limits of the SoftWindows screen. If you want a bigger image, you have to restart your Microsoft Windows session. WABI allows the application windows to be resized whenever you want. This freedom, however, is not free of dangers.

By default, Freelance starts its execution in a maximized window (the maximize button on the upper-right of the window is pushed). This means that there is no space left in your screen, not even enough to reach the border of the Freelance window and resize it. This can be a problem. If you launch a very demanding task (a reformatting of all the document, for example), you will not be able to perform any other task on that display until Freelance finishes its duty, and the mouse cursor changes from an hourglass to an arrow.

To prevent this, restore the window to its normal size, and enlarge it by grabbing it from one of its corners.

The Freelance tutorial requires a VGA display to run and is not compatible with the WABI large display. Other applications known to have this problem are Aldus PageMaker, Hardvard Graphics and Lotus AmiPro. The tutorial does not run under SoftWindows, either. In both cases, the program declares the display an EGA monitor and exits.

The overall look and feel of Freelance under both Windows emulators was remarkably similar and very close to the PC version. The graphical operations were performed smoothly, and the final result was satisfying in both cases. The bigger, chunkier graphics of WABI are perhaps more apt for this type of application, and the ability of resizing the window at will proved to be very useful too. Also, the Screen Show function is more dramatic in WABI since it occupies all the screen instead of only the emulator window.
Appendix A. Devices Supported on the RISC System/6000 Model 40P

The following is a list of devices that have been tested on the RISC System/6000 Model 40P. This list can be obtained from MKTTOOLS and is provided here for completeness. Be aware that this list is updated periodically. Make sure you have the newest version.

The list can be obtained by entering the following command on a VM screen:

TOOLCAT MKTTOOLS GET 40PDEVS PACKAGE

or

TOOLS SENDTO USDIST MKTTOOLS MKTTOOLS GET 40PDEVS PACKAGE

A.1.1.1 Internal Devices

- 1.44MB Diskette Drive - Standard
- 360MB Disk Drive
- 540MB Disk Drive
- 720MB Disk Drive
- 1GB Disk Drive
- 2GB Disk Drive
- CD-ROM (2X) - SCSI
- 2GB Internal 4mm Tape
- 4GB Internal 4mm Tape

A.1.1.2 8-bit Graphics Options (PCI)

- IBM E15 Graphics Adapter (entry 2D)
- IBM S15 Graphics Adapter (midrange 2D)
- IBM Power GXT150P Graphics Adapter (advanced 2D)

Note: Display cables may be required for use with the Power GXT150P

A.1.1.3 Communication Adapter Options (ISA)

- IBM Ethernet Adapter
- IBM Token Ring Adapter
- IBM X.25 Adapter

A.1.1.4 Supported IBM Monitors

- POWERdisplay 20
- POWERdisplay 17
- IBM 17S/S Sight and Sound Monitor
- 6324 family
- 6327 family
- 6325 family
- 9524 family
- 9525 family
- 9527 family
- 9521 family
A.1.1.5 Supported External Devices

- IBM 3510 External SCSI Storage Enclosure (*)
- Portable Disk Unit (7203-001)
- 1GB External Disk Drive (7204-001)
- 1GB External Disk Drive (7204-010)
- 2GB External 4 mm Tape Drive (7206-001)
- 4GB External 4 mm Tape Drive (7206-005)
- 1.2GB External 1/4” Tape Drive (7207-012)
- 2.3GB External 8mm Tape Drive (7208-001)
- 5.0GB External 8mm Tape Drive (7208-011)
- External CD-ROM (7210-001)
- External CD-ROM (7210-005)

**Note:** All internal media/disk devices listed can be used with the 3510 External SCSI Storage Enclosure.
Appendix B. IBM GXT150P Configuration Tables

5.6.4, “Adapter Combinations for Multihead Support” on page 133 shows the valid adapter configurations for multi-head operation.

When the IBM GXT150P graphics adapter is used, the adapter needs to be configured for the terminal you want to attach to it. For this purposes, the GXT150P adapter provides a switch block.

The tables presented in Figure 116 on page 260 and Figure 117 on page 261 describe how the switches should be set depending on the monitor type, resolution and frame rate you are using with the adapter.

The table presented in Figure 118 on page 262 provide you with information about the feature code and part number of the cable you need for the different monitor types.

B.1 IBM Monitors

The following table shows the IBM GXT150P switch setting for IBM monitors.
<table>
<thead>
<tr>
<th>Monitor Type</th>
<th>Video Card Switch 1234</th>
<th>Resolution Non Interlaced</th>
<th>Frame Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6314 6319</td>
<td>1111</td>
<td>1024 x 768</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>0010</td>
<td></td>
<td>70</td>
</tr>
<tr>
<td>6317 6324 6325 6327 9524 9525</td>
<td>1111</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>0010</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1011</td>
<td></td>
<td>75.8</td>
</tr>
<tr>
<td>9527 9521 7091-7s1</td>
<td>1111</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>0010</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1011</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>1010</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>1101</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>8517</td>
<td>1111</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td>8508 mono</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>67</td>
</tr>
<tr>
<td>POWERdisplay 16s</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>72</td>
</tr>
<tr>
<td>POWERdisplay 16</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1101</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>POWERdisplay 17</td>
<td>0010</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>0100</td>
<td>1280 x 1024</td>
<td>75.8</td>
</tr>
<tr>
<td></td>
<td>1111</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>0110</td>
<td>1280 x 1024</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>1101</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>POWERdisplay 20</td>
<td>0010</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>0100</td>
<td>1280 x 1024</td>
<td>75.8</td>
</tr>
<tr>
<td></td>
<td>1111</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>0110</td>
<td>1280 x 1024</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>1101</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>1091-051 16</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>72</td>
</tr>
<tr>
<td>5081-016</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td>6091-016</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1101</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>6091-019</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1110</td>
<td></td>
<td>67</td>
</tr>
<tr>
<td>6091-19i</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1101</td>
<td></td>
<td>77</td>
</tr>
<tr>
<td>6091-023</td>
<td>1111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
</tbody>
</table>

*Figure 116. Switch Setting GXT150P for IBM Monitors*
## B.2 Non-IBM Monitors

The following table shows the IBM GXT150P switch setting for non-IBM monitors.

<table>
<thead>
<tr>
<th>Monitor Type</th>
<th>Video Card Switch 1234</th>
<th>Resolution Non Interlaced</th>
<th>Framed Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ikei MF5117</td>
<td>0011</td>
<td>1024 x 768</td>
<td>60</td>
</tr>
<tr>
<td>Mitsubishi HL-6915</td>
<td>0010</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>0011</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>0111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td>Mitsubishi Hi/FL-6615</td>
<td>0010</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>0011</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>0111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td>NEC 5D Multisync</td>
<td>0010</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>0011</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>0111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td>NEC 4D</td>
<td>0010</td>
<td>1024 x 768</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>0011</td>
<td></td>
<td>60</td>
</tr>
<tr>
<td>NEC 5FG</td>
<td>0110</td>
<td>1280 x 1024</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>0001</td>
<td>1024 x 768</td>
<td>75.8</td>
</tr>
<tr>
<td>NEC 6FG</td>
<td>0110</td>
<td>1280 x 1024</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>0001</td>
<td>1024 x 768</td>
<td>75.8</td>
</tr>
<tr>
<td>Nano 9070U</td>
<td>0011</td>
<td>1024 x 768</td>
<td>60</td>
</tr>
<tr>
<td>Sony GDM1606 GMD1953</td>
<td>0111</td>
<td>1280 x 1024</td>
<td>60</td>
</tr>
<tr>
<td>Sony GDM1605 GMD1954</td>
<td>0011</td>
<td>1024 x 768</td>
<td>60</td>
</tr>
<tr>
<td>Sun Monitor</td>
<td>0101</td>
<td>1152 x 900</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>0100</td>
<td></td>
<td>66</td>
</tr>
<tr>
<td>Goldstar VGA 1465</td>
<td>1111</td>
<td>1024 x 768</td>
<td>60</td>
</tr>
<tr>
<td>Hyundai SVGA</td>
<td>1111</td>
<td>1024 x 768</td>
<td>60</td>
</tr>
<tr>
<td>NEC 3FGx</td>
<td>1111</td>
<td>1024 x 768</td>
<td>60</td>
</tr>
<tr>
<td>Panasonic C1395</td>
<td>1111</td>
<td>1024 x 768</td>
<td>60</td>
</tr>
</tbody>
</table>

*Figure 117. Switch Setting GXT150P for Non-IBM Monitors*
### B.3 Monitor Cables

The following table shows which cable is needed to attach your monitor to the IBM GXT150P graphics adapter.

<table>
<thead>
<tr>
<th>Monitor Type</th>
<th>Max Resolution Non Interlaced</th>
<th>Cable Feature Code</th>
<th>IBM Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>6314</td>
<td>1024 x 768</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>6317</td>
<td>1280 x 1024</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>6319</td>
<td>1024 x 768</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>6327</td>
<td>1280 x 1024</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>6324, 6325</td>
<td>1280 x 1024</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>9524, 9525</td>
<td>1280 x 1024</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>9521, 9527</td>
<td>1280 x 1024</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>8517</td>
<td>1280 x 1024</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>8508</td>
<td>1280 x 1024</td>
<td>4213</td>
<td>52G3255</td>
</tr>
<tr>
<td>1091-051</td>
<td>1280 x 1024</td>
<td>9021</td>
<td>09G3539</td>
</tr>
<tr>
<td>5081-016</td>
<td>1280 x 1024</td>
<td>4214</td>
<td>09G3539</td>
</tr>
<tr>
<td>POWERdisplay 16</td>
<td>1280 x 1024</td>
<td>4229</td>
<td>09G3539</td>
</tr>
<tr>
<td>POWERdisplay 16</td>
<td>1280 x 1024</td>
<td>4214</td>
<td>09G3539</td>
</tr>
<tr>
<td>POWERdisplay 17</td>
<td>1280 x 1024</td>
<td>4214</td>
<td>09G3539</td>
</tr>
<tr>
<td>POWERdisplay 19</td>
<td>1280 x 1024</td>
<td>4214</td>
<td>09G3539</td>
</tr>
<tr>
<td>6091-023</td>
<td>1280 x 1024</td>
<td>4214</td>
<td>09G3539</td>
</tr>
<tr>
<td>POWERdisplay 20</td>
<td>1280 x 1024</td>
<td>4214</td>
<td>09G3539</td>
</tr>
<tr>
<td>7091-7s1</td>
<td>1280 x 1024</td>
<td>None</td>
<td>11H4004</td>
</tr>
</tbody>
</table>

*Figure 118. Monitor Cables for GXT150P*
Appendix C. Windows Applications Supported Under WABI

The Personal Computer Desktop Integration section of Sun Microsystems (the part of Sun Microsystems that develops WABI) has certified the following applications to run under WABI 2.0.

1. Individual Applications
   a. Microsoft Excel 5.0 (or 4.0)
   b. Microsoft Word for Windows 6.0 (or 2.0)
   c. Microsoft PowerPoint 4.0 (or 3.0)
   d. Microsoft Project 3.0 or 4.0
   e. Microsoft Mail Client 3.2
   f. Microsoft Access 2.0
   g. Microsoft Windows 3.1.1 (or 3.1)
   h. Lotus 1-2-3 for Windows 4.0 (or 1.1)
      i. Lotus AmiPro 3.01 (or 3.0)
      j. Lotus Approach 2.1
   k. Lotus Freelance Graphics 2.01
   l. Lotus Organizer 1.1
   m. Lotus cc:Mail Client 2.0
   n. Lotus Notes Client 3.0c
   o. Borland Paradox for Windows 4.5 (or V1.0)
   p. Borland Quattro Pro For Windows 5.0 (or V1.0)
   q. Intuit Quicken 3.0
   r. WordPerfect for Windows 6.0a (or 5.2)
   s. Harvard Graphics for Windows 2.0 (or 1.0)
   t. CorelDRAW 4.0 (or 3.0)
   u. Aldus PageMaker 5.0 (or 4.0)
   v. Procomm PLUS for Windows 1.02 (or 1.0)

2. Suites
   a. Microsoft Office 4.3 (including unified install)
   b. Lotus SmartSuite 2.0

This list was last updated on December 9, 1994. You can get the last version of this list on Sun’s World Wide Web homepage (http://www.sun.com). You can also find useful information on this topic in the WABI 2.0 Release Notes. To access this file, double-click on the WABI Notes icon in the WABI Tools program group of the WABI Program Manager.
# List of Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APA</td>
<td>all points addressable</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td>AVI</td>
<td>Audio/Video Interleaved</td>
</tr>
<tr>
<td>BOS</td>
<td>Base Operating System</td>
</tr>
<tr>
<td>BTAS</td>
<td>Toot-Time Abstraction Software</td>
</tr>
<tr>
<td>CAD</td>
<td>Computer Aided Design</td>
</tr>
<tr>
<td>CDE</td>
<td>Common Desktop Environment</td>
</tr>
<tr>
<td>COMIO</td>
<td>Common Input/Output</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>CuAt</td>
<td>Customized Attributes</td>
</tr>
<tr>
<td>CuDv</td>
<td>Customized Devices</td>
</tr>
<tr>
<td>DCE</td>
<td>Data-Circuit Terminating Equipment</td>
</tr>
<tr>
<td>DMA</td>
<td>Direct Memory Access</td>
</tr>
<tr>
<td>DRAM</td>
<td>Dynamic Random Access Memory</td>
</tr>
<tr>
<td>DSE</td>
<td>Data-Switching Equipment</td>
</tr>
<tr>
<td>DTE</td>
<td>Data-Terminal Equipment</td>
</tr>
<tr>
<td>EDC</td>
<td>Error Detection Control</td>
</tr>
<tr>
<td>FSA</td>
<td>File Sharing Architecture</td>
</tr>
<tr>
<td>FTP</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>GEArena</td>
<td>Global Environment Area</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>HRP</td>
<td>PowerPC Reference Hardware Reference Platform Architecture</td>
</tr>
<tr>
<td>IBM</td>
<td>International Business Machines Corporation</td>
</tr>
<tr>
<td>IDE</td>
<td>Internal Data Equipment</td>
</tr>
<tr>
<td>ISA</td>
<td>Industry Standard Architecture</td>
</tr>
<tr>
<td>ITSO</td>
<td>International Technical Support Organization</td>
</tr>
<tr>
<td>JPEG</td>
<td>Joint Photographic Experts Group</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>MIME</td>
<td>Multimedia/Multipart Internet Mail Extension</td>
</tr>
<tr>
<td>MPEG</td>
<td>Moving Pictures Expert Group</td>
</tr>
<tr>
<td>MJPEG</td>
<td>Motion Joint Photographic Expert Group</td>
</tr>
<tr>
<td>NCSA</td>
<td>National Center for Supercomputing Applications</td>
</tr>
<tr>
<td>NFS</td>
<td>Network File System</td>
</tr>
<tr>
<td>NIM</td>
<td>Network Install Management</td>
</tr>
<tr>
<td>NVRAM</td>
<td>non-volatile Random Access Memory</td>
</tr>
<tr>
<td>OCS</td>
<td>On-Chip Sequencer</td>
</tr>
<tr>
<td>OS</td>
<td>Operating System</td>
</tr>
<tr>
<td>OSArea</td>
<td>Operating System Specific Data Area</td>
</tr>
<tr>
<td>PCI</td>
<td>Peripheral Component Interconnect</td>
</tr>
<tr>
<td>PCMCIA</td>
<td>Personal Computer Memory Card International Association</td>
</tr>
<tr>
<td>PdAt</td>
<td>Predefined Attributes</td>
</tr>
<tr>
<td>PCSIM</td>
<td>PC-Simulator/6000</td>
</tr>
<tr>
<td>PdDv</td>
<td>Predefined Devices</td>
</tr>
<tr>
<td>PM</td>
<td>Power Management</td>
</tr>
<tr>
<td>PReP</td>
<td>PowerPC Reference Platform Specification</td>
</tr>
<tr>
<td>PROFS</td>
<td>Professional Office System</td>
</tr>
<tr>
<td>PROM</td>
<td>Programmable Read-Only Memory</td>
</tr>
<tr>
<td>PP</td>
<td>Physical Partition</td>
</tr>
<tr>
<td>SPOT</td>
<td>Shared Product Object Tree</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
<tr>
<td>ROM</td>
<td>Read-Only Memory</td>
</tr>
<tr>
<td>ROS</td>
<td>Read-Only Storage</td>
</tr>
<tr>
<td>RTAS</td>
<td>Run-Time Abstraction Software</td>
</tr>
<tr>
<td>RTC</td>
<td>Real-Time Clock</td>
</tr>
<tr>
<td>SCSi</td>
<td>Small Computer System Interface</td>
</tr>
<tr>
<td>SMIT</td>
<td>System Management Interface Tool</td>
</tr>
<tr>
<td>SMP</td>
<td>Symmetric Multiprocessor</td>
</tr>
<tr>
<td>SNA</td>
<td>System Network Architecture</td>
</tr>
<tr>
<td>SOM</td>
<td>System Object Model</td>
</tr>
<tr>
<td>SVC</td>
<td>Switched Virtual Circuits</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
</tbody>
</table>
Index

A
abbreviations 265
Abstraction Software Components 10
Boot-Time Abstraction Software (BTAS) 10
Run-Time Abstraction Software (RTAS) 10
acronyms 265
Actors in HUMAN-CENTERED Computing 174
Adapter combinations for Multihead Support 133
Additional Multimedia Hardware 211
graphic adapters 211
IBM E15 graphics adapter 212
IBM S15 graphics adapter 212
POWER GXT150P graphics adapter 212
IBM amplified speakers 211
IBM personal microphone 211
IBM video capture enhancement 212
Architecture, File Sharing (FSA) 221
defining the CD-ROM device 222
sound support 223
the .swconfig file 223
defining the diskette device 222
defining your E: drive 221
setting AIX directories as PC drives 221
Architecture, PReP 7
Architecture, PReP Specification 7
Audio Mix and Master Volume 191

B
boot image 67
boot support 55
boot components specifically for AIX on RSPC Systems 59
boot record structure on RSPC Systems 65
hardfile layout for RSPC Systems 64
impact on boot utilities, commands and scripts 58
multiple platform boot 55
non-volatile RAM (NVRAM) 62
configuration data for non-native ISA devices 63
global environment area (GEArea) 62
operating system specific data area 63
NVRAM utilization on RISC System/6000 vs RSPC 63
platform-specific components 56
base and proto extension files 56
ODM predefined database 58
RAM file system 58
RSPC firmware 60
Software ROS for AIX 60
construction of the IPL control block 61
locating and transferring control to the AIX boot image 61
NVRAM initialization by Software ROS 61

Boot-Time Abstraction Software 10
BTAS 10

C
CD-Audio Player 188
Collaborative Computing 170
Configuring AIX Directories as PC Drives 238
Configuring ISA Adapters 112
using SMIT or command line 112
configuring ISA Ethernet adapters 113
configuring ISA Ethernet adapters at AIX level 114
configuring ISA Ethernet adapters at firmware level 113
configuring ISA token-ring adapters 115
configuring ISA token-ring adapters (with switches) at hardware level 116
configuring ISA token-ring adapters at AIX level 118
configuring the auto 16/4 token-ring ISA adapter at firmware level 117
on the RISC System/6000 Model 40P 117
on the RISC System/6000 Model 43P 118
testing ISA adapter configuration 119
Configuring ISA X.25 Adapters 124
basic X.25 communication tests 129
configuring ISA X.25 adapters at AIX level 126
configuring ISX X.25 adapters at hardware level 124
Configuring MIME Types for Mosaic 206
Configuring PCI Adapters 129
accessing the second display 133
configuring non-graphic PCI adapters 130
configuring PCI graphic adapters 130
configuring two PCI graphic adapters (multihead) 132
configuring/replacing the first PCI graphic adapter 131
Configuring SCSI Devices 134
Configuring SoftWindows for Multiple Users 223
Configuring VoiceType Navigator 197
command types 198
CDE actions 199
internal actions 199
keystrokes 198
creating your own commands 199
Conversational Applications of HUMAN-CENTERED Computing 172
intelligent agents 173
speech recognition 173
continuous vs. Discrete Speech 174
dictation 173
navigation 173
speaker dependent and speaker independent applications 173

© Copyright IBM Corp. 1995

267
Customizing Mosaic 205
Cutting the Underground Support Costs 169
dictation 170
examples of HUMAN-CENTERED computing 170
security 170
voice response systems 170

D
Device Configuration on RSPC Systems 99
database object classes 101
cuAt (customized attributes) 104
cuDv (customized devices) 103
PdAt (predefined attributes) 102
PdDv (predefined devices) 101
device configuration database 100
enhancements to the configuration database 105
DOS File Services Under WABI 236

E
Entering the Kernel Debug Program 164
Error Logging Facility 165
Exit Insignia SoftWindows 218

F
File Sharing Architecture (FSA) 221
Files Modified by SoftWindows 219

G
Games, Demos and Miscellaneous Software Tested 253
Getting and Installing an Insignia SoftWindows License 216

H
Handling AIX Boot Problems 155
Handling Network Installation Problems 161
updating the firmware 161
recovery from a failed firmware update 162
Handling Power-Up Problems 149
handling power-up failures 152
Phase 2 150
Phase 3 150
Phase 4 151
power-up initialization 149
Phase 1 149
Handling Software ROS Problems 154
Hardware Diagnostics 156
displaying the error log 156
hibernation logical volume 144
difference between PM enablement and PM configuration 145
power switch behavior 145
system standby state 144

I
importance of Windows emulation 213
Information Sources about PowerPC-based Systems 166
Initializing an Insignia SoftWindows User 217
Insignia SoftWindows 214
Insignia SoftWindows container files 219
changing your booting device 220
creating a D: drive 220
drive C: — the booting disk 220
Insignia SoftWindows System Requirements 226
Insignia SoftWindows, AIX interaction with 226
the RUNUX command 226
Insignia SoftWindows, comparison with WABI for AIX emulation 251
Insignia SoftWindows, comparison with WABI for AIX multitasking 252
Insignia SoftWindows, comparison with WABI for AIX networking 252
Insignia SoftWindows, comparison with WABI for AIX protected mode 251
Insignia SoftWindows, configuring for multiple users 223
Insignia SoftWindows, exiting 218
Insignia SoftWindows, files modified by 219
Insignia SoftWindows, getting and installing a license 216
Insignia SoftWindows, initializing a user 217
Insignia SoftWindows, installing 215
Insignia SoftWindows, installing DOS and Windows applications on 227
Insignia SoftWindows, installing IBM TCP/IP for DOS 230
Insignia SoftWindows, networking support 228
networking commands for DOS 228
Using the Novell NetWare client 229
Insignia SoftWindows, printing with 224
Insignia SoftWindows, remote execution of 225
Insignia SoftWindows, starting 217
Insignia SoftWindows, understanding 219
SoftWindows container files 219
Insignia SoftWindows, using the Novell NetWare client 229
installing IBM TCP/IP for DOS 230
Installation of WABI for AIX 232
Installing DOS and Windows Applications on SoftWindows 227
Installing Insignia SoftWindows 215
Installing Mosaic 205
ISA Bus Architecture 32
how to connect to the PowerPC 32
introduction 32
reasons for ISA support 32
M

Media Player 188
Memory Management Under WABI 237
Miscellaneous Hints and Tips 159
starting System Management Services 159
booting in maintenance mode 160
Mosaic 204
downloading Mosaic via FTP 204
Mosaic’s Online Help 206
MPEG Player 189
playing an MPEG file 190
Multimedia Demos 201
miscellaneous multimedia software 204
speech dictation 201
text-to-speech 202
dictionary editor 203
talking head 202
TalkingBiff 203
Text-to-Speech window 203
Type-n-Talk 203
Multimedia Hardware 209

N

Network Installation 77
preparing the network environment 77
Networking Support for Insignia SoftWindows 228
NIM Master configuration 78
filesystems creation 79
installing the NIM Master filesets 78
the /export filesystem 79

O

Open Firmware 13
device tree 14
FCode 14
Fcode debugging 14
modularity 14
operating system debugging 14
plug-in device drivers 13
programmable user interface 14

P

PCI Bus Architecture 27
features and benefits 28
cross-platform compatibility 29
high data transfer speed 29
multiple bus support 30
processor independence 29
introduction 27
investment protection 31
local bus overview 27
Plug and Play support 31
PCMCIA Bus Architecture 33
cards 35
introduction 33
PCMCIA Bus Architecture (continued)
socket 35
software services 36
card enabler 36
card services 36
socket services 36
Plug and Play 36
benefits 37
hardware and software requirements 37
what is Plug and Play? 37
PM problems and warnings 143
booting from CD-ROM directly after
hibernation 144
possible network problems 144
problems changing configuration while
hibernating 144
requirements for device drivers to support
hibernation 144
Power Management 20, 135
device-level power management 135
Implementation for energy-managed systems 22
device and subsystem Power Management 24
support for suspend and hibernation system
states 24
micro power management 135
model 20
system-level power management 135
Power Management Components 136
PM commands and user interfaces 138
PM core 136
PM daemon 137
PM kernel services 137
PM library 138
PM-aware device drivers 137
Power Management Software Installation and
Configuration 140
PM configuration 141
PM installation 141
Power Management States 139
device local standby 139
hibernation 139
system full-on 139
system suspend 139
PowerPC Hardware Reference Platform
Architecture 24
HRP introduction and history 24
PowerPC Hardware Reference Platform introduction
and history 24
PowerPC Hardware Reference Platform architecture
document 25
HRP architecture goals 25
HRP brand and certification 26
PowerPC Hardware Reference Platform
architecture goals 25
PowerPC Hardware Reference Platform brand and
certification 26
purpose of the HRP architecture document 25
purpose of the PowerPC Hardware Reference
Platform architecture document 25
PowerPC Reference Platform

component variations 8
firmware 12
firmware problems 13
firmware solution 13
hardware configuration 4
Expansion Bus(es) 6
Human Interface Subsystem 6
Industry Interface Standards 6
Memory Subsystems 5
Real-Time Clock 6
Storage Subsystem 5
Implementation 18
Machine Abstraction 8
mandatory components 7
optional component 7
optional components 7
PowerPC Reference Platform, explained 3
PReP Specification
System Topology 7
PowerPC Reference Platform Specification 1
Implementation 18
PowerPC Reference Platform Specification, explained 3
PowerPC Reference Platform Specification, explained 3
PowerPC Reference Platform Specification, reasons for having 1
PowerPC-based Systems, information sources 166
PreP 3, 18
multiprocessor system 20
portable system 18
PReP, explained 3
Reference Implementation 18
server system 20
PReP Specification 1
component variations 8
firmware 12
firmware problems 13
added bootable devices 13
added display devices 13
firmware solution 13
Implementation 18
Machine Abstraction 8
Achievements 8
example 9
requirements 9
mandatory components 7
System Topology 7
PReP Specification, Architecture 7
PReP, Architecture 7
PReP, reasons for having 1
preparing ISA adapter configuration (continued)
recording settings of ISA adapters already configured (continued)
recording ISA X.25 adapter settings 108
selecting parameter values for ISA adapters 109
Printing with SoftWindows 224

R
reasons for having a PowerPC Reference Platform Specification 1
reasons for having a PreP 1
Remote Execution of SoftWindows 225
RISC System/6000 Model 40P 38, 210
features and benefits 39
hardware characteristics 41
audio subsystem 42
connectivity 42
graphic adapters 42
graphic displays 43
input devices 42
processor and memory subsystems 41
storage subsystem 41
limitations 45
RISC System/6000 Model 40P system performance 43
RISC System/6000 Model 43P 45, 210
features and benefits 47
hardware characteristics 49
audio subsystem 50
cache subsystem 49
connectivity 50
graphic displays 51
input devices 50
memory subsystem 49
processor subsystem 49
storage subsystem 49
video subsystem and graphic adapters 51
limitations 54
system performance 52
RISC System/6000 systems 27
PCI-based 27
RSPC Firmware (System ROS) 15
Bi-Endian Support 16
RSPC hardware, difference 1
RSPC Systems network installation limitations 97
RTAS 11
Run-Time Abstraction Software (RTAS) 11
Running Diagnostics Tests 158
base diagnostics supported 158
hardware test limitations 159
Running Windows Applications 213

S
Setting the Machine Serial Number 164
Setting the System Passwords 162
power-on password 162
supervisory password 163
Setting the System Passwords (continued)
unattended start mode 163
setting up and configuring an X.25 network 120
Software ROS Initialization 153
Software tested, FrameMaker 254
Software tested, Freelance Graphics 2.01 254
Software tested, Games, Demos and
Miscellaneous 253
Software tested, Windows and DOS 253
SoftWindows-AIX Interaction 226
SoftWindows, requirements of 226
changing memory size 227
Speech Tools 192
VoiceType Navigator 192
Audio Settings window 194
Navigator window 195
Speechbar window 193
Starting Insignia SoftWindows 217
Structure of the RSPC Boot Image 68
boot image creation 69
modifications to the boot commands 70
bootinfo 71
boottlist 71
bosboot 71
mkboot 71
mkmboot 72
rc.boot 72
supported boot devices on RSPC Systems 72
selecting boot devices 73
supported external boot devices 73
System Dump Facility 165

T
the /inst.images Filesystem 79
allocating resources for the stand-alone
installation 90
client RSPC configuration 92
defining the lpp_source resource object 86
defining the shared product object tree (SPOT)
resource object 88
initiating the BOS installation 91
installing additional software into the SPOT
resource 89
NIM client machines definition 84
NIM Master activation 79
NIM network objects definition 82
post installation operations 96
resource objects definition 86
the /tftpboot filesystem 79
Touch/Pen 175
Troubleshooting and Miscellaneous 147
problem-solving and reference guide 147
problem-solving overview 147
problem-solving tools 148

U
Ultimedia Services 179
audio editor 185
editing a movie 186
editing an audio file 186
installing Ultimedia Services 180
movie editor 181
multimedia tools 180
playing a video file 183
playing an audio file 186
recording a movie 184
recording and playback options 187
recording sound 187
Understanding SoftWindows 219

V
Video and Image Viewers 207
2424.Xloadimage 209
XAnim 208
XV 208
Video Monitor 192

W
WABI and SoftWindows, comparison of 250
WABI for AIX 232
WABI for AIX, comparison with Insignia SoftWindows
emulation 251
WABI for AIX, comparison with Insignia SoftWindows
multitasking 252
WABI for AIX, comparison with Insignia SoftWindows
networking 252
WABI for AIX, comparison with Insignia SoftWindows
protected mode 251
WABI for AIX, comparing AIX directories as PC
drives 238
defining diskette devices 239
WABI for AIX, defining CD-ROM devices 240
printer support 240
WABI for AIX, defining diskette devices 239
defining CD-ROM devices 240
WABI for AIX, file services under 236
record locking and file sharing 236
WABI for AIX, filename mapping 234
WABI for AIX, files modified by 233
WABI for AIX, installation of 232
running WABI for AIX for the first time 232
WABI for AIX, installing a Windows application 247
WABI for AIX, installing and using the DOS shell 244
WABI for AIX, interaction with AIX 234
filename mapping 234
WABI for AIX, memory management 237
WABI for AIX, networking support for 249
International Technical Support Organization
Managing AIX V4 on PCI-Based
RISC System/6000 Workstations (40P/43P)
September 1995
Publication No. SG24-2581-00

Your feedback is very important to help us maintain the quality of ITSO Bulletins. Please fill out this questionnaire and return it using one of the following methods:

• Mail it to the address on the back (postage paid in U.S. only)
• Give it to an IBM marketing representative for mailing
• Fax it to: Your International Access Code + 1 914 432 8246
• Send a note to REDBOOK@VNET.IBM.COM

Please rate on a scale of 1 to 5 the subjects below.
(1 = very good, 2 = good, 3 = average, 4 = poor, 5 = very poor)

Overall Satisfaction
Organization of the book
Accuracy of the information
Relevance of the information
Completeness of the information
Value of illustrations
Grammar/punctuation/spelling
Ease of reading and understanding
Ease of finding information
Level of technical detail
Print quality

Please answer the following questions:

a) If you are an employee of IBM or its subsidiaries:
   Do you provide billable services for 20% or more of your time? Yes____ No____
   Are you in a Services Organization? Yes____ No____

b) Are you working in the USA? Yes____ No____

c) Was the Bulletin published in time for your needs? Yes____ No____

d) Did this Bulletin meet your needs? Yes____ No____
   If no, please explain:

What other topics would you like to see in this Bulletin?

What other Technical Bulletins would you like to see published?

Comments/Suggestions: ( THANK YOU FOR YOUR FEEDBACK! )

Name
Address
Company or Organization
Phone No.